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INTRODUCTION 
T he chief strength of the Apple Macintosh , its ease of use, is paradoxically a 

major weakness. Mac users learn so much by doing that they don't bother reading 
manuals and introductor y texts. That's too bad, because the Mac has another level 
of performance that is hard to discover by unguided experimentation but is easy to 
master with brief explanation. T hat's what this book is all about: tips to help you 
learn new ways to perform everyday Mac tasks and in the process gain insights 
into more efficient and productive ways to use your Mac. 

Mac Insights can help you start and quit applications faster, find disk space you 
didn't know was there, troubleshoot when your Mac doesn't work right, rescue lost 
and damaged files, and transfer information to and from other types of computers, 
including mainframes and IBM PCs. It gives you advice on organizing applications 
and documents on disks, printing envelopes on an ImageWriter or LaserWriter, 
and formatting for a LaserWriter even if you don't have one. 

With this book, you can find out how to best eject disks, select options in 
dialog boxes, draw dotted and dashed lines, mix text attributes on the same line in 
MacPaint and MacDraw, and select words, lines, sentences, phrases, paragraphs, 
and other large areas of text. You also get tips on creating custom MacPaint brush 
shapes, using several MiniFinders, adding Command-key shortcuts to menus, 
personalizing icons and pointers, printing pin-feed labels, and adding characters 
of your own design to any font. 

Tip sources 

For well over two years I have been reading and answering letters that 
Macintosh users write to my "Get Info" column in Macwor/,d magazine. Much of what 
has appeared there appears in Mac Insights. I've selected the best information from 
"Get Info" and included it here to save you from hunting through back issues. 

But material from "Get Info" only accounts for about a third of the tips in this 
book. The rest of the tips come from research I've done both for my column and 
specifically for this book. I have scoured countless newsletters, magazines, books, 
information-ser vice databases, electronic bulletin boards, and so on (see the 
acknowledgments for a complete list of my sources). 
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Using this book 

To get the most out of Mac Insights, you should already be familiar with the 
Macintosh . Do you know what I mean by menu, menu bar, pointer, insertion point, 
desktop, window, title bar, scroll bar, folder, application, document, icon, highlight, 
dialog box, and button? Can you select, choose, open, close, click, double click, drag, 
and scroll? If not, please spend a couple of hours with your Macintosh owner 's 
manual before reading this book. 

Where a tip applies to just one application program, you need a fundamental 
knowledge of the application's features and operation to be able to make use of the 
tip. For example, don't bother with the word-processing tips unless you know how 
to use MacWrite or another word processor to write, edit, print, and save a letter. 

You can use Mac Insights in several ways. Read the entire book-or a complete 
section- from beginning to end, if you like. But if you're like most Mac users, you'll 
probably pick up the book and browse through it, looking for suggestions that 
intrigue you and ideas you want to try. O r perhaps you'll go directly to the subjects 
that interest you-advice on using modem commands, help with formatting text 
documents, a cure for worn-out mouse feet, and so on. Are you having trouble print­
ing a document? Turn immediately to the troubleshooting chapter's concise list of 
common ImageWriter and Laser Writer problems and their cures. Perhaps scan the 
printing chapter for more help. Or check the index and discover other tips that men­
tion printing problems. Because I think you'll use the Mac Insights index often , I've 
prepared as complete and helpful an index as possible. 

I've tried every one of the tips in this book on several variations of the Mac. T he 
tips all work on the standard Mac 512 K, the Mac 512 K Enhanced, and the Mac Plus. 
Most tips also work on Macs with the original 64K ROMs and on the Mac XL, but I 
did not test the tips extensively on those machines. When testing, I used the latest 
program versions available as of April 1986. Naturally, if (perhaps I should say when) 
a software publisher distributes a new version of a particular application program, 
you may have to experiment a bit to make some tips work properly. 

Where appropriate, I name the specific products, especially software, that you'll 
need for the tips. In case your local Apple dealer or software store does not stock all 
these programs, l 've listed sources at the end of the book. 
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I think you'll find Mac Insights informative, fun, and easy to use. I hope it will 
stimulate your curiosity and sense of adventure, and encourage you to experiment 
and explore. If you have any suggestions for tips you'd like to see included in the next 
edition, please send them to me at Microsoft Press, 16011 N .E. 36th, Box 97017, 
Redmond, WA 98073-9717. 
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Shortcuts 

The Macintosh user interface makes learning applications easy, 
but may get in the way once you master basic skills. 

Fortunately, there are shortcuts for bypassing many easy-but­
lengthy procedures. Some shortcuts are fairly obvious, such as 
the Command-key shortcuts listed in the menus. For example, 

everyone soon discovers that pressing Command-X, 
Command .. c, or Command-Vis quicker than choosing Cut, Copy, 
or Paste from the Edit menu. This chapter describes some equally 
usefid shortcuts that Mac users don't always find on their own. 
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Mac Insights 

USING THE MOUSE 
Dragging a window without activating it 

When several windows are displayed on the screen, dragging one window by its 
title bar normally puts it on top of all others and makes it the active window. If you 
want to move a window aside to see what's underneath it, but don't want to activate it, 
press the Command key when you start to drag. You can release the Command key 
after you begin dragging. 

T his trick will not work with the Alarm Clock desk accessory's window. Like all 
windows without title bars, the Alarm Clock window always comes to the top and 
becomes active when you drag it. 

Opening a compatible document from the Finder 

It's usually easy to open a document directly from the Finder's desktop. You 
either select the document's icon and choose Open from the Finder's File menu, or 
double click on the icon. However, if the application that created the document is not 
on any of the disks whose icons appear on the desktop, the Finder complains An 
application can't be found [or this docurnent. 

Suppose that your goal is to open the document, not with the application that 
created it, but with a compatible application; for example, you might want to open 
a MacTerminal document with MacWrite. To open the document: 

1. Select the document and application icons. 

2. Choose Open from the Finder's File menu. 

The document and application must be in the same folder, since the Finder won't let 
you select items from different folders at the same time. 

This shortcut works with some applications, but not all. For example, MacWrite 
can open any plain-text document, but not a formatted Jazz or Microsoft Word doc­
ument. MacPaint and MacDraw cannot open any documents but their own. 
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Opening several documents from the Finder 

Applications such as MacDraw and Microsoft Excel can open more than 
one document from the Finder at a time. To open several documents at once: 

1. Select all the documents. 

2. Choose Open from the Finder's File menu. 

The Finder can't simultaneously select documents from different folders, so all the 
documents must be in the same folder. · 

This shortcut doesn't work for all applications capable of opening several docu­
ments at once. For example, Microsoft Word opens only one document from the 
group you select. If you want to work with more than one Word document at a time, 
you have to start Word and open each document individually. 

Removing disk icons 

Early versions of the Finder did not allow you to drag a disk icon to the Trash 
unless you ejected the disk first. Beginning with Finder version 4.1, however, you can 
drag any disk icon-except the icon of the startup disk-into the Trash. The Finder 
removes the disk icon from the desktop and, if the disk is inserted, ejects it. Version 
5.1 or above also lets you drag the startup-disk icon into the Trash; the startup disk 
is ejected, but its dimmed icon remains on the desktop. 

USING THE KEYBOARD 
Using the Edit-menu command equivalents 

Get in the habit of using Command-Z, Command-X, Command-C, and 
Command-V instead of choosing the Undo, Cut, Copy, and Paste commands from 
the Edit menu. You have two hands: Use them both to save time and effort! 

Ejecting disks 

You can usually eject the disk in the internal drive by pressing Command-Shift- I, 

or the disk in the external drive by pressing Command-Shift-2. One notable occasion 
when these keyboard shortcuts do not work is when the disk-swapping alert box 
commands P/,ease insert the disk . .. 
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Avoid any temptation to shut down or restar t your Mac after you have pressed 
Command-Shift- I or Command-Shift-2 to eject a disk, especially if any documents 
are open at the time. At the very least, you'll probably disrupt the Finder's desktop, 
and you may corrupt the open documents, too. 

Saving screen snapshots 

You can record the current screen image as a MacPaint document, called a 
screen snapshot or screen dump, by pressing Command-Shift-3. Screen snapshots 
are saved on the disk that contains the application program you're using, and each 
snapshot requires anywhere from 2 to 56K of disk space. The Mac beeps if you 
press Command-Shift-3 when there's not enough disk space available to save a 
screen snapshot. 

You can record up to ten snapshots, which will automatically be named Screen 0 
through Screen 9, at a time. If you try to record an eleventh snapshot without first 
removing or renaming some of the Screen 0 through Screen 9 documents, the Mac 
will beep at you. 

Printing screen snapshots 

To print a screen image, turn on the ImageWriter and press Command-Shift-4. 
If the Shift Lock key is depressed, you get a snapshot of the whole screen. If not, only 
the active window is printed. 

Disposing of applications, system files, and locked items 

Errare humanurn est, the Romans said, and the Finder got wind of it. As a result, 
it asks you Are you sure you want to remove . . . ? every time you drag an application or 
system file to the Trash. You have to click OK to confirm that you know what you are 
doing. T he Finder takes an even harder stance if you try to d iscard a locked item. 
That item is wcked or in use, and can't be removed, it chides, and makes you use the Get 
Info command to unlock the item before trying again. 

If you never make mistakes, you can circumvent the Finder's warnings about 
removing applications, system files, and locked items by pressing the Option key 
as you drag icons to the Trash. 
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Shortcuts 

Fast finding of file names 

When you choose the Open command from within an application that uses the 
hierarchical file system (HFS), you are presented with a scrollable list of file names 
from which to select the one you want to open. Searching a long list can be tedious. 
To narrow the search, type the first part of the name you want. When you stop 
typing, the first name that matches your entry is automatically found and selected. 
T he keyboard touch setting in the Control Panel desk accessory determines how 
long you can pause while typing without starting a new request. 

Tabbing to change drives 

On systems with more than one drive, the dialog boxes for disk commands such 
as Open and Save As contain a Drive button. Clicking the Drive button changes 
drives. On a Mac Plus or other Mac that uses the hierarchical file system (HFS), 
pressing the Tab key has the same effect. 

Arrow-key navigation in Open and Save dialog boxes 

The mouse is the standard tool for scrolling through the fi le and folder names 
listed in the Open, Save, and Save As dialog boxes, and for opening folders and 
selecting a file by name. On a Mac Plus, you can use the arrow keys to navigate the 
list of file and folder names. Pressing the Up or Down Arrow key selects the file or 
folder name listed above or below the currently selected name, scrolling the list if 
necessary. To open a selected folder, press Command-Down Arrow. To back up 
to the previous folder, press Command-Up Arrow. 

The same keyboard navigation is available on any Mac that uses the hierarchical 
fi le system (HFS) and has either a Mac Plus keyboard or a numeric keypad. · 

Tabbing in dialog boxes 

In dialog boxes where you must type several items, you can usually advance 
from one item to the next by pressing the Tab key. The whole of the next item is usu­
ally selected, so you can change it simply by typing its replacement. Pressing Tab 
when you reach the last item in the box takes you back to the first item. 
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Pressing Return or Enter in dialog boxes 

Pressing the Return or Enter key when you're in a dialog box usually has the 
same effect as clicking the OK button. However, if a button other than the OK button 
is surrounded by a thick border, pressing Return or Enter effectively clicks the 
thickly bordered button. 

In dialog boxes that have no OK button, pressing Return or Enter usually con­
firms the dialog box. Here again, a thickly bordered button takes precedence. 

Scrolling through MacPaint's fonts and font sizes 

MacPaint, like most applications, provides no shortcuts for choosing a specific 
font name or font size. However, you can use the keyboard to step consecutively up 
or down through the list of fonts or the list of sizes. 

0 Press Command-Shift-Period to advance to the next font. 

0 Press Command-Shift-Comma to back up to the previous font. 

0 Press Command-Period to advance to the next larger font size. 

0 Press Command-Comma to back up to the next smaller font size. 

Notice that the symbols < and >, which are the uppercase symbols on the Comma 
and Period keys, suggest direction. 

Grabbing the page in MacPaint and Microsoft Excel 

When working with the pencil in MacPaint, you may want to bring another 
part of your picture into view. You simply press the Option key to temporarily turn 
the pencil into a grabber, then slide the page in the desired direction. 

When previewing printed pages on the screen in Microsoft Excel, you normally 
see a reduction of the entire page, but you may want to see part of the page image in 
its full size. You can click on the area you want to check and then press the Option 
key, temporarily changing the pointer into a grabber that you can use to bring any 
part of the full-size page image into view. 

Undoing in MacPaint 

The Undo feature is particularly valuable in MacPaint. If at first you don't draw 
a line or shape correctly, undo and try again. For a super-quick undo, just hit the 
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Tilde key. Except when you are typing, pressing Tilde has the same effect as press­
ing Command-Z or choosing Undo from the Edit menu. 

Selecting or deleting the previous word in Microsoft Word 

If the insertion point is between words in a Microsoft Word document, pressing 
Shift-Backspace selects the word to the left of the insertion point. Pressing Option­
Backspace deletes the word to the left of the insertion point. If the insertion point is 
not between words, the word containing the cursor is selected or deleted. 

Microsoft dialog boxes 

Most Microsoft products, including Excel, Word, Multiplan, File, Chart, and 
BASIC, have a number of keyboard shortcuts that operate in dialog boxes. You can 
usually operate the displayed buttons by pressing the Command key as you type the 
first letter of the button name. For example, in the Open d ialog box, you can eject a 
disk by pressing Command-E. Pressing Command-Period cancels the dialog box, 
as if you had clicked the Cancel button. 

In Microsoft Excel, and to a lesser extent in other Microsoft products, the same 
keyboard technique works for other options listed in dialog boxes. ln a dialog box 
where there is no place to enter text, you can omit pressing the Command key, and 
simply type the first letter of the button name. In some cases, you can also use the 
mouse to effectively select a dialog-box option and click the OK button, by just dou­
ble clicking on the option. You can also select an option and at the same time OK the 
dialog box by combining the double-clicking technique with the keyboard shortcut; 
simply double type the first letter of the option while pressing the Command key. 

Opening MacProject's Task Info window 

Each task in a MacProject schedule chart lasts a specific duration and uses spe­
cific resources. You enter and edit duration and resource information for a task in its 
Task Info window. While working on the schedule chart, you can bring up the Task 
Info window by pressing the Tab key. Once the Task Info window is active, you can 
move from entry to entry by pressing the Tab key. 

You can also open the Task Info window by pressing Command-T; you close it 
by pressing Command-T again. 
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Selecting the next MacProject task 

When working on a schedule chart in MacProject, you can select the next task 
or milestone box to the right by pressing the Return key. However, if you are editing 
the text inside a task or milestone box, pressing Return breaks the line of text at the 
insertion point. To advance to the next task or milestone, you must select the task or 
milestone box before pressing Return. 

Pressing Return while working in the Task Info window also moves you to the 
next task or milestone. 

Saving time online 

Here are several keyboard shortcuts that can save you time and money when 
you're connected with many online information services, including CompuServe 
and Delphi: 

8 

D Command-0 cancels output so that you can type another command right 
away. It saves you the time and expense of reading menus you know or mes­
sages and information you don't care about. 

D Command-C cancels the command you last typed and returns you to the 
previous menu. 

D Command-S temporarily suspends the display of information on the screen. 
(Careful-the meter is still running!) 

D Command-Q resumes screen display of information that was suspended 
when you pressed Command-S. 



Troubleshooting 

Having trouble with your Macintosh system? The 
troubleshooting table in this section summarizes 

common problems and ways to cure or prevent them. 
First, find the problem area in the first column of the 
table. (Sometimes you'll have to scan more than one 

problem area; for example, trouble you consider part 
of starting or restarting may be listed not under 
"Can't start" but under "Mac" "Error alerts " 

' ' ' "Keyboard," or "Disks!') Then scan the second 
column for symptoms like those you're experiencing. 

The last two columns explain what's probably 
wrong and what you can do to fix the trouble 

or work around it. 
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Problem 
area 

Mac 
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COMMON PROBLEMS 

Symptoms 

Dark screen 

Bright screen 
but no picture 

Flashing 
apple in 
menu bar 

Pointer gone or 
doesn't move 

Pointer moves 
erratically 

Broken lines 
and static 

Likely 
causes 

Brightness 
turned down 

Screen-saver 
desk accessory 
installed 

Mac broken 

Mac broken 

Alarm clock 
"ringing" 

Mouse cable 
loose 
Program 
crashed 

Mouse broken 

Mac broken 

Dirt on mouse 
roller 

Rolling mouse 
on uneven 
surface 

Mouse feet 
worn off 

Program 
crashed 

Too much 
picture-tube 
coating 

Cures 

Turn brightness control clockwise 

Tap any key, or move mouse to deactivate 
desk accessory 

Have Mac repaired 

Have Mac repaired 

Turn off alarm clock using Alarm Clock 
desk accessory 

Plug mouse cable firmly into Mac 

In Switcher, press Command-Option-Shift­
Period; otherwise, restart Mac 
Repair or replace mouse 

Have Mac repaired 

Remove roller, then clean and reassemble 
mouse 

Provide smooth surface 

Install Magnum's Mouse Mover 

Replace mouse 

In Switcher, press Command-Option-Shift­
Period; otherwise, restart Mac 

Turn Mac off and back on for temporary 
fix; have excess coating removed 

(cont.) 



Problem 
area 

Error alerts 

Traubleshooting 

COMMON PROBLEMS 

Symptoms 

System error 

Too little 
memory 

Likely 
causes 

Program 
crashed 

Bad disk 

Dirty disk drive 

Disk drive 
broken 

Missing Hard 
Disk 20 file 

Too much 
picture-tube 
coating 

Too many 
windows open 

Document 
too large 
or complex 

Large 
Clipboard 

Memory 
cluttered 

Cures 

In Switcher, press Command-Option­
Shift-Period; otherwise, restart Mac 

After restarting crashed program, check for 
damage to document you were using (gnash 
teeth, if necessary); see "System error ID 
table" for possible enlightenment. If problem 
persists, try to discern sequence of events that 
causes problem and avoid repeating 
sequence; yell at software publisher 
Use another disk 

Clean drive with disk-cleaning kit 

Use another drive; have broken drive 
repaired 

Start up with single-sided disk whose 
System Folder contains these files: Hard 
Disk 20, System (version 3.1.1 or above), 
and Finder (version 5.2 or above); drag 
copy of these fi les to double-sided disk 

Turn Mac off and back on for temporary 
fix; have excess coating removed 

Close desk accessories; if application a llows 
multiple documents to be open at once, 
close some 

With programs that keep entire document 
you're working on in memory, such as 
MacDraw, MacProject, ThinkTank, and most 
spreadsheet programs, split document in two 
by culling and pasting several pages of 
document to new documents (via Scrapbook 
if necessary), and then save smaller 
documents 
Select one letter or similar small object, 
choose Copy from Edit menu, then choose 
Copy again 
Save document you're working on 

Quit, restart application program, and 
reopen document you were working on 

(cont.) 
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Problem 
area 

Error alerts 
(cont'd.) 

Can't 
start up 

12 

COMMON PROBLEMS 

Symptoms 

Other alert 
with error 
code 

Dark screen 

Disk drive 
doesn't operate 

FlashingX 
on disk icon 

Disk ejects 
prematurely 

Sad Mac 
icon 

Likely 
causes 

Program 
surprised 

No power 

Bad cable 
connection 

Disk drive 
broken 

Mac broken 

Disk not 
sta rtup disk 

Disk not 
startup disk 

System file 
missing 

Missing 
Hard Disk 
20 file 

Memory 
tests failed 

Cures 

Something you did created error situation 
that program author did not anticipate 
(perhaps you used another program, with 
Switcher, or a desk accessory to delete or 
rename a file the program was using); see 
"Miscellaneous error ID table" for more 
possibilities 

Check power switches, cords, and circuit 
breakers or fuses 

SCSI devices attached to Mac Plus must be on 

Turn off power and check cable for tightness 

If you can start up from another drive, have 
broken drive repaired 

If you can't start up from another dr ive, have 
Mac repaired 

Use disk that contains System fi le 
and Finder 

Try cures listed under "Disk drive doesn't 
operate" 

Use disk with System file and Finder in same 
folder 

Try cures listed under "Disk drive doesn't 
operate" 

Start up with disk that contains System fi le, 
then copy System file from startup disk 

Start up with single-sided disk whose System 
Folder contains these files: Hard Disk 20, 
System (version 3. 1. l or above), and Finder 
(version 5.2 or above); drag copy of these fi les 
to double-sided d isk 

Try cures listed under "Flashing X on 
disk icon" 

If code beneath sad Mac icon doesn't begin 
with OF, some of Mac's memory may be bad ; 
have Mac repaired 

(cont.) 



Troubleshooting 

COMMON PROBLEMS 
Problem Likely 
area Symptoms causes Cures 

Can't System Restart while holding down Option and 
start up error Command keys 
(cont'd.) Try cures listed under "Sad Mac icon" 

Can't load Finder Start up with disk that contains good Finder, 
Finder damaged then copy Finder to problem disk 

or missing 

Can't start Normal with Use special diskette for startup with hard disk 
from hard some hard 
disk disks 

System file Start up with diskette and then copy diskeue's 
missing or System fi le to hard disk's System Folder; with 
damaged some hard disks, you must also run a special 

disk-installation program provided by the 
hard-disk manufacturer (consult your hard 
disk owner's manual) 

Hard disk Turn on hard disk, wait minute or so, 
not ready and try restarting Mac 

Hard-disk Turn off all power switches, check cable 
cable loose tightness, turn on power, and try again; with 

internal hard disk, have internal connections 
checked 

Hard disk If you can start up with diskette, have hard 
broken disk repaired 

Hard disk Start up with diskette and reformat according 
needs to instructions in hard-disk manual 
reformatting 

Mac broken If you can't start up at all, have Mac repaired 

Mac clicks Mac broken Have Mac repaired 
or chirps 

Keyboard Keyboard Sometimes Use mouse 
dead no typing 

is expected 

Program In Switcher, press Command-Option-Shift-
crashed Period; otherwise, restart Mac 

Cable loose Ensure cable securely inserted in Mac 
and keyboard 

Keyboard or Repair or replace keyboard or cable 
cable broken 

Mac broken Have Mac repaired 

(cont.) 
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Problem 
area 

Keyboard 
(cont'd.) 

Clock 

Disks 

14 

COMMON PROBLEMS 

Symptoms 

Keyboard 
erratic 

Equal-sign 
key generates 
comma 

Clock 
inaccurate 

Can't open 
from disk 

Can't save 
on disk 

Likely 
causes 

Debris 
inside 
keyboard 

You switched 
to startup disk 
that doesn't 
include HFS 

Startup d isk 
has old 
System fi le 

You switched 
to startup 
disk with old 
System file 

Battery 
low or dead 

Disk askew 
in drive 

Dirty drive 

Bad disk 

External 
drive cable 
loose 

Drive 
broken 

File locked 

Disk locked 

Disk full or 
nearly fu ll 

Disk, drive, 
or cable not 
functioning 

Cures 

Repeatedly tap faulty keys to dislodge debris 

Open keyboard case, vacuum or blow out 
dust and debris, and reassemble keyboard 

Update that disk or remove its System Folder 

Update startup disk with latest System file 
(dated after January 4, l 986) 

Update that disk or remove its System Folder 

Replace clock battery with EverReady 
No. 523 or equivalent 

Eject disk and reinsert it 

Clean drive with disk-cleaning kit 

Use backup copy of document or application 

Use internal drive; then quit, shut down, turn 
off power, and check cable for tightness 

Try opening from other drive (if you have 
two); have broken drive repaired 

Save under different name 

Slide disk-locking tab so no hole shows 
in corner of disk 

Save on anoth er disk; later, reorganize 
documents 

Try cures listed under "Can't open 
from disk" 

(com.) 



Problem 
area 

Disks 
(cont'd.) 

Troubl.eshooting 

COMMON PROBLEMS 

Symptoms 

Folders or 
files missing 

Can't eject 
disk 

Drive doesn't 
spin 

Likely 
causes 

Startup disk 
doesn't 
include HFS 

You switched 
to startup disk 
that doesn't 
includeHFS 

Mac drives 
have no 
tject lever 

Program 
crashed 

Mac confused 

Disk, drive, 
or cable not 
functioning 

Cures 

Update startup disk with latest Finder and 
System files (dated after January 4, 1986) 
Macs without 128K ROM also require Hard 
Disk 20 file to use HFS 

Update that disk or remove its System folder 

In Finder, select disk's icon and choose 
Eject from File menu, or drag disk's icon 
to Trash 

In most applications, choose Open or Save 
As and then click Eject button in dialog 
box that appears 

Press Command-Shift-I for internal drive, or 
Command-Shift-2 for external drive 

In Switcher, press Command-Option-Shift­
Period; otherwise, hold down mouse button 
as you restart Mac 

As last resort, push straightened paper clip 
into hole near disk insertion slot 

Press Command-Shift-I or Command-Shift-2 
to eject disk and then reinsert disk 
Print document, type it using typewriter, or 
read it aloud to tape recorder, in case you 
have to recreate it 

Send document to another Mac via serial 
port, using modem and phone lines if other 
Mac is not nearby 

Try cures listed under "Can't open 
from disk" 

(collt.} 
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COMMON PROBLEMS 
Problem Likely 
area Symptoms causes Cures 

Disks Good disk Double-sided Use SOOK disks only in SOOK drives 
(cont'd .) unreadable (SOOK) d isk in 

single-sided 
(400K) drive 

400K HFS disk Use disks initialized with HFS only in SOOK 
in old Mac drive or in 400K drive with HFS 

Disk, dr ive, Try cures listed under "Can't open 
or cable not from disk" 
functioning 

Can't initialize Defective Use a nother d isk 
disk disk 

Missing Hard Start up with single-sided disk whose System 
Disk 20 file Folder contains these files: Hard Disk 20, 

System (version 3. 1. l or above), a nd Finder 
(version 5.2 or above); drag copy of these 
fi les to double-sided d isk 

All disks Mac confused Quit, turn off Mac, remove clock battery, wait 
unreadable five minutes, install clock battery, restart 

Mac, and try inserting disks again 

Can't fully Disk held lnsert disk with locking tab on left 
insert disk upside down 

Drive broken Have drive repaired 

Disk drive Defective disk Use another disk 
spins nonstop Disk, drive, Try cures listed under "Can't open 

or cable not from disk" 
functioning 

ImageWriter Doesn't print Power switch Turn on 
a nything off 

Select lamp Press Select switch once 
unlit 

Cable loose Plug cable securely into lmageWrite r 
and Mac 

(cont.) 
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Problem 
area 

lmageWriter 
(cont'd.) 

Troobleshooting 

COMMON PROBLEMS 

Symptoms 
Likely 
causes 

Cover off 
or loose 

Out of paper 

Disk full 

Mac confused 

Bad disk 

Program 
malfunction 

ImageWriter 
broken 

No standard Disk locked 
or high 
quality 

Prints gibberish ImageWriter 
switches set 
wrong 

Wrong cable 

Printer buffer/ 
spooler 
malfunction 

Cures 

Place cover securely on lmageWriter 

Put more paper in printer and make sure 
Select lamp is lit 

Copy document, application, or both to 
blank d isk; remove from original disk 
after copying 

Print one page at a time, indicating page 
to print in page-range fields in Print 
dialog box 

Verify printer and port choices with Chooser 
desk accessory 

Use Apple's Installer program to install 
Chooser desk accessory and new ImageWriter 
printing resource (version 2.2 or above) 

Quit, turn off Mac, remove clock battery, wait 
five minutes, install clock battery, restart 
program, and try printing again 

Quit, copy document to another disk, restart 
program, and try printing again 

Quit, restart program, and try printing again 

Check ImageWriter by turning it off and 
holding down Form Feed button while 
turning it back on; it should repeatedly print 
line of letters, numbers, and symbols; if it 
doesn't, have it repaired 

Slide disk-locking tab so that no hole shows in 
corner of disk 

See tip in Printing chapter for correct 
switch settings 

Try new cable 

Disconnect printer buffer or turn off spooler, 
and try again 

(co111 .) 
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Problem 
area 

ImageWriter 
(cont'd.) 

18 

COMMON PROBLEMS 

Symptoms 

Prints only Us 

Compressed 
line near 
top of page 

Line height 
uneven 

Picture lighter 
than text 

Macpaint 
pictures 
distorted 

Thin lines 
across patterns 

Print 
quality 
poor 

Likely 
causes 

Mac confused 

Normal with 
some pin-feed 
paper 

Paper-feed 
lever set 
wrong 

Slack in gears 

Normal 
condition 

Normal on 
original 
ImageWriter 

Wrong 
orientation 
selected 

Normal 
condition 

Paper-thickness 
lever set 
wrong 

Cures 

Quit, turn off Mac, remove clock battery, wait 
five minutes, install clock battery, restart 
program, and try printing again 
See tip in Printing chapter for explanation 

Try different weight of paper 

Use single-sheet paper 

Apply even, gentle tension to paper coming 
out of printer 

Set lever for pin-feed or pressure-feed 
paper 

Turn printer off and on just before 
printing 

No cure for variations in line height with 
small font sizes on original ImageWriter; use 
larger font size or get ImageWriter II 

Get ImageWriter II or use FixPic desk 
accessory 

Select Tall Adjusted or Wide in Page Setup 
dialog box 

ImageWriter has trouble with some patterns; 
try heavy paper with different combinations 
of paper feed settings 

Set thickness lever (under printer cover) 
all the way up for one-part paper, or 
down one notch for each additional copy 

(com.) 



Tr<iUbleshooting 

COMMON PROBLEMS 
Problem Likely 
area Symptoms causes Cures 

lmageWriter Top or Wrong Choose Page Setup from File menu, 
(conl'd.) bottom measurements change margin measurements, and 

margin in Page Setup print again 
off dialog box 

On lmageWriter Remove front cover and set switch SW 1-5 
II, switch SWl-5 to Open 
set wrong 

Muddy Pigment Replace ribbon and use color sparingly (white 
colors on transfer background and sparse patterns) 
ImageWriter II on ribbon 

Paper wrinkles Paper supply Clear paper path 
or tears obstructed 

Paper-feed Set lever for pin-feed or pressure-feed paper 
lever set wrong 

Laser Writer System error Unprintable Print small sections of document until you 
character find section that causes error; retype that 
in document section to eliminate bad character 

Doesn't pr int Still preparing Wait as long as middle light on 
anything page image LaserWriter blinks; complex page may 

take 20 minutes or more to prepare 
Out of paper Add paper 
Paper jam Remove printed pages from output tray 

Clear paper path 
Mac confused Verify printer and port choices with 

Chooser desk accessory 
Use Apple's Installer program to install 
Chooser desk accessory and new 
LaserWriter printing resource (version 3.0 
or above) 

Laser Writer Verify printer and port choices with 
not selected Chooser desk accessory 
Apple Talk Use Control Panel desk accessory to 
not connected connect AppleTalk 

Excess space Font Cancel Font Substitution option in Page 
between words Substitution Setup dialog box; select all text and 

option selected manually change Lo LaserWriter font 

(cont.) 
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COMMON PROBLEMS 
Problem Likely 
area Symptoms causes Cures 

Laser Writer Slow to Normal under Avoid large, heavy screen fonts such as 
(cont'd.) print some conditions Athens, London, and Venice 

Avoid frequent switching from one screen 
font to another 

In MacDraw, avoid patterns other than black, 
white, and shades of gray 

Avoid bitmap graphics, such as MacPaint 
images 

Switcher Out of memory RAM cache on Turn RAM cache off or reduce memory 
allotted to it; then quit Switcher and restart it 

Can't Applications in Move all applications in set to same folder as 
load set different folders Switcher document, or to System Folder 
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Caution: Look, but don't touch unless you know what you're doing. The power­
supply board and picture tube may contain dangerous residual high voltages. 

To open a Macintosh case, you must first remove five screws, one from behind the 
battery cover, with a Tarx T-15 screwdriver. Then use the edge of a ruler 

to pry the case af1arl. 
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SYSTEM-ERROR IDS AND THEIR MEANINGS 

System errors 

ID 

2 
3 

4 

5 

6 

7 

8 

9 

IO 

11 

12 

13 

14 

Meaning 

Bus error: Memory-reference problem occurred on Mac XL, 
or on modified Mac or Mac Plus 
Address error: Program referred to odd memory address 
Illegal instruction: MC68000 microprocessor encountered 
machine-language instruction it did not recognize 
Zero divide: Signed Divide (DIVS) or Unsigned Divide (DIVU) 
machine-language instruction had divisor of 0 
Check exception: Check Register Against Bounds (CHK) 
machine-language instruction failed; perhaps Pascal value-out­
of-range error occurred 
TrapV exception: Trap On Overflow (TRAPV) machine­
language instruction failed 
Privilege violation: Mac always runs in privilege (supervisor) 
mode; perhaps erroneous Return From Execution (RTE) 
machine-language instruction encountered 
Trace exception: Trace bit on microprocessor's status 
register set 
Line 1010 exception: 1010 trap dispatcher failed, making 
it impossible to use ROM 
Line 1111 exception: Unimplemented machine-language 
instruction encountered; perhaps leftover breakpoint from 
program debugging 
Miscellaneous exception: Nonspecific error condition caught 
by microprocessor 
Unimplemented core routine: Microprocessor encountered 
nonexistent trap number, perhaps fictitious ROM routine 
Spurious interrupt: Interrupt vector table entry for particular 
level of interrupt is NIL; usually occurs with level 4, 5, 6, or 7 
interrupts 
110 system error: Mac's File Manager found bad type field 
in entry on 110 request queue, or dCtlQHead field was NIL 
during Fetch or Stash call in custom driver routine, or needed 
device-control entry has been purged 

15 Segment Loader error: GetResource procedure unable to read 
segment into memory 

16 Floating-point error: Halt bit in floating-point environment 
word set 

17-24 Can't read PACK resource into memory 
25 Memory full or fragmented: Memory Manager unable to fill 

program's request for more memory 
26 Segment Loader error: GetResource procedure encountered 

nonexecutable resource or unable to read 'CODE' segment 0 
into memory for some other reason 

27 File map destroyed: Volume contains block with block number 
higher than last block or lower than first block on volume 

28 Stack overflow error: Memory problem occurred because stack 
expanded into heap 

(co11t.) 
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NONSYSTEM-ERROR IDS AND THEIR MEANINGS 

lnputfouLpuL 
device erro rs 

File errors 

22 

ID Meaning 

- 17 
- 18 
- 19 
-20 
-2 1 

-22 

-23 

-25 
-26 
-27 

-28 

-33 
-34 
-35 
-36 
-37 
-38 
-39 
- 40 
- 42 
- 43 
- 44 
- 45 
- 46 
-47 
-48 
-49 

- 50 

- 5 1 
- 52 
-53 
-54 
- 55 

Can'L perform requesLed conLrol procedure 
Can't perform requested status procedure 
Can't read 
Can't write 
Device or drive r unknown (reference number doesn't match 
unit table) 
Device or driver unknown (reference number specifies NIL 
handle in unit table) 
Driver not opened for requested read or write; attempt LO 

open RAM serial drive r failed 
Attempt Lo remove open driver 
Driver resource missing 
Input or outpuL request aborted, or error while aborting 
print operation 
Driver not open 

Directory fu ll 
Disk full (all allocation blocks on volume full) 
No such volume 
IIO error 
Bad name (perhaps zero length) 
File not open 
End of file reached while reading 
AttempL to position before start of file 
Too many files open 
File not found 
Volume physically locked 
File locked 
Volume locked by software flag 
File busy; altempt Lo d elete open fi le(s) 
Duplicate fi le name 
File a lready open for writing; multiple paths for writing 
not allowed 
Error in fi le specification; parameters don't specify existing 
volume, and there's no default volume; bad disk-drive 
positioning information; bad d rive number 
Attempt to use nonexistent access path 
Error geLting file position 
Disk ejected or volume off-line 
ALtempt to open locked file for writing 
Volume already mounted and on-line 

(cont .) 
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NONSYSTEM-ERROR IDS AND THEIR MEANINGS 

File errors 
(cont.) 

Disk errors 

Clock-chip 
errors 

Apple Talk 
errors 

ID Meaning 

-56 
-57 

-58 

-59 
-60 
- 61 

- 64 
-65 
-66 
-67 
-68 
-69 
-70 
-71 
- 72 
- 73 
-74 
-75 
-76 
- 77 
- 78 
-79 
-80 
-81 

-85 
-86 
-87 
-88 

-91 

-92 
- 93 
-94 
- 95 
- 97 
-98 

No such drive 
Not Macintosh disk; volume lacks directory in Macintosh 
format 
External file system; file-system identifier is nonzero, or 
path reference number is greater than l 024 
Problem during rename 
Bad block on master directory; must reinitialize volume 
Writing not allowed 

Drive disconnected 
No disk inserted 
Disk seems blank 
Can't find address mark 
Verification of read fai led 
Bad address mark 
Bad address mark 
Missing data mark 
Bad d ata mark 
Bad data mark 
Write underrun occurred 
Drive error 
Can't find track 0 
Can't initialize disk controller chip 
Tried to read side 2 of disk in single-sided drive 
Can't correclly adjust disk speed 
Drive error 
Can't find sector 

Can't read clock 
Verification of time change failed 
Verification of parameter RAM fai led 
Valid ity status not $A8 

Socket already active; socket not known; no room 
for more sockets 
Data-size error 
Bridge between two AppleTalk networks missing 
Protocol e1Tor 
Can't get clear signal to send 
Can't open driver because port already in use 
Can't open driver because port not configured for 
this connection 

(com.) 
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NONSYSTEM-ERROR IDS AND THEIR MEANINGS 

Scrap errors 

Memory errors 

Resource 
errors 

More AppleTalk 
errors 

24 

ID Meaning 

- 100 
-102 

- 108 
- 109 
- 111 
- 112 
- 117 

- 192 
- 193 
- 194 
-195 

- 1024 
-1025 
-1026 
-1027 
-1028 
-1029 
-1096 
-1097 
- 1098 
- 1099 
- 1100 
- 1101 
- 1102 
-1103 

-1104 
-1105 
- 3 101 
- 3 102 
-3103 
-3104 
-3105 
- 3 106 
- 3 107 
-3108 
-3109 

Desk scrap (Clipboard) not initialized 
Scrap doesn't contain data of type requested 

Not enough room in heap zone 
NIL master pointer 
Attempt to use free block 
Attempt to purge locked block 
Block is locked 

Resource not found 
Resource file not found 
Unable tO add resource 
Unable to remove resource 

Buffer overflow (Name-Binding Protocol-NBP) 
Name not confi rmed (NBP) 
Name confirmed for d ifferent socke t (NBP) 
Duplicate name (NBP) 
Name not found (NBP) 
Names information socket error (N BP) 
Send request fa iled (AppleTalk-Transaction Protocol- ATP) 
Too many concurrent requests (ATP) 
Too many responding sockets (ATP) 
Bad responding socket (AT P) 
Bad sequence number (ATP) 
No release received (ATP) 
Conu·ol block not found (ATP) 
Additional response packet sent before fi rst response 
packet (ATP) 
Too many outstanding calls (ATP) 
Request aborted 
Too much data for buffer 
MPP driver not installed 
Bad checksum (Datagram-Delivery Protocol-DDP) 
Can't find name-address pair in buffer (NBP) 
Socket or protocol type invalid or not in table 
Response message too large (ATP) 
Bau respuusc:: fru111 ATPRequest function 
AB Record not found 
Asynchronous call abon ed because socket closed before 
call completed 



Hardware 
hints 

The Mac is a simple machine, as computers go. It's easy 
to set up and requires little maintenance. This chapter offers 

ideas for installing the Mac in unusual situations, 
for prolonging trouble-free operation, and for fixing common 

minor problems yourself. 

25 



Mac Insights 

DISKS AND DISK DRIVES 
Disk life 

The specification for 3Y2-inch disks calls for them to operate without dropouts 
(that is, with less than 10 percent loss of signal amplitude) for 10 million passes, with 
the drive head positioned over one track. What does that mean to you and me? Disk 
manufacturers-including Sony, BASF, and others-are reluctant to state a theo­
retical disk life in terms of hours of operation, because so many factors can affect it. 
High or low temperatures, high humidity, dusty or smoky air, magnetic fields, vibra­
tion, and dirty drive heads can all reduce the useful life of a disk. 

Statistics on 3Y2-inch disk longevity are incomplete, but for comparison, 5Y4-inch 
disks tend to last one to two years before reaching retirement age. History has shown 
that 5Vt-inch disks generally fail because of physical abuse-bending, denting, fold­
ing, and so forth-before they wear out. 

By the way, disks have an indefinite shelflife as long as they're kept in pleasant 
surroundings. To a disk, "pleasant" means clean, dry (between 8 and 90 percent 
relative humidity, with no water forming on the disk surface), between 39 and 127 
degrees F, and away from magnetic fields. As long as you meet these conditions, you 
don't have to worry about your disk archives fading or developing worm holes. 

External drive placement 

There are two things to consider when deciding where to put your external disk 
drive: safety and convenience. Magnetic disturbance from the Mac's power supply 
can permanently destroy information on the disk in the external drive. Since the 
power supply is located against the left side of the Mac's case, its magnetic influence 
may affect an external drive placed on the top or to the left of the machine. 

Placing the external drive on top of the Mac is also risky for another reason: If 
the disk drive is allowed to soak up the heat steaming out of the top of the machine 
for a long time, the drive's head may expand enough out of alignment that it cannot 
read relatively cold disks. The drive will usually work again if you take it off the Mac 
and allow it to cool down. 

The only place left for the external drive is on the right side of the Mac. You can 
reduce the desk space the external drive occupies by setting it on its side, with its feet 
facing the right side of the Mac. The drive should work reliably in this position, 
though inserting disks sideways does take some getting used to. 
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THE MOUSE 
Avoiding worn-out mouse feet 

T he two "feet" that support the front of the mouse can wear off after several 
months' continuous use on a hard surface. Without its front feet, the mouse wobbles 
and doesn't glide smoothly. To keep your mouse's feet from wearing out, you can 
buy or make a mouse pad. 

To make a pad, you'll need a piece of the nylon-covered neoprene used for wet 
suits. Use the type called Nylon I, which has nylon on one side only. A 4- by 6-inch 
piece is adequate; 8 by 10 inches is ample. Place the fabric nylon side up, rubber 
side down. 

If this advice comes too late and your mouse's feel are already worn out, try 
applying self-adhesive Velcro strips to the bottom of the mouse, adjacent to the worn 
feet. Use the soft, fu zzy half of the Velcro, not the half with stiff plastic hooks. Or 
buy Magnum Software's Mouse Mover. It is a sort of three-wheeled, ball-bearing 
roller skate that clips to the base of your mouse, eliminating the worn-feet syndrome 
and making the mouse somewhat easier to move precisely. Its 99 ball bearings are 
a biL noisy, especially on hard surfaces-it makes your mouse sound like it's trying 
out for a roller derby. 

Replacing the mouse-button switch 

Lots of clicking and double clicking may wear out the switch on your mouse 
button. You can have the switch replaced , or you can replace it yourself if you are 
mechanically inclined. If you're doing it yourself, you'll need the following: 

0 A pair of needle-nose pliers. 

0 A small soldering iron ( 15 to 30 watts) and some 60/40 rosin-core solder. 

0 Radio Shack part number 275-017 or 275-0 16, or an equivalent subminiature 
single-pole, double-throw (SPOT) switch that measures% by Vt by 3/s inch 
and is rated 0.1 amp 250 volt or better. 

Once you've assembled these items, proceed as follows: 

1. T here is a metal lever attached to the Radio Shack switch. Remove the lever 
with the needle-nose pliers. 

2. Remove the two screws that hold the mouse case together and put them aside 
where they won't get lost. 
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3. Holding the mouse upside down, separate the two halves of its case. They 
don't pull straight apart; you must slide the bottom half forward slightly. 
When the case comes apart, take care not to lose the plastic mouse button 
and its spring. 

4. Remove the entire switch and cable assembly from the mouse as a unit. The 
switch is held in place by a small knob that sticks into the side of the switch. 
Carefully pry the support bracket arm that contains the knob back just far 
enough to release the switch. 

5. One at a time, desolder the two wires attached to the old switch, and then sol­
der them in the corresponding places on the new switch. 

6. Reinstall the cable assembly and new switch in the mouse. 

7. Reassemble the mouse. Before screwing the case together, click the mouse 
button to make sure it feels right. If it doesn't, its spring may be crooked; 
open up the mouse again and check. 

THE SCREEN 
Etching 

A stationary image, such as the Mac's menu bar, displayed continuously for 
weeks or months, may etch the screen's phosphor, leaving a shadow. The Macintosh 
owner's manual suggests dimming the screen with the brightness control whenever 
you leave the machine on and unattended for a long time. The brightness control 
is located at the front of the Mac on the overhang under the Apple logo. 

The Fade to Black desk accessory, by Brian L. Matthews, eliminates this prob­
lem. It automatically paints the entire screen black after a period of no keyboard 
or mouse-button activity, leaving only a wandering icon visible to remind you that 
the Mac is still switched on. A click of the mouse brings the screen back to life. You 
choose the length of the inactive period in seconds or minutes. You should be aware 
that Fade to Black does not always restore the screen properly with some programs, 
notably MacPaint, and that it may cause problems while you are printing or tele­
communicating. 
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Mac XL distortion 

Compared with the 9-inch screen of the Mac 512 and Mac Plus, the 12-inch 
screen of the Macintosh XL has room for larger windows, more icons, wider word­
processing lines, more spreadsheet columns, and so on. However, the images are 
taller and thinner, making squares look like rectangles and circles look like ovals. 
The problem is the different dot shapes on the two screens: Dots on the Mac XL 
are rectangular instead of square. 

The dot shape of the Mac XL can be made square by installing an accessory 
inside the machine. Apple offers a Mac XL screen-modification kit that irrevocably 
alters the dots. Two other products, BitFixer from All Star Computer Services and 
Lisa Vision from the company of the same name, give you a choice: You can have 
rectangular dots for programs written for the Lisa computer, such as Lisa 717, the 
Pascal Workshop, or UNIX; or, with just the flip of a switch, you <'.an have square 
dots for Mac programs. 

THE SPEAKER 
Amplified sound 

The audio-output jack lets you pipe the Mac's sound output to an external 
speaker, an audio amplifier, or even a tape recorder. T he jack accepts a standard 
Vs-inch phone plug. 

Electronics stores carry adapter cables that send the monaural sound from the 
Mac to both channels of a stereo amplifier; Radio Shack part number 42-2153 is 
one such cable. Connect the cable to high-level input jacks on the amplifier or tape 
recorder. The Mac's sound output signal will overload low-level input j acks, such as 
those intended for a magnetic phono cartridge or microphone, resulting in loud 
but distorted sound. 

Speaker placement 

If you attach an external speaker to your Mac, don't place the speaker on or near 
an external disk drive or disk storage cabinets. The speaker contains a magnet that 
could destroy the information on your disks. 
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COOLING 
Don't block vents 

If you place your hand over the vents at the top of the Mac, you'll feel hot air 
escaping, particularly on the side where the power switch is located. As the hot 
air escapes, it draws cooler air into the machine through vents near the bottom 
of the case. The cooler air gets hot as it passes over the electronic components 
inside the Mac and rises out the top, drawing in more cool air. 

If you block the vents, you stop the How of air, and the Mac may overheat and 
die. Hence, do not leave papers, books, cats, or other objects on top of the Mac, or 
stack anything against its sides. 

Avoiding sunstroke 

Heat builds up rapidly inside a car parked in the sun. The same thing happens 
inside a Mac if you leave it in the sun, and you can't cool the Mac off by roll ing down 
the windows! The electronic components inside your Mac are at least as sensitive to 
heat as you are, so find it a cool place in the shade. 

Adding a fan 

If you want to make sure your Mac stays cool, you can add a fan. One model, the 
Fanny Mac from Beck-Tech, fits into the handle recess at the top of the machine and 
increases the volume of air flowing through it. The fa n includes an electrical surge 
suppressor and a power switch, which you use instead of the Mac's power switch. 

Another model, the MacBreeze from Levco, clips inside the Mac. Instead of 
boosting the general airflow through the machine, the MacBreeze blows air directly 
at the power-supply components, which run much hotter and tend to fail earlier 
than the Mac's other components. 
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ELECTRICITY 
Ungrounded fears 

Many older buildings have no electrical grounding available. You may be able 
to get around ungrounded outlets with adapter plugs, but they only provide a true 
ground if used properly. In some cases, connecting the small wire of the adapter 
to the screw on the outlet's cover plate is adequate. But often that cover-plate screw 
is not.grounded. 

You can ground the cover-plate screw by running a 14-gauge insulated wire from 
the screw to the nearest cold-water pipe. Use a cold-water pipe, not a hot-water pipe 
or radiator, because the hot-water boiler may interrupt the ground. A hardware 
store or electrical supply store should have a bracket that clamps to the pipe and has 
a terminal to which you can attach the wire. 

To be really secure, you should also ground the cold-water pipes by connecting 
them to a grounding rod ahead of the water meter. Typically, the rod is 8 feet long, 
but to be sure it will function properly, it ought to reach down into the water table. 

To reliably ground your Mac in an oUer building, you may need lo run a wire froni 
the plug adapter at the electrical outlet to the nearest cold-water pipe. 
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12-volt battery power 

Although the Macintosh is designed to use the 120-volt alternating current (AC) 
that comes out of power outlets in residences or business offices, it can also be pow­
ered by 12-volt direct current (DC) from car batteries. You'll need a device called an 
inverter, which transforms direct current to alternating current. 

There are two types of inverters: sine-wave and square-wave. Sine-wave inverters 
produce a smooth alternating current and are expensive. Square-wave inver ters are 
inexpensive, but alternate abruptly between the negative and positive flow of elec­
trical current. If these transitions occur too quickly, the filter capacitors in the Mac's 
power supply could heat up. However, this situation is unlikely to cause a problem 
because the inverter would probably fail before the capacitors did. Most inexpensive 
square-wave inver ters contain transformers that produce comparatively slow volt­
age transitions. 

The inverter must produce AC power between 95 and 120 volts under load; that 
is, when the Mac is plugged into it and turned on. Inexpensive inverters may pro­
duce peak voltages outside that range under no load , but the peaks usually smooth 
out when a load is applied. T he frequency of the inverter's AC output is unimpor­
tant, because the Mac controls the frequency internally as needed . 

The inverter must also produce enough power for whatever you plug into it. The 
Mac draws between 40 and 60 watts. Inverter output is usually given in amps, but 
you can convert the amps to watts by multiplying them by the number of volts. T hus, 
the Mac requires 0.33 to 0.5 amp at 120 volts. Attaching an external d isk drive does 
not increase the power requirement significantly, but plugging in a printer or hard 
disk does. For example, an Apple HD 20 hard disk draws 30 watts (0.25 amp at 120 
volts), and an ImageWriter draws 20 watts on standby and 180 watts while printing 
(0.13 to 1.5 amps at 120 volts). 

How long will a batter y last? T hat depends on how much you plug into the 
inverter and on the capacity of the batter y. Batter y capacity is measured in amp­
hours. If you divide the batter y's amp-hour rating by the total amps drawn by the de­
vices attached to it, you come up with the number of hours the battery will last. For 
example, the Mac itself draws between 3.5 and 5 amps at 12 volts DC ( 40 to 60 watts 
divided by 12 volts), so a 55-amp-hour battery will last between 11 and l6 Y2 hours. 
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Foreign power 

The US models of Macintosh and ImageWriter are designed to operate at 107 
to 132 volts AC, at a frequency of 50 to 60 hertz. In countries with 220- or 240-volt 
power, you can operate a US-type Mac and ImageWriter with a 220- to 110-volt (a 
"two-to-one") step-down transformer. For the Mac alone, the transformer must be 
rated at 60 watts (60 VA) or higher. For the Mac and ImageWriter together, the rat­
ing must be 240 watts (240 VA) or higher. Get a good-quality, grounded (three­
prong plug) isolation transformer. Do not use a cheap transformer; it may ruin 
your computer equipment. 

By the way, you may encounter some difficulty should your "foreign" computer 
need repairs, since Apple dealers generally stock parts only for equipment designed 
for their country. They should be able to order parts for any model, but that involves 
waiting for the parts to arrive. Also, your Apple warranty or AppleCare service con­
tract is valid only in the country of purchase. For warranty repairs or AppleCare 
service, you must return the malfunctioning equipment to the country where you 
bought it. So if you're thinking about sending your equipment abroad, take the time 
to put it through its paces first, so that any problems covered under the warranty can 
be corrected before you export it. 

MAINTENANCE 
ImageWriter head breakdown 

If you print large pictures containing many solid black areas, the print head 
of an original-model ImageWriter may overheat and fail, requiring a new head. To 
avoid this expense, design your pages so that they are no more than 25 to 30 percent 
solid black. Allowing the head to cool off between pages also helps prevent overheat­
ing. The ImageWriter II comes with built-in protection against head overheating. 

Squeaky ImageWriter 

The ImageWriter user's manual suggests lubricating the shaft on which the head 
mechanism travels with a light machine oil once a year. However, it cautions that you 
should not use electric-motor oil or any lubricant that contains rust inhibitors. The 
problem is that it's almost impossible to find a machine oil without rust inhibitors. 
Apple recommends sewing-machine oil-even if it contains a rust inhibitor - for 
lubricating the ImageWriter. 
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Removing fingerprints from disks 

A single fingerprint can render a disk unreadable. Fingers don't often find their 
way past the metal shutter on a 3~-inch disk, but it does happen: Young fingers, es­
pecially, have a way of circumventing the protective shutter. Should one of your disks 
suddenly turn up unreadable, you can check it for fingerprints by sliding open the 
shutter and looking at the disk surface under a strong light. 

Remove any fingerprints you find with a cotton swab moistened with alcohol. 
Twirl the swab to pick up any loose strands of cotton, and blow gently on the disk to 
dry the alcohol. 

If you spill coffee on the keyboard . .. 

If you spill liquid on your keyboard and it stops working, unplug the keyboard, 
turn it upside down to drain out the liquid, and let it dry for a day. If that doesn't do 
the trick, you'll have to take it in for repair. 

Opening the case 

You may have seen ads for do-it-yourself memory upgrades, cooling-fan kits, 
and replacement disk drives, and wondered how difficult they would be to install. To 
see whether you want to tackle making internal modifications yourself, start by try­
ing to open the Mac's case. (A word of warning: Opening the case does not void the 
warranty, but any damage you cause in the process is not covered under warranty.) 
The five screws you must remove, including the one hidden behind the clock-battery 
cover, require a special screwdriver with a Torx T-15 tip and an 8-inch shaft. After 
you remove the screws, a friction coating makes it very difficult to remove the back 
cover; use a ruler edgewise as a wedge to pry the case apart. 

As you open the case, a piece of foil may fall off the sockets at the back of Mac. 
Don't be alarmed. Save the foil so you can slip it back over the sockets when you 
reassemble your Mac. 
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Inside the case, you will see the following: 

D A large vertical circuit board called the analog or power-supply board. 

D A large horizontal circuit board called the digital or logic board. 

D The picture tube. 

D Beneath the picture tube, the disk drive. 



Peak 
performance 

Originally, the Mac suffered the fate of all 
generalists: It did many things adequately, but 

nothing exceptionally well. That situation changed 
markedly as more memory and other hardware 
improvements became avaUable, and with the 
introduction of software that takes advantage 

of the additional hardware power. This chapter 
introduces some of what you can do to 

soup up your Mac. 
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SPEED 
Faster application startups 

From the Macintosh desktop, you can designate one application on each disk 
to be the "startup application." Then whenever you start the Mac with that disk, the 
startup application is automatically opened, bypassing the Finder's desktop. Assum­
ing you are using a floppy disk, this gets the application going 5 to 20 seconds faster. 

To designate the startup application: 

1. Select the icon of the application you want started automatically. 

2. Choose Set Startup from the Finder 's Special menu. 

Undoing the Set Startup command 

To change a disk so that it once again starts up the Finder's desktop, instead 
of an application such as Mac Write, make the Finder the startup application. If you 
have removed the Finder from the disk to free up space, you will have to copy it from 
another disk, such as the System or System Tools disk that came with your Mac, be­
fore you can make it the startup application. Then proceed as follows: 

I. Display the Finder's desktop by quitting the startup application. 

2. Open the System Folder and select the Finder icon. 

3. Choose Set Startup from the Special menu. 

Adding more memory 

Most application programs run noticeably faster on a Mac with 512 Kor more 
of memory than they do on a Mac with 128 K. The extra memory stores more fonts 
and other resources, more program segments, and more of the document you're 
working on. As a result, the Mac makes fewer trips to the disk when you change 
fonts, choose from menus, or bring different parts of a document into view. 
Fewer trips to the disk mean better performance. 

MacPaint (versions 1.5 and above), for example, keeps an entire drawing in 
memory on a 5 l2K Mac. Thus when you move the drawing with the grabber, the for­
merly unseen parts of the drawing appear immediately. On a l28K Mac, you must 
wait as MacPaint retrieves the formerly unseen parts of the drawing from the disk. 
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Upgrading with 128K ROM and SOOK disk drive 

Upgrading a 512K Mac that still has the original 64K ROM and single-sided 
(400K) disk dr ive by installing the Mac Plus 12SK ROM and double-sided (SOOK) 
disk drive improves its performance significantly. The QuickDraw procedures in the 
12SK ROM display text 50 percent faster and draw graphics an average of twice as 
fast as the QuickDraw procedures in 64K ROM. The larger ROM includes many of 
the most commonly used resources that formerly had to be transfer red from disk, 
such as the 12-point Chicago font. T he SOOK disk drives are two to three times faster 
than 400K disk drives, not counting the speed improvements that result when you 
activate the disk caching included with the upgrade. 

RAM disks 

Few programs require or can take advantage of 512K of memor y. Only the 
most powerful or complex programs, such as Jazz, Microsoft Excel, and Helix, will 
use ever y bit of memory available, and they use it only when working on extremely 
large files. You can exploit fallow memor y by turning it into an electronic disk 
drive, called a RAM disk. 

You can create a RAM disk with programs such as Mac Memory Disk from 
Assimilation, Quick Disk from Symmetry, MacMate! from SMB Development, or 
the public-domain RamStart by George A. Nelson. With these programs, you spec­
ify how much memory to allot to the RAM disk, and most have a method for desig­
nating which files are to be copied onto the RAM disk once it has been created. If 
you have a Mac Plus or Mac 512K Enhanced, make sure the RAM disk program 
works with the l28K ROM before using it. 

Transferring information from an electronic RAM disk is much faster than from 
a mechanical disk. However, there are some drawbacks. When the Mac's power goes 
off, the RAM disk vanishes and all the information on it is instantly erased. As a 
result, you must recreate the RAM disk every time you restart the Mac. Recreating it 
and transferring information onto it adds about 30 seconds to star tup time. And 
keep in mind that because the RAM disk is so volatile, it's a bad place to save docu­
ments you are working on. 

A RAM d isk sounds like a great place to put the System file and the Finder, and 
perhaps a few application programs- that is, until you think about how much space 
all those files require. On a 512K Mac, RAM-disk size is limited to about 350K, room 
enough for only the System file, the Finder, and a small application program. Such 
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a small RAM disk probably won't have room to support printing, which requires the 
Image Writer fi le and may require an extra SOK of workspace on the RAM disk. Un­
less your Mac has a megabyte of memory or more, you'll fi nd a RAM disk most 
useful in cases like the following: 

0 If you like to switch back and forth between applications, put the Finder 
and the System file on the RAM disk for all applications to use. Add an 
Image Writer file if you want to try printing with the RAM disk. But remove 
the System file from each application-program disk you plan to use, or drag 
it out of the System folder on a double-sided disk or other disk that uses the 
hierarchical file system (HFS), so that one of those System files doesn't take 
over when you start the application. 

0 If you plan to use just one application, put it on the RAM disk along with the 
System file, the Finder, and the ImageWriter or Laser Writer file. 

Disk caching 

Unused memory can be put to work as a disk cache for frequently used infor­
mation. T he Mac Plus and Mac 512K Enhanced have a built-in disk-caching feature, 
as does every 5 12K Mac that has been upgraded with a new 128K ROM since 
January 1986. You can also buy special disk-caching programs, such as Nevins' 
TurboCharger and Mainstay's MacBooster, to use with other Macs. 

Here's how disk caching works: As information is transferred from disk, a copy 
of it is kept in the area of memory set aside as the disk cache. When that information 
is needed again, it can be copied quickly from the disk cache instead of slowly from 
disk. If the cache becomes full, the oldest or least used information in it is discarded. 
T hus, if you switch applications, parts of the fi rst application program in the cache 
are eventually replaced by parts of the second application. 

A disk cache trades the raw speed of a RAM disk for versatility and safety. 
Because it is constantly copying and recopying information from the disk, it is not as 
fast as a RA M disk. In addition, documents are normally saved on disk, not in the 
disk cache. However, the disk cache is especially useful for the following: 
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0 Searching and sorting database files. 

0 Scrolling back and forth in long documents. 

0 Frequent switching among two or three applications that are collectively too 
large for a RAM disk. 

0 Long sessions with a single application that, together with the System file, is 
too large for a RAM disk. 
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THE SWITCHER 
Including the Finder 

When you use the Switcher, try to find room for the Finder as the first applica­
tion in the set. The amount of memory that the Finder requires depends on the 
number of windows it has open and on the number of disk icons on its desktop. 
You'll need a minimum of 106K for one disk icon and 128K or more for several. 

Normally you quit an application to remove it from the Finder, but the Finder's 
File menu has no Quit command. However, when using the Finder version 5. l and 
above from the Switcher, the Shut Down command in the Special menu changes to 
Quit. If you use an earlier version of the Finder with the Switcher, you must star t an­
other application from the Finder, and then quit that application to return to the 
Switcher with the Finder's former slot vacant. 

To quit the Switcher itself when the Finder is among the active applications, first 
quit all active applications except the Finder. Then quit the Switcher. The Switcher 
hands the Mac over to the Finder, since it is the only remaining active application. 

Conserving memory 

The Switcher's Save Screen feature uses 22K per application. By turning it off, 
you can reduce the amount of memory the Switcher itself uses and free up more 
memory for applications. To turn off Save Screen before installing an application, 
use the Configure T hen Install command in the Switcher menu. After installing an 
application, you can turn the Save Screen feature on and off by clicking the screen in 
the Mac icon to the right of the application name in the Switcher's list of installed ap­
plications. If you attempt to turn on Save Screen when there's insufficient memory, 
the Switcher beeps. In that case, use the Show Info Window command in the 
Switcher's File menu to see how memory is being used. 

Speeding up switching 

Turning off the Switcher's Save Screen feature may save memory, but it slows 
down switching between applications. If fast switching is more important to you 
than conserving memory, turn on the Save Screen feature for every application 
by clicking the screen of every Mac icon in the Switcher's main window. 
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Turning off other optional Switcher features also speeds up switching between 
applications. Choose the Options command from the Switcher menu and make sure 
the Always Convert Clipboard and Switching Animation options are not checked. 
With the Always Convert Clipboard option off, you must hold down the Option key 
in order to convert the Clipboard when you switch applications. 

Why convert the Clipboard? 

Why is Clipboard conversion necessary when switching applications? Many 
applications maintain a private clipboard for cutting, copying, and pasting within 
the application. Most applications convert their private clipboard to the universal 
Mac Clipboard document when you quit the application or choose a desk accessory 
from the Apple menu. 

When you request Clipboard conversion from the Switcher by turning on the 
Always Convert Clipboard option or by pressing the Option key when you switch, 
the Switcher fools the application you're switching from into thinking you've just 
chosen a desk accessory from the Apple menu, forcing the conversion of the private 
clipboard to the Clipboard document. It also fools the application you're switching to 
into thinking you've just closed a desk accessory, forcing conversion of the Clipboard 
document to that application's private clipboard. Without the conversions, what you 
cut or copy in the first application remains on its private clipboard, unknown to the 
second application. 

Application sets and attached documents 

Once you have configured a set of applications with the Switcher, you can use the 
Save Set command from the Switcher's File menu to save the configuration as 
a Switcher document. The Load Set command then installs the set of applications. 

You can also attach a document to each application in the set and have the 
Switcher open the attached documents when it installs the set. You attach a 
document to an application as follows: 
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1. Install or configure the application. 

2. Select the application by clicking its name in the Switcher's main window. 

3. Choose Attach Document from the Switcher's File menu and, in the Open 
dialog box that appears, select the name of the document you want to attach 
to the application. 
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All the applications in a set must be present on one of the disks inserted when 
you load the set. With Switcher 4.4, if any application in a set is on a disk that uses 
the hierarchical file system (HFS), all applications in the set must be in the same 
folder on that disk. Later versions of the Switcher do not have this restriction. If the 
Switcher can't find an application called for in the set, it stops installing the 
set and displays an explanatory message. If an attached document is missing, 
Lhe SwiLcher ignores it and installs the application with a new document. 

Automatically installing an application set 

If you want one set of applications and their attached documents automatically 
installed when you start Switcher, name the set Switcher.startup when you use the Save 
Set command to save it. To have that set automatically installed when you start the 
Mac, use the Set Startup command from the Finder's Special menu to make the 
Switcher the startup application. 

Using the Switcher with a disk cache or RAM disk 

Both the Switcher and the applications you start through the Switcher can use 
the memory you set aside for a disk cache or RAM disk. Practically speaking, you'll 
need a megabyte or more of memory to use the Switcher together with a disk cache 
or RAM disk. 

Set up the cache or RAM disk first, and be sure to leave enough room for all the 
applications you want to install with the Switcher. Once they are installed, you must 
not change the size of the cache or RAM disk. 

How much memory does an application need? 

When you install some applications, they te ll the Switcher how much memory 
they prefer and the minimum amount they must have. For applications that don't 
specify preferred and minimum memory sizes, the Switcher allocates 128K. 

You can set memory-allocation sizes yourself using the Configure Then InstaJI 
command in the Switcher's Switcher menu. But why bother with changing memory­
allocation size? On the one hand, many programs perform better or accommodate 
larger documents when more memory is available. For example, MacPaint works fine 
with 128K, but works faster with 179K; Microsoft Excel requires at least 256K, but 
works better with 304 K and can take advantage of even more memory to open a 
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larger document or more documents. On the other hand, you may need to reduce 
an application's memory size in order to install another application as part of the 
same Switcher set. 

If an application doesn't specify its preferred and minimum memory sizes, and 
they're not listed in the application's manual, you will have to determine what they 
should be by trial and error. Here's how you determine the preferred memory size: 
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1. With no RAM disk installed and the disk cache off, start the Switcher. 

2. Click a vacant slot in the Switcher menu, and choose Configure Then In­
stall from the Switcher menu. The standard Open dialog box appears. 

3. Open the application you want to configure. A configuration dialog box 
opens, showing the preferred and minimum memory sizes for the 
application. 

4. Enter the Preferred Memory Size. Try a large number initially, but not more 
than 420 on a Mac 512K or 935 on a Mac Plus. Click the Temporary button 
to put the dialog box away and reveal the main Switcher window. 

5. Start the application by double clicking on its icon in the main Switcher 
window. Open a document and use the application heavily for several 
minutes. Try as many commands as you can, especially those that make 
the disk operate. 

6. When the disk quiets down, or after five to ten minutes' use, return to the 
Switcher by clicking between the two-headed arrow in the menu bar or by 
choosing Switcher from the Apple menu. 

7. Choose Show Information Window from the Switcher's File menu. The 
Switcher Information window appears, showing memory usage with a bar 
chart. T he dark gray area of the bar chart shows how much of the allocated 
memory the application is actually using. If less than 90 percent of the bar 
is dark gray, you can probably get away with allocating less memory for the 
application. To do that, quit the application and repeat the process begin­
ning with step 2, but use a slightly smaller memory size in step 4. 

8. When you decide on an optimum size, make a note of it and reconfigure the 
application with the Configure Then Install command, but this time click the 
Permanent button. 
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Use the merrwry-usage bar chart in the Switcher Infonnation window to see whether 
an application is actually using all the mernory allocated for it. Here, Microsoft Excel 

is using almost all of the 3 JOK it has availabl.e. 

For the minimum memory size, try 128K. Very few applications work reliably with 
less. If an alert message appears when you try to star t the application, advising you 
the program failed or couldn't be run, try a larger size. 

Emergency exit 

If the pointer freezes, the keyboard goes dead, or you get a system error mes­
sage while using an application with the Switcher, don't restart the Mac. Instead, 
press Command-Option-Shift-Period; you may have to press these keys several times 
to get a response. This emergency exit usually returns you to the Switcher with the 
other installed applications intact. A message appears advising you that the applica­
tion was terminated by the emergency exit. Although you can't resume the particu­
lar application that failed, you can switch to the other installed applications. After 
using the emergency exit, it's a good idea to quit the other applications in an 
orderly manner and restart the Mac. 
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You shouldn't have to think about which disk is 
the startup disk, but you do. You don't have 
to think about icon names, but you should. 

No one wants to think about copying files and folders 
from disk to disk, but everyone does, 

and you soon forget which disk contains what. 
Thinking about speeding up the switch from one 

application to another, or about finding more 
disk space? The tips in this chapter help 

you deal with these bothersome disk, file, and 
folder details - and more. 
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STARTUP DISKS 
What makes a disk a startup disk? 

Starting up a Mac requires a startup disk, which is any disk that contains a Sys­
tem file and, in most cases, a Finder. Furthermore, on a double-sided disk, a hard 
disk, or any other disk that uses the hierarchical file system (HFS), both of these files 
must be in the same folder. By convention, the System file and Finder are usually 
kept in the System Folder. A single-sided startup disk, which normally does not use 
HFS, need not contain the Finder, provided it contains either a MiniFinder or an 
application that has been designated a startup application with the Finder's Set 
Startup command. 

In addition, a startup disk usually contains the following: 

D The Scrapbook File, Note Pad File, and Clipboard File. 

D One or more application-program and document files. 

Most applications also expect to find printing resource files, such as the ImageWriter, 
AppleTalk ImageWriter, or LaserWriter file, on the startup disk, whether or not the 
application itself is on the startup disk. 

The System file on the startup disk determines which fonts and desk accessories 
are available. You can use the Font/DA Mover program to add and remove fonts or 
desk-accessories in any System file, so that different startup disks have different sets 
of fonts and desk accessories. 

The startup disk may be a 3Y2-inch disk in the internal drive, a 3Y2-inch disk in 
the external drive, an internal hard disk, a hard disk attached to the external drive 
port, or, on a Mac Plus, a disk drive attached to the SCSI (small computer system in­
terface) port. At startup time, the Mac looks in those places in that order and uses 
the System file, Finder, and other files from the first startup disk it finds. 
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Switching startup disks and System files 

The System file on the startup disk affects the settings in the Chooser (or 
Choose Printer) and Control Panel desk accessories and the contents of the Scrap­
book and Note Pad desk accessories, as well as which fonts are available and which 
desk accessories are listed in the Apple menu. The Mac switches startup disks, and 
concomitantly switches System files, when you do any of the following: 

D Start an application located on another startup disk. To switch from some 
hard disks, notably Apple's Hard Disk 20, you must hold down the Option 
key while you start an application on another drive. 

D Open a document that is not itself located on another startup disk, but whose 
application is. To switch from a hard disk, you may have to hold down the 
Option key while you open the document. 

D Restart the Mac with a different 3Y2-inch startup disk. 

D Hold down the Option and Command keys while you double click the Finder 
icon on the startup disk you want to switch to. 

Preventing System-file switching 

You can prevent the switching of System files and thereby avoid the chance of 
attendant changes to Chooser and Control Panel settings, Scrapbook and Note Pad 
contents, font and desk-accessory availability, and so on-all of which may occur 
when you start an application or open a document from the Finder or MiniFinder. 
Here's how: 

D If you are starting an application on a disk that contains Finder version 5.1 or 
above, simply drag the Finder- and MiniFinder, if one is present-out of 
the folder it shares with the System file on that disk. 

D If you are opening a document whose application is on a disk that contains 
Finder version 5.1 or above, separate the System file from the Finder and any 
MiniFinder on the application disk. 

D If you are starting an application on a single-sided disk or other disk that 
does not use the hierarchical file system (HFS), you must either rename the 
Finder icon or make the icon invisible on that disk. 

Finder versions 5.2 and above won't let you rename their icons, but you can make 
any icon invisible with a disk-editing program such as Fedit, or with Apple's 
resource-editor program, ResEdit. Follow the steps on the next page to make the 
Finder invisible using ResEdit. 
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I. For safety, make a copy of the disk whose Finder you want to make invisible. 
If possible, copy ResEdit version l .OD7 or above onto that disk. 

2. Start ResEdit. A small window appears for each disk currently inserted. The 
title at the top of each window identifies which disk it is for; a list of names 
inside the window shows which application, document, and other files are on 
the disk. For double-sided disks, hard disks, and other disks that use HFS, 
folders are also listed. 

3. On an HFS disk, open the folder that contains the Finder; usually it is 
in the System Folder. 

4. Locate the Finder in the disk or folder window and select it by clicking 
its name (make sure you select the Finder on the correct disk!). 

5. Choose Get Info from ResEdit's File menu. An information window appears. 

6. Find the check box labeled lnvisib/,e and click it so that an X appears in it. 

7. Close the information window. ResEdit asks if you want to save the change 
you made; click the Yes button. 

8. Quit ResEdit. 

9. If there is a MiniFinder installed on the disk whose Finder you made in-
visible, return to the Finder and remove the MiniFinder. 

The MiniFinder will always switch to the System file on a single-sided disk or other 
disk that doesn't use H FS, even if the Finder on that disk is invisible. Therefore, you 
must remove all MiniFinders in order to prevent switching System files when you 
start an application on a non-HFS disk. If you want to use MiniFinders but you want 
to avoid switching System files, stick to opening applications from HFS disks. 

Using desktop patterns as System-file ID 

The current desktop pattern is kept in the System file, so if you assign a different 
pattern to each System file, you'll be able to tell when the Mac has changed System 
files. Whenever you switch to a new version of the System file for the first time, use 
the Control Panel desk accessory to change the desktop pattern. 

A couple of applications, notably MacPaint and the MiniFinder, always use the 
standard gray desktop pattern regardless of the Control Panel setting, so there's no 
use trying to change them. 
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THE FINDER 
Optimal use of windows 

Optimize the use of windows in the Finder by placing seldom-used icons at the 
bottom of the window and then shrinking the window so that the icons a re no longer 
visible. Keeping windows small makes it easier to work with more of them at a time. 
But don't make them so small that you spend more time hunting for icons in them 
with the scroll bars than you would spend moving windows around. 

If you usually use only one or two of the items in a window, consider moving 
them onto the desktop. Then you'll rarely need to open the window they came from. 
For example, if you are a Microsoft Excel user, you could move the Resume Excel 
icon to the desktop and leave the Excel disk window closed . 

Sorting icons 

Have you ever wished the By Name, By Date, By Size, and By Kind commands in 
the View menu would rearrange the icons in a window, rather than displaying sorted 
text information about the icons? It turns out that, indirectly, you can make them do 
this. Here's what you do: 

1. Open the window whose icons you want to organize, and choose By Icon or 
By Small Icon from the View menu. If you chose By Small Icon, press the 
Option key and choose Clean Up from the Special menu, thereby compact­
ing the small icons in the window. 

2. Choose By Name, By Date, By Size, or By Kind from the View menu. Infor­
mation about the icons is displayed in text format in the order you requested. 

3. Choose Select All from the Edit menu, highlighting everything in 
the window. 

4. Drag all the selected items out of the window, onto the desktop. When 
you release the mouse button, the items appear as a pile of icons on 
the desktop. 

5. Immediately drag the still-selected icons back into their original window, 
where they are again displayed in text format in the order you requested 
in step I. 

6. Choose By Icon or By Small Icon from the Special menu the same as in 
step l, and the icons are displayed left to right and top to bottom in the 
same order as the text information they have replaced. 
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Aligning dragged icon 

Want some help straightening up icons? With Finder versions 5.1 and above, 
press the Command key as you start to drag an icon or group of icons. When you 
release the mouse button to end the drag, all highlighted icons automatically line 
up along an invisible grid. This feature works in the small icon view as well as the 
standard icon view. 

Realigning all icons 

Pressing the Option key while you choose Clean Up from the Special menu 
forces the Finder (versions 5.1 and above) to move all icons in the active window to 
the upper left corner of that window while aligning them with an invisible grid. 

Don't open any windows 

When you start up, insert a disk, or quit an application, the Finder normally 
opens the same disk and folder windows that were open when you last shut down, 
started the application, or ejected the disk. To eliminate the time-consuming auto­
matic window opening, hold down the Option key until you see the Finder's menu 
bar or the icon of the disk you inserted. This feature is only present in Finder ver­
sions 5.1 and above. 

Forget opening this window 

The Finder normally remembers when you open windows, and automatically re­
opens the same windows the next time it encounters the corresponding disk. If you 
hold down the Option key while opening a window, the Finder (versions 5.1 and 
above) will not remember the event. When you next start up the Mac or quit an ap­
plication with the same disk inserted, or when you insert that disk, the window will 
not reopen automatically. 

Closing all windows at once 

With versions 5.1 and above of the Finder, you can close all windows by pressing 
the Option key while choosing Close from the File menu or while clicking the close 
box of any window. 
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Generic and name-brand icons 

What are those blank, featureless icons that sometimes haunt the desktop? 
Where do they come from? Where do they go? The Finder has the answers. 

The Finder is responsible for drawing icons on the desktop, but it contains 
images for only the folder icon, the trash icon, the System-file icon, a generic ap­
plication icon, and a generic document icon. The Finder does not contain images 
for the unique icons that most application programs and documents use. Instead, ap­
plications such as MacWrite and MacPaint contain within their programs icons for 
themselves and for the documents they create. 

To understand how the Finder assigns icons, you need to know how a document 
and an application program are linked. Each document and application has two hid­
den attributes-four-letter codes called Creator and Type-that tell the Finder 
which icon to use. An application's Creator attribute is a unique monogram, such as 
MPNT, and its Type is always APPL. A document's Creator attribute specifies which 
application contains its icon and its Type attribute specifies which of the Creator ap­
plication's set of icons to use. Hence the application that creates a particular type of 
document, not the document itself, knows what the document icon should look like. 

For all the applications and documents on a disk, the Finder initially fetches icon 
images from the appropriate applications. Rather than repeat this process every 
time you insert the disk, the Finder copies the icon images it fetches into an invisible 
document called the Desktop file. Whenever the Finder encounters a document for 
which it cannot find a matching Creator application, it searches the Desktop file 
for another document of the same Creator and Type and uses that document's 
icon. If the Finder cannot find a matching application or document, it substitutes its 
generic document icon, which looks like a blank page with the right corner folded 
over. Pressing Command-Shift-3, for example, creates a snapshot of the screen as 
a MacPaint-type document. But if none of the disks inserted at the time contains 
MacPaint or MacPaint documents, the new document gets a generic icon. 

D 
GDP-Life Table Ram Start 

Generic document icons (left) usually appear when a document is saved on a disk 
that does not contain similar documents or the application that created the docurnenL. 
Generic application icons (right), though, appear when no one has )'Ct created uni,que 

icons for t/U! applications. 
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If a document you have created shows up on the desktop as a generic icon, you 
can replace it with a "name-brand" icon, as follows: 

I. Drag the generic document icon to a disk that contains a name-brand 
icon for another document of the same type. The Finder then converts the 
generic icon to a name-brand icon. 

2. Copy the newly converted name-brand icon back to its original disk. 

When an application has a generic icon, it usually means no one has ever cre­
ated a unique icon for the application. You can create an application icon using an 
icon-editing program or resource editor, as described in the Resources chapter. 

Finding a hidden window 

To bring the open window of a folder or disk icon to the front, double click on 
the hollow folder or disk icon. 

Wrong Finder font? 

The Finder determines which font to use for the names of icons by looking at the 
parameter RAM area of memory, which contains standard settings for the printer 
selection, speaker volume, keyboard repeat rate, and so on. If a program changes 
the parameter RAM settings, the Finder may use the wrong font, resulting in dis­
torted icon names. To clear the parameter RAM so that is will be reset to standard 
settings during the next startup, you must remove the clock battery, as follows: 

1. Shut down, turn off the Mac, and remove the clock battery for approx­
imately five minutes. 

2. Replace the battery, turn on the Mac, and start up with the formerly 
corrupted disk. 

3. After startup, use the Control Panel desk accessory to reset the time, 
date, and other settings. 

GET INFO 
Unreliable file locking 

T he Finder's Get Info command includes an option for locking a document, 
application, or folder in order to prevent erasing it or replacing it. Most applications 
respect this lock, but not all do. Microsoft Word and MacWrite, for example, both 
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save over a locked file without warning. Before entrusting the safety of an important 
document to the Get Info lock, test the lock's efficacy on an unimportant document. 

When you need long comments .. . 

You can describe the purpose or contents of a disk, application, document, or 
folder in the comments box at the bottom of a Get Info window. T he box can hold 
50 words, but only three lines of the comment are visible at once. On a Mac Plus or a 
Mac 512K equivalently upgraded, the text scrolls automatically as you enter it. You 
can see text that has scrolled out of view by placing the pointer near the middle of 
the box, ·pressing the mouse button, and dragging the pointer out of the box. On 
an earlier model Mac, you can bring the last two lines of a five-line comment into 
view by temporarily cutting the first two lines out; be sure to paste them back 
before closing the Get Info window. 

NAMES 
Keep icon names brief 

Keep icon names brief if you prefer the By Icon view to the others available 
in the View menu. Icon names longer than about 12 characters tend to overlap when 
you arrange icons with the Clean Up command. 

Accommodating long icon names 

If you must use long icon names, you can arrange the icons so that their names 
do not overlap. The following method staggers alternate columns quickly and neatly: 

1. Arrange the icons into rows and columns by pressing the Option key 
while choosing Clean Up from the Finder's Special menu, or by sorting 
the icons as described in "Sorting icons." 

2. Select every other column of icons by pressing the Shift key as you click 
on each icon in the column, or as you drag selection rectangles around 
the icons. 

3. Drag the selected group of icons down a half-inch or so. 

Including dates in names 

You may want the date in the names of some documents, such as correspon­
dence. T he Finder can list documents by date, but the Open dialog box cannot. 

55 



Mac Insights 

Compacting long names 

Use lowercase letters, which are narrower than uppercase, to squeeze longer file 
names into less space. 

Rules for names 

A disk name can contain up to 27 characters. A document, application, or folder 
name can contain up to 31 characters. On a single-sided disk or any other disk that 
does not use the hierarchical file system (HFS), a document, application, or folder 
name can contain up to 63 characters. Do not use colons in names, and avoid 
putting a period at the beginning of a name. 

COPYING 
Flagging new documents for moving 

When you first save a document that you know you'll later have to move to an­
other disk, prefix the document name with a special character, such as @. Back in 
the Finder, you'll see the prefix and remember to make the move. 

Moving by dragging 

Save time when moving an icon to another folder or copying it to another disk by 
dragging it directly to the destination folder or disk icon-don't bother hunting for 
the folder or disk window. If the destination folder or disk icon is open, drag the file's 
icon to its hollow folder or disk icon. And if the destination folder or disk icon is 
closed, don't bother opening it. The Finder will still copy the icon you're dragging 
into the next available spot in the destination folder or disk. 

Excluding files or folders when copying disks 

The Finder completely replaces the contents of one disk with the contents of 
another disk when you drag the source disk's icon over the destination disk's icon­
provided both disks are the same type and have the same storage capacity. However, 
the Finder does not copy any documents, applications, and folders whose icons you 
have previously dragged onto the desktop. After copying the disk, you can return the 
icons on the desktop to their former locations in the source disk window by selecting 
the icons and choosing Put Away from the Finder's File menu. 
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Think twice when copying folders 

When the Finder asks, Replace items with same names with the selected items?, take 
a mental inventory of the destination disk before clicking OK. If you are copying a 
folder to a disk that contains a folder by the same name, the new folder will replace 
the old-and every last thing in it. Unfortunately, the Finder doesn't warn you that it 
is about to replace the "entire contents" of one folder with those of another, as it does 
with disks. Until Apple makes this change (if ever), be alert when copying folders. 

CATALOGS 
Printing catalogs of MacPaint documents 

MacPaint's Print Catalog command prints a catalog of the MacPaint documents 
in the folder that contains the currently open MacPaint document. If the currently 
open document is on a single-sided disk or other disk that doesn't use the hier­
archical fi le system (H FS), the catalog includes all documents on the disk, regardless 
of folders. MacPaint itself does not need to be in the same folder or even on the same 
disk as the currently open document. 

Obtaining disk catalogs 

In order to print a complete directory of every file in every folder on a d isk, you'll 
have to use something other than the Finder's Print Catalog command or the screen­
snapshot feature (which you activate by pressing Command-Shift-4). 

The MDC II program from New Canaan Microcode constructs and prints a 
complete directory of one disk or a catalog of a disk collection. It displays two catalog 
windows. One window lists the disks in the catalog and the other lists the files. For 
each file on every disk, it shows the name, date created, date modified, size, creator, 
type, and disk (volume). Folders on disks that don't use the hierarchical file system 
(H FS) are completely ignored. MDC II handles about 5000 files and has a search fea­
ture to help you find a file in the catalog. With special icons, it also identifies which of 
32 categories you have put the fi le in. Files can be listed in alphabetical order by 
name, by either date created or date modified, by creator, by type, or by volume. All 
this information can be printed on paper, 3-by-5 cards, or special pin-feed labels. 
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MINIFINDERS 
Using a MiniFinder for faster startups and quits 

If you have lots of documents and applications on a hard disk or even on a 
double-sided disk, the time spent waiting for the Finder to construct its desktop can 
be annoying. One way to speed up disk operation is to use the MiniFinder rather 
than the Finder to open applications. For example, starting up the Mac with two 
double-sided disks takes 10 seconds less with a MiniFinder than with the Finder. 

The MiniFinder allows you to install up to 12 document or application icons on 
its own abbreviated version of the desktop. If you need to open other applications, 
clicking the MiniFinder's Open Other button causes a standard Open dialog box to 
appear, from which you can open any application (but no documents) on any disk. 
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To install a MiniFinder: 

1. Select the icons of up to 12 applications and documents you want imme­
diately available from the MiniFinder. All icons, including the icons of the 
applications required to open the selected documents, must be in the 
same window. 

2. Choose Use Mini Finder from the Special menu. In the dialog box that ap­
pears, click the Install button. A MiniFinder icon is created on the current 
startup disk. If the current startup disk uses the hierarchical file system 
(HFS), the MiniFinder icon will be in the same folder on the startup disk 
as the Finder. 

You can double click the MiniFinder icon to start the MiniFinder. Whenever you 
start up the Mac, the MiniFinder, rather than the Finder, takes control. 

Arranging icons in a Minifinder 

Once you install icons in a MiniFinder, they are fi xed in place; you can't drag 
them around as you can in the standard Finder. However, you can decide what their 
positions will be before instaJling them in the Mini Finder. Before choosing Use 
Mini Finder from the Finder's Special menu, arrange the icons in four rows of three, 
starting with the left icon in the top row and working left to right and top to bottom. 
If you have fewer than 12 icons, the unused slots must be in the bottom rows. 

Using several MiniFinders 

T he MiniFinder is limited to 12 icons, but you can set up multiple levels of 
MiniFinders that accommodate many application and document icons. For exam­
ple, using two levels, you can install 132 documents and applications. The first-level 
MiniFinder contains up to 12 renamed MiniFinder icons. Double clicking one of 
these icons opens a second-level MiniFinder. Each second-level MiniFinder contains 
the icon of the fi rst-level MiniFinder and up to l l application and document icons. 
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You can install two /eue/,s of MiniFirukrs that let you quickly access up to 132 appli­
catwns and documents. From the first-level Min.i.Finder, double click on a renamed 
MiniFirukr icon to move to the second level. To return to the first Leve~ double click 

on the icon l.aheled MiniFinder. 

When creating two levels of MiniFinder, you create and rename the MiniFinder 
icons in the second level before you create the first. (There's a trick to renaming 
MiniFinder icons for the second level: The Finder won't let you rename a Mini­
Finder icon directly, but you can rename a duplicate of the icon.) Create the second 
level as follows: 

1. Arrange the application and document icons in folders so that all the icons 
for any one MiniFinder are in the same folder. Once you install a set of 
icons in a MiniFinder, you must not move the icons to different folders. 

2. If you want to be able to move from a second-level MiniFinder back to 
the first level, the folder must also contain a MiniFinder icon named 
MiniFinder. This icon acts as a placeholder for the final first-level 
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MiniFinder, which you'll create later. To create the placeholder, select any 
application icon and choose Use MiniFinder from the Special menu. In a 
few seconds, an icon named MiniFinder appears (it will probably be in the 
System Folder). 

3. Drag the placeholder MiniFinder into the folder in which you're collecting 
applications and documents. 

4. Select the 11 application and document icons, plus the placeholder Mini­
Finder icon, choose Use MiniFinder from the Special Menu, and click Install 
in the dialog box that appears. 

5. On a double-sided disk, hard disk, or other disk that uses the hierarchical 
file system (HFS), the new MiniFinder icon appears in the System Folder. You 
no longer need the placeholder MiniFinder icon you used in step 4, so drag it 
to the Trash. However, on a single-sided disk or other disk that doesn't use 
HFS, the new MiniFinder icon replaces the placeholder you used in step 4, 
so do not remove it. 

6. Select the new MiniFinder icon (remember to use the one in the System 
Folder on an H FS disk), and choose Duplicate from the File menu. A 
duplicate MiniFinder icon appears, labeled Copy of MiniFinder. 

7. Rename the duplicate MiniFinder icon. If it's not already in the System 
Folder, drag it there. If you're going to create another second-level Mini­
Finder, use the existing MiniFinder icon as the placeholder in step 3. 

Repeat steps 3 through 7 for each second-level MiniFinder. Then you're ready to cre­
ate the first-level MiniFinder, as follows: 

1. Open the System Folder and select all the renamed second-level MiniFinder 
icons you have created. 

2. Choose Use Mini Finder from the Special Menu. A few seconds after you 
click Install, an icon named MiniFinder appears in the System Folder. 

Bypassing the MiniFinder when quitting 

To bypass the MiniFinder and go directly to the Finder when you quit an appli­
cation, press the Option key while choosing Quit from the application's File menu. 
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FREEING DISK SPACE 
Removing the Finder 

Removing the Finder from a disk frees up about 56K of disk space. T he Finder 
is not required on single-sided disks, which normally do not use the hiera rchical file 
system (HFS). Provided you first designate a startup application with the Finder's Set 
Startup command, you can remove the Finder and still use the single-sided disk as 
a startup disk. 

Warning: Q uitting most applications when there is no Finder or MiniFinder 
present usually results in a serious system error. 

T he Mac will not let you remove the Finder from the current startup disk by 
dragging the Finder icon to the Trash. First you must switch startup disks as de­
scribed in "Switching startup disks and system files." 

If you remove the Finder from an H FS disk, the disk is no longer a star tup disk, 
in which case you may as well remove the System file, Scrapbook File, Note Pad File, 
and Clipboard File. 

Removing unused printing resources 

You can save space on your startup disks by removing printing resources you 
don't need from the System Folder. To remove unused printing resources, drag them 
to the Trash . 

What kinds of resources might you discard? Well, you almost certainly do not 
need both the ImageWriter and AppleTalk ImageWriter resources. To print on an 
ImageWriter II with an AppleTalk card, the AppleTalk ImageWriter resource must 
be present. To print on an ImageWriter or lmageWriter II without AppleTalk, most 
applications need the ImageWriter resource. Microsoft Excel, Word, and Multiplan 
need the ImageWriter resource to print in standard or high quality, but not in draft 
quali ty. For draft-quality printing in these applications, use the Printer Setup com­
mand from their File menus to pick a printing resource such as Typewriter or TTY. 

Other candidates for the T rash are the LaserWriter and Laser Prep resources, 
which you need only if you have a LaserWriter or if you prepare documents on your 
Mac for later printing on a LaserWriter attached to a different Mac. You can remove 
the LaserWriter and Laser Prep resources from any disk that you never use for 
Laser Writer printing or preparation. 
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Omitting needless fonts 

One way to free up space on a startup disk is to remove fonts you never use. Each 
size of ever y font is a separate entity that you can add or remove from a System file 
using the Font/DA Mover program. Removing all sizes of the New York font, for ex­
ample, frees almost 27K. 

Small font sizes tend to require the least space, usually on the order of l .5K to 
2.5K each . Large sizes may take more than 13K apiece. Before you remove large 
sizes, make sure you don't need them for best-quality printing on an ImageWriter. 
The Mac obtains best-quaJjty print by condensing a font size that is double the size 
to be printed. For example, you need Geneva 24 to get best-quality Geneva 12. 

Fonts you remove need not be lost forever. The Font/DA Mover lets you save 
them in font fi les before removing them; later you can copy them back to a System 
file from the font fi les. 

Removing desk accessories 

Desk accessories are part of the System file and, as with fonts, you can remove 
disused ones with the Font/DA Mover program. The amount of space required by an 
individual desk accessory may be anywhere from less than I K to more than 40K, 
though few are larger than IOK. 

In addition to removing desk accessories you never use, you may want to con­
sider removing ones you seldom use from most of your startup disks. For example, if 
you use only one printer, you don't really need the Chooser on every disk. The Con­
trol Panel and Alarm Clock are two other desk accessories you might need on only 
one disk. When you need to change settings with one of those desk accessories, it's no 
great inconvenience to have to switch to the disk they're on. 

Purging the Scrapbook 

Old clippings in the Scrapbook waste disk space. Ideally, you should purge your 
Scrapbook file regularly, but if you can't bear to throw old stuff away, you can keep 
a copy of the Scrapbook file under a different name, perhaps on another disk. 
Here's how: 

1. Select the Scrapbook-file icon, which is usually in the System Folder, and 
choose Duplicate from the File menu. 

2. Change the name of the copy of the Scrapbook file, if you want, and drag its 
icon to another disk. 
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3. Choose Scrapbook from the Apple menu and remove all the deadwood 
from the Scrapbook window. 

Later, if you want to retrieve a clipping from an old Scrapbook, temporarily re­
name the Scrapbook file on the startup d isk, change the name of the old Scrapbook 
icon back to Scrapbook Fil,e, and drag it to the current startup disk. Now when you 
choose Scrapbook from the Apple menu, the Scrapbook window displays the con­
tents of the old Scrapbook. 

Saving unformatted documents to save space 

An unformatted , text-only document usually takes up less disk space than the 
same document with character- and paragraph-formatting information. So if you 
can live without font, style, size, margin, tab, paragraph indent, and other format­
ting, you can consume as much as 30 percent less space by clicking the Text Only 
option in those Save and Save As dialog boxes that offer it. 

Deleting from a desk accessory 

How many times have you wished you could delete a fi le while using an applica­
tion insLead of having to go back to the Finder? T here are several desk accessories 
that allow you to delete fi les from almost any application. One such desk accessory, 
Disklnfo from Maitreya Designs, d isplays a scrollable list of fi le names- in name or 
date order-similar to the one you see in the Finder when you choose By Name or 
By Date from the View menu. You select one file at a time from the list for deletion, 
verify your selection in a separate dialog box, and verify again if the fi le is locked . 

Warning: Delete fi les with caution, or you may cause the application program 
hosting the desk accessory to fail spectacularly. Don't delete fi les that are still open, 
or temporary files with names like Paintl , MWOOOJ, Print File, and UndoFile. When 
you're using the Switcher, be especially careful that you don't delete a fi le from one 
partition that's in use in another partition. 
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When you don't need help ... 

Applications that provide built-in help information usually keep that information 
in a separate disk file. In most cases, you can remove the help file and free up a sub­
stantial amount of disk space. So if you are beyond help, look for an icon with the 
word help in its name, copy that icon to a backup disk, and then drag it from the 
working disk into the Trash. 

Lean MacPaint 

MacPaint has two screens of built-in help information, which you access with the 
Introduction and Shortcuts commands on its Goodies menu. Both help screens are 
MacPaint resources that you can remove using a resource-editor program, thereby 
making MacPaint about 13 K lighter. Use Apple's general-purpose resource editor, 
ResEdit version l.OD7 or above, as follows: 

1. For safety's sake, make a copy of your MacPaint disk. Copy ResEdit onto 
that disk. 

2. Start ResEdit. A small window appears for each disk currently inserted. 
The title at the top of each window identifies which disk it is for, and a list 
of names inside the window shows which application, document, and 
other files are on the disk. For double-sided disks, hard disks, and other 
disks that use the hierarchical file system (HFS), folders are also listed. 

3. Locate MacPaint in its disk window and double click it. Another small win­
dow opens, listing all the resources in MacPaint by their four-letter names. 

4. Find the resource named PICT in the MacPaint window and click it to 
select it. 

5. Choose Clear from ResEdit's Edit menu. 
6. Close the MacPaint window. ResEdit asks if you want to save the change you 

made; click the Yes button. 

7. Quit ResEdit. 

After removing the PICT resource from MacPaint, choosing Introduction or 
Short Cuts from the Goodies menu does nothing. 
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WHERE TO PUT IT? 
Squeezing more files onto single-sided disks 

Apple's hierarchical file system (HFS), which is used automatically on hard disks 
and double-sided disks, does not limit the number of fi les you can store on a disk. 
However, the flat fi le system normally used on single-sided disks does limit the num­
ber of files on a disk. As a result, a single-sided disk that contains only small docu­
ments (for example, 2K correspondence documents) may have as much as 200K 
of disk space still available when the number-of-files limit occurs. 

The number of fi les allowed on a disk depends on the length of the fi le names, 
and the dependency is not linear. You can have at most 84 files on a single-sided disk 
where the average file name length is between 14 and 22 characters. If the file name 
length averages 6 to 13 characters, you can put 96 files on the same disk. There's no 
point making all names shorter than five characters, since you won't get more than 
108 files on any single-sided disk by doing so. 
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On a Mac Plus or other Mac that uses HFS, you can set up a single-sided disk to 
use HFS and thereby get around the number-of-files limit. The method differs for 
new and old disks: 

0 Set up a new single-sided disk for HFS when you first initialize it. When you 
finish typing the disk name at the end of the initialization process, hold down 
the Option key as you press Return. 

0 To convert an old single-sided disk to HFS, you must erase it. Choose Erase 
from the Finder's Special menu and hold down the Option key as you click 
the One-Sided button in the dialog box that appears. For best results, hold 
down the Option key until the box goes away. 

Working efficiently with one drive 

If your Mac has only one built-in 3V2-inch disk drive-no external drive and no 
hard disk-you must organize the contents of your disks carefully to avoid excessive 
disk swapping. First, put every application program on its own startup disk. In what­
ever space remains on each application's disk, put the documents you are still work­
ing on with that application. Most applications need some d isk space for temporary 
work files, so be sure to leave ~OK or more free on each disk. If all the documents­
in-progress for a particular application won't fit on one disk, put the overflow on 
another startup disk along with another copy of the application program. When 
you finish working on a document, copy it onto a disk that contains only documents 
and remove it from the application disk to make room for the next document you 
create. (Avoid keeping multiple copies of the same document on different disks; 
you can waste lots of time figuring out which has the most recent changes.) 

Disks multiply rapidly on one-drive Mac systems, so try to develop some com­
pulsive habits with regard to labeling and storing your disks. Otherwise, finding a 
particular document may take 10 minutes or more. When your collection grows to 
more than 30 disks, seriously consider cataloging it with a program such as MDC II 
from New Canaan Microcode. 

If your one-drive Mac has a megabyte or more of memory, you can use half 
the memory as if it were a disk drive (see "RAM disks" on page 39 in the "Peak 
performance" chapter). Programs such as the public-domain RamStartcan auto­
matically create a RAM disk, copy the System Folder to it, and make it the startup 
disk. Your Mac essentially becomes a two-drive system and your 3 V2-inch disks no 
longer need to carry the 200K burden of a System file and Finder, leaving more 
room on them for documents. There may even be room on the RAM disk for an 
application, freeing up even more actual disk space. 
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Working efficiently with two drives 

On a Mac with two or more disk drives, you'll probably want to reserve one drive 
for applications on startup disks and the other drive for documents on non-startup 
disks. If an application is particularly large and there is not enough room for it on a 
startup disk, you can keep it, along with its documents, on a non-startup disk in the 
other drive. If the applications you want to work with are small, you may be able to 
fit more than one on the same startup disk, making switching between them 
faster. But be sure to leave SOK or so free on the startup disk. Most applications 
need work space on that disk even if the document you're working on is on 
another disk. 

With some applications, the ImageWriter file or other printing resource, the 
Clipboard file, and the Scrapbook file must be on the application disk, which may 
or may not be the startup disk. You'll know an application requires this arrangement 
if you can't print a document or you can't find a clipping in the Scrapbook. 

You don't need as many startup disks with two drives as you do with one drive. 
This means you'll use fewer disks overall, because they won't be filled with duplicates 
of the System Folder and the application programs. 

TO THE RESCUE 
Rebuilding the Finder's desktop 

If a Serious system error . .. message appears when you insert a disk, it's possible the 
Finder's invisible Desktop file has become corrupted. The Desktop file keeps track of 
which documents, applications, and folders are present on a disk, what their icons 
look like, where the icons are located on the desktop, and so on. 

Usually the Finder recognizes a corrupt Desktop file and rebuilds it automat­
ically; occasionally, however, the Finder falls down on the job. To force the Finder 
to rebuild the Desktop file for a disk, follow these steps: 

1. Start up with another disk. 

2. Hold down the Option and Command keys while you insert the trouble­
some disk. The Finder asks if you're sure you want to rebuild the desktop; 
click Yes. 

Rebuilding the Desktop file erases any comments you might have entered in Get 
Info windows and, on single-sided disks, erases the names of folders. 
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You can forestall about 90 percent of the problems you're likely to encounter 
with the Desktop file if you always eject your disks before switching off the Mac. 

Repairing damaged startup disks 

It's sometimes possible to restore a damaged startup disk by starting with an­
other disk and copying the System file from the good disk to the damaged disk. 

Retrieving documents from bad disks 

If you're unable to start up with a disk that contains valuable documents, you 
may be able to retrieve the documents by treating the bad disk as a non-startup disk. 
This technique works- sometimes-because the Finder is more finicky than most 
applications with regard to damaged disks. Here are the steps to follow: 

1. Start the Mac with a good startup disk, preferably one that contains the ap­
plication that created the documents you want to retrieve. 

2. Start the application. 

3. Open a document from the bad disk with the application's Open command 
and save the document on a good disk with the Save As command. 

Repeat step 3 for each document on the bad disk. 

Salvaging a damaged file or disk 

When all else fails, you may be able to recover a lost file or rescue a damaged file 
or disk with a disk-editor program. For example, John Mitchell's Fedit allows you to 
easily recover lost files, such as ones you've deleted, and to repair such esoteric items 
as the disk directory and volume map. By following directions in the program's doc­
umentation, you may also be able to rescue portions of a damaged text file. 

If you're unable to salvage the contents of a disk, you may still be able to re­
initialize and reuse it. Follow these steps: 

1. Start up with another disk, one that contains the Finder version 5.1 or above. 

2. Hold down the Option, Command, and Tab keys while you insert the trou­
blesome disk. The Finder asks if you're sure you want to completely erase the 
disk; click Yes. 
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In the '50s and '60s they painted flames on cars. 

In the '70s they sewed patches on bluejeans 
and they tie-dyed T-shirts. 

In the '80s, they're customizing computers. 

You can get in on the latest trend by changing fonts, 
icons, pointers, menus, and dialog boxes in your Mac 

applications. Read all about it in this chapter. 
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ABOUT RESOURCES 
Although the System file seems to hog disk space, it actually conserves it. 

The System file serves as a public library of information useful for many programs. 
Among other things, it contains descriptions of fonts, menus, windows, pointers, 
icons, buttons, and scroll bars. These pieces of information are called resources. 
Unlike a real librar y, the System fi le hands out an unlimited number of copies of its 
resources to application programs and never expects the resources to be returned. 

Application programs can also have their own private collection of resources. 
Even documents can have resources. Usually, the private application and document 
resources do not duplicate the System-file resources. It is by cutting down on the 
duplication of resources that the System file actually saves disk space. 

Resources are classified by type and each type has a four-character name; any 
that appear to have shorter names contain a mandatory blank space. The table on 
the fac ing page lists some standard resource types, many of which are found in a 
typical System file, and explains what each contains. Every individual resource has 
an ID number that uniquely identifies it among all other resources of the same type. 

Although application resources generally do not duplicate System-file resources 
for space-economy reasons, this doesn't mean that they can't duplicate them. If an 
application resource has the same type and ID number as a System-file resource, 
the application resource is used. For example, applications that need to modify the 
standard Open or Save As dialog boxes might have their own resources for these 
functions. Similarly, resources in document files can override duplicate resources 
in application fi les (though many application programs disable this feature). 
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Type 

ALRT 
B DL 

CDEF 

CNTL 
CURS 
DITL 
DLOG 
DRVR 
DSAT 
FKEY 
FOND 
FONT 
FREF 
FRSV 
ICN# 

ICON 

INIT 

INTL 

MBAR 
MDEF 
MENU 
PACK 

PAT 
PAT# 
PDEF 
PICT 

PREC 
SICN 
STR 
STR# 
WDEF 
WIND 

Resources 

STANDARD RESOURCES 

Contents 

Alert box templates 
Correlator of local ID numbers for icon lists and file references to their actual 
lCN# and FREF lD numbers 
Program code that constructs and handles operation of controls such as scroll bars 
and buttons 
Control templates 
Pointer shapes 
Items (text, controls, and graphics) used in dialog and alert boxes 
Dialog-box templates 
Program code for desk accessories and device drivers 
Definition of system startup alert box and its contents, and program code that displays it 
Program code for Command-Shift-number key sequences (for example, Command-Shifl-3) 
Font family description 
Font definitions 
Correlation of file types wi1.h local icon lD numbers 
Identii.y of foms reserved for system use 
Icon lists; typically icons with shadow-like masks, which permit icons to look active, 
inactive, or hollow, and to be highlighted or not highlighted in any of those three 
states, like disk and document icons that can appear against the background of 
the desktop 
Icons, without masks, that can only look plain, like the icons for the printer and 
modem ports, and alert boxes 
Information used at startup time, including definition of system-error alert box 
and its contents, and program code that displays and handles it; also contains 
standard keyboard configuration 
Formats and rules for specific countries, including number punctuation, currency 
symbol, time and date formats, metric system or not, and alphabetization rules 
Number of menus and their resource ID numbers 
Program code for drawing menus 
Menu contents 
Packages of program code that serve as extensions to ROM and perform less 
common functions, such as disk initialization 
Single patterns, such as scroll bar "elevator" and current desktop pattern 
Lists of patterns, such as standard desktop and MacPaint pattern palettes 
Program code to drive printer 
MacPaint-style pictures, such as those used in Control Panel and Alarm Clock 
desk accessories 
Printer driver's private data storage 
Small icons, such as those used in hierarchical file system's Open dialog box 
Assorted bits and pieces of text 
Lists of text strings 
Program code for drawing windows 
Window templates 
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T he fact that resources are tucked away in the System file does not mean that 
they are inaccessible. If you are adventurous, you can use a program called a re­
source editor to change the resources, and therefore the look of the application, 
without changing the program's code. T here are two basic kinds of resource-editor 
programs: General-purpose resource editors, such as Apple's ResEdit, work with 
all types of resources; other resource editors, such as FONTastic from Altsys and 
Icon Switcher from PBI Software, are specialized for working on one parti-
cular resource type. 

The ResEdit program 

Apple's ResEdit program is a general-pur pose resource editor. With it, you can 
edit, copy, and paste all types of resources. It includes several specialized editors for 
specific types of resources, such as fonts, icons, and dialog boxes. Apple informally 
distributed unfinished versions of ResEdit th roughout 1985 and 1986. All the t ips in 
this book have been tested with version I.OD?, created in Januar y 1986. Many of the 
tips do not work with earlier versions, so be sure you have ResEdit l .OD7 or above. 

Since resources are vital to the fu nctioning of a program, editing them may 
cause the program to fail. For safety's sake, always make a copy of the disk that 
contains the resources you plan to change. Experiment only on the copy, never 
on the original disk. 

For best performance on a Mac that has only one disk drive, copy the ResEdit 
program onto the experimental disk. T his expedient may not always be possible, 
since ResEdit is a large program, but it saves much disk swapping if you can 
manage it. 

When you start ResEdit, a small window appears for each d isk currently 
inserted . T he title at the top of each window identifies its disk, and a list of names 
inside the window shows which application, document, and other fi les are on that 
particular disk. For double-sided disks and other disks that use the hierarchical fi le 
system (HFS), folders are also listed, with small folder icons alongside the folder 
names. You can open a folder, revealing its contents, by double clicking on its name. 

Although you can edit any fi le listed, you should avoid editing the ResEdit and 
System files currently in use. Instead , ed it a copy of those files from another d isk. 
You don't have to quit ResEdit to switch disks: First eject the disk you want to change 
by closing its disk window, then insert the desired disk in its place. A window appears 
for the new disk, listing its fi les. 
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To locate the particular resource you want to edit: 

1. Double click on the name of the fi le in the appropriate disk or folder window. 
For example, if you want to edit a resource in the System file, double click 
on its name in the disk window. (On an HFS disk, the System file is usually 
inside the System Folder, so you must first double click on the System Folder's 
name to open up its folder window, where the System file will be listed .) 
When you double click on the file name, another window opens up, listing 
all the resource types in the fi le by their four-letter names. You may also 
type the first part of a file or folder name to select it, and then press 
Return to open it. 

2. Double click on the name of the resource type you want to edit; you may 
also type the first part of the name and press Return. A window displaying 
a list of the individual resources of that type opens up. This window's title al­
ways starts with the name of the resource type, but its format depends on the 
resource type. For example, the ICON and ICN # windows display pictures of 
icons. For many resource types, individual resources are listed in a general 
format: by type, name, and ID number. You can force ResEdit to display the 
resources in the general format by pressing the Option key while you double 
click on the name of the resource type. 

3. Double click on the name of the individual resource in the resource 
window. A window in which you can actually edit the resource opens up. 
Since most individual resources are identified only by ID number, you may 
have to double click several, one after the other, until you find the right one. 

Changes you make to a resource with ResEdit are not saved to disk until you 
close the file window, close the disk window, or quit ResEdit. At that time, ResEdit 
asks whether you want to save the changes before closing; you click a Yes or No but­
ton to answer. Until you click Yes, you can revert to the last saved version of the 
resource by choosing Revert from the File menu. 

T he rest of this chapter explains how to edit individual resources of several types 
once they are displayed in their windows. 
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FONT RESOURCES 
Changing the default application font 

MacWrite and most other application programs use the Geneva font by default 
because the System file designates it as the standard application font. It has not 
always been so; longtime Mac users will remember that New York was the standard 
application font for the first five months of 1984. 

You could designate a different font as the standard application font by changing 
the System file with a resource editor such as Res Edit or a disk editor such as Fedit, 
but there are easier alternatives. The desk accessory variously called ApplFontl.03 
and Change Font D.A. (which doesn't yet work on the Mac Plus), written by Lofty 
Becker, lets you change the standard application font to any available font by clicking 
buttons. It's available from users' groups, as is an application-program form of the 
desk accessory. 

Secret characters 

Most fonts contain a hidden character that you can type by pressing Option­
Shift-Tilde. Different sizes of the same font may contain a different character. 

Wllllflllllllll•lf NewYork9 Q(:>QQQQO Geneva 9 ............. Toronto 9 

New York IO IHlllllll Geneva 10 (#«ff( Toronto 12 
111111 New York 12 ............ Geneva 12 •••• Toronto 14 

IJJU'JIJ New York 14 ~~~~ Geneva 14 ~ Toronto 18 

•••• New York 18 QQQQ Geneva 18 ~ Toronto 24 

iii NewYork24 •• Geneva 24 .e. .e. .e. .e. .e. London 18 

Mooaco9 .. \ •.I .. , 
Athens 18 eeoee11110 Venice 14 

·~ ·~ ·~ UlllUU Monaco 12 ~~~ San Francisco 18 

Many fonts have a hidden charact.er you can type by pressing Option-Shift-Tilde. 
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Changing a font 

Most fonts displayed on the Mac are resources contained in the System file. 
Using a special program, such as FONTastic from Altsys, you can easily edit fonts to 
change the look of the letters, to change the symbols, and so forth. With more work, 
you can also edit fonts using the ResEdit program. Prepare a font for editing with 
ResEdit as follows: 

I. Start ResEdit, insert a copy of the disk containing the font you want to 
change, and find and open the System file; the file may be inside a folder 
on a hierarchical file system (HFS) disk. Then open the resource window 
for the FONT resources, all as described in "The ResEdit program" earlier 
in this chapter. 

2. Each size of every font is a separate resource, so look for the name and size 
of the font you want to edit and double click on it. A large font-editing win­
dow opens; you may have to move it in order to see all of it. 

..... 

New YorlclB 

••• •• • • •• •• •• •• •• •• • • •••• •• •••••• •• •• •• •• •• • • •••••• 

The quick 
brown fox 
jumps 
over the 
lazy dog. 

f j;l h 
l_ __ J 

....___ 103 ----' 

,t.DLOI( 17-4-553-1-10 

Fonts displayed on the screen are FONT resources that you can edit in a ResEdit 
font-editing window. 

A sample piece of text written in the font appears boxed in the upper right part 
of the font-editing window. If you want to see characters not currently displayed , you 
can include them in the sample text using normal text-editing methods. 
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An enlargement of the character currently selected for editing appears near 
the middle of the font-editing window. The three black triangles along the left edge 
of this font-editing window define the vertical dimensions of the entire font, in the 
selected point size. The middle triangle marks the baseline, where most letters end. 
T he bottom triangle shows how far lowercase letters with descenders, such as y and 
g, descend below the baseline. T he top triangle shows how far the tallest letters as­
cend above the baseline. Independent of the ascender and descender markers, 
every FONT resource specifies one to three dots of space, called leading, for sep­
aration between lines of text. You cannot change the amount of leading from 
the font-editing window. 

The two black triangles along the bottom edge of the editing window define 
the horizontal dimensions of the currently selected character. The left triangle 
marks the character 's offset, which determines how close the selected character 
is to the character on its left. T he right triangle marks the character's width, 
which determines how close the selected character is to the character on its right. 

T he code that begins ADLOW in the bottom right corner of the font-editing 
window numerically reports the Ascent, Descent, Location, Offset, and Width 
of the character selected for editing. The ascent, descent, offset, and width are all 
measured in dots from the character's origin, which is the point on the baseline 
used as a reference for drawing the character. T he location specifies where the 
character image sta1-ts in the FONT resource. 

::: ::.Ain.g:S:i'f .O'ffL·:· 
: : Descent 

h-l 
Character origin l Character width 
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Character offset 

The vertical size of a font (its point size) is measured ahove and below a baseline. The 
horizontal dimensions of a character are measured /,efl and right of its origin point. 
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The selected character appears in its actual size inside a selection rectangle near 
the bottom right corner of the window. Beneath the selected character is the ASCII 
code number assigned to the character. Characters with adjacent code numbers 
flank the selected character. (Character code numbers range between 0 and 255. 
Normally, code 65 is assigned to an uppercase A, which is produced by pressing the 
Shift-A key combination, 66 is assigned to uppercase B, and so on.) 

For each characler you wam Lo ediL, follow Lhese steps: 

I. Select the character you want to change simply by typing it. Alternatively, 
scroll rapidly through the characters by dragging the selection rectangle 
right or left or scroll one character at a time by clicking beside the selec­
tion rectangle. 

2. Edit the enlargement of the character as if it were in MacPaint's FatBits. 
Click on a black dot to make it white and click on a white space to make 
a black dot. 

3. If you want to change the horizontal dimensions of the character, drag the 
black triangles at the bottom of the editing window. Watch in the sample text 
at the right side of the window to see the results. 

4. To adjust the vertical dimensions of the font as a whole, drag the top and 
bottom black triangles along the edge of the character-editing window. 
(The baseline marker cannot be moved.) Watch the effects of your 
changes in the sample text in the right side of the font-editing window. 

When you have finished making changes to the font, close the file window. 
Res Edit asks if you want to save the changes you just made; click either Yes or No. 
Quit ResEdit when you have finished editing resources. 

On a Macintosh Plus, Mac 512K Enhanced, or other Mac equivalently upgraded, 
the Chicago 12 font is included in the 128K ROM. The FONT resource in the ROM 
overrides the same resource on a disk, so editing the font on disk has no effect on 
what is displayed or printed. 

There is also no point in changing FONT resources for Laser Writer fonts, 
such as Times, Helvetica, and Courier. T he FONT resources for LaserWriter 
fonts are used only to display the fonts and printing on an lmageWriter. The 
Laser Writer has its own built-in font definitions and they override any like­
named FONT resources when printing on the Laser Writer. 

79 



Mac Insights 

Creating overstrike characters 

Do you sometimes wish the Mac had a non-erasing backspace key, like a type­
writer, so you could combine two or more characters to put accents over any letter or 
create otherwise unavailable mathematical symbols? You can put an accent, circum­
flex, umlaut, or tilde over some letters by typing Option-Apostrophe, Option-£, 
Option-I, Option-U, or Option-N followed by another letter. You can get the same 
results with any combination of characters by manipulating the two triangles that 
determine character width in the ResEdit font-editing window. Here's how: 

1. While editing any character as described in "Changing a font" earlier 
in this chapter, drag the right horizontal black triangle to the left, so that it 
is directly under the character's origin. The last two numbers in the bottom 
right corner of the character-editing window, the offset and the width, 
will now match. 

2. Try typing the character you have just edited before and after some other 
characters in the sample text area in the upper right corner of the font­
editing window. When you type a character whose width and offset 
match, the insertion point does not move, so the next character you type 
overstrikes the first. 

For best results, all the characters that overstrike one another must be the same 
number of dots wide. 

The method described here for adjusting character widths doesn't work on all 
fonts. If moving the black triangles in the FONT resource-editing window has no 
effect on displayed characters, chances are the font in question has a corresponding 
FOND resource that contains a character width table. T hat table overrides the width 
settings in the FONT resource. Changes to the FONT resources for Laser Writer 
fonts don't affect printing on a Laser Writer, because the Laser Writer has its own 
definitions for Times, Helvetica, and Courier. Also, the 128K ROM present in 
ever y Mac Plus and many other Macs contains a FONT resource for Chicago 12 
that overrides the System-file Chicago 12 resource. 
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Adding characters to a font 

There are more than 30 key combinations involving the Option key for which no 
particular. character has been defined. (With most fonts, typing an unused key com­
bination produces a rectangle.) T he exact set of undefined combinations varies from 
font to font. For example, the character generated by pressing Option-Shift-Tilde is 
defined in some fonts but not others. Laser Writer fonts generally have no undefi ned 
combinations. 

Key Cops 

I * 
7 8 g -

4 5 6 + 

1 2 3 

0 

I * 
7 8 g -
4 5 6 + 

1 2 3 

0 

There are key combinations involving both the Option key (lop) or the Of1tion and 
Shift keys (bottom) for which characters have not been defined in the Geneva 12 font. 

As with other fonts, yau can define characters for these combinations using the 
ResEdit program. 

You can use the ResEdit program to assign your own characters to undefined 
combinations. Once you have the font-editing window on the screen, type a key com­
bination that selects one of the undefined ASCII code numbers. (Code numbers 
between 217 and 251 are usually undefined.) Then just follow the instructions for ed­
iting a character in "Changing a font" to add the newly defined character to the font. 
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Creating a unique customized font 

If you want to have both modified and unmodified versions of a font available, 
they must have different names. Otherwise, you won't be able to tell them apart in 
a Font menu. But renaming one of them is not enough, because Mac application pro­
grams do not use the font name to identify a font. They use the FONT resource ID 
number. For example, neither you, the program, nor MacWrite can tell the dif­
ference between a customized Geneva 10 and a standard Geneva 10 unless you 
change the name and resource ID numbers of one. Specialized font-editor 
programs, such as FONTastic, take care of this for you. You can also change font 
names and resource ID numbers using the ResEdit program. 

In order to change resource ID numbers, you must understand how they are 
derived. A resource ID number is computed from two other numbers: the fontnum­
ber and the font size. The font number is a number between 0 and 511 that uniquely 
identifies the font among all fonts that are either in the System file now or might be 
there at some point in the future. Font numbers 0 through 127 identify fonts that are 
created by Apple, numbers 128 through 383 are assigned by Apple to certain fonts 
that are created by others, and numbers 384 through 511 are open for general 
use. You should therefore give your customized font a number between 384 and 511 
in order to avoid conflict with "official" fonts. 

To compute the resource ID number, you multiply the font number you have 
selected by 128 and add the point size. The table on the facing page lists font and 
resource ID numbers for several sizes of some common fonts and for font num­
bers 508 through 511. 

Having chosen a font number and computed the resource ID number for 
your customized font, assign the resource ID number to the font using ResEdit, 
as follows: 

1. Start ResEdit, insert a copy of the disk you want to change, and find and 
open the System file. On a hierarchical file system (HFS) disk, it may be in­
side a folder. Then open the resource window for the FONT resources, all as 
described earlier in "The ResEdit program." 

2. Select your customized font by clicking its name in the resource window, 
and then choose Get Info from ResEdit's File menu. An information 
window opens, with the resource ID number selected. 

3. Edit the resource ID number you computed and close the information 
window. 

Repeat steps 2 and 3 for each size of your customized font. 
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RESOURCE ID NUMBER FOR POINT SIZE 

Font Font Point Size 
Name Number O* 9 10 12 14 18 24 
Chicago 0 0 9 10 12 14 18 24 
New York 2 256 265 266 268 270 274 280 
Geneva 3 384 393 394 396 398 402 408 
Monaco 4 512 52 1 522 524 526 530 536 
Venice 5 640 649 650 652 654 658 664 
London 6 768 777 778 780 782 786 792 
Athens 7 896 905 906 908 910 914 920 
San Francisco 8 1024 1033 1034 1036 1038 1042 1048 
Toronto 9 1152 1161 1162 1164 1166 1170 1176 
Seattle 10 1280 1289 1290 1292 1294 1298 1304 
Cairo 11 1408 1417 1418 1420 1422 1426 1432 
Los Angeles 12 1536 1545 1546 1548 1550 1554 1560 

Timest 20 2560 2569 2570 2572 2574 2578 2584 
Helveticat 21 2688 2697 2698 2700 2702 2706 27 12 
Couriert 22 2816 2825 2826 2828 2830 2834 2840 
Taliesin 24 3072 3081 3082 3084 3086 3090 3096 

Your Font 508 65024 65033 65034 65036 65038 65042 65048 
Your Font 509 65 152 65161 65 162 65 164 65 166 65170 65176 
Your Font 510 65280 65289 65290 65292 65294 65298 65304 
Your Font 511 65408 65417 65418 65420 65422 65426 65432 

* The point size 0 font contains the font name. 
t FONT resources do not affect the look of text printed on a Laser Writer. 

You probably noticed that the information window for each font resource had 
a space for a name, but that the space was blank. That space is for the name of the 
resource, not the name of the font. The name for the entire font is kept in the infor-
mation window for that font's 0-point resource, which contains no character 
definitions. You get at the 0-point resource by reopening the FONT resource 
window in the following special manner: 

1. Close the FONT resource window, if it is open. 

2. Reopen the window by double clicking the resource named FONT in the file 
window while pressing the Option key. A resource window opens, listing font 
resources in the general format, with their types, resource names, and re-
source ID numbers. Every resource listed has an ID number but only a few 
have names. 
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3. Click the 0-point resource for the font you want to rename; usually it's the 
only resource for that font with a name. Choose Get Info from the File 
menu. An information window opens. 

4. Edit the font name and resource ID number in the information window 
using normal text-editing methods. (Remember, this is the 0-point size, so 
the ID number equals 128 times the font number.) When you have finished 
editing, close the information and FONT windows. 

Many fonts have a FOND resource in addition to FONT resources. The FOND 

resource contains the name, FONT resource ID numbers, and other information 
about an entire font family, such as Geneva or Times. If your custom font has a 
FOND resource, you must change the name and FONT resource ID numbers in it 
to match the changes you just made to the FONT resources. Use ResEdit as follows: 
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1. Look for the FOND resource right above the FONT resource in the file win­
dow. If none is listed, skip to step 7. Otherwise open the FOND resource by 
double clicking its name. A resource-editing window opens. 

2. Change the number in the second box, labeled Family ID, to the new font 
number (not one of the computed resource ID numbers). 

3. Scroll down past the boxes labeled Ascent, Descent, Offset ... , and Extra . ... 
Stop scrolling when you find the phrase # of Font entries. Below it 
are one or more sets of three boxes labeled Font Size, Font Sty/£, and Res ID. 
There is one set for each font size in the FONT resource, and the sets 
are separated by lines of five asterisks. 

4. In each set, change the box labeled Res ID to the new resource ID you 
calculated for the accompanying font size. 

5. When you have finished entering the resource ID numbers, choose Get Info 
from the File menu. An information window appears. 

6. Enter the name of the custom font in the box labeled Name:, and then close 
the information and FOND windows. 

7. When you have finished changing the FONT and FOND resources for your 
customized font, close the file window. Answer Yes when ResEdit asks if you 
want to save changes. 
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Fonts in application files 

Fonts customarily reside in the System file, where they are available from any 
application for use in any document. But fonts can also reside in application pro­
gram files. Fonts from the application file appear on the font menu along with fonts 
from the System file. Transferring the burden of specialty fonts from the System file 
to an application file helps to reduce the size of the System file, and may make the 
difference between a common System file fitting in a small RAM disk on a 
Mac 512K or not. 

You can copy a font to an application program file using Apple's Font/DA Mover 
program. Normally, it only lets you open the System file and font files; they are the 
only files listed in the Open dialog box. But if you press the Option key while dick­
ing the Open button, the Open dialog box lists all the fi les on the disk. You'll even 
see the names of invisible files such as Desk Top. After opening an application file, 
you'll be able to copy fonts to it as if it were a System file. You may discover some ap­
plications already secretly contain a font or two. MacPaint, for example, has a font 
named 12 that contains aJI the icons for the drawing tool palette and the various 
brush shapes for the paintbrush tool. Don't forget to remove fonts from the 
System file after copying them to application files. 

®Font Mou er 0 Desk Accessory 

New York ID ( » Copy» 12 
New York 12 New York 36 
New York 14 ( Aemoue ~ 
New York 18 
New York 20 
New York 24 13954 bytes 

selected .IQ 
System MacPaint 

on !Omega 1 Help on !Omega 1 
1786K free 1786K free 

( Close Quit Close l 

New York 36: The q u i c k b r 0 

Pressing the Option key whi/,e clicking the open In.titan in the Font/DA Maver 
program /,ets you open any wpy fonts to and from any .fi/,e, not just the System 

.fi/,e and fonts files. 
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ICON AND POINTER 
RESOURCES 

Personalizing icons 

T ired of the same old icons? They're easy enough to change with a special pro­
gram, such as Icon Switcher from PBI Software. And, since most icon resources are 
stored in the System file or an application file, you can also edit them with a general­
purpose resource editor, such as Apple's ResEdit, though it takes some work. 

An application's icon and the icons of its documents are ICN # resources that 
are stored in the application file. The application may use other icons too, such as 
the drawing of Bill Atkinson in MacPaint's About MacPaint window. Those icons 
are ICON resources; they are also stored in the application file. 
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Custorniu your Mac applications with icons that express your personality. 

Using ResEdit, locate the icon you want to edit as follows: 

1. Start ResEdit, insert a copy of the disk containing the icon you want to 
change, and open the application program file where the icon resides. T he 
file may be inside a folder on a hierarchical fi le system (HFS) disk. 
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2. Double click on the ICON and ICN# resource types. Two resource win­
dows open, showing pictures of the icons comprising each type of icon 
resource. Move the windows so they don't overlap. 

3. Find the icon you want to edit and double click it. A large icon-editing 
window opens; you may have to move it in order to see it all. 

ICN#'s ID • 128 from M11cP11int 

•• ••• •• 
• • •• • • •••• • • •••••• • ••••••• • • • •••• • • • •••• • • • ••• • • • • • • • • • • • • •••••• • • • • • • • • • • • • •• • •• • • • ••• ••• • • • • •••• •••••••• • ••• • • •• • •• ·. .. ::: • •• • •• • •••••••• • •• .. ..· ··::: 
•• • • • • • • 

• ... ••••• ••••••• • •••••••• .:::::::::::. • •••••••••••••• ••••••••••••••••• ••••••••••••••••••• ••••••••••••••••••••• ••••••••••••••••••••••• • •••••••••••••••••••••••• ••••••••••••••••••••••••••• • •••••••••••••••••••••••••••• •::::::::::::::::::::::::::::::. • •••••••••••••••••••••••••••• ••••••••••••••••••••••••••• • ••••••••••••••••••••••••••• • •••••••••••••••••••••••••• •••••••••••••••••••••••••• ••••••••••••••••••••••••• • ••••••••••••••••••••••• • •••••••••••••••••••••• ••••••••••••• • •••• ••••••••••• • •• ••••••••• ••••••• ••••• . .. • 

!0 § Icon ID • 2006 from M11cP11in t ~ 

• ••••• •• • ••••••• • ••••• •• •• • •••••••••••• •• ••• ••••• •• • ••••• •••••• ••• ••• • •••• ••••• • • • • •• • ••• • •• •• ••••• • • •• •••• • ••• ••• •• • •••••• • •••• • •••• •• ::::1 ••• • • •••• •;:•:: .. ... .... ... ... . . ~ ••• •• • • •• •• • • • •• . ::. . . : . ... . = .·: . .. . .. . . .... ·-' ••• ••• • • ••• • ••• •••• •• • • •• • •• ••••••••• •••• • • • •• ••••• •• •• • • ••• ••• • • • ••••• • •• ••• • • • • •• • • • •••• •• • • •• • •••• ••••• •• •• • • • •• •• •• •• 

Most icons are resources that you can edit in a ResEdit icon-editing window. There 
are two types of editing windows: one for ICN # resources (top) and the other for 

ICON resources (bottom). 
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ResEdit has two styles of icon-editing windows, one for each type of icon re­
source. The editing window for ICON resources shows the icon both magnified and 
in its actual size. The editing window for ICN# resources shows the icon magnified, 
a shadow-like mask of the magnified icon, five variations of the icon in its actual size, 
and a miniature version of the icon. To edit an icon: 

I. Edit the enlargement of the icon as if it were in MacPaint's FatBits. Click 
on a black dot to make it white and click on a white space to make a 
black dot. 

2. Make the mask of an ICN#-type icon conform to your edited icon by 
choosing Data - > Mask from the kn# menu. 

3. When you have finished editing, close the editing window. 

Repeat these steps for each icon you want to change in the file: 
If you have edited only ICON resources, there's nothing more to do but close 

the file window, answer Yes when ResEdit asks if you want to save your changes, quit 
ResEdit, and enjoy using your personalized icon. However, if you have edited ICN# 
resources, you must first take additional steps to let the Finder know about the 
changes. This involves copying all the changed ICN# resources to the DeskTop 
file on the same disk, as follows: 
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I. If you have closed the ICN # resot'.lrce window for the application pro­
gram file, reopen it. 

2. Look in the disk window for the Desk Top and double click its name. 
Every disk has a Desk Top file, so make sure you open the one from the 
disk on which you edited the icons. A window opens, listing the resource 
types in the DeskTop file. 

3.· Double click the ICN# resource type. A resource window opens, showing 
which icons are in the DeskTop file. 
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4. There should now be two windows showing ICN# resources: one window 
for the Desk Top file, showing the original, versions of the icons you have 
edited, and the other for the application file, showing the edited versions 
of the same icons. Move the ICN # windows so they are side by side. 

5. In the DeskTop's ICN# window, find an original icon that needs replacing 
with its edited version; use the scroll bar if necessary. Double click the 
icon and, when the icon-editing window opens, note the resource ID num­
ber in its title bar. Then close the editing window. 

6. Click the application's ICN# window to activate it, click the corresponding 
edited icon to select it, and then choose Copy from the Edit menu. 

7. Activate the DeskTop's ICN# window again and choose Paste from the Edit 
menu. The edited icon is pasted into the DeskTop's ICN# window (you may 
have to scroll to see it). 

8. Select the original icon in the DeskTop's ICN# window and choose Clear 
from the Edit menu. The original icon vanishes. 

9. Select the replacement icon in the DeskTop's ICN# window and choose 
Get Info from the File menu. An information window appears, showing 
the unedited icon's resource ID number. 

10. Change the resource ID number to match the one you noted in step 5 
and close the information window. 

11. Repeat steps 5 through IO for each icon in the DeskTop fi le that needs 
replacing. When you have finished replacing the icons, close the 
ICN# windows. 

12. Close the Desk Top file window and answer Yes when ResEdit asks if you 
want to save your changes. 

13. Close the application file window and answer Yes when ResEdit asks if you 
want to save your changes. 

14. FinaJly, you can quit ResEdit. 
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Personalizing pointers 

All pointers but one-the standard arrow-are CURS resources stored in 
the System file or in an application file, so you can edit the pointer shapes with a 
general-purpose resource editor such as ResEdit. (ResEdit calls each CURS re­
source a cursor.) You can also change each pointer's "hot spot," which aligns the 
pointer with the mouse location. Here's how you locate a pointer shape that is 
defined in the System file: 

1. Start ResEdit, insert a copy of the disk containing the pointer shapes you 
want to change, and find and open the System file. It may be inside a folder 
on a hierarchical file system (HFS) disk. 

2. Open the resource window for the CURS resources. It contains a replica of 
each pointer in the file. 

3. Double click the pointer you want to edit. A cursor-editing window opens . 

• ••• • • • •• • • • 
= ··= == • • • • • • •••••• •••••• •••••• •••••• 

•••••••••• •••••••••• •••••••••• •••••••• • ••••• •••••• • ••••• •••••• 

•••••• •••••• •••••• • ••••• • • • • • • • • • • •• • ••• • •• • • • • • • • ••••• • ••••• • ••••• • ••••• 

All pointers except the staruiard arraw are resources that )'UU can edit in a ResEdit 
cursor-editing window. Yuu can change both the pointer shape and the /wt spot that 

links it to the rrwuse location. 

The cursor-editing window has three editing panels: The left panel shows a 
magnified version of the icon, the center panel shows the optional mask (which 
affects the appearance of the pointer against non-white backgrounds), and the right 
panel shows the location of the hot spot. The window also shows the pointer against 
three background patterns. 

The following table shows how a pointer's appearance is determined by the 
color-black or white-of each dot in the pointer itself, the color of each dot in the 
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pointer's mask, and the color of the dots under the pointer. If all mask dots are white, 
for example, the pointer is completely transparent. 

Color of Pointer Dot 
White 
Black 
White 
Black 

Color of Mask Dot 
Black 
Black 
White 
White 

Resulting Color 
White 
Black 
Same as background 
Inverse of background 

Once you have located the pointer shape, you change it like this: 

I. Edit the magnified pointer in the left panel as if it were in MacPaint's 
FatBits. Click on a black dot to make it white and on a white space to make 
a black dot. 

2. If the center panel of the editing window is not blank, choose 
Data - > Mask from the Cursor menu. This creates a mask that shadows 
the pointer. You can also edit the mask using FatBits techniques. 

3. In the right panel of the editing window, click the place where you want 
the hot spot. A black dot appears there. 

4. Try out the new pointer by choosing Try Cursor from the Cursor 
menu. See how it looks over various background patterns and test the 
serviceability of the hot-spot location. If the pointer doesn't look right, edit 
it or its mask. If it doesn't have the right feel, change the location 
of the hot spot. 

5. When you have finished editing, close the cursor-editing window. 

6. Repeat steps 2 through 5 for each pointer you want to change in the file. 
T hen close the System file window, answer Yes when ResEdit asks if you 
want to save the changes you just made, and quit Res Edit. 

Many applications define special pointers, and a few even redefine the standard 
pointers in the System file. Therefore, you may have to look for CURS resources in 
application files rather than in the System fi le in order to find the pointer shape you 
want to change. The procedure for editing an application CURS resource is exactly 
as just described, except that in step I on the facing page, you open the application 
file instead of the System file. 

Some applications don't use CURS resources to define their pointers. MacPaint, 
for example, uses a FONT resource. You can't change a pointer using the method 
described here unless it's a CURS resource. 
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KEYBOARD RESOURCES 
The Dvorak layout 

If you do a lot of typing on your Mac, you may be interested in trying the key­
board layout devised by Dr. August Dvorak for improved speed and accuracy. The 
Dvorak desk accessory, which is in the public domain, can switch the standard Mac 
QWERTY keyboard to a Dvorak layout and back. The keyboard layout remains in 
effect until you restart the Mac; changing disks or application programs has 
no effect. T he standard Key Caps desk accessory shows which layout is active. 

The Dvorak desk accessory does diverge from the original Dvorak layout in 
a few ways. For example, the desk accessory doesn't rearrange the top row of keys, 
whereas Dr. Dvorak's original layout changed the order of the numerals and symbols 
in the top row. Also, the Option or Option-Shift keys for special characters work the 
same as they do with the QWERTY layout. 

You install the Dvorak desk accessory in your System files with Apple's 
Font/DA Mover program. 

Reset from keyboard 

If you're the kind of person who always seems to be groping along the left side of 
your Mac for the Reset button, you might like to move the reset function to the key­
board. No, there's no soldering to do, but you will have to write a machine-language 
program that instructs the Mac to reset itself when you press Command-Shift-0. 
Sound intimidating? Don't worry. Your job is easy, because the Mac does most of the 
work for you. When you press Command-Shift-number, the Mac looks in the System 
file for an FKEY resource whose ID number matches the number key you pressed. 
If it finds a matching resource, it runs the machine-language program code con­
tained in the resource. 

The program code that resets the computer consists of one machine-language 
instruction: the RESET instruction. So all you have to do is create the new FKEY 
resource and type the four-character code for the RESET instruction (4£70) into 
it. You can do this easily with the ResEdit program. Here's how: 
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1. Start ResEdit, insert a copy of the startup disk you want affected by the 
keyboard reset, and find and open the System file, all as described in 'The 
ResEdit program." The System file may be inside a folder on a hierarchical 
file system (HFS) disk. Open the resource window for the FKEY resources. 
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2. There should be two FKEY resources listed in the resource window, one 
with ID number 3 and the other with ID number 4. Create a new FKEY 
resource by choosing New from the File menu. An FKEY-editing window 
opens, with a text insertion point flashing inside a box labeled Data. 

3. To write the machine-language program, type 4£70 (don't press Return). 

4. Choose Get Info from the File menu and, in the information window that 
opens, change the resource ID number to 0. Also, click the Purgeable 
option to give the Mac maximum flexibility in memory management. 

5. Close the information window, the FKEY-editing window, and the System­
file window. Answer Yes when ResEdit asks if you want to save changes. 

6. That's all there is to it, so you can now quit ResEdit. 

The Command-Shift-0 reset only works if the FKEY 0 resource is installed in the 
System file currently in use. It won't work after a catastrophic failure when an appli­
cation locks up, the pointer freezes, or the screen goes haywire. 

Warning: Don't habitually reset the computer as a shortcut to quitting and shut­
ting down in an orderly fashion. Otherwise you'll sooner or later corrupt a disk and 
perhaps lose documents and applications in the bargain. 

MENU RESOURCES 
Adding Command-key shortcuts 

Command-key shortcuts for menu choices are great timesavers, but some appli­
cation programs don't have enough of them. You can add your own Command-key 
shortcuts, or change existing ones, using the ResEdit program as follows: 

1. Start ResEdit, insert a copy of the disk containing the application for which 
you want to create Command-key shortcuts, and open the application file 
all as described in "The ResEdit program." The System file may be inside a 
folder on a hierarchical file system (HFS) disk. Open the resource window 
for the MENU resources. 

2. Each menu is a separate resource whose ID number indicates its location 
on the menu bar. ID number 1 is the Apple menu, ID number 2 is usually 
a File menu, and so on. Double click the ID number of the menu for 
which you want to create Command-key shortcuts, and a menu-editing 
window opens. 
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Menu contents are MENU resources that are stored in an application file. You can 
edit them with the ResEdit program lo add Command-key shortcuts, change wording, 

alter text style, or add icons. 

3. Make sure you've got the right menu by checking the title in the box 
labeled title. If you've missed the mark, close the editing window and 
repeat step 2. 

4. Use the scroll bar to find the command you want; its name will be 
displayed in a box labeled menultem. 

5. Continue scrolling until you see the box labeled Irey equiv. In this box, 
enter the character that, in combinalion with the Command key, will 
be the shortcut for the selected command. 

6. Repeat steps 4 and 5 for each Command-key shortcut you want to create 
or edit in the same menu. 

7. If you want to work with another menu in the same application, go back 
to the MENU resource window and repeat from step 2. 

8. When you have finished ed iting menus in this application, close the appli­
cation's fi le window and answer Yes when ResEdit asks whether you want 
to save your changes. 
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Command-key shortcuts must be unique within an application; you should 
not try to use one Command-key shortcut for more than one menu command in 
the same program. When used in combination with the Command key, shifted 
keys are considered the same as unshifted keys. Hence q and Qare the same, and 
so are = and +. For consistency among applications, use uppercase letters in 
Command-key shortcuts. 

It's best to avoid Command-number combinations, since Command-Shift-number 
combinations are reserved for ejecting disks, recording screen snapshots, and so 
on. If you run out of uppercase letters when creating your Command-key shortcuts, 
use Command-Option with uppercase letter or symbol keys. 

Menu wording and style 

While you're using the ResEdit program to create or edit Command-key short­
cuts as just described, you can also change the menu title and the menu items. In 
ResEdit's menu-editing window, they appear in the boxes labeled title and menultem. 
Use standard text-editing methods to change the contents of these boxes. 

The menu title is always displayed in plain style. The menu items, though, 
can be displayed in any combination of bold, italic, underline, outline, shadow, 
condensed, and extended styles. You can select style attributes for each menu item 
individually while you are otherwise editing the menu with ResEdit. Here's how: 

1. In the menu-editing window, scroll beyond the menu/tem box until you 
can just see several pairs of buttons, each pair labeled with the name of a 
different style. 

2. To select a style, click the button labeled I. To deselect a style, click the button 
labeled 0. 

Incidentally, the pair of buttons labeled ignored is, in fact, ignored; whichever of the 
two buttons you click, it has no effect. 

Menu icons 

Very few application programs use icons in menus, probably because the icons 
take up so much space. But any menu item can have an icon. It appears to the left of 
the menu-item text, or by itself if there is no text. 

The icons used in menus are ICON resources. The icon for a particular menu 
item is identified in a MENU resource by a number equal to the ICON resource ID 
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number minus 255. For example, an icon whose ICON resource ID number is 256 
has an icon number of I in a MENU resource. The icon number in the MENU re­
source must be between I and 255 (an icon number of 0 means the menu item has 
no icon), so only those icons with ICON resource ID numbers between 256 and 511 
may appear in menus. Therefore the first task to accomplish in adding an icon to a 
menu is to define the icon as an ICON resource with an ID number between 256 and 
511. You can do this using ResEdit as follows: 
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1. Start ResEdit, insert a copy of the disk containing the application to whose 
menu you want to add an icon, and open the application program file, all as 
described in "The ResEdit program." The file may be inside a folder on a hi­
erarchical fi le system (HFS) disk. 

2. If the application has no ICON resource type, choose New from the File 
menu. In the dialog box that appears, type ICON. A blank ICON resource 
window opens. Skip to step 5. 

3. If the application does have an ICON resource type, double click it while 
pressing the Option key. A general-format resource window opens, listing 
resource ID numbers currently used by ICON resources. Make a note of 
the resource ID numbers between 256 and 51 l that are already in use, 
and close the resource window. 

4. Double click the ICON resource type (this time without pressing the 
Option key). A resource window opens, showing pictures of the existing 
ICON resources. 

5. To create a new icon, choose New from the File menu. A blank icon-editing 
window appears. Skip to step 8. 

6. To use an existing icon as is or to edit one, click it to select it and choose 
Duplicate from the Edit menu. A copy of the icon appears in the ICON 
resource window. 

7. If you want to use the duplicate icon as is, skip to step 9. To edit the du­
plicate icon, double click it and an icon-editing window opens. The ID 
number in the title bar should be different from the original icon's 
ID number. If they're the same, you've opened the original instead 
of the duplicate, so close the editing window and try the other icon. 
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8. Edit the icon as if it were in MacPaint's FatBits. Click on a black dot to 
make it white and click on a white space to make a black dot. Close the 
editing window when you finish editing. 

9. Click the icon you want to use in the menu to select it, and choose 
Get Info from the File menu. An information window appears. 

10. Change the ID number to some unused ID number between 256 and 511, 
and close the information window, the ICON resource window, and the 
application file window. Answer Yes when ResEdit asks you whether you 
want to save your changes. 

After preparing the ICON resource, you have to enter the icon number, which is the 
resource ID number minus 255, in the MENU resource. Menu editing with ResEdit 
is described in "Adding Command-key shortcuts" on page 93. After opening the 
MENU resource window and then the menu-editing window for the menu in which 
you want the icon, scroll through the editing window until you find the menu item 
next to which you want the icon to appear. The icon number goes in the box labeled 
icon, located just below that menu item's title. 

DIALOG- AND AI .. ERT-BOX 
RESOURCES 

Displaying longer Get Info comments 

T he Finder's Get Info command, which is on the File menu, displays a dialog box 
that reports various facts about an application, document, or folder icon. In addition, 
it provides space for you to type comments about the icon in your own words. The 
comments can be as long as five lines, but you can only see three lines at a time. 

The Get Info dialog box itself is a DLOG resource. The items in it-text, icon, 
text-editing area, and so on-comprise a DIT L (dialog item list) resource. You can 
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edit these resources with the ResEdit program to enlarge both the dialog box and 
the area provided for comments. First you need to locate the Get Info DLOG re­
source and its contents, as follows: 
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1. Start ResEdit, insert a disk with a copy of the Finder, and open the Finder. 
It is usually inside the System Folder on a hierarchical file system (HFS) disk. 
Then open the resource window for the DLOG resources, all as described in 
''The ResEdit program." 

2. Find the DLOG resource whose ID number is 192 and double click on it. A 
dialog-editing window opens, titled Dialog ID= 192 from Finder. 

Dialog boxes, such as the Finder's Get Info dialog box, are DLOG resources that you 
can edit in a ResEdit dialog-editing window. To resize a dialog box, drag its bott01n 

right comer. You can also drag the dialog box Lo a new location, but application 
programs often ignore the location set in the DLOG resource and display the 

dialog box elsewhere. 

3. Double click anywhere inside the miniature Get Info dialog box. An edit­
ing window opens for DITL resources. Drag this editing window up by 
its title bar so you can see its lower edge. 
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;o Dlolo_g_ Item llst ID • 192 from 

'--------il 
The items in a didog box-buttons, text, text-editing areas, and so on- • 

are DITL resources that you can reposition and resize in a ResEdit 
dia/,og-item-list-editing window. 

The text-editing area reserved for Get Info comments appears as a rectangle at 
the bottom of the DI TL-editing window. Although you could resize the text-editing 
area by dragging the rectangle's bottom right corner, it's easier and more accurate to 
specify a new size numerically, as follows: 

1. Double click inside the text-editing rectangle. A window opens in which 
you can edit one dialog item. 

-o Edit Item #15 

O Button ® Enobled 
O Check boH 0 Dlsobled 
0 Rodio contro l 

O Stotic teHt top 156 J ® Editoble teHt 
left 10 J 0 CNTL resource 

0 ICON resource bottom tl•§ 
O PICT resource right 374-~ J 
0 User item 

Te11t 

I I 
In a ResEdit dialog-item-editing windaw, you can select the type of item, specify its 

location and size, and edit any text it might contain. The item's location and size are 
measured in screen dots from the upper /,eft corner of the dialog box to the top, left, 

bottom, and right edges of the item. 

99 



Mac Insights 

2. Change the number in the box labeled bottom from 204 to 236. T his will 
make the comments rectangle 32 dots taller, which is the amount needed 
for two more lines of Chicago 12 text. Then close the dialog-item-editing 
window and the dialog-item-list-editing window. 

3. Back in the dialog-editing window, lengthen the miniature Get Info d ialog 
box by dragging its bottom right corner straight down far enough to 
accommodate the newly lengthened comments rectangle. 

4. After adjusting the length of the Get Info dialog box, close the d ialog­
editing window, the DLOG window, and the Finder window. Answer Yes 
when ResEdit asks whether you want to save your changes. 

Editing alert boxes 

From a resource point of view, alert boxes and dialog boxes are very similar. In 
fact, some alert and dialog boxes look very much alike. So it should come as no sur­
prise that alert boxes are usually defined by resources that you can edit with the 
ResEdit program. 

Alert boxes themselves are ALRT resources, which you edit exactly like DLOG 
resources. The items in alert boxes are DITL resources, which you edit the same as 
DITL resources used for dialog boxes. 

Experimenting with dialog and alert box changes 

Because you can edit resources, you have a great deal of control over the appear­
ance of dialog and alert boxes. However, dialog and alert boxes are not solely 
defined by resources: Application programs can and do alter them on the Ay. If 
their alterations overlap changes you have made with ResEdit, ugly may be too polite 
a word to apply to the result. Hence, you should experiment with dialog and alert 
box changes on a copy of the application program or System fi le, and should not put 
the redesigned dialog or aler t box into service until you have thoroughly tested all 
aspects of it in action. 

Before changing a dialog or alert box, make sure you are editing the right 
ALRT, DLOG, or DITL resource. For example, many application programs contain 
custom Open and Save As dialog boxes that will override those resources in the Sys­
tem file. So before blithely editing either of these System-fi le resources, you should 
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check every application you plan to use with the System file. If you find equivalent 
resources in the applications, you must edit them, too; otherwise the unedited 
application versions will override the edited System-file versions. 

Application resources may not have the same resource ID numbers as the 
System-file resources they replace. For example, the resource ID number for 
the standard Open dialog box is -4000, for both DLOG and DITL resources. 
MacWrite uses the standard Open dialog box from the System file, but the Font/DA 
Mover program uses ID number 300 for its custom Open dialog box. 

Some of the changes you can make with ResEdit to ALRT, DLOG, and DITL 
resources are almost sure to cause problems, unless you also rewrite the application 
program that uses them. You'd be wise to heed these warnings: 

0 Never remove items from a dialog or alert box. 

0 Never change an item in a dialog or alert box from one type-button, 
check box, static text, CNTL resource, user item, and so on-to another. 

0 Don't use the Send to Back or the Bring to Front command in the 
DITL menu, which appears when a dialog-item-list-editing window is active. 
Those commands can disrupt the way the dialog or alert box works. 

0 Don't edit or remove text such as 11 0 or 11 1 that you find in a dialog-item­
list-editing window. These markers are destined to be replaced by mean­
ingful text when a program that uses them is run. 

0 When editing some DITL resources, choosing Full Window from the 
DITL menu enlarges the editing window considerably. T he enlarged win­
dow may be so large that you have to drag it around to see it al l. You may 
find items at the extreme edges of an enlarged dialog-item-list-editing 
window. Such items are invisible when used in a dialog or alert box, unless 
the application that uses them makes them visible by relocating them 
while it is running. Don't move these "invisible" items. 
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PRINTING RESOURCES 
Custom paper sizes 

Two or three of the five paper sizes offered in the Page Setup dialog boxes of 
most application programs are of no use to most Mac users. Not many people use 
both US Letter and A4 Letter, for example. The five paper sizes are specified in the 
PREC resource 3 in the ImageWriter file, so with ResEdit you can change them to 
the sizes you use most frequently. 

ResEdit versions l.OD7 and above allow you to define your own resource-editing 
templates similar to the built-in templates for menus windows. The templates are 
TMPL resources in the ResEdit file. You define a template for PREC resource 3 
as follows: 
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1. Start ResEdit, insert a disk containing a copy of ResEdit, find and open 
that copy of ResEdit, and open the resource window for the TMPL re­
sources, all as described in ''The ResEdit program." 

2. Choose New from ResEdit's File menu. A template-editing window opens, 
showing only a line of five asterisks. In this window, you will create a tem­
plate that describes the structure of PREC resource 3 by listing the items 
it contains in the order they occur. 

i!O~ TMPL "PREC" ID • 27858 from ResEdlt 1.007 ~ 

••••• ~ 
Lobel I# Sizes 

ii Type lowno 
••••• ·=::: 

Lobel I Height #1 1m1 

Type I DWRD I 
i11!i ••••• 

Lobel I Width #1 

I Type I DWRD I 
••••• 

The TMPL resources in ResEdit contain templates for editing resources. You can 
create a template for any resource that doesn't already have one, such as 

the ImageWriter fiu!'s PREC resource 3. 
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3. To add an item to the template-editing window, select the line of asterisks 
by clicking it, and choose New from ResEdit's File menu. Two boxes, 
labeled Lahel and Type, appear below the asterisks you selected, and an­
other line of asterisks appears at the bottom of the window. In the Label 
box, you enter a word or short phrase that describes the item. Then, in the 
Type box, you enter a four-letter code that identifies the type of item. A 
PREC resource 3 has two types of items, DWRD and PSTR. DWRD is a deci­
mal number (not hexadecimal) from 0 to 65535. PSTR is a string of 
characters that ResEdit invisibly prefixes with the string length. 

4. The first item in PREC resource 3 is the number of page sizes to be dis­
played in the Page Setup dialog box. It's a type DWRD item. So, type 
something like #Sizes in the first Label box and DWRD in the first Type box. 

5. The next 12 items in PREC resource 3 are the paper dimensions. They're 
also type DWRD items. Select the bottom line of asterisks and choose New 
12 times from the File menu. In the 12 new Label and Type boxes, enter 
Height #1, DWRD, WUith #1, DWRD, and so on through WUith #6, DWRD. 

6. The last six items in_ PREC resource 3 are the paper-size names. Add 
another six new items to the end of the template, and enter labels such 
as Name #1, Name #2, and so on. T he names are all type PSTR items. 

7. Carefully check the labels and types you have entered. Then close the 
template-editing window. The as yet unamed TMPL resource you just 
cr eated is selected in the list of TMPL resources. Name it by choosing Get 
Info from ResEdit's File menu and typing PREC in the space provided for 
the name. Notice that ResEdit has supplied a unique resource ID number 
in the space below the name. 

8. Close the information window, the TMPL window, and the ResEdit win­
dow. Click Yes when ResE<lit asks whether you want to save the changes 
you just made. 

9. Quit ResEdit. 
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To change the page sizes listed in the Page Setup dialog box: 

1. Start the copy of ResEdit in which you created the new template, insert 
a copy of the disk containing the lmageWriter file whose page sizes you 
want to change, and find and open that ImageWriter file. T he file may be in­
side a folder on a hierarchical file system (HFS) disk. Then open the resource 
window for the PREC resources, all as described in ''The ResEdit program." 

2. There are several PREC resources. Double click the one whose ID number 
is 3. An editing window opens, showing all the items in the PREC re­
source 3 displayed according to the template you created. 

3. Use standard editing methods to change the number of page sizes, the 
page-size measurements, and the page-size names. Page size is expressed 
in increments of Yi20-inch, so you must multiply all dimensions by 120 

before typing them. For example, 11 inches is entered as 1320. 

After making changes, check them thoroughly before placing the new version 
of the ImageWriter file into service. Not all paper sizes work with all applications. For 
example, MacWrite's I-inch-minimum left margin makes it hard to use small sizes 
of paper effectively. 

Custom paper sizes for one application 

The Page Setup dialog box normally contains the paper sizes specified in the 
ImageWriter file, but any application can substitute its own sizes and have them dis­
played in the dialog box, instead. The sizes specified by PREC resource 4 in an 
application file override the sizes specified by PREC resource 3 in the ImageWriter 
file. If you want to use nonstandard paper sizes with a particular application, you 
can use the ResEdit program to add a PREC resource 4 to an application file by 
copying, renumbering, and editing the PREC resource 3 from the ImageWriter 
file. Here's how: 
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1. Start ResEdit, insert a disk that contains any lmageWriter file, and open the 
lmageWriter file. The file may be inside a folder on a hierarchical file system 
(HFS) disk. Then open the resource window for the PREC resources, all as 
described in "The ResEdit program." 

2. Select the PREC resource with ID number 3 in the ImageWriter window 
and choose Copy from the Edit menu. 
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3. Open the application file by double clicking on its name in the disk win­
dow. A window opens, listing the resources in the application. If you need 
to switch disks in order to open the application file, you can eject a cur­
rently inserted disk by closing its disk window. 

4. Choose Paste from the Edit menu to add PREC resource 3 to the ap­
plication file. 

5. Double click on the PREC resource. Another window opens, listing PREC 

resources by number. If there is already a PREC resource 4, then select 
PREC resource 3, choose Clear from the Edit menu, and skip to step 7. 

6. Select PREC resource 3 and choose Get Info from the File menu. In the 
window that opens, change the ID number to 4, then close the window. 

7. Quit ResEdit. A dialog box asks if you want to save your changes; 
answer Yes. 

After adding PREC resource 4 to the application file, you change the paper 
sizes it specifies to suit your needs for that application. Do this using ResEdit in the 
manner described for PREC resource 3 in "Custom paper sizes." 
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Printing is a common concern of most applications. 
What~ true in MacWrite about reductions and 

enlargements, wrinkled paper, print quality, disk 
workspace, and lmageWriter versus LaserWriter 

also applies to MacDraw, Microsoft Excel, and scores 
of other applications. These are the topics covered 

in this chapter. 
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CONTROL 
Printer buffers and spoolers 

When printing, the Macintosh stands idle much of the time because it outputs 
information much faster than the printer can print it. For more efficient use of your 
Mac, you can attach a device between it and the printer to act as a reservoir for the 
information waiting to be printed. This frees your Mac to get on with other tasks. 

One kind of device, called a printer buffer, accepts information from the Mac at 
a fast rate, stores it in its own memory, and sends it out as the printer is ready for it. 
The more memory the buffer has, the more information it can store. 

A small printer buffer is built into the ImageWriter itself. (If you watch carefully 
when printing a MacPaint document, you can see the effects of the buffer: The 
ImageWriter continues for several seconds after MacPaint returns to the drawing 
window, printing the information that the Macintosh has passed to its buffer.) But 
this buffer is not large enough to make an appreciable difference in the Mac's effi­
ciency, so you may want to buy an accessory printer buffer that contains more 
memory than the buffer built into the ImageWriter. If you have an ImageWriter II, 
you can attach a small buffer inside the printer, or you can buy larger external buff­
ers that work with nearly any printer. They include the Universal Printer Buffer 
from Jonathan Freeman Designs and the Transet 1000 from Hayes Micro­
computer Products. 

A printer buffer reduces the wait while printing but does not eliminate it. If the 
document being printed is larger than the printer buffer, the Mac must eventually 
slow down and trickle information into the buffer at the same rate at which the 
printer empties the buffer. A delay also occurs as the Mac prepares each page 
for printing. This delay is longer for best-quality printing than for faster-quality, 
and some application programs are faster at preparing pages for printing than 
others. You may not notice this delay because buffers have a sort of flywheel effect, 
smoothing out the surges of printer and disk activity, so that the Mac and the 
printer don't have to wait on one another. 

Another kind of device that can free up the Mac is a program called a print 
spooler. Some hard-disk drives, such as Tecmar's MacDrive or Personal Computer 
Peripherals' MacBottom, contain built-in print spoolers that use the hard disk as a 
printer buffer. The spooler stores printer-bound information on an unused part of 
the hard disk and sends the information to the printer on demand. 
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You can also buy print-spooler software as a separate option. For example, 
MacServe, from lnfosphere, allows you to print documents and continue working 
on other documents in the same application. 

Unattended chain printing 

Would you like to print several documents in succession, without having to give 
the Print command for each one? The Finder can instruct an application program 
to print a series of documents directly from a directory window, a folder window, or 
the desktop. All you do is select the documents you want printed (by dragging a 
selection rectangle around their icons or by holding down the Shift key as you click 
their icons one at a time) and choose Print from the Finder's File menu. 

The Finder starts with the selected icon nearest the upper left corner of the 
window or desktop, and continues from left to right and top to bottom. For each 
selected icon, the Finder opens the appropriate application and tells it to print the 
document. The documents you select for printing can be from different applica­
tions. The only requirement is that the application needed to print each document 
must be present on one disk whose icons are currently on the desktop. 

For example, suppose you have two disk icons currently on the desktop: a 
MacWrite/MacPaint disk in the internal drive and a documents-only disk in the 
external drive. With this arrangement, you could print a group of MacWrite docu­
ments, a group of MacPaint documents, or a mixture of both types of documents. 

In contrast, suppose you have three disk icons on the desktop: a MacWrite disk 
in the internal drive, a documents-only disk in the external drive, and a MacPaint 
disk that's been ejected from the internal drive. With this arrangement, you could 
print a group of MacWrite documents or a group of MacPaint documents, but not a 
mixture of both types. Here's why. Suppose a MacPaint document were the first to be 
printed. After printing it, the Mac would display only two disk icons on the desktop, 
one for the MacPaint disk and the other for the documents-only disk. The MacWrite 
disk would have been ejected so that you could insert the MacPaint disk, and the 
MacWrite icon would have disappeared from the desktop after MacPaint was 
opened. The Finder would then continue chain-printing until it encountered the 
first MacWrite document. Then, since it could no longer locate MacWrite, it would 
have to stop. 
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Resetting margins for reductions or enlargements 

When you specify a reduction or enlargement for either the ImageWriter or 
Laser Writer printer, most applications reduce or enlarge the margins right along 
with the document. If you want unscaled margins, you must adjust them manually. 

lmageWriter 
Paper: ®US Letter 

O us Legal 
O Computer Paper 

v2.2 

0 A4 Letter 
O International Fanfold 

Orientation Special Effects: O Tall Adjusted 
O SO 3 Reduction 
O No Gaps Between Pages 

([ OK J) 

(Cancel J 

=La=s=e=rW=ri=te_r~==========~--v3,...o_ (( OK J) 
Paper: ® us Letter O A4 Letter Reduce or llI!I!ll 3 [ Cancel ) 

O US Legal O BS Letter Enlarge: 

Orientation 

-~ 
Printer Effects: 
0 Font Substitution? 
O Smoothing? 

The / mageWrit,er Page Setup dial.og box usually has a 50 percent reduction option. 
The LaserWriter Page Setup dial,og box allaws any reduction or enlargement 

from 25 lo 400 percent. 

Some applications, such as Microsoft Word, File, and Microsoft Excel, automat­
ically adjust both the right and left margins so that the document spans the page. 
With these applications, you need to change the margins only if you want to enlarge 
or reduce them. Other applications, such as MacWrite, T hink Tank, and MacDraw, 
automatically adjust the left margin but not the right; you must do it manually. For 
example, in MacWrite you must drag the right margin marker in all formatting 
rulers before printing. 

It's not always possible to set the right margin so that the document prints across 
the whole page. For example, the 7 inches between right and left margins allowed in 
MacWrite's formatting rulers normally span the page, but shrink to 3Y2 inches when 
reduced by 50 percent. 
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Removing blank pages 

Blank lines at the end of a text document sometimes cause the printer to "print" 
a blank page after the last page of the document. A manually inserted page break at 
the end of a text document has the same effect. You can avoid these blank spaces at 
the end of the document by removing all unnecessary white space or page breaks. 
Just drag across the whitespace to select it and press the Backspace key. 

Other types of documents may also have useless page breaks that cause blank 
pages. When you enlarge objects in a MacDraw document, for example, MacDraw 
automatically expands the size of the drawing so that it covers more pages. If you 
later shrink the objects, MacDraw does not automatically reduce the size of the draw­
ing. To eliminate the blank pages that result, use the Drawing Size command in the 
Layout menu. 

Spreadsheet documents may also have useless page breaks. Most spreadsheet 
programs allow you to set page breaks manually by selecting a cell and choosing a 
command. Multiplan and Microsoft Excel, for example, create a page boundary 
above and to the left of the selected cell when you choose Set Page Break from the 
Option menu. If you have too many manually set horizontal page breaks, you can 
remove them by selecting any cell in the row below the page-boundary line and 
choosing Remove Page Break from the Options menu. Similarly, you can remove a 
manually set vertical page break by selecting any cell in the column to the right of 
the page-boundary line and choosing Remove Page Break from the Options menu. 

Eliminating blank rows and columns 

Spreadsheet programs normally print a full page of rows and columns, even 
if the spreadsheet being printed occupies only the top left corner. Usually you can 
eliminate blank rows at the bottom and blank columns to the right using one of the 
following: 

0 The Print dialog box may contain an option to print just selected cells. 
Multiplan, for example, has this option. 

0 You may be able to designate a print area. In Microsoft Excel, for exam­
ple, you select the area you want to print and then choose Set Print Area 
from the Options menu. 

0 Almost all programs let you set your own page boundaries and print only 
the pages you specify. In Multiplan and Microsoft Excel, for example, you 
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select the cell below the bottom row and to the right of the rightmost column 
of the area you want printed, and choose Set Page Break from the Options 
menu. Then you specify a range of pages in the Print dialog box to exclude 
the blank pages below and to the right of the manually set page boundaries. 

Printing nonadjacent spreadsheet pages 

In Multiplan and Microsoft Excel, you can print several nonadjacent pages with 
one Print command. Your spreadsheet must be organized vertically into one-page 
sections. To suppress printing of a particular page, you temporarily set all the col­
umn widths in that section to zero. 

PROBLEMS 
My printer is battery-powered 

Because the clock battery in the Macintosh maintains information about which 
printer is in use and to which port it is connected, the printer may stop working if 
the battery runs low. If that happens, turn off the Mac and remove the battery. Wait 
five or ten minutes, and then turn it back on and leave it on until you have a replace­
ment battery. In the meantime, the Mac will use electricity from the power cord to 
maintain the clock, printer, and port information. 

OnlyU 
Under certain circumstances your ImageWriter may suddenly start printing 

the letter U over and over. You can turn off the printer to stop the annoying U 
characters, but your screen will soon go into slow motion as a result. Don't despair. 
Quit the application you're using and shut down the Mac. While you're doing that, 
you can keep up the screen speed by occasionally turning the printer on and 
off quickly. 

This behavior may occur when you try to print on an ImageWriter after using 
a startup disk that was set up for the LaserWriter, with AppleTalk connected. You 
need not actually have printed anything on the LaserWriter. 
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The AppleTalk setting in the Control Panel is not affected by changing application 
programs, switching disks, shutting down, pressing the Reset button, or turning off 
the Mac. You must use the Control Panel desk accessory to change the AppleTalk set­
ting. If your Control Panel does not include a setting for AppleTalk, the startup disk 
has an old version of the desk accessory. Use the installer program, which is on the 
System Tools disk that comes with the Mac Plus and Mac 512K Enhanced. 

Garbage in the middle of the page 

When the ImageWriter pauses midpage and then prints garbage, it may mean 
that the Mac sent the lmageWriter too much information at once. The lmageWriter 
is supposed to signal when its built-in printer buffer becomes full, and the Mac is 
supposed to heed the signal and stop sending. This communication process, called 
handshaking, fails if the ImageWriter doesn't send the signal or if the Mac doesn't 
receive it. If the Mac keeps sending information when the printer is busy, the infor­
mation gets garbled and the ImageWriter starts printing garbage. 

There are two possible causes of handshaking problems: a wrong setting on the 
lmageWriter and a missing wire in the printer/Mac connecting cable. 1n order for 
the ImageWriter to send its busy/ready signals, switch 3 of switch assembly SW2 
must be set to the open position. So first check the switch assembly, which is lo­
cated under the front cover of the ImageWriter. If the switch is set correctly, then 
the problem is in the cable that connects the Mac to the lmageWriter. The wire that 
runs between pin 2 on a Mac Plus plug or pin 7 on a Mac 512 K plug and pin 2 on 
an lmageWriter ll plug or pin 20 on an lmageWriter plug is used exclusively for the 
busy/ready signal. Some cables, including the first 3000 ImageWriter to Mac 512K 

cables manufactured by Apple, do not have a wire connecting those pins, and may 
even lack the pins. If the wire is missing, the Mac cannot tell whether the printer 
is busy or ready, and may send information too rapidly. Sorry, but t11e only thing 
to do is buy or make a new cable. 

Pin-feed paper wrinkles 

If pin-feed paper wrinkles as it goes through your ImageWriter, the paper-feed 
lever is probably set in the friction-feed position. While you can get away with cross­
feeding for a few pages, eventually the paper starts to drift sideways in the friction­
feed mechanism while the pin-feed sprockets try to keep it on track. So make sure 
the paper-feed lever is flipped to the pin-feed position before you start printing a 
multiple-page document on pin-feed paper. 
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First line on page compressed? 

The IrnageWriter may compress the line being printed on pin-feed paper when 
the perforation at the top of the page passes under the pinch rollers. On an original 
ImageWriter, this occurs in the top Y2 inch of the page, and as a result is only visible 
when the No Gaps Between Pages option has been selected in the Page Setup dialog 
box. On an lmageWriter II, the problem occurs about I inch from the top of the 
page and the results may be visible with normal gaps between pages. 

Line compression is less likely if there is an even, gentle tension on the paper 
coming out of the printer. Try attaching a clothespin or other light weight to the 
outgoing paper as it falls over the back of the printer. Sometimes switching to a dif­
ferent weight of paper eliminates the squashed line. If all else fails, use single sheets 
instead of pin-feed paper. 

Compressed lines may also be caused by using pin-feed paper in an Image­
Writer with the paper-feed lever in the friction-feed position. Flipping the paper­
feed lever may eliminate the problem. 

Burping to take up the slack 

Even when the ImageWriter's paper-feed lever is set correctly, the first line of a 
document may be squashed or stretched in height. To reduce the chance of this hap­
pening-especially if you have just torn off some paper-"burp" the ImageWriter 
by turning it off and on again. Burping takes up the slack in the gears. 

Solving print-time system errors 

If a system-error alert box appears while you are printing a document, try print­
ing smaller sections by specifying page ranges in the Print dialog box. If you are able 
to print most of the document but have trouble with one page, it's possible an un­
printable character has infiltrated the document. You may be able to print a trouble­
some page of text in draft quality and spot the characters that have gone bad. If 
so, delete the text around the bad characters and retype from the draft-quality 
printed page. Then try printing again. 

When best and faster quality don't work . .. 

If nothing happens when you try to print a document in best or faster quality 
on an ImageWriter, the application disk is probably locked. The locked disk pre­
vents the application program from saving images of the printed pages 
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on disk, a necessary intermediate step for most applications when printing in 
faster or best quality. Unlocking the application disk usually solves the problem. 
If it doesn't, unlocking all the disks you are currently using should do the trick. 

Draft printing on the ImageWriter does not require images of the printed 
pages to be saved on disk, so you can usually print in draft quality when al l disks 
are locked. 

APPEARANCE 
Achieving the best results in best quality 

To achieve the best results with best-quality printing, the Mac uses a font that is 
double the size to be printed. The double-size font is then reduced 50 percent before 
printing. For example, the Mac needs Geneva 20 for best-quality Geneva 10 printing. 

Before you print a document in best quality, make sure the double-size font is 
available. If necessary, use the Font/DA Mover program to copy a missing size into 
the System file, which is generally on the application disk. 

Printing better draft-quality documents 

The ImageWriter uses its own nonproportional font for draft-quality print­
ing. To match the word spacing of the Mac's proportional fonts, the printer inserts 
unsightly gaps between the draft-quality words. You can eliminate the gaps by 
changing the entire document to a nonproportional font, such as Monaco 12, 
before printing it in draft quality. 

In addition, Microsoft Word can use the ImageWriter as a generic printer for 
fast, decent-looking draft-style output. Proceed as follows: 

1. Make sure the icon named Typewriter, which comes on the Microsoft Word 
master disk, is on the same disk as the Microsoft Word program you're using 
for printing. On a double-sided disk, hard d isk, or other disk that uses the hi­
erarchical fi le system {HFS), the Typewriter icon must be in the same folder 
as Microsoft Word. 

2. Choose Printer Setup from Microsoft Word's File menu. In the dialog box 
that appears, select Typewriter as the type of printer and 12 as the pitch . 
Click OK. 
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3. Choose Preferences from the Edit menu and select the Display as Printed 
option. Click OK. Microsoft Word temporarily substitutes the Dover 10 font 
throughout your document, so you can review paragraph formatting 
onscreen before printing. 

4. When you're ready to print, choose Print from the File menu. You can spec­
ify a page range, number of copies, and type of paper feed, but you have no 
choice of print quality. 

If the Dover font is not in the System file, New York or Geneva is used for display. 
When reviewing the document in step 2, you can change the font, size, or style of any 
text. Italic, outline, and shadow styles are not displayed on the screen or printed, nor 
are any font or size changes. These unseen changes are made to the file, however, 
and will appear if you reverse either step 2 or step 3. 

The choices you make in the Printer Setup and Preferences dialog boxes are 
semipermanent. Neither closing the document window, quitting Microsoft Word, 
nor shutting down the Mac (in an orderly manner) has any effect on them. In order 
to subsequently print any Microsoft Word document in faster or best quality, you 
must reselect the ImageWriter in the Printer Setup dialog box. 

ImageWriter print-quality problems 

The original ImageWriter has trouble printing certain patterns-especially the 
standard gray desktop pattern-evenly. The ImageWriter II has less trouble. 

A number of factors contribute to the problem, including the type of paper you 
use, the method of paper feed, and the alignment of the print head. Try a heavy 
paper with a rough finish. Move the pin-feed sprockets off to the side and try pin­
feed paper with the paper-feed lever in the friction-feed position. Or try a combina­
tion: Feed pin-feed paper through the sprockets and put the paper-feed lever in the 
friction-feed position. But only print two or three pages at a time this way, because 
the friction-feed and pin-feed mechanisms get out of sync after about three pages 
and the paper may wrinkle. 

Unfortunately, there's little you can do ·about print-head alignment. Sometimes 
removing and reinstalling the head helps; the procedure for the original Image­
Writer is described on page 28 of the ImageWriter user's manual. 

116 



Printing 

Improving the quality of pictures printed outside MacPaint 

MacPaint pictures inserted into MacWrite text often look worse on paper when 
you specify best-quality printing than when you specify faster-quality printing. Nei­
ther version looks as good as MacPaint's final-quality printing. This discrepancy 
occurs because MacPaint and MacWrite do not use the same method to prepare the 
image of a page for the printer. 

MacWrite uses the standard ImageWriter file, which is usually located in the Sys­
tem Folder, and the QuickDraw procedures built into the Mac's ROM to prepare the 
image of the printed page. When you choose best quality for a MacWrite document, 
text is printed using a 50 percent reduction of a font that is twice the displayed point 
size. The result is denser, darker, and more fully formed than faster-quality print. 

However, graphics created in MacPaint, which are called bitmap images, gener­
ally look worse if they are doubled and then reduced. Each dot in the original 
bitmap image would end up expanded to a cluster of four dots in the printed image. 
An original ImageWriter can't print such a dense image well, because its dots are 
larger than the space between them. For example, a gray pattern would end up 
black. To prevent loss of detail, MacWrite, and other applications that use the Image­
Writer file, normally thin the expanded bitmap image by removing three of the dots 
in each cluster of four. T his is preferable for most bitmap images, though the thin­
ned graphics do come out lighter than the unthinned text. 

In contrast, MacPaint has its own special programming that smooths and 
enhances the image when you choose Print Final. Since this programming is part 
of MacPaint itself and is not contained in the QuickDraw procedures or the lmage­
Writer file, it is not available to another application such as MacWrite. 

There are some bitmap images that look better without thinning. Application 
programs can choose not to thin a specific bitmap image, but few programs use this 
capability. There's a desk accessory, called FixPic, that you can use to modify a Mac­
Paint graphic that you've cut or copied to the Clipboard but haven't yet pasted into 
another type of document, so that it will not be thinned. FixPic, written by Michael 
A. Casteel, works with MacWrite and Microsoft Word, but does not work with 
MacDraw. 

For a solution that works with all applications, replace your original ImageWriter 
with an ImageWriter II. It prints smaller dots, so the Mac does not thin bitmap im­
ages that are to be printed best quality. 
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Correctly proportioned MacPaint pictures 

Do MacPaint pictures seem to be stretched vertically when printed as part of 
other types of documents? You can print correctly proportioned pictures from pro­
grams such as MacDraw, MacWrite, and Microsoft Word by doing the following: 

I. Before printing, choose Page Setup from the File menu. 

2. In the dialog box that appears, select Tall Adjusted orientation. 

The normal Tall orientation results in a horizontal dot density of 80 dots per inch. 
Tall Adjusted orientation results in 72 dots per inch, the same as MacPaint. 

Tall Adjusted does have some side effects, however. The whole document-text 
as well as pictures-is widened by about 13 percent on the printed page. For exam­
ple, text that was supposed to take 5% inches will take 6Y2 inches, instead. The 
expanded text that results from selecting TaJI Adjusted orientation is somewhat 
lower in quality than the normal text you get with TaJI orientation. The degree of 
difference in quality depends on the font, size, and quality (best or faster) you 
choose. By the way, Wide orientation has the same proportions as Tall Adjusted. 

Wide documents 

To produce certificates and other documents wider than an 8Y2- by 11-inch piece 
of paper on a typewriter, you simply insert the paper crosswise. With the Mac, the 
Page Setup dialog box in most applications offers a page-orientation option that has 
the same effect. You feed the paper in normally and the printer prints sideways. 

MacPaint does not use the Page Setup dialog box. To print a MacPaint document 
sideways, you must draw it sideways. Any part of a MacPaint drawing that can only 
be created upright, such as text, can be selected with the selection rectangle and 
then rotated sideways by choosing Rotate from the Edit menu. You can also use the 
Paint Cutter or Paint Doctor program, or the ClickArt Effects desk accessory, to 
rotate a drawing after creating it. Resist the urge to turn your Mac on its side, or 
you'll block its cooling vents and make it overheat. 
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MANAGING DISKS 
Why disks fill up while printing 

With some applications, printing an entire document in standard or high quality 
on an lmageWriter may require as much as twice the amount of disk space needed to 
save the document. The extra disk space is used to store an image of every printed 
page. Other applications prepare and print one page image at a time, and therefore 
require only enough disk space to save the entire document and store the image of 
the page about to be printed. 

If there is not enough disk space available, a message appears during prepara­
tion of the page images advising you that the disk is full. The message may be 
specific, such as Microsoft Word's Not enough disk space to print current page, or it may 
be vague, such as MacDraw's The print command was not compl.eted. 

Draft-quality printing on the lmageWriter does not require extra disk space, 
because the preparation of page images is not necessary for printing. Likewise, 
printing on the LaserWriter does not require extra disk space, since each page 
image is prepared in the LaserWriter's memory. 

Working around full disks 

If you get a disk-full message during printing, what do you do? Here are some 
techniques to try: 

D Many applications look for space only on the disk that contains the System 
file. So you must move the document you want to print to a disk that contains 
only documents and remove it from the System disk. (With some applica­
tions, notably MacDraw, the application program must also be moved to 
the document disk.) 

D If the document is already on a document disk, move it to a blank disk. 
A few applications, such as Microsoft Word, are smart enough to look for 
disk space on any disk available, not just the application or System disk. 

D Move the application program to the document disk and remove it from the 
System disk. 

D Make more space available on the System disk by using the Font/DA Mover to 
remove unneeded fonts and desk accessories from the System file. 

D Print the document a few pages-or even one page-at a time. 

D Use a hard disk. 
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Most of these methods involve freeing up disk space. How much space is 
enough? The answer varies depending on the application doing the printing and 
the complexity of the document being printed. MacWrite and Microsoft Word, for 
example, need about 6K per page for pages that contain only text. A page con­
taining a simple picture requires about 8K, while a page containing an extremely 
complex picture can require up to 32K of free disk space. MacDraw can be even 
greedier than MacWrite or Microsoft Word. A MacDraw document containing lots 
of MacPaint-style pictures may require 70K or more to print one page at a time. 

As a rule of thumb, 30 to 50 K of free space on the disk that contains the applica­
tion program is enough. But be prepared to set aside more if your experience shows 
that it's needed. 

No extra disk space for MacPaint printing 

Unlike most application programs, MacPaint does not pause before printing to 
prepare an image of the page. Why? Because no single MacPaint document ever oc­
cupies more than one page and MacPaint always knows what that page looks like. 
Thus there is no need to prepare a page image for printing. 

THE IMAGEWRITER 
Faster Faster quality 

When you select Faster print quality in the Print dialog box, the ImageWriter's 
bidirectional printing capability is normally suppressed to improve quality. On an 
ImageWriter II , you can sacrifice some quality for bidirectional speed by pressing 
the Caps Lock, Shift, and Option keys while you click OK in the Print dialog box. 
Some lmageWriter Ils are adjusted well enough for satisfactory bidirectional faster­
quality printing. Bidirectional printing stays in effect until you change startup disks, 
restart, or press the Command key while clicking OK in the Print dialog box. 

Avoiding paper curl 

Paper that sits in the ImageWriter for a couple of hours, wound around the 
platen, acquires a permanent curl. You can avoid the curling by rolling the paper 
back just far enough to turn on the ImageWriter's red Paper Error light. At that 
point, the paper clears the platen but is still engaged in the pin-feed sprockets. 
Remember to roll the paper forward again before printing. 
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Aligning paper to print with no gaps between pages 

Ordinarily, you load paper into the lmageWriter so that the top edge of the 
paper is about Y2 inch above the print head, putting the top edge of the paper just 
above the place where the pressure rollers contact the platen. 

Application programs normally consider the top V2 inch of ever y page an 
unprintable area. Selecting the No Gaps Between Pages option in the Print dialog 
box allows printing in the top V2 inch of the page, but requires somewhat different 
paper handling. 

D On an original ImageWriter, load hand-fed paper with the pressure rollers 
pulled back and the top edge of the paper even with the top of the print 
head. The entire page is then printed with the pressure rollers back. 

D On an ImageWriter II , use the Form Feed/Paper Load button to load hand­
fed paper, and then roll the paper back Vi6 inch, so it's even with the top of 
the hole located to the left of the print head in the clear plastic guide. 

D Load continuous paper as usual, with the top edge nearly even with the 
top of the pressure rollers. Then, if the first page of the document con­
tains something to be printed in the top V2 inch of the page, the Mac rolls 
the first sheet of paper forward until the print head is even with the per­
foration between sheets, and prints the first page of the document on 
the second sheet of continuous paper. The first sheet of paper is wasted. 
However, if there is nothing to print in the top V2 inch of the first page, 
printing begins immediately and the first sheet is not wasted. 

No cure for no-gaps glitch 

When you print without gaps between pages on the ImageWriter, a slight imper­
fection may appear about V2 inch below the top of some pages. This glitch occurs if 
the paper buckles slightly as the perforation rolls through the pressure rollers. The 
design of the ImageWriter 's paper-feed mechanism causes the problem, so there's 
not much you can do about it except try different weights and kinds of paper or 
use hand-fed paper. 

Unavoidable page breaks 

With some odd sizes of paper it's impossible to completely eliminate breaks 
between pages. Selecting the No Gaps Between Pages option in the Page Setup 
dialog box forces the height of the page image to be a multiple of eight dots, 

121 



Mac Insights 

which equals V9 inch. If the paper size, as selected in the Page Setup dialog box, is 
not a multiple of eight dots high, the paper size and page size cannot match. A mis­
match causes a very thin gap (less than eight dots) at the bottom of every page. All 
of the standard paper sizes-US Letter, US Legal, A4, and International Fanfold­
are an even multiple of eight dots high . 

Switch settings 

The ImageWriter has two sets of small switches, labeled SWJ and SW2, that are 
located under the front cover. On an original ImageWriter, they are near the right 
front corner; on an ImageWriter II, they are near the left front corner. Ostensibly, 
these switches control page size, text size, foreign character set, and several esoteric 
options. In fact, the SW l settings are not critical since Mac programs can and do 
override all of them. However, if the SW2 settings are wrong, the ImageWriter may 
refuse to print, or may print gibberish. Here are the correct settings: 
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SW1 

t C l I 

~~fltl 
N3d0 

SW 2 

~ 'B ~ lfl Pf! i91a ~ 
1234 5 171 

SW 1 SW 2 

Standard settings f<Jr the swi,tches on an miginal lmageWriter (top) and on 
an ImageWriter II (bottom). On the ImageWriter JI, switches 5 and 6 of SW2 are set 

at the factory and slwuldn't be changed. 
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THE LASERWRITER 
Toner cartridge life 

Laser Writer toner cartridges have a shelf life of 2Y2 years from the date of 
production. A coded form of the production date is stamped on Apple-brand car­
tridges. Here is how you decode the date: 

NLNN 

/I~ 
Last digit A • January Day of 
of the B · February the month 
year C · March 

0 -April 
E-May 
F · June 
G ·July 
H - August 
I • September 
J ·October 
K-November 
L· December 

The code on a LaserWriter loner cartridge can be decoded lo determine its production 
date. The cartridge can be used up to 2~ )'ears after that date. 

Shake gently occasionally 

If the Laser Writer prints darker or lighter on one part of every page, the toner 
may be unevenly distributed . Remove the toner cartridge and rock it gently to redis­
tribute the toner. 

LaserWriter formatting without a LaserWriter 

You don't have to own a LaserWriter to use one. Many copy shops and com­
puter stores offer LaserWriter printing, charging a per-page rate. But you must 
plan ahead, or your first attempt to use this service will be disappointing. The print 
quali ty will be fantastic, but the formatting of margins, the page breaks, and the 
font size won't work the way they do for ImageWriter pr inting. 
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To accurately format a document for printing on the LaserWriter, you need a 
startup disk that has the following: 

0 The Laser Writer and Laser Prep files. 

0 A System file that contains the LaserWriter fonts-minimally Times, 
Helvetica, and Courier in 10- and 12-point sizes. 

D The Chooser and Control Panel desk accessories. (If you use 
Finder version 4.1, substitute the Choose Printer desk accessory.) 

If you have a Mac Plus or Mac 512 K Enhanced or can borrow or rent one, you can 
easily set up disks for LaserWriter formatting. You need the System Tools disk that 
comes with the Mac Plus or Mac 512K Enhanced and any startup disk-single- or 
double-sided-that has enough space available. Use the Installer program on the 
System Tools disk to install the Laser Writer file on the startup disk; all the nec­
essary items listed above are installed automatically. 

A set of basic LaserWriter fonts requires 30K of disk space; the LaserWriter 
driver requires another 36K. You can strip the disk of expendable desk accessories, 
fonts, help files, and so on, and still not have enough room to put your application 
program on the same disk. ln that case, put the application program on its own 
disk, without a System file, and expect to do some disk swapping. 

With the required fonts, files, and desk accessories installed, you can format 
for the LaserWriter on any Mac. Here's how: 
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1. If your startup disk has Finder version 5.1 or above, use the Control Panel 
desk accessory to indicate AppleTalk is connected, even if your Mac is not ac­
tually connected to an AppleTalk network. Then use the Chooser desk 
accessory to select the LaserWriter. Skip to step 3. 

2. If your startup disk has Finder version 4.1, use the Choose Printer desk 
accessory to select no printer by clicking in the white space below the last 
printer listed; then click OK. This fools the Mac into thinking you have a 
LaserWriter attached but turned off. Warning: Do not select the 
AppleTalk Connected option unless AppleTalk is connected to the printer 
port. If you do, you will be unable to use your ImageWriter later on. 

3. Change the text in your document to a LaserWriter font by selecting the 
text and choosing a new font in the conventional manner. MacWrite ver­
sion 4.5, MacDraw, and other applications designed to work with the 
LaserWriter should then display fairly accurate LaserWriter formatting 
on the screen. 
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The LaserWriter fonts look crowded on screen, and may look a bit crude if the 
sizes you're using aren't installed in the System file. Don't let the crowded, crude dis­
play bother you; Helvetica, Times, Courier, and other LaserWriter fonts actually 
used for printing are stored in the Laser Writer itself and always print beautifully. 

Line-length differences 

The LaserWriter expands the screen width by 10 percent. Some applications 
adjust for the difference, while others do not. For example, a line that measures 
6 inches long on a MacWrite formatting ruler actually prints 6.6 inches long on a 
LaserWriter. To print a 6-inch MacWrite line on a LaserWriter, you must set the 
margins for a 5Y2-inch line. Instead of adjusting the margins, you could specify 
a 90 percent reduction in the Page Setup dialog box, but that would shrink the 
height as well as the length. 

Unlike MacWrite, Microsoft Word adjusts the formatting ruler for you, so that 
its measurements are true for the ImageWriter or the LaserWriter. However, if you 
switch printers using the Chooser or Choose Printer desk accessory after starting 
Word, you must also choose Page Setup from the File menu and click OK in the dia­
log box (no changes are required in the dialog box) in order to get Word to change 
the ruler dimensions to match the printer change. 

Font-size differences 

LaserWriter fonts are smaller than similar screen fonts. T hus, a document takes 
less room on the page after you change it from a screen font such as New York to a 
LaserWriter font such as Times. You have to change tabs, spacing, page breaks, and 
font size to compensate. 

Call me Ishmael. Some years ago-­
never mind how long precisely- having 
little or no money in my pur.;e, and 
nothing particular to interest me on shore, 
I thought I would sail about a little and 
see the watery part of the world. It is a 
way I have of driving off the spleen, and 
regulating the circulation. Whenever I 
find myself growing grim about the 
mouth; whenever it is a damp, drizzly 
November in my soul; whenever I find 
myself involuntarily pausing before 
coffin warehouses, and bringing up the 
rear of every funeral I meet; and 

Call me Ishmael. Some years ago­
never mind bow long precisely­
baving little or no money in my 
purse. and nothing particular to 
interest me on shore, I thought I 
would sail about a little and see 
the watery part of the world. It is 
a way I have of driving off the 
spleen, and regulating the 
circulation. Whenever I find 
myself growing grim about the 

Text printed in New York 12 on an lmageWriter (right) wkes considerably more room 
on the page than the same text printed in Times 12 on a LaserWriter (l.eft). Sirni/.ar 
differences exist between Geneva and Helvetica and between Monaco and Courier. 
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Automatic font substitution 

When printing on a LaserWriter, you do not have to manually change the text 
in your document to a LaserWriter font. If you select the Font Substitution option in 
the Print dialog box, the LaserWriter automatically uses T imes for New York, 
Helvetica for Geneva, and Courier for Monaco. 

However, the Font Substitution feature does not compensate for the fact that 
LaserWriter fonts are smaller overall than their screen counterparts. Instead it ad­
justs the space between letters, words, and lines in order to match the line breaks and 
number of lines per page that you see on the screen. As a result, text looks spread 
out on the page. 

Call me Ishmael. Some years 
ago-never mind how long 
precisely-having li ttle or no 
money in my purse, and 
nothing particular to interest 
me on shore, I thought I would 
sail about a little and sec the 
watery part of the world. It is a 
way I have of driving off the 
spleen , and regulating the 
circulation. Whenever I find 
myself growing grim about the 

The Font Substitution option in the LaserWriter Print diawg box automatically re­
places a screen Jant such as New York with an equivalent LaserWriter font such as 
Times. fl adjusts the spacing between /,etters, words, and lines Lo maintain fidelity 

with the screen. 

LaserWriter fonts onscreen 

Even after converting a document to LaserWriter fonts such as T imes and 
Helvetica, what you see on the screen is not quite what you get on the Laser Writer. 
How could it be? T he LaserWriter composes text from dots that are less than one­
quarter the size of screen dots. As a result, the LaserWriter fonts must be rounded 
to the nearest whole screen dot for display on the screen. 

The dot-size differences make the enhanced LaserWriter font styles you see on 
the screen vary tremendously from the same thing printed on a LaserWriter. T he 
LaserWriter's diminutive dots allow more subtle enhancements than do the screen's 
bulky dots. 
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Helvetica 12 bold 
ABCDEFGHIJKLMNOPQRSTUVWXYZ 
abcderghljlclmnopqrstuvwxyz 
$1234567890 

:niJko.s n1°lf1A' 
ABC'IJJ!/TaH.1.l!U.MNc'11'(.'li' STllf'fy,\'J'Z 
<tlul<'.fk;/Jfll:biln.wnnln'ry.: 
ll234567b.'W 

Times 12 bol4 
ABCDEPGHIJJCLMNOPQRSTUVWXTZ 
abcdefchilklmJu>pqr.stumyz 
$1234567890 

Helvetica 12 oblique (italic) 
ABCDEFGHIJKLMNOPORSTUVWXYZ 
abcdefghijklmnopqrstuvwxyz 
$1234567890 

Helvetlca 12 bold 
ABCDEFGHIJKLMNOPQRSTUVWXVZ 
abcdefghljklmnopqrstuvwxyz 
$1234567890 

Helvetlc& 12 Shcdow 
ABC DE FGH IJKLMNOPQRSTUV 
WXYZ 
&bed e ig h IJ !ti m n opq rs tu v wxy z 
$123~567890 

Times 12 italic 
ABCDEFGH/JKIMNOPQRSTUVWXrz 
abcdefghijldmnopqrstuvwxyz 
$1234567890 

Times 12 bold 
ABCDEFGm.JKLMNOPQRSfUVWXYZ 
abcderghiJ"klmnopqrstuvwxyz 
$U34567890 

Ylmc1 12 Sbndow 
A!BCIDBIFO lllHlJJK:ll.MNO!PQ!RS'il'llJVW 
XYZ 
a bcdcf1hijltlmn opqntu v wxy z 
$1 234$6789 

With LaserWriter fonts, what you see onscreen (l.ejt) is not quite what )'OU get in print 
(l.ejt). The screen can only approximate with its big dots what the LaserWriter prints 

with its small ones. 

Avoiding slow printing 

Printing 

The LaserWriter takes much longer to print some documents than it does to 
print others. There are things you can do to cut down on printing time. When print­
ing any type of document: 

0 Print a multiple-page document all at once, not a page at a time. The Laser­
Writer does a lot of time-consuming preparation at the beginning of every 
print run. 

When creating any document that contains text, not including text that's part of 
a MacPaint image: 

0 Use Laser Writer fonts rather than screen fonts. Screen font definitions must 
be loaded from the FONT resources on the Mac, but the LaserWriter fonts 
are built in. 
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D If you do use screen fonts, avoid large, heavy ones such as Athens, London, 
and Venice. T he LaserWriter takes an extraordinarily long time to print a 
page that contains these fonts. 

D Don't change fonts frequently in the document. T he Laser Writer builds each 
character to be printed either from its built-in font definitions or from the 
font definitions in FONT resources. It keeps characters it builds in its mem­
ory for reuse. When the font changes, it must clear its memory and build 
each character in the new font from scratch. 

When creating a MacDraw document or other object-oriented graphics 
document: 

D Avoid patterns other than black, white, and the standard grays. T he 
LaserWriter has built-in definitions for those patterns, but others must be 
constructed from scratch. 

J;>rinting envelopes 

Envelopes can be fed manually and printed one at a time on a LaserWriter. 
Here's how: 

1. Choose Page Setup from the File menu and select the sideways printing 
orientation. 

2. Set up the address in the top left corner of the page, about 3Y2 inches from 
the left edge and 2 inches from the top. Don't forget to allow for the page 
margins when you place the address. 

3. Choose Print from the File menu and select Manual Feed as the paper 
source. Click OK. T he LaserWriter may print a page of instructions that ex­
plain how to feed paper manually. 

4. Tuck the flap of the envelope out of the way, inside the envelope. 

5. Wait for the yellow light on the front of the LaserWriter to glow steadily. 
T hen hold the envelope face up and place it at the top of the LaserWriter's 
manual-feed tray, so that it is just under the roller inside the printer. 

6. After a few seconds, the LaserWriter realizes something is under the roller, 
grabs the envelope, and draws it in. 

Labels and other small items can also be handled in the same manner as enve­
lopes. However, the LaserWriter cannot print any closer than Y2 inch from any edge. 
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If you're like most Mac users, you do some writing 
with your Mac. You may do other things 

with it too, but you probably at least write 
an occasional letter with a word-processing 

application such as MacWrite or Microsoft Word. 
On the surface, word-processing applications are 

about as easy to use as an electric typewriter. 
Just beneath the surface, though, are dozens of 

powerful features that let you work more efficiently. 
This chapter discloses methods you might not 

discover in the normal course of using your word­
processing application for selecting text, getting 

around a document, editing, dealing with graphics 
in text, formatting, and more. 
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GETTING AROUND 
Finding the insertion point 

When you scroll back and forth in a large Microsoft Word document to review 
your work, it's easy to lose track of the insertion point. To bring the part of the docu­
ment that contains the insertion point back into view, type a letter- any letter. Then, 
if necessary, press Backspace to delete the letter. 

Although this technique also works in MacWrite, there's an easier way to locate 
the insertion point in a MacWrite document: Pressing the Enter key scrolls the docu­
ment to show the insertion point without your having to make any changes. 

Keyboard navigation 

The thought of selecting an insertion point or some text with a mouse rankles 
many accomplished typists. They would prefer to keep their hands on the keyboard. 
Microsoft Word allows you to move the insertion point or cursor, scroll the docu­
ment, and select text-all from the keyboard. Pressing the Command and Option 
keys turns the right side of the keyboard into a directional control pad. While hold­
ing those keys down, pressing 0 moves the insertion point up one line, L moves it 
right one character, the Comma moves it down one line, and K moves it left one char­
acter. Adjacent to those four keys are four more that move in the same direction as 
their neighbors, but a greater distance: Command-Option-P moves the insertion 
point up one page, Command-Option-Semicolon moves right one word, Command­
Option-Period moves down one page, and Command-Option-J moves left one word. 
If you hold down the Shift key along with the Command and Option keys, Microsoft 
Word selects text as you move the insertion point. Pressing the Quote key while hold­
ing down Command-Option intensifies the action of the next control-pad keystroke. 
For example, pressing Command-Option-Quote followed by Command-Option-K 
moves the insertion point to the left end of the line. 

In MacWrite, there is no way to move the insertion point or select text with 
the keyboard. 
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Line up 
Tqp of screen 

Character right 
End of line right 

Word left 
Sentence left 

Line down 
Bottom of screen 

Scroll up 

i..----Word right 
Sentence right 

Page down 
End of document 

In Microsoft Word, lwlding down the Command and Option keys lets y<JU move and 
select text from the keyboard without using the mouse. 

Place markers 

Finding a particular passage of text in a large document using nothing but the 
scroll bar is a chore. Some word-processing programs will, on command, bring into 
view a place you have previously marked in the document. Although neither 
MacWrite nor Microsoft Word has this feature, you can fake it. Here's what you do: 

1. Type unique character combinations, such as §I, §2, and so on, at the points 
in the document that you want marked. 

2. Locate the markers later using the Find command (from the Search menu). 

Don't forget to remove the markers when you finish editing the document. 
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s File Edit Sean h rormut f on t ~ti.111.' 

- ----- ---- Find 

..... \!.~J.L~.P. §.t .. _.Y.t.!!-1!I.!!..J?..!!.ill.Il.Lt~L.P.e r£.~.!J!.J.!!. we_r:_..Q.W°...§....!.b.1.L!l.!:l .. ~n.!l.r;_!lQ we v _gr,_ 
the cost per pair has 1ncreased 27 percent. The black w1ngt1p cont1nues to 
be our top seller et 14 pa1rs a quarter. This 1s only because of the IBM 
plant loc11ted 1n Lawndale. The black tassle sl1p-on Is the next 
best-selling shoe and at S 150.00 a pair is contrlbut1ng substant1a11y to the 
deportmenrs seles. Amante w111 Introduce a fall loafer In cordoven; 1t 
would be great to hove o full run of this styl e. 

In the children·s depertment, seles have dropped merkedly s1nce lost year, 
as the graph on the next page shows. This 1s due primarily to increased 
competit1on. Nickers department store has added a beauti ful new 
ch11dren·s shoe depertment on their th1rd floor. Our salesmen were certain 
we were los1ng more and more cus tomers to N1ckers, so for t wo weeks In 
Februor we asked customers 1n our chlldren·s department what the 11ked 

Use unique characters as place markers in long documents, tlien locate them quickly 
with lhe Find command. 

SELECTING 
Selecting words 

To quickly select a whole word, point at it and double click the mouse button. 
If you hold down the mouse button on the second click, you can drag the pointer 
to select text in whole-word increments. 

Double clickjng selects words differently in MacWrite and Microsoft Word. 
MacWrite does not select the blank space after a word, but Microsoft Word does. 

Selecting lines 

To select text a line at a time in a MacWrite document, place the pointer in 
the left margin, hold down the mouse button, and then drag the pointer up or down 
in the margin. As you drag, lines of text are highlighted. 

To select text a line at a time in a Microsoft Word document, place the pointer in 
the left margin (it changes to the shape of an arrow pointing to the right). To select 
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just one line, click the mouse button once. To select more than one line at a time, 
hold down the mouse button and drag up or down in the margin. 

In MacWrite or Word, you can drag the pointer past the top or bottom edge of 
the window to scroll the document and automatically select more lines as it scrolls. 

Selecting sentences 

In Microsoft Word, you can speedily select a sentence by holding down the Com­
mand key and dicking on any part of the sentence. To select several sentences, hold 
down the Command key, press the mouse button, and drag. Once you start drag­
ging, you can release the Command key. You can also extend a selection by 
sentences: Use the scroll bar to locate the sentence to which you want to extend the 
selection, press the Command key, and click anywhere in the sentence. 

MacWrite has no method for quickly selecting an entire sentence. You must place 
the pointer at one end of the sentence, hold down the mouse button, and drag the 
pointer to the other end of the sentence. Alternatively, you can place the pointer at 
one end of the sentence and click the mouse button, then place the pointer at the 
other end of the sentence and hold down the Shift key while you click the mouse 
button again. 

Selecting phrases 

You may find it easier to select phrases by dragging backward-right to left, and 
up-from the end of the phrase to its beginning. Your eye is already at the end of 
the phrase after reading from right to left, and it's easier to start there and drag 
backward than to look back and drag forward. 

Selecting paragraphs 

To select a whole paragraph in a MacWrite document, place the pointer in the 
left margin next to the first line, hold down the mouse button, and then drag down 
the margin until the pointer is next to the line after the end of the paragraph. This 
method ensures that the selection includes the invisible return character that marks 
the end of the paragraph. 

With Microsoft Word, place the pointer in the left margin next to any line of the 
paragraph and double click the mouse button. If you hold down the mouse button 
on the second click, you can select adjacent paragraphs by dragging the pointer 
up or down. 
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Selecting large blocks of text 

To select a large block of text in both Mac Write and Microsoft Word, click an 
insertion point at one end, use the scroll bar to bring the other end into view, and 
press the Shift key while clicking an insertion point there. This method is faster 
than forcing either program to scroll automatically by dragging past the window 
boundaries. 

Selecting the entire document 

To select an entire MacWrite document, proceed as you would with any other 
large block of text: Click at one end of the document, scroll to the other end, and 
then hold down the Shift key while clicking again. With Microsoft Word, place the 
pointer in the left margin next to any line, hold down the Command key, and click 
the mouse button. 

EDITING 
Saving often to avoid clogging memory 

During a Microsoft Word editing session, the Mac's memory can become 
clogged with fragments of added, deleted, and changed text. Performance suffers 
and eventually this message appears: Session too long: low on merruny. Save your docu­
ment before continuing These symptoms are common after a massive text replacement 
using the Change command, for example, or after a change in tabs that affects many 
paragraphs simultaneously. 

You can forestall the low-on-memory syndrome by saving often. Just press 
Command-S whenever you pause to ponder. 

Efficient correction while typing 

As you type, it is easiest to erase a mistyped word or two with the Backspace key. 
Mouse methods for text removal may be more powerful, but moving your hands 
away from the keyboard may interrupt your typing flow. 
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Restoring backspaced text 

In Mac Write, if you use the Backspace key to erase a word or phrase character 
by character and you later change your mind, you can press Command-Backspace to 
restore the text, even if you have typed something else or moved the insertion point 
in the interim. This technique restores up to 49 characters, one at a time. However, if 
you highlight the word or phrase and press Backspace just once to erase it, pressing 
Command-Backspace will not restore it. 

Pressing Command-Backspace will not restore erased text in Microsoft Word. 

Replacing text directly 

To replace text, select the old and type the new. The selected text is automatically 
deleted when you start typing. There's no need to press Backspace first. 

Recycling deleted text 

Today's trash may be tomorrow's treasure, so don't hastily condemn the sen­
tences and paragraphs you delete to oblivion. Instead, cut and paste them to a 
recycling bin, perhaps at the end of your document, beneath a line of asterisks. You 
can also store scraps in the Scrapbook, but you may find that method too slow unless 
you have a hard disk or RAM disk. In Microsoft Word, you can open a new, untitled 
window to hold discarded text. Don't delete the leftovers permanently until you have 
finished the final editing on the document. 

Evaluating phrasing options 

Trying to decide which of two phrasings works better in a certain passage? In 
both MacWrite and Microsoft Word, the following method lets you see first one pas­
sage, then the other, in context: 

1. Type one alternative, select it, and type the other. 

2. Deliberate. 

3. Choose Undo or press Control-Z, the shortcut for the Undo command. The 
first alternative reappears. 

4. Deliberate. 

5. Undo again. The second alternative reappears. 

6. Repeat steps 2 through 5 until you either make a decision or fall asleep. 
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Quick moves and copies 

Microsoft Word versions 1.05 and above let you move or copy selected text from 
one place in a document to another without using the Cut, Copy, or Paste command. 
Here's how you do it: 

I. Select the text you want to move or copy. 

2. If necessary, scroll the new location into view. 

3. To copy the selected text, hold down the Option key, press the mouse button, 
drag the insertion point to where you want the selected text copied, and then 
release the mouse button. (You may release the Option key once you start 
dragging the pointer.) To move the selected text rather than copying it, press 
Shift-Option rather than Option by itself. 

Holding down Option or Shift-Option when you press the mouse button changes the 
behavior of the insertion point. Instead of selecting text as you drag, the insertion 
point follows the pointer. This method works between two windows containing the 
same document, but not between two windows containing different documents. 

Removing double spaces 

After a lengthy editing session, your document may be sprinkled with double 
spaces between words. While these gaps won't stop the earth from rotating, they're 
ridiculously easy to eliminate with the Change command, so why put up with these 
blemishes? Get rid of them like this: 
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I. In Microsoft Word, select the entire document by pressing the Command 
key and clicking with the pointer anywhere in the left margin (no need to do 
this in MacWrite). 

2. Choose Change from the Search menu and, in the dialog box that ap­
pears, type two spaces in the Find What field and one space in the Change 
lo field. Naturally, the spaces you type are indistinguishable from the 
blank space already in the dialog box, but they are there nonetheless. 

3. Click the Change All or Change Selection button. In MacWrite, you 
must then click OK to acknowledge that you realize Change All cannot 
be undone. This limitation does not apply in Microsoft Word. 
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Note that if you have indented your paragraphs, aligned columns in tables, or 
done any other text placement by typing spaces instead of using tabs or indentation 
markers in formatting rulers, this method for removing double spaces ruins your 
paragraph indentation, column alignment, and so forth. 

Save typing time 

Save time by devising standard abbreviations for long or complicated words and 
phrases, and using them throughout a document. After you have finished typing 
your document, use the Change command (from the Search menu) to replace each 
abbreviation in turn with its proper expansion. Instead of using the Change com­
mand to expand abbreviations in batches in Microsoft Word, you can use the 
glossary to expand each abbreviation right after typing it. 

Try to pick unique abbreviations that won't appear in the middle of regular 
words. For example, you might decide to use //ne for Nebuchadnezzar, but you 
wouldn't want to choose ne, because the ne in the word prune would then be ex­
panded to pruNebuchadnezzar. Alternatively, to guard against unwanted expansion 
of embedded occurrences of an abbreviation, select the Whole Word option in the 
Change dialog box before clicking the Change All or Change Selection button. Or 
in Microsoft Word, click the Change Then Find button to expand an abbreviation 
or click the Find button to skip an abbreviation. If necessary, undo the change by 
pressing Command-Z. 

Using multiple windows when editing documents 

While you are editing, Microsoft Word's multiple-window capability can help you 
reduce clutter, avoid unintentional changes, and keep the original text intact until 
you finish revising. Instead of trying out changes directly on the original document, 
open a new window for use as an editing scratch pad. (Resize and move the windows 
so that the original window fits above the editing window; the lower window's title 
bar and the upper window's scroll bar can overlap.) Copy text from the original win­
dow, paste it into the new window, and experiment. When you finish revising one 
section, cut it from the editing window, paste it into the original document, and 
save the original. 

All character formatting done in the editing window is transferred when you 
paste. If you paste whole paragraphs, the paragraph formatting is also transferred, 
but transferred words and sentences match the paragraph formats of their destina­
tions. Numbered footnotes in the original and the revision are renumbered 
automatically when you paste. 
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Although MacWrite doesn't have multiple windows, you can use a desk accessory, 
such as Mock Write or Notepad+ (which is part of Side Kick), as an editing scratch 
pad . However, these desk accessories do not allow you to do any character or para­
graph formatting, so you have to format your changes after pasting the edited text 
into the MacWrite window. 

PICTURES IN TEXT 
DOCUMENTS 
Precise picture pasting 

Copying a picture from MacPaint into MacWrite or Microsoft Word should be 
a simple task-a matter of cut- or copy-and-paste. But sometimes where the picture 
ends up in the text document seems to be controlled by mysterious, supernatural 
forces. In fact, three things determine a picture's initial position: 
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D The location of the insertion point in the text document determines where 
the picture will be inserted. If the insertion point is at the beginning of a 
line, the picture goes on that line. Otherwise the picture goes on the line 
below. In either case, any text that follows the insertion point becomes a 
new paragraph below the picture. 

D Both Microsoft Word and MacWrite always place a picture flush against the 
left margin. 

D A picture that seems off-center in Microsoft Word or away from the left mar­
gin in MacWrite has extra white space around it. MacWrite and Microsoft 
Word treat the whole picture-surrounding white space included-as an in­
divisible unit. T he extra white space results from selecting too large an area 
with the selection rectangle in MacPaint. To avoid excess white space, always 
select with the lasso. 
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The insertion-point location and margin settings similarly affect the initial 
position of pictures copied from MacDraw, Microsoft Chart, and other drawing 
programs. Extra white space is not a factor here though , because drawings from 
these applications never have extra surrounding white space. 

Moving pictures up and down 

After pasting a picture into a MacWrite or Microsoft Word document, you 
can move the picture up or down by removing or adding lines above it. 

Moving pictures sideways 

A picture in a MacWrite or Microsoft Word document can be dragged left or 
right as far as the margins allow. Here's how: 

1. Select the picture by clicking anywhere on it. A selection box appears 
around the picture, showing just how much white space is actually part of 
it. Be careful not to type anything or brush the keyboard while a picture is 
selected, because the typing will replace the picture. Should this happen 
accidentally, immediately choose Undo from the Edit menu. 

2. Place the pointer over any border of the selection box (but avoid the three 
black squares on the bottom border). The pointer changes shape from an 
I-beam to an arrow. 

3. With the mouse, drag the selection box right or left to the place where you 
want the picture. 

4. Release the mouse button. The picture jumps inside the selection box at its 
new location. 

If the margins keep you from moving the picture as far to the right or left as 
you'd like, adjust them. In MacWrite, insert a formatting ruler above the picture and 
move its margin markers. Don't forget to insert another formatting ruler below the 
picture to reset the margins for the text following the picture. In Microsoft Word, 
select the picture, choose Show Rulers from the Edit menu, and change the 
margin markers. 
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Resizing pictures 

To stretch or shrink a picture in a MacWrite or Microsoft Word document, you 
can use the three black squares that appear on the bottom border of every selection 
box. Follow these steps: 
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1. Place the pointer over one of the squares and drag it with the mouse. As 
you drag, the selection box changes size. 

2. Release the mouse button when the selection box is the size you want 
the picture to be. The picture changes its proportions to fit the box's new 
size and shape. You can undo the size change by choosing Undo from the 
Edit menu. 
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Pictures in Mac Write and Microsoft Wm·d documents can be resiz.ed by dragging the 
small bl.ack squares on the bottom border of the sdection box. 

Microsoft Word has an alternate method of resizing, as follows: 

1. After selecting the picture, press Command-Shift-Y. 

2. Type a number from 0 to 9 to indicate the new picture size. The number 
9 produces a picture 90 percent the size of the original, 8 produces one 
80 percent as large, and so on. The number 0 restores a reduced picture 
to its original size. 
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CHARACTER FORMATTING 
Extra space after italics 

Italic text has its place in an otherwise Roman (plain) text paragraph: It is most 
often used for book titles, technical terms, and foreign-language phrases. But with 
normal spacing, italic text often collides with the Roman text that follows it. To pre­
vent such character collisions, type an extra blank space after the last italic letter. 

Do not add extra space after italics in a document you plan to print on a 
LaserWriter, however. Unlike the screen and the ImageWriter, which fabricate italics 
by slanting Roman fonts, the Laser Writer has special italic fonts designed to fit 
seamlessly with their Roman counterparts. 

Nonproportional spacing 

Proportionally spaced fonts predominate on the Mac. In the Chicago, Geneva, 
and New York fonts, for example, an m is wider than an l. You cannot turn off 
proportional spacing with those fonts. If you want nonproportional spacing, you 
will have to use a monospaced font, such as Monaco, Dover, Washington D.C., or 
Courier. If the monospace font of your choice is not listed in MacWrite's Font menu 
or Microsoft Word's Character Formats dialog box, use the Font/DA Mover program 
to install it. 

Hard Spaces 

Normal blank spaces, which you type by pressing the Spacebar, are considered 
soft places in a paragraph, where lines can be broken to fit the margins. Sometimes 
you may want to prevent a line from breaking on certain spaces-when typing 
formulas and equations, for example. In those places, press Option-Spacebar to type 
a hard, nonbreaking space. 

You can use hard spaces anywhere you can use normal spaces, including dialog 
boxes. In Microsoft Word, pressing Command-Spacebar also produces a nonbreak­
ing space in regular documents, but does not work in dialog boxes. 

One cautionary note: With a proportionally spaced font (Geneva, New York, 
Times, Helvetica, and so on), a hard space is twice the width of a normal space. With 
a monospaced font (Monaco, Courier, and so on), hard spaces are the same width as 
normal spaces. 
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Using style to create visual separation 

Some people like to separate different elements of a document with a line 
of asterisks, hyphens, underscores, lowercase o's, periods, colons, solid dots (press 
Option-8), or other characters. The Mac's different character formats - bold, italic, 
underline, outline, and shadow-permit a great many variations on the standard 
line of characters. For example, an underlined underscore produces a double 
horizontal line. 

I 

Keystroke Style 

***** Shifl-8 ***** Outline 

Hyphen ------ Shadow 

Shift-Hyphen Underline 
000000 0 000000 Italic, Outline 

Period ·············· Outline 

Colon .............. Italic, Shadow .............. 
••••• Option-8 00000 Outline 
++++++ Option-/ ++++++ Bold, Italic 
00000 Shift-Option-V 00000 Bold, Outline 

Combine characters and styks Jar visual separation. 

Double subscripts and superscripts 

Formulas and equations that require double subscripts (that is, subscripts of sub­
scripts) and double superscripts can easily be created in MacPaint and copied into a 
text document. But the desired results can also be obtained directly in MacWrite 
and Microsoft Word. 

Special subscript and superscript fonts contain letters and numerals that are 
raised above or below the standard position of characters on a line. When you use 
these fonts with the Subscript or Superscript style, you get double subscripts and 
superscripts. The Dayton Fonts, from Plugh, Inc., include subscripts and super­
scripts, ornamented Greek and English alphabets, a square-root toolkit, fraction 
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connectors, dots, integrals, sums, large brackets, and other symbols used in equa­
tions. SciFonts, from Paragon Courseware, inclues 12-point regular, 9-point 
superscript, and 9-point subscript fonts of the standard English alphabet and Arabic 
numerals, the Greek alphabet, and mathematical symbols, plus a 12-point cursive 
English font. All these fonts can be installed in any System using the Font/DA Mover, 
and work equally well with MacWrite and Microsoft Word. 

Copying character attributes 

Choosing fonts, sizes, and styles from menus gets tedious in no time. Using key­
board shortcuts saves work, if you can remember the right keystroke for the 
attribute you want. In Microsoft Word, you need only use the keyboard shortcut 
once for each combination of font, size, and style in a document. After that, you can 
copy the attributes from an already formatted character, as follows: 

1. Select the text you want to format. 

2. Locate any character that has the combination of attributes you want to copy 
and place the pointer over it. You can scroll the document if necessary; the 
text you selected in step l need not be visible. 

3. Press Command-Option while you click on the character you found in step 2. 

With Word version 1.05 or above, you can copy character attributes across a 
split window but not between two different windows. 

LINE FORMATTING 
New line, same paragraph 

Ordinarily, the wordwrap feature automatically starts a new line when your 
typing reaches the right margin. At times you may want to start a new line before 
reaching the right margin, without starting a new paragraph. In Microsoft Word, 
you type Shift-Return to start a new line. MacWrite, on the other hand, has no 
new-line feature. 
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Custom line spacing 

Standard line-spacing options may not provide enough flexibility for all occa­
sions. You can add height to a line without otherwise affecting it by changing the 
font size of any blank space on the line. The larger the font size, the taller the blank 
space, and therefore the more space there will be above the letters on the line. Giving 
the blank space the Outline or Shadow style increases its height even more. Even 
choosing a different font for the blank space can affect the line height. Here is a list 
of the heights in screen dots of several fonts at different sizes: 

Font Sizes 

Font 9 10 12 14 18 24 
Chicago 15 
New York 12 12 15 17 21 26 
Geneva 12 12 15 18 22 28 
Monaco II 15 
Toronto 12 15 17 23 29 
Athens 22 
Los Angeles 14 28 
Dover 12 12 

Enlarging a blank space also makes it wider, not just taller. This side effect is 
invisible if you enlarge the blank space at the end of the line. Remember, however, 
that later editing may move the enlarged blank space away from the end of the line 
or even down to the next line, necessitating a new round of fine-tuning. Also, if the 
blank space at the end of the line is too close to the right margin, enlarging it may 
have no effect, and MacWrite may not even let you select it. 

Don't bother figuring font sizes of blank spaces in Microsoft Word. You can 
directly set the line spacing used in each individual paragraph to any number of 
points, any fraction of an inch, or any fraction of a centimeter. (A point equals 
Yn inch, or about the size of one screen dot.) Use the Formats command in the 
Paragraph menu. 

How MacWrite treats hyphens 

Hyphenated words and phrases occur frequently in English writing. MacWrite, 
unlike Microsoft Word, treats these as an indivisible entity. It keeps an entire hy­
phenated compound word on one line, because it does not consider a hyphen a 

144 



Word processing 

legitimate place to automatically break a long line. Thus, if one of the following 
terms did not fit at the end of a line, MacWrite would wrap the whole thing around 
to the next line: 

aide-de-camp 
daughter-in-law 
ex-husband 
half-baked 
helter-skelter 
higgledy-piggledy 
hocus-pocus 
hurdy-gurdy 
jack-o'-lantern 
maue r-of-fact 

much-loved 
namby-pamby 
president-elect 
quasi-judicial 
self-restraint 
10-meler 
touch-me-not 
vice-president 
white-faced 
wishy-washy 

You can trick MacWrite into breaking a line at a hyphen by typing a blank space 
after the hyphen. The extra space is invisible while it is at the end of the line. Just re­
member that later editing may move the extra space away from the end of the line, 
where it will become visible. 

Using optional hyphens 

Microsoft Word breaks a line at the hyphen in a compound word or phrase, but 
keeps unhyphenated long words intact. For example, if the word anthropom01phism 
does not fit at the end of a line, the entire word is put at the beginning of the 
next line. 

You can show Microsoft Word where a long word may be divided by pressing 
Command-Hyphen to type an optional hyphen. When a word that contains optional 
hyphens occurs at the end of a line, Microsoft Word tries to divide the word at one of 
them and, if successful, shows a hyphen. Otherwise, optional hyphens are invisible. 
To save time typing, put long words with optional hyphens in the glossary. 

When lines won't center 

Are centered lines in your MacWrite document off-center? You probably have 
blank spaces at the beginning or end of the lines. Here's how you can remove them: 

I. Select leading spaces by dragging the pointer from the first word on the line 
toward the left margin, as shown in the next figure. Press Backspace. 

2. Select trailing spaces by dragging the pointer from the last word on the line 
toward the right margin. Press Backspace. 
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In Mac Write, extra blank spaces at tlw beginning or end of a centered line lhraw tlw 
line off center. 

Reliable column alignment 

Have you ever spent hours carefully lining up lists and columns with blank 
spaces, only to have a change of font, size, or style throw everything off? If so, you 
are a victim of proportional character width. Spacing over with the Spacebar may 
work fine on a typewriter, where all characters have the same width, but characters 
in the Mac's proportional fonts have very different widths. When you factor in the 
complications caused by different fonts and different styles, accurate alignment with 
blank spaces becomes virtually impossible. 

For reliable alignment of lists and tables in MacWrite and Microsoft Word docu­
ments, you must use tabs, not blank spaces. Unlike blank spaces, the location of tab 
markers in formatting rulers is unaffected by your choice of font, size, or style. 
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PARAGRAPH FORMATTING 
MacWrite ruler specifications 

The following restrictions apply to the markers in a MacWrite formatting ruler: 

D The maximum right margin is 8 inches. 

D The minimum left margin is 1 inch. 

D The smallest adjustment interval for all markers is V.6 inch. 

D Margin markers must be at least 2 inches apart. 

D The indent marker must be at least 1 inch from the right-margin marker. 

D No tab markers are allowed left of the left-margin marker or right of the 
right-margin marker. 

D Tab markers must be at least o/is inch from margin markers. 

D Tab markers must be at least o/16 inch apart. 

D The maximum number of tab markers per ruler is 10. 

Speedy changing of the formatting ruler 

Every time you make a change to a MacWrite formatting ruler, you must wait 
while the change is applied to all the text between that formatting ruler and the next 
one. The more text there is, the longer you have to wait. If you are making several 
changes to the same ruler, having to wait between each change can be pretty 
annoying. 

You can cut your waiting time to virtually nothing by temporarily inserting a 
formatting ruler immediately below the one you are changing. Here's what you do: 

I. Click an insertion point at the beginning of the line below the ruler you 
plan to change. 

2. Choose Insert Ruler from the Format menu, so that you now have a pair 
of rulers. 
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3. Make all your changes to the top ruler of the pair. MacWrite does not make 
you wait between changes while it adjusts the text below the pair of rulers, 
because the bottom ruler temporarily governs the text's format. 

4. Remove the temporary bottom ruler by clicking on it and pressing the Back­
space key. MacWrite makes all the changes at once. 

Eleventh MacWrite tab marker 

When the indentation marker is to the left of the left margin marker in a 
MacWrite formatting ruler, pressing the Tab key on the first line of a paragraph 
advances the insertion point to the left margin marker. T he presence of other tab 
markers does not affect this feature, so the left margin marker effectively becomes 
an eleventh tab marker. 

Avoiding too many MacWrite paragraphs 

With version 4.5 of MacWrite, heavily formatted MacWrite documents, 
especiaHy those with lots of short paragraphs, are apt to display the message Too 
many paragraphs for this document! This is because this version counts paragraphs in 
order to keep track of a document's size. (Earlier versions of MacWrite- versions 2.2 
and below-do not count paragraphs.) By counting paragraphs instead of charac­
ters, as most other word-processing programs do, MacWrite version 4.5 can scroll 
through a long document more quickly. 

The program allows you to create a document with 500 paragraphs on a 128K 
Mac and 2047 paragraphs on a 512K Mac, marking every return character and for­
matting ruler as a paragraph. Since it considers single lines and even blank lines to 
be paragraphs, you can imagine how quickly these limits are reached in documents 
that contain many one-line paragraphs: television, stage, radio, and movie scripts, 
for example. 

You can avoid the Too many paragraphs . . . message in some documents by ending 
paragraphs with tabs instead of carriage returns. For paragraphs whose first lines 
are not indented, follow these steps: 
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I. Place the indentation marker over the left margin marker, place a decimal 
tab as near the left margin as you can, and remove all other tab markers. 

2. To end a paragraph, press the Tab key instead of the Return key. 

3. Now type the next paragraph. Text emerges from the left of the decimal 
tab until it hits the left margin, after which it emerges from the right. 
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If one of the first three or four characters in a paragraph is a period, you must 
end the paragraph before it with a carriage return, not a tab. Otherwise the period 
throws off the alignment of the paragraph. 

For paragraphs with indented first lines, follow these steps: 

1. Place the indentation marker over the left margin marker and place a reg­
ular tab marker at the point to which you want the first line indented. 

2. To end a paragraph, press the Tab key instead of the Return key. 

3. Type the next paragraph. Text emerges from the right of the regular tab. 

If you wish to type an occasional flush-left paragraph, such as a heading, end the 
paragraph before it with a carriage return, not a tab. 

In documents that already have tab markers in their formatting rulers, you may 
have to type more than one tab to start a new paragraph. In documents with text 
justified at both margins, you must end paragraphs with carriage returns; the tab­
bing methods just described will not work. 

Flush headings, indented paragraphs 

Creating a MacWrite document that has headings flush with the left margin and 
indented paragraphs is simple if you use enough formatting rulers. A ruler before 
every heading sets up the flush-left condition and another ruler after the heading 
sets the indented-paragraph condition. But formatting rulers visibly clutter up the 
document and they chew up memory and disk space. You can reduce the profusion 
of formatting rulers with the strategic use of tabs. Here's how: 

1. In the formatting ruler above the first heading, place a decimal tab as close 
to the left margin as possible. 

2. Set the indentation marker for the amount of indentation you want on the 
first line of every regular paragraph. 

3. When you're ready to end the last paragraph before a new heading, press the 
Tab key instead of the Return key. Remember, Mac Write considers a blank 
line a paragraph. So if you want a blank line between the paragraph and the 
heading, press Return and then press Tab. 

4. As you type the heading, text emerges from the left of the decimal tab until 
it hits the left margin, after which it emerges from the right. 
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Section 5. The Congress shell have po'Wer to enforce, by appropriate legislation, the 
provisions of this article. 

Arti cle fifteen 

Section 1. The right or citizens or the United States to vote shall not be denied or abridged 
by the United Stales or by any State on account of race, color, or previous condition of servitude. 

Section 2. The Congress shell have po'Wer to enforce this article by appropriate 
legislation. 

Article Sixteen 

The Congress shell have po'Wer to lay and collect taxes on incomes, from 'Whatever source 
derived, 'Without apportionment among the several States, and 'Without rega rd to any census or 
enumeration. 

Artil 

It takes only one f onnatting ruler with a decimal tab to set up flush-left headings and 
indented paragraphs, pravUled you press Tab, not Return, to end the last paragraf1h 

before a heading. 

The decimal-tab method does not work if there is a period near the beginning 
of the heading, since the period lines up at the decimal tab, thus pulling the leftmost 
part of the heading away from the margin. The following method is a bit more com­
plex than the decimal-tab method , but it works for headings with periods near 
the left margin: 

1. In the formatting ruler above the first heading, place a regular tab as close 
to the right margin as possible. 

2. Set the indentation marker for the amount of indentation you want on the 
first line of every regular paragraph. 

3. When you're ready to end the last paragraph (or blank line) before a new 
heading, type tabs to advance to the rightmost tab marker. Then advance 
to the end of the line by typing a couple of blank spaces: two spaces for 
12-point or larger text, four spaces for 9- or IO-point text. 

4. Now type the heading. Text emerges from the right, at the left margin. 

Both of these methods work with all types of alignment-left, right, centered, 
and justified. 
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91.67 RIGHT-OF-WAY RULES; EXCEPT WATER OPERATIONS 
(e) General . When 'West her conditions permit, reoerdless of 'Whether en operation ts 

conducted under i nstrument fliQht rules or visual nt9ht rules, vi9ilence shell be met ntei ned by 
each person opereti no an st rcreft so es to see and evoid other ei rcreft in compliance 'With this 
section. When e rule of this section gives another et rcreft the r ight of'Wey, he shall give 'Way to 
the\ at rcreft end mey not pass over , under, or eheed of it, unless 'Well cleer. 

{b) In distress. An etrcreft in distress hes the right of'Way over ell other air treffic. 
(c) Converging. When ei re raft of the same cetegory ere converging et epproxi matel y 

the seme altitude (except heed-on, or neerl y so) the 81 rcreft to the other·s ri9ht hes the right of 
'Way. If the et rcreft ere of different categories- -

end 

( I) A balloon hes the right of 'W8y over eny other category of ei rcreft; 
(2) A glider hes the right of 'Wey over en airshi p, eirplene or rotorcreft ; 

(3) An etrshtp hes the right of'Way over en eirplene or rotorcreft . 
Hwever, en ei rcraft to'Wi no or refuell n9 other ei rcreft hes the right of 'Wey over ell other 

engine-driven eircreft. 
(d) Approaching head-on. When eircreft ere epproechi no eech other heed-on, or 

neerl y so, eech pilot of each et rcreft shell alter course to the right. 

This MacWrit,e f ormatling ru/,er gives indenJed paragraphs when you press Re tum, 
and flush-left headings with periods near the left margin when )'OU press Tah 

twice and type a coupk of blank spaces. 

Mixing indentation in MacWrite correspondence 

Either of the methods just described for mixing flush-left headings and indented 
paragraphs works well for correspondence in which the address, salutation, and 
complimentary close are all flush left but where the body paragraphs are all 
indented. Just use tabs to start new flush-left lines or paragraphs and carriage 
returns to start new indented paragraphs. 

Invisible MacWrite formatting rulers 

In MacWrite, outlines and other documents with several paragraph styles­
different margins, tabs, indentations, and so forth-require lots of formatting-ruler 
changes. To eliminate the tedium of constantly inserting and adjusting new rulers, 
or of scrolling through the document in search of an existing ruler to copy, why not 
keep a set of preformatted rulers at the end of your document? When you need to 
change paragraph formats, you copy the appropriate ruler from the end of the 
document and paste it above the paragraph to be formatted. 
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Don't worry about the set of rulers taking up too much valuable screen space 
and slowing down the display speed as you type. Those problems disappear if you 
hide the rulers. But how do you select and copy an invisible ruler? You give it a visible 
name, as follows: 

I. Choose 9-point text and type a line of hyphens to separate the main docu­
ment from the set of rulers. Press Return twice at the end of the line. 

2. Insert a formatting ruler (choose Insert Ruler from the Format menu) and 
adjust it for the first paragraph style. Then type a descriptive name for the 
ruler you have just set up and press Return twice. 

3. Repeat step 2 for each additional paragraph style. 

4. Choose Hide Rulers from the Format menu. 

To copy a ruler, you select the blank line above the appropriate ruler name at the 
end of the document and choose Copy from the Edit menu, or press Command-C. 
Then you can paste the copied ruler-still invisible-ahead of the paragraph to be 
formatted in the main document. The best place to paste the invisible ruler is over 
the entire blank portion at the end of the line below which you want the format 
change. To do this, drag the mouse from the end of that line to the left margin 
on the line below it, and then paste. 
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About Microsoft Word's formatting rulers 

Formatting rulers in Microsoft Word cannot be cut, copied, and pasted the 
way they can in MacWrite. In Microsoft Word, a formatting ruler is automatically 
attached to every return character. If you move or remove a paragraph's return 
character, you also move or remove its formatting ruler. 

For example, if you paste one paragraph (A) into the middle of a differently for­
matted paragraph (B), Word changes the format of the first part of paragraph B to 
match the format of paragraph A. To put it another way, the first part of paragraph 
B becomes the first part of paragraph A. To copy just the text from paragraph A, 

and not the format, exclude the return character at the end of paragraph A when 
you select it. 

Similarly, unintentional changes to a paragraph's format occur if you acciden­
tally remove the return character at the end of the paragraph. Use caution when 
selecting text at the end of a paragraph to avoid unintentionally including the 
return character in the selection. 

Return characters are normally invisible, but you can see t11em if you choose 
Show ~ from the Edit menu. 

Copying paragraph formats 

Once you set up a paragraph format-tabs, margins, indentation, spacing, and 
alignment- in a Microsoft Word document, the format is retained as you continue 
typing. Each time you press the Return key to start a new paragraph, the paragraph 
format is automatically copied from the preceding paragraph. But what if you want 
to change the paragraph format for one paragraph and then revert to a format used 
earlier for the next paragraph? Changing the format for each paragraph by adj ust­
ing formatting rulers and choosing commands from menus is too much work. And 
using keyboard shortcuts only saves time if you can remember the right keystrokes 
for the attribute you want. 

In Microsoft Word, you need to use those methods only once for each paragraph 
format you set up in a document. After that, you can copy the format from any exist­
ing paragraph, as follows: 

1. Select the paragraph you want to format. 

2. Locate any paragraph that has the format you want to copy. You can scroll 
the document if necessary; the paragraph that you selected in step 1 need 
not be visible. 
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3. Place the pointer in the left margin alongside the paragraph you found in 
step 2. The pointer shape becomes an arrow pointing to the right. 

4. Press Command-Option while you click next to the paragraph whose format 
you want to copy. 

With Microsoft Word version l .05 or above, you can copy paragraph formats 
across a split window but not between two different windows. 

PAGE HEADERS AND FOOTERS 
Retrieving MacWrite header and footer windows quickly 

After you open MacWrite's header or footer window, you can return to the main 
document window by clicking anywhere on it. The header and footer windows 
remain on the screen but are hidden beneath the document window. You can re­
trieve the header or footer window by clicking at the extreme right edge of the 
screen. To display the header window, click alongside the document window's title 
bar; to display the footer window, click alongside the document window's scroll bar. 

You may not be able to retrieve the header and footer windows in the manner 
just described if you have moved any of the windows from their standard positions 
(by dragging their title bars). Also, you will be unable to retrieve them in that man­
ner if you explicitly closed them (by clicking their close boxes or choosing Close 
from the File menu while they are active). 

Header and footer experiments 

To experiment with headers and footers in MacWrite, set up the screen so 
the header, footer, and document windows are all visible. Then, as you change the 
header or footer, you can see how it affects the document. Here's the procedure: 
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1. Shrink the document window so that it occupies the upper half or so of the 
screen. 

2. Open the header or footer window, shrink it to about half its initial size, and 
drag it below the document window. 

3. Create an experimental header or footer in its window. 
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4. To see how the experimental header or footer looks, click on the document 
window. If necessary, scroll to the nearest page break. 

5. Repeat steps 3 and 4 until you like the way the header or footer looks in the 
document. 
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Experiment witJi headers and footers in Mac Write by arranging tJie screen so llie 
header orfooler window is visible at the same lime as the document window. 

Formatting header and footer page number, date, and time 

In MacWrite, the font, style, and size of the page number, date, and time icons in 
the header and footer windows are determined by the attributes of the first charac­
ter typed in the window. If the window is empty except for the icons, assign the 
attributes as follows: 

1. Type a blank space in the upper left corner. 

2. Select the space and, from the Font and Style menus, choose the attributes 
you want for the page number, date, and time. 
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This trick won't let you specify a different style for each icon, so if, for example, 
your document requires bold page numbers and underlined dates, you might con­
sider putting the page numbers in the footer window and the date in the header 
window, or vice versa. 

Putting text next to pictures in headers and footers 

Although MacWrite won't let you type next to a picture in a document window, 
you can position the page number, date, and time icons next to a picture in the 
header and footer windows. You may even put the icons on top of a picture. 
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November 6, 1986 

10:34 AM 

The page number, date, and time icons in MacWrite'.s header and footer windows can 
be placed next to <Jr on top of a picture. 

When to leave out the date icon 

Don't use MacWrite's date icon in the header or footer windows of a letter or 
other document that carries a fixed date. MacWrite always replaces the icon with 
the current date, rather than the date on which you printed or saved the document. 
Typing the date may seem like more work now, but in three weeks, when you re­
open the document to see exactly when you sent the letter, you'll be glad you 
didn't use the date icon. 
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Suppressing a MacWrite header after the first page 

Eliminating the header from the first page of a MacWrite document is easy: 
You just choose Title Page from the Format menu. Achieving the opposite effect­
eliminating the header from all but the first page-is more difficult. You must print 
the document in two stages: First, you print the first page of the document with the 
header visible; then you print the remaining pages of the document with the header 
hidden. Follow these steps: 

1. Make the header visible by choosing Display Headers from the Format 
menu. 

2. Print only the first page by choosing Print from the File menu and entering 
a page range from 1 to 1. 

3. Hide the header by choosing Remove Headers from the Format menu. 

4. Print the remaining pages by choosing Print from the File menu a second 
time and entering a page range from 2 to 999. 

Why would you want to bother with this cumbersome procedure? If you wanted 
to print a letterhead at the top of the first page of your letter, for example, it might 
seem simpler to put it directly at the top of the document. T hen you'd use the header 
window to restate the name of the recipient and print the page number and date on 
following pages, using the Title Page command from the Format menu to keep the 
header off the first page. However, this "simpler" approach would require that you 
type the date on the first page and in the header. You wouldn't be able to use the date 
icon in the header window unless the date on which you printed the letter coincided 
with the date you typed on the first page of the letter. 

Changing the page-number font in Microsoft Word 

Microsoft Word's automatic page-numbering feature, which you select in the dia­
log box displayed when you choose Division from the Document menu, always uses 
the New York 12 font. If you want a different font or special style, you have to set up 
your own page numbering in a running-head paragraph. Here's how: 

1. Type the word page in your running-head paragraph in the location where 
you want the page number to appear. (This is a placeholder for the actual 
page number, which will be inserted at the time of printing.) 
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2. Press Command-Backspace, causing Microsoft Word to look up page in the 
glossary and replace it with its expansion (page). 

3. Select the word (page) and use the Character menu to set the font, style, and 
size you want for page numbers. 

When you print the document, Microsoft Word replaces the word (page) with the 
correct page number in your chosen format. Note that you must expand page to 
(page) using the glossary; typing (page) directly does not work. 

FOOTNOTES AND REFERENCES 
Using Notepad as a footnote repository 

MacWrite does not automatically position and number footnotes or references, 
but you can do it yourself with the aid of the Notepad desk accessory. Here's how: 

1. After opening your MacWrite document, get out the Notepad and drag it by 
its title bar to the bottom of the screen. 

2. Click on the document window. T he Notepad should be just visible at the 
bottom of the screen, sticking out beneath the document window. 

3. Type your document. When you encounter a footnote, bring out the Note­
pad by clicking on the edge that sticks out beneath the document window, 
and type the footnote on the Notepad. Start the footnote with the next foot­
note number. When you return to your main document, be sure to add the 
footnote number to it (use superscript style if you like). 

4. When you have finished typing and editing your document, cut and paste 
the footnotes from the Notepad to the main document, either at the end of 
each page or at the end of the document, whichever your style d ictates. If 
you like, you can select each footnote number in turn and make it 
superscr ipt style. 

T he standard Notepad desk accessory has a limited capacity. For heavily anno­
tated documents, you may need a more capacious repository for your footnotes or 
references, such as the Mock Write or Notepad + desk accessories. 
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FORMATTING DOCUMENTS 
Creating wide MacWrite documents 

The standard width of a MacWrite document is 57/s inches. By widening the doc­
ument window and adjusting the margins, you can increase that width to 6114 inches 
and still see the whole document. Here's what you do: 

I. Set the left-margin marker and, if you want, the indentation marker at the 
I-inch mark. 

2. Drag the document window to the left slightly, but leave a narrow gap 
between its left edge and the left edge of the screen. 

3. Widen the document window by dragging its size box to the right as far as 
possible. The document window partially hides the scroll bar, but the scroll 
bar still works. 

4. Set the right-margin marker at the 7114-inch mark. 
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The MacWrite document window can be adjusted to display all of a 
61/4-inch-wide document. 
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Creating even wider MacWrite documents 

Hidden on the right of ever y MacWrite document is another inch or so of usable 
space. Displaying the hidden space only requires a couple of mouse moves: 

I. Drag the document window by its title bar an inch to the left. 

2. Widen the window by dragging its size box as far to the right as possible. 

Having displayed the hidden part of a wide document, how do you make use of 
it? Unfortunately, there is no way to take advantage of the extra width gracefully­
at least, not while you are actually creating a document. MacWrite lacks a horizontal 
scroll bar and does not automatically scroll from side to side as you type. To see the 
hidden part of a wide document, you must drag the window to the side. T his proce­
dure is so cumbersome that you're better off typing, editing, and proofing your 
document with narrower margins. Then, just before printing, widen the window 
and reset the right margin at the 8-inch mark in the formatting rulers. 
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Widening the top and bottom margins in MacWrite 

The normal top and bottom margins in a MacWrite document are V2 inch and 
Y4 inch, respectively. If you want larger margins on every page, add blank lines to the 
header and footer windows. 

The header and footer windows each hold up to six return characters, or a total 
of seven lines. If you need taller margins, remember that you can use formatting 
rulers in the windows to set line spacing. You can also change the font, size, and style 
of each line to fine-tune its height. 

Accommodating printed letterheads 

When typing a letter that will be printed on letterhead stationer y, you must plan 
for the space taken up by the letterhead. You could ignore the problem as you type 
and take care of it when you print, by cranking the stationery through the printer 
until the letterhead is above the print head. However, this method makes it hard to 
tell when you have typed more than will fit on one page. Depending on the length 
and format of your letter, you can do one of the following instead: 

D If your letter is only one page long, the easiest and most reliable method of 
accommodating a letterhead in MacWrite is to insert the appropriate number 
of blank lines above the text of the letter. 

D If your MacWrite letter runs to more than one page and you want the top 
margin to be the same on all the pages, insert blank lines in the 
header window. 

D If your MacWrite letter will be more than one page long and subsequent 
pages will have a different top margin from the first page, first insert the 
number of blank lines necessary to accommodate the letterhead above 
the text of the letter. Then insert blank lines in a header window and 
choose Title Page from the Format menu to print the blank header on all 
pages but the first. 

· D For a Microsoft Word letter, change the top margin in the Page Setup 
dialog box to the distance from the top of the page to where you want the 
first line of the letter printed. If you need to allow extra space for a wider 
margin at the top of the first page of a multiple-page letter, type blank 
lines at the beginning of the letter. 

D When you print the letter, feed each sheet of paper through the printer until 
its top edge lines up with the top of the paper bail. 
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Starting a new page 

The method for starting a new page in MacWrite is obvious: Choose Insert Page 
Break from the Format ruler. T he method in Microsoft Word is less obvious but just 
as easy: Press Shift-Enter. 

Removing a MacWrite page break 

MacWrite has no special command for removing a page break inserted by an 
Insert Page Break command. To delete one, do this: 

1. Select the blank space at the end of the page by placing the pointer just 
above the dotted line that marks the page boundary and clicking once. 

2. Press Backspace or use the Cut command. 

If the Mac beeps when you try to select the blank space in step I , it means the page 
break occurred naturally due to the length of the document, including the size of 
the header and footer. Natural page breaks cannot be removed, only artificial ones. 

You can delete any blank lines that remain after removing a page break by drag­
ging the pointer across them and pressing Backspace. 
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above the page boundary's dotted line. 
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Removing a Microsoft Word page break 

To remove a page break set by pressing Shift-Enter in a Microsoft Word docu­
ment, double click anywhere on the dotted line that marks the artificial page break 
and press the Backspace key. 

Top-to-bottom centering 

MacWrite has no command to vertically center text on a page, but you can do 
it yourself by adding the right number of blank lines above the text. Here's one 
approach: 

I. Remove extra blank lines above and below the text to be centered. 

2. Below the text, press Return repeatedly until a page break appears, 
counting the number of times you press Return. 

3. Press Backspace half the number of times you pressed Return. 

4. Select all the remaining blank lines below the text. 

5. Cut the selected lines and paste them above the text. 

6. If more text follows on another page, insert a page break below the 
centered text. 

Creating document templates 

Unless every document you create is different, you will save time in the long run 
if you sort your documents by type and make a preformatted template for each cate­
gory. This is how you create a template: 

I. Choose New from the File menu. 

2. Set up formatting rulers, headers, footers, and other paragraph and docu­
ment formatting. 

3. Choose the font, size, and style you wish to start the document with. 

4. Enter any text that will appear in every document of this type. 
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5. Insert any pictures that will appear in every document of this type. 

6. Save the document using a suitable generic name, such as Letter, Envelo-pe, 
or Lahel. 

The next time you want to create a new document, instead of using the New 
command, open the appropriate template document. To avoid accidentally overwrit­
ing the original template with your new document, immediately use the Save As 
command and give the document its own name. 

Envelope addressing 

Usually, the business letters you type have the address of the recipient at the 
top of the first page. Why type this address again for the envelope? Instead, you can 
copy the address to a separate "page" at the end of the letter and print using the Cut 
Sheet or Hand Feed option. After typing the letter, follow these steps: 

1. Select all lines of the address at the beginning of the letter and choose Copy 
from the Edit menu. 

2. Scroll to the end of the letter, click an insertion point, and start a new page 
there for the envelope. In MacWrite, choose Insert Page Break from the 
Format menu. In Microsoft Word, press Shift-Enter. 
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3. Get ready to format the address. In MacWrite, choose Insert Ruler from the 
Format menu. In Microsoft Word, choose Show Ruler from the Edit menu. 

4. Press Return seven times in order to create seven blank lines at the top 
of the envelope. 

5. Choose Paste from the Edit menu, putting a copy of the address on the 
new page. 

6. Drag the indentation marker to about the 3V2-inch mark on the ruler. In 
Microsoft Word, you must select the entire address before dragging the 
marker. The copied address will shift to the right, lining up with the new 
position of the marker. 

7. Change the size of the address to 12 or 14 point if you prefer, even if the 
letter itself uses a smaller size. 
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The document is now set up to print the address on a separate page. If you need 
to, you can now go back and change the letter without affecting the position or ac­
curacy of the address that will be printed on the envelope. 

When you print the letter, be sure to select the Cut Sheet or Hand Feed option. 
As you print, a dialog box advises you each time you must insert another sheet of pa­
per into the printer. After you have printed the last page of the actual letter, put an 
envelope in the printer instead of a sheet of paper. 

You may have to experiment at first in order to get the address positioned where 
you want it on the envelope. Adjust the left/right alignment of the envelope in the 
printer, the indentation-marker position in the formatting ruler, and the number of 
blank lines between the formatting ruler and the address. 

Envelope addressing: Another method 

The method for addressing envelopes just described does not work well if the 
document uses headers or footers, because they are printed on the envelope as well 
as on the pages of the letter. If you have headers or footers in your letter, you can still 
print the recipient's address on the envelope by copying the address from the letter to 
a separate document, as follows: 

I. Print the letter. 

2. Select all lines of the address at the beginning of the letter and choose 
Copy from the Edit menu. 

3. Close the letter document and create a new document for the envelope 
(in Microsoft Word, you need not close the letter document before open­
ing a new one). 

4. Get ready to format the address. In MacWrite, choose Insert Ruler 
from the Format menu. In Microsoft Word, choose Show Ruler from 
the Edit menu. 

5. Press Return seven times in order to create seven blank lines at the top 
of the envelope. 
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6. Choose Paste from the Edit menu, putting a copy of the address in the new 
document. 

7. Drag the indentation marker to about the 3Y2-inch mark on the ruler. In 
Microsoft Word, you must select the entire address before dragging the 
marker. The copied address will shift to the right, lining up with the new 
position of the marker. 

8. Change the size of the address to 12 or 14 point if you prefer, even if the 
letter itself uses a smaller size. 

9. Print the envelope. 

Note that steps 3 through 8 here are the same as steps 2 through 7 in the previous 
method of envelope addressing. 

You may wish to save the envelope document as a template. The next time you 
need to address an envelope, you open the template, select the old address, and paste 
the new address in its place. In Microsoft Word, you should paste the new address 
below the old address, copy the paragraph format from the old address as described 
in "Copying paragraph formats," on page 153, and then remove the old address. 

Return addresses for envelopes 

Your best bet if you want a return address on a standard, number 10 (business­
size) envelope is a rubber stamp or printed stationery. You can use the ImageWriter 
to print a return address, but it is hard to print closer than V2 inch from the top edge. 
And with MacWrite you can't print the address less than % inch from the side of the 
envelope unless you fold the envelope first. (With Microsoft Word, you can get closer 
to the side.) 

If you're determined to try printing the return address, proceed as described 
in either of the two tips on envelope addressing, substituting the return address for 
three or four of the seven blank lines at the top of the envelope. The return address 
and the recipient's address require different indentation-marker settings, so you'll 
need two sets of formats (or tabs). Position the indentation marker for the return 
address as far to the left as possible, and that for the recipient's address at about 
the 4-inch mark. 
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CONVERTING DOCUMENTS 
Removing unwanted return characters 

Documents imported from other computers often have a return character at the 
end of each line, making each line act like a separate paragraph. Although you can 
laboriously weed out the extra return characters one at a time with the Backspace 
key, why not use Microsoft Word's Change command to eliminate them all in a few 
seconds? (Sorry-this can't be done in MacWrite.) First, you replace the blank line 
that occurs after ever y real paragraph with an unusual combination of characters 
you are certain doesn't appear anywhere in the document. Next, you replace all the 
remaining return characters in the document-the extra returns at the end of each 
line- with spaces. And finally, you change the unusual combination of characters 
that you inserted after every real paragraph back to return characters. It takes a lot 
longer to explain than to do, as you'll see if you follow these steps: 

1. Select the entire document by pressing Command and clicking anywhere 
in the left margin. 

2. Choose Change from the Format menu and, in the dialog box that appears, 
tell Word to find Ap Ap and change it to an unusual combination of charac­
ters, such as@@@. Then click Change All. 

3. Choose Change again, and in the Change dialog box tell Word to find Ap 
and change it to one blank space (hit the Spacebar once). T hen click 
Change All. 

4. Choose Change a third time, and in the Change dialog box tell Word 
to find @@@ (or whatever you used in step 2) and change it to "p/\p. Click 
Change All one last time. 

In Microsoft Word's Change and Find dialog boxes, the symbol Ap stands for a re­
turn character. Using /\ p /\ p for the Find What string assumes that the blank lines 
after each real paragraph contain exactly one blank space. If the blank lines in your 
document have more spaces or no spaces, you will have to type a different number of 
blank spaces between the two Ap symbols in step 2. Use the Show~ command in the 
Edit menu to reveal paragraph marks and blank spaces. 
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Using MacLink to convert from WorclStar or Multimate 

Almost all word-processing programs allow the same types of formatting varia­
tions, such as boldface text, variable margins, and page headers. However, WordStar 
accomplishes that formatting one way on an IBM PC and MacWrite does it another 
way on the Macintosh. If you simply transfer a WordStar document to the Mac and 
open it with MacWrite, it will be full of strange characters- the result of MacWrite's 
misinterpreting the WordStar formatting conventions. 

MacLink, a communications program designed specifically for transferring doc­
uments between the Macintosh and the IBM PC, can translate formatted WordStar 
or Multimate documents into formatted MacWrite documents, and vice versa. 

Converting from ThinkTank to Microsoft Word 

Suppose you have prepared an outline with ThinkTank and you now want 
to dress it up or flesh it out with Microsoft Word. You use the Open command in 
Microsoft Word's File menu to open the T hinkTank outline, but the outline looks 
odd: Attached to each line at the left margin is a prefix, such as .HEADO +. How do 
you clean up the mess? To transform the odd-looking document into a conventional 
outline, follow these steps: 

168 

1. Before you start to tinker, use the Save As command to save a copy of the 
outline as a Microsoft Word document- under a different name- and close 
the original T hinkTank document. 

2. Select the entire document (press the Command key and then click in the 
left margin). 

3. Set tabs every Y2 inch or so across the document (use the Tabs command in 
the Paragraph menu). 

4. Select and delete the prefix .HEADO +, together with all the blank spaces that 
follow it. (The prefix is next to your summit headline, which you may now 
wish to center and embellish.) 

5. Choose Change from the Search menu. In the dialog box that appears, 
tell Word to find .HEAD I ? . (Don't forget the initial period and each of the 
blank spaces; choose Show ~ from the Edit menu to see exactly how many 
spaces there are.) Then tell Word to change the Find What string to nothing. 
Click Change Selection and voi/a! All your main headings are now flush 
against the left margin. 
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6. Choose Change again and modify the Find What string to .HEAD 2 ? . 
Tell Word to change the string to its symbol for a tab character: "t. Click 
the Change Selection button (the entire document should still be selected 
from step 4), and all your second-level headings are indented to the 
first tab marker. 

7. Now choose Change again and tell Word to replace .HEAD 3 ? with "t" t. 
Click Change All and all your third-level headings are indented to the 
second tab. 

8. Continue as in steps 5, 6, and 7, modifying the Change dialog box to replace 
each additional heading level with one more tab-character symbol than the 
previous level. 

s File Edit Seorch Chorocter Porogroph Document 

4 

Chonge 

Find Whot: r·H=E=A=D""4=?=~--======~==9 
Chonge To: At A t A~ 

'--~-'-~~~~~~~~~~~~~ 

D Whole Word D Motch Upper/ Lowercose 

RFind NeHtlJ (Chonge, then Find ) (ChongeJ Chon e Selection 

Althaugh you can open Think Tank outlines directly in Microsoft Worcl, you 
must replace the odd-loo/ling prefixes with tab characters in order to restore 

proper indentation. 

If an outline heading is too long for one line, it will automatically wrap around 
to the next line, with the wrap starting at the left margin. You may wish to adjust the 
left margin for runover lines, so that they line up with the appropriate tab. 
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If you typed text windows in ThinkTank 512, when you open the outline in 
Word, the text in the windows remains flush against the left margin and a return 
character is embedded at the end of each line. You should remove all return charac­
ters except the last one in each paragraph, and yo~ may wish to adjust the margin 
and indentation settings as well. Make these and any other changes just as you would 
with any other Microsoft Word document. 

lncidentaJly, Microsoft Word treats pictures in a ThinkTank document as text. 
The result is lots of gibberish instead of pictures. Each picture begins with .pict and 
ends just before .HEAD. You'll have to clear out the gibberish between these markers 
and copy the pictures from ThinkTank to Word using the Edit menu's Cut and Paste 
commands, perhaps using the Scrapbook desk accessory or the Switcher program. 
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Thanks to MacPaint and MacDraw- and your own 
creativity-you'll never produce dull documents 

again. You can learn a lot about these applications by 
experimenting, but if you want to get right down to 
the business of creating art, the tips in this chapter 

will get you started fast. 
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SELECTING 
Selection rectangle or lasso? 

MacPaint has two tools for selecting parts of a drawing: the selection rectangle 
and the lasso. The selection rectangle, sometimes called the marquee, selects every 
dot (black or white) within a rectangular region. Typically, this means an object is se­
lected along with some surrounding white space. If you copy an object selected by 
the selection rectangle and paste it over a larger object or background pattern, the 
selected surrounding white space is pasted, too. 

The lasso selects the black dots it encircles and, if some of the selected black dots 
completely enclose a region, any white dots inside the region are also selected. The 
end result is that the lasso selects objects without extra surrounding white space. If 
you copy a lassoed object and paste it over a larger object or background pattern, 
only the selected object is pasted. 
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The selectian rectangle includes extra white space around an object, 
but tlze lasso does not. 

The Trace Edges, Flip Horizontal, Flip Vertical, and Rotate commands in the 
Edit menu can be used only with objects selected by the selection rectangle. 
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Tightening the noose 

Don't bother completely encircling objects as you select them with the lasso. In­
stead, drag the "rope" three-quarters of the way around the objects and release the 
mouse button. MacPaint takes the rope straight back to your starting point for you, 
and then tightens the noose. 

Selecting large MacPaint areas 

It's impossible to cut or copy an area of a MacPaint document that's larger than 
the drawing window, at least using MacPaint itself However, several desk accessories 
and independent application programs can copy or cut larger pieces. This list shows 
how large an area the following four products can select: 

Art Grabber 
QuickPaint 
Paint Cutter 
PaintMover 

Type 
Desk accessory 
Desk accessory 

Application 
Application 

Width x height (inches) 
8.00 x 10.00 
7.05 x 4.34 
8.00 x 10.00 
8.00 x 10.00 

Centering a MacDraw object 

Instead of adjusting the scroll bars to center a selected object in the MacDraw 
window, choose Reduce and then Enlarge from the Layout menu. If you're already 
using a reduced view, select Enlarge and then Reduce. 

Selecting multiple MacDraw objects 

When you want to make the same change to several objects in a MacDraw docu­
ment, select all the objects first and make the change once. To select multiple objects, 
hold down the Shift key as you click on them one by one. 

If you need to select more than half the objects in a document, it's faster to select 
them all and then exclude the ones you don't want selected. Here's how: 

I. Choose Select All from the Edit menu, or press Command-A. 

2. Hold down the Shift key as you click on the objects you don't 
want selected. 

173 



Mac Insights 

Selecting a group of MacDraw objects 

Selecting an entire group of adjacent o~ects in a MacDraw document relies on 
a familiar Mac technique: dragging a selection rectangle. You do it like this: 

1. Imagine a rectangle around the group of objects. 

2. Place the pointer at one corner of the imaginary rectangle and press the 
mouse button. The pointer changes to the shape of a pointing hand. 

3. Drag to the diagonally opposite corner of the imaginary rectangle. 
A selection rectangle appears. 

4. When the selection rectangle encloses all the objects, release the mouse 
button. The selection rectangle disappears, leaving all the objects it 
enclosed selected. 

T he selection rectangle must completely enclose every object you want selected. 
If an object you thought you had enclosed is not selected, try again with a different 
shape or size selection rectangle. Or add objects to the group selection by holding 
down the Shift key while you click on them one by one. (You can also use this 
method to deselect objects without deselecting the whole group.) 

Missing MacDraw handles 

MacDraw marks the corners of selected objects with small black boxes, called 
handles. However, when you select two or more identical objects that exactly overlap, 
all their handles are invisible. If this happens, how can you work with them, either 
as a group or singly? 

To treat the objects as a group: 

1. Choose Group from the Arrange menu. 

2. Proceed as if you were working with one object. 

To treat the objects singly, you'll have to separate them, like this: 

I. Select the topmost object by clicking on it, then drag it aside. 

2. Repeat this step with the next object. 

Later, you can restack the objects by selecting them all and aligning them on 
left /right centers and top/bottom centers. 
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DRAWING TOOLS 
Constraining MacPaint and MacDraw tools 

With most MacPaint and MacDraw tools, pressing the Shift key before you start 
to draw restricts the tool's freedom of movement. For example, the Shift key restricts 
the line-drawing tool so that it will draw only a line that goes up, down, sideways, or 
on a 45-degree diagonal. Similarly, the Shift key restricts movement of a MacPaint 
object selected with the selection rectangle or the lasso to a vertical or horizontal 
direction. In MacDraw, pressing the Shift key contrains movement of a selected ob­
ject to a vertical, horizontal, or 45-pegree diagonal direction. 

Selected object can be moved p .... Selected object can be moved 
vertically or horizontally only· ·· · · · · · · · · · i-;..--l_.,.. vertically or horizontally only 

Scrolls up/down or right/left only . . . . . . . . 0 A .. .. No effect 

No effect ..... ............. ... ...... .. . 

Brushes up/down or right/left only ...... . 

~ ,,.m 

e (l 
. . .. Sprays up/down or right/left only 

.... Draws line up/down or right/left only 

Draws line up/down or right/ left, '-.,. O .... Erases up/down or right/left only 
or at 45-degree diagonal only · · · · · · · · t----t---1 

Draws square only. . . . . . . . . . . . . . . . . . . . . . D mfil .... Draws square only 

Draws rounded-comer square only ...... . 

Draws circle only ..... . ........ . .. .. .. . . 

No effect .. ..... ...................... . 

DU 

o • 
c:? u 

. ... Draws rounded-comer square only 

. . .. Draws circle only 

. ... No effect 

Draws polygon with vertical, horizontal, 
or 45-degree diagonal sides only 

CT IJX. Draws polygon with vertical, horizon-
---- · · · · tal, or 45-degree diagonal sides only 

The Shift key restricts freedom of movement for most MacPaint tools. MacDraw tools 
are similarly constrained. 

In MacPaint, you must press the Shift key before you start to use a tool or move a 
selected object, but you can release it once you begin: The Shift key's effect lasts until 
you release the mouse button. If you happen to start moving in the wrong direction, 
choose Undo and try again. 
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Customizing MacPaint's brush shapes 

Wh? could ask for more than 32 brush shapes for MacPaint's paintbrush tool? 
Anyone who wants any shape other than a square, circle, straight line, or dot, that's 
who! If you count yourself among this group, you'll be glad to learn that MacPaint's 
brush shapes are in fact part of a special "font" and, as such, they are resources that 
you can edit with Apple's resource-editor program, ResEdit (this works with version 
I.ODS, but not with versions between l.OD7 and I.OD l2). First you need to locate the 
font, as follows: 
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1. For safety, make a copy of your MacPaint disk. Experiment on the spare 
copy, never on the original. 

2. If you have only one disk drive, remove all icons except MacPaint and the 
System Folder from the disk window. Then copy ResEdit onto the disk. 

3. Start ResEdit. A small window appears for each disk currently inserted. 
Each window lists the names of all the applications and documents on that 
particular disk. For double-sided disks and other disks that use the hier­
archical file system (HFS), folders are also listed. 

4. Find MacPaint (it may be inside a folder on an HFS disk) and double click on 
it. Another small window opens, listing all of MacPaint's resources by their 
four-letter names. 

5. Find the resource named FONT and double click on it. Yet another small 
window opens, listing the names and ID numbers of the fonts contained 
in MacPaint. 

6. MacPaint should have only one font, named 12. Double click on it. A large 
font-editing window opens; you may have to drag it by its title bar to see 
all of it. 
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MacPaint's brush shapes are part of its private "font," called font 12, and you can 
edit them using the ResEdit program's font-editing features. 
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ResEdit's font-editing window has three parts. A box in the upper right corner 
displays a sample of the font. With conventional fonts, the sample is The quick brourn 
fox jumped over the lazy dog, but with MacPaint's font 12, the sample is unintelligible. 
Near the middle of the window is an enlargement of the character currently selected 
for editing. 

The selected character appears in its actual size inside a selection rectangle near 
the bottom right corner of the window. Beneath the selected character is the ASCII 
code number assigned to the character. Characters with adjacent code numbers 
flank the selected character. Character code numbers range between 0 and 256. In 
a conventional font such as Geneva, code 65 is assigned to capital A, 66 to B, and so 
on. In MacPaint's font 12, the code numbers are interpreted as tools, as cursors, and 
as brush shapes. MacPaint's brush shapes have code numbers between 120 and 15 1. 
The large black square shape (code number 120) defines the shape and size of the 
eraser tool too, so don't change it unless you want a different eraser shape. You may 
edit the tools and cursors with code numbers outside the brush-shape range, but 
doing so has no effect in most cases. 
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To change a brush shape, you select an existing shape and then edit it using 
FatBits techniques. For each brush shape you want to change, follow these steps: 

1. In the bottom right corner of the editing window, select the brush shape 
you want to change. To scroll rapid ly through the shapes, drag the selec­
tion rectangle right or left. Scroll one shape at a time by clicking beside 
the selection rectangle. 

2. In the middle of the text-editing window, edit the enlargement of the shape 
as if it were in MacPaint's FatBits. Click on a black dot to make it white and 
on a white space to make a black dot. (The maximum size of a brush shape is 
16 dots high by 16 dots wide.) At any time during the editing, you can revert 
to the last saved version of MacPaint's resources by choosing Rever t from 
ResEdit's File menu. 

3. When you have finished making changes, choose Quit from ResEdit's File 
menu. ResEdit asks if you want to save the changes you just made; click 
Yes or No. 

After quitting, you'll want to use the Finder to rename this custom version of 
MacPaint so that you don't confuse it with the regular version. 
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If none of MacPaint's 32 brush shapes is quite what yau need, create ')'ow· own using 
the ResEdit program. 
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Borderless MacPaint shapes 

To draw borderless rectangles, ovals, freehand shapes, and polygons, select 
the dotted line at the top of the line-width palette in the bottom left corner of the 
MacPaint screen. 

SeH-closing polygons and freehand shapes 

Connecting the last side of a MacPaint polygon to the starting point takes a 
sharp eye and steady hand, or some cleanup with the eraser after the fact. The same 
difficulty arises when drawing freehand shapes. MacPaint will draw the last side of 
a fi lled polygon if you double click at the end point of the next-to-last side. Likewise, 
it will close a freehand shape by drawing a straight line from the point at which 
you release the mouse button to the starting point of the shape. 

How to activate FatBits precisely 

To activate MacPaint's FatBits magnifier over a particular part of the drawing 
window, use the Command key in conjunction with the pencil tool. Simply select the 
pencil tool, press the Command key, and click on the part of the picture you want 
magnified. 

Using tools in FatBits 

Most tools function normally in FatBits. Although they are not themselves mag­
nified, their effects usually are. For example, the spray-can and paintbrush pointers 
appear in their normal size, but they paint with magnified ink. In contrast, the 
eraser not only appears unmagnified, it also erases an unmagnified swath. Watch 
the small inset window in the upper left corner of the drawing window to see the 
actual effect of the tool you're using. 

You can use the selection rectangle or Jasso in FatBits to precisely select a ver y 
small area of your picture. 

Be careful with the paint can in FatBits. If there's a gap in the boundary of a 
shape you're filling, the pattern will leak out across the entire drawing window, not 
j ust the portion currently visible in the FatBits window. You may not notice the extent 
of the damage until you've left FatBits, by which time it's too late to choose Undo. 
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Switching to the grabber 

To scroll another part of your picture into view when using MacPaint's pencil 
tool, you can switch temporarily to the grabber just by pressing the Option key. This 
technique is particularly useful with FatBits. 

Brush-mirrors symmetry 

MacPaint's brush mirrors make it easy to draw symmetrical objects. But it's hard 
to draw a symmetrical object that converges at the center unless you start on the axis 
of symmetry. Finding the axis empirically can be aggravating, but not if you take 
advantage of the Undo feature, as follows: 

1. Choose Brush Mirrors from the Goodies menu and select the brush shape 
and brush-mirror axes you want to use. Click OK. 

2. Estimate the location of the axis of symmetry in the drawing window and 
click there. If, for example, you have selected two or more axes, you must es­
timate the location of the center of the drawing window and click there. One 
or more pairs of dots appear, bracketing the axis or axes. 

3. Center the pointer by eye between all the dots. Do not click. 

4. Without moving the mouse, undo the dots by pressing Command-Z or 
the Tilde key. 

5. Hold down the mouse button and create the desired brush-mirrors pattern. 

Double-dick shortcuts in MacPaint 

By double clicking on the selection rectangle, grabber, paintbrush, pencil, eraser, 
or any pattern, you can shortcut the more time-consuming mouse actions listed here: 

Selects entire drawing windows Engages/Disengages FatBits 

Shows entire page Erases entire drawing window 

Chooses brush shape Selects (any pattern) for editing 
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Reusing the same MacDraw tool 

After you draw an object- a line, rectangle, rounded-corner rectangle, oval, 
curve, freehand shape, or polygon-MacDraw versions l. 7 and l. 9 select the 
standard arrow-shaped pointer so you can move or resize the object you drew. 
If you would rather draw another similar object, you must reselect the tool you 
used. You can either click on the tool in the tool rack in the usual way, or you can 
press the Command key and click anywhere in the drawing window. 

LINES AND CURVES 
Patterned lines 

If you press the Option key as you start to draw a line in MacPaint, the line is 
drawn in the currently selected pattern. You may release the Option key once you 
start to draw the line. T he same trick works for MacPaint's other drawing tools: the 
rectangle, rounded-corner rectangle, oval, freehand shape, and polygon. 

Dotted and dashed MacPaint lines 

The dotted line in MacPaint's line-width palette and the dashed line in 
MacDraw's Lines menu do not produce dotted and dashed lines. T hey are used 
for drawing borderless filled shapes. 

You can get dotted and dashed lines by using any of the other line widths with 
an appropriate pattern. In MacPaint, first choose the line width and pattern, and 
then hold down the Option key as you draw. In MacDraw, choose the line width 
and pattern-before or after drawing- from the Pen and Lines menus. 

T he spacing of the dots and dashes and the length of the dashes that make up 
the line depend on the pattern you choose and the angle of the line. For example, 
any pattern made up of horizontal lines produces a dotted vertical line. For a dotted 
horizontal line, you must use a pattern made up of vertical lines. 

With some patterns, the position of a line affects how it looks. To understand 
why, you need to think about how patterns are defined and used. Each pattern is 
defined by an 8- by 8-dot square. As you draw, the patterned squares are laid end to 
end like floor tiles. A line one dot wide uses Vs of each patterned square, so a single 
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pattern may produce differently patterned lines, depending on where the lines fall 
in the 8- by 8-dot square. For example, the gray diamond pattern can produce sev­
eral varieties of dotted and dashed lines or no line at all, depending on where on the 
screen you draw them. 

• !:. ·'· !:. :. .. ·'" ,;, :. .. ·"· .7. ,,._ ·'· .7. :. .. . .. -........................................ -.... .. 
Dotted and dashed lines can be produced by using an appr<tpriate line width and pat­
tern. The same pattern produces differently jJaUerned lines, depending on the angl.e 

and location of the line. 

When you need smooth MacPaint curves 

For a smooth curve in MacPaint, you can lasso part of a circle or oval and drag 
it into position. 

PATTERNS AND FILLING 
Using transparent (watercolor) paint 

MacPaint normally draws and fills with opaque paint that covers objects under­
neath. If you hold down the Command key as you draw, MacPaint uses transparent 
paint that blends with objects underneath like a watercolor wash. The Command key 
has this effect on the paintbrush and spray can, on patterns inside filled shapes, and 
when you hold down the Option key, on lines and shape borders, too. The Com­
mand key does not affect the paint can. 

Screening with MacPaint patterns 

It's impossible to produce a true gray color on the Macintosh screen, but you can 
simulate shades of gray with a technique used in the publishing industry. Black-and­
white books and newspapers often contain photographs and other illustrations that 
seem to have been printed in shades of gray. To get the apparent gray tones, the 
printing trade photographs the original illustration through a mesh screen, breaking 
the continuous gray color into a pattern of closely spaced black dots on a white back­
ground. Where the dots are large, the image looks dark gray, and where the dots are 
small, the image looks light gray. The result is called a halftone. Dot spacing in a 
normal halftone screen is regular, but other screens can be used for special effects. 
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Half tone variations rendered &y the folluwing specwl-effect screens (clockwise [ram 
top l.eft): lwriumtal line, nonnal halftone, mezzotint, and randmn line. 

If you are willing to give up detail for startling results, you can get the effect 
of special halftone screens with MacPaint patterns. Here's how: 

1. Use the selection rectangle to select the object to be screened and choose 
Invert from the Edit menu. 

2. Select the filled-rectangle tool, the no-border line width, and the pattern 
you want to use for screening. 

3. Hold down the Command key and draw a rectangle on top of the in­
verted object. 

4. Select the inverted, screened object with the selection rectangle and choose 
Invert from the Edit menu. 
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1) 

3) 
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2) 

4) 

For special-effect screens in MacPaint, invert an object, draw over it with transparent 
paint, and invert it again. 
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Saving custom MacPaint patterns 

Spend as long as you like creating a custom MacPaint pattern palette. You won't 
lose it when you quit if you save the current document before quitting. MacPaint 
saves the current pattern palette along with the current document, and uses that 
palette when you open the same document later. 

You can use this feature to override MacPaint's standard selection of patterns. 
Simply save your custom pattern palette with a blank document and open that docu­
ment instead of choosing New when you want to start a new picture. Use Save As, 
not Save, the first time you save your picture, to give the document its own name. 
Otherwise the document containing the picture replaces the blank document. 

Picking up MacPaint patterns 

Instead of recreating dot by dot a custom pattern that appears in the drawing 
window but not in the pattern palette at the bottom of the screen, you can copy the 
pattern from the drawing window to the pattern palette. Here are the step-by-step 
instructions: 

l. Use the grabber tool or Show Page command to manuever the drawing so 
that the pattern you want to put in the palette appears in the right half or 
bottom third of the drawing window. 

2. In the palette, double click the pattern swatch you want to replace with the 
pattern from the drawing window. A pattern-editing window appears. 

3. Point at the pattern you want to copy from the drawing window and click 
the mouse button. The center of the arrow, not the tip, determines which 
pattern is picked up. 

4. Click OK to install the pattern in the palette. 
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You can copy a pattern from the drawing window lo the pattern-editing window by 
pointing at it and clicking. 

Transferring patterns between MacPaint drawings 

Using the pattern-pickup technique described in "Picking up MacPaint pat­
terns," you can replace a pattern in one picture's pattern palette with a custom 
pattern from another picture. Follow these steps: 
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1. Open the document that contains the pattern you want to copy, and find or 
create a swatch of the pattern in the drawing window. 

2. Copy part of the pattern from the drawing window to the Clipboard and 
close the drawing window. 

3. Open the destination document, locate an empty spot in it, and paste the im­
ported pattern swatch there. For best results, the pattern should be in the 
right side or bottom of the drawing window. 

4. Activate the pattern-editing window by double clicking on the pattern you 
want to replace in the pattern palette, then pick up the imported pattern by 
clicking on it in the drawing window. 
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If you want to copy several patterns from the same document, maneuver them 
into a group and copy the whole group to the Clipboard in step 2. (Don't worry 
about clobbering the picture; remember you can always choose not to save these 
changes when you close the document.) When you paste into the destination docu­
ment, the whole group of patterns appears in the drawing window. Repeat step 4 

for each pattern you want to pick up. 

Creating a MacPaint pattern library 

Copying a pattern from one MacPaint picture to another is easy, but finding a 
particular pattern is difficult unless you know where to look. To reduce the con­
fusion, create a pattern library in the Scrapbook or a MacPaint document dedicated 
to that purpose. Each time you create a custom pattern, copy a small swatch of it to 
the Scrapbook or your pattern-library document. If the library document fills up, 
start another. When you need to copy a pattern, you need to search only through 
your library, not through every document you've ever created (and bothered to save). 

LaserWriter gray tones 

Since the Mac cannot display true shades of gray, it must fake them with patterns 
of black and white dots. The illusion of middle gray tones on the screen is fairly con­
vincing, but light and dark grays are less so. To fool the eye, dot distribution must be 
smooth, but a few coarse dots sparsely sprinkled on a contrasting background on the 
Mac screen can only approximate light and dark shades of gray. 

Much smoother dot distribution is possible on the Laser Writer, where dots are 
one-quarter the size of screen dots. As a result, gray patterns from MacDraw's Fill 
and Pen menus look different displayed on the screen than printed on the Laser­
Writer. The transition from one shade of gray to the next is much subtler on the 
Laser Writer, giving you smoother shading but also making patterns on things like 
graphs less distinguishable. These effects are also apparent in other applications 
that produce MacDraw-type drawings, such as Microsoft's Chart and Excel. 

With MacPaint, the gray patterns you use in a picture do not change when you 
print them on a Laser Writer. When you draw or paint with patterns in MacPaint, 
they become an inseparable part of the overall picture. The Laser Writer sees the 
whole MacPaint picture as one unit, and cannot treat selected parts of it in any 
special manner. 
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Filling around an object 

Filling inside an object is easy: Use the paint can in MacPaint and the Fill menu 
in MacDraw. Filling around an object isn't much harder. Here's the procedure: 

1. ln MacPaint, you must select the object with the lasso and copy it to the Clip­
board. T his step is unnecessary in MacDraw. 

2. Next, draw a filled object the size and shape you want the background 
around the object to be. The filled object obscures the original object. If 
you want the surrounding area to be borderless, choose either the dotted 
line in MacPaint's border-width palette or the dashed line in MacDraw's 
Line menu. 

3. ln MacPaint, paste the original object on top of the one you just drew. ln 
MacDraw, choose Send to Back from the Arrange menu. 

Customizing MacDraw patterns 

ln MacDraw, you have 36 patterns available in the Pen and Fill menus for draw­
ing or fi lling objects. MacDraw versions l. 7 and 1.9 do not let you customize the 
patterns available in these menus. However, since MacDraw's patterns are resources, 
you can edit them with Apple's resource-editor program, ResEdit (version l.OD5 or 
above), as follows: 

188 

1. For safety, make a copy of your MacDraw disk. Experiment on the copy, 
never on the original. 

2. If you have only one disk drive, remove all icons except MacDraw and the 
System Folder from the MacDraw disk window. Then copy ResEdit onto 
the disk. 

3. Start ResEdit. A small window appears for each disk currently inserted. 
Each disk window lists the names of all the applications and documents on 
that particular disk. For double-sided disks and other disks that use the 
hierarchical file system (HFS), folders are also listed. 

4. Find MacDraw (it may be inside a folder on an HFS disk) and double click on 
it. Another small window opens, listing all of the resources in MacDraw by 
their four-letter names. 
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5. Find the resource named PAT# in the MacDraw window and double click on 
it. A small window titled Pattern Lists opens, showing a dozen of the patterns 
contained in MacDraw. 

6. Double click anywhere on the patterns. A small pattern-editing window 
opens. At the bottom of the editing window are three patterns. The one 
currently selected for editing has a selection rectangle around it. A larger 
sample of the selected pattern appears in the upper right part of the win­
dow, and an enlargement of the pattern appears in the upper left 
corner of the window. 

7. Select the pattern you want to change. You can scroll rapidly through the 
patterns by dragging the selection rectangle right or left, or you can scroll 
one pattern at a time by clicking beside the selection rectangle. 
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The pauerns in MacDraw's Fill and Pen menus are resources tlwt you can edit using 
the ResEdit program's paUern-editingfeatures. 

189 



Mac Insights 

8. Edit the enlargement of the selected pattern as if it were in MacPaint's 
pattern-editing window. Click on a black dot to make it white, and click on a 
white space to make a black dot. You cannot make a pattern larger than eight 
dots high by eight dots wide. At any time during editing, you can revert to 
the last saved version of the MacDraw resources by choosing Revert from 
ResEdit's File menu. 

9. When you have finished making changes, choose Quit from ResEdit's File 
menu. Res Edit asks if you want to save the changes you just made; click 
Yes or No. 

10. After quitting, you'll want to use the Finder to rename the custom version of 
MacDraw to distinguish it from the regular version. 

If none of MacDraw's 36 patterns i5 quite what )'OU want, create your own using 
the ResEdit program. 

T he changes you make to MacDraw patterns affect both new and old docu­
ments, occurring retroactively in old documents when you open them . The changes 
are not permanent, however. You can always re-edit the patterns with ResEdit, or 
reopen old documents with a version of MacDraw that has different patterns. 
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SHADOWS 
Using Trace Edges for shading in MacPaint 

Ordinarily, MacPaint's Trace Edges command (from the Edit menu) outlines 
everything you select with the selection rectangle. If you press the Shift key as you 
choose Trace Edges, or press Command-Shift-£, you get an outline with a shadow 
on the right and bottom edges. The difference between using Trace Edges with the 
Shift key and using it without is similar to the difference between the outline and 
shadow text styles. 

Making shadows 

You can add a shadow to any object in a MacPaint picture by using the lasso and 
the Edit menu, as follows: 

l. Lasso the object and choose Copy from the Edit menu, putting a copy of the 
object on the Clipboard. 

2. With the object still lassoed, select a dark pattern for the shadow from the 
pattern palette and choose Fill from the Edit menu. 

3. Choose Paste from the Edit menu to get a copy of the original object from 
the Clipboard. 

4. Drag the copy of the original object over the fi lled object, leaving just a 
shadow showing on two adjacent sides. 

In MacDraw, you can use a similar technique, except that you don't need to use 
the Clipboard: 

1. Select the object and choose Duplicate from the Edit menu. 

2. Choose a dark pattern for the shadow from the Fill menu. 
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3. Choose Send to Back from the Arrange menu. 

4. If necessary, select the original object and choose a nontransparent pattern 
from the Fill menu. 

It is easy to add shadows in MacPaint or MacDraw. 

LABELS AND OTHER 
LETTERING 

Civilizing MacPaint typing with Note Pad 

MacPaint was never meant to be a word processor, but at times you will want to 
include text in a picture. Since MacPaint has no word-wrap feature, you must keep 
your eye on the screen as you type and press the Return key when the line you're 
typing gets too long. Editing is simple, but tedious, consisting of backspacing and 
retyping. The Note Pad desk accessory is much more civilized, so why not type 
and edit small amounts of text there, copy the finished text to the Clipboard, and 
paste it into MacPaint? Be sure to copy from the Note Pad, not cut, so that if neces­
sary you can go back to the Note Pad, edit the text, and paste it again into MacPaint. 

Changing the style of text copied to MacPaint 

If you copy a text selection from the Note Pad, MacWrite, Microsoft Word, or 
another word processor onto the Clipboard and then paste it into MacPaint, the text 
arrives in MacPaint's standard font, style, and size. While the transplanted text is still 
selected, you can easily change any of those text attributes. Simply choose the attri­
butes you want from the MacPaint menus. You can also change the text's alignment, 
using the Align Left, Align Center, and Align Right commands in the Style menu. 
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The dimensions of the selection rectangle into which you paste the text from the 
Clipboard determine the left, right, top, and bottom margins for the text. When you 
change the font size or reshape the selection rectangle, the lines of text are reformed 
automatically to fit within the left and right borders of the selection rectangle. If 
there is too much text to fi t in the rectangle, the excess is chopped off at the bottom, 
though you can retrieve it by choosing a smaller font size or by stretching the selec­
tion rectangle. 

There are limitations to the formatting you can do in MacPaint, however. Since 
the text attributes you choose in MacPaint affect all the selected text, you can't mix 
fonts, sizes, and styles in the same selection. Also, it is difficult to duplicate the mar­
gins, indentation, and tab formatting of a full-fledged word-processing program by 
adjusting the size of the selection rectangle. 

When you want more style ... 

You can use the Mac's screen snapshot feature to import elaborately formatted 
text into MacPaint from a word processor such as MacWrite or Microsoft Word with­
out losing the formatting. The text must be copied one screenful at a time and 
cannot be changed in MacPaint. Here are the steps: 

I. Open the word-processing document, scroll the formatted text you want 
to copy into view, and press Command-Shift-3 to take a snapshot of the 
screen. The snapshot is saved as a MacPaint document on the same disk 
as the application program (MacWrite or Microsoft Word) under the 
name Screen 0. 

2. Quit the word-processing program. Start up MacPaint, select the text you 
need from the Screen 0 document, cut the selection to the Clipboard, and 
paste it into the final MacPaint document. 

If the formatted text is too long to fit on a single screen, you can scroll the next 
piece of text into view and take another snapshot. When you press Command-Shift-3 
again, another MacPaint document, named Screen 1, is recorded. You can take up 
to ten snapshots, named Screen 0 through Screen 9, at a time. A beep when you press 
Command-Shift-3 means the disk is too full to record another snapshot. 
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Mixing MacPaint text attributes 

ls there an easy way to mix text attributes in MacPaint? If you make changes to 
the font, size, or style of a piece of text, all the text is affected. You cannot selectively 
change the style of just a portion of the text. Clicking another insertion point does 
allow you to change text attributes without affecting the text you've already typed, 
but it's hard to properly align the insertion point with existing text. Using MacPaint's 
grid feature helps you position it on the same line, but doesn't help you as far as even 
spacing between words is concerned. 

The answer is to press the Enter key before choosing a different font, size, or 
style. Attributes of previously typed text are unchanged, but any new text you type 
has the new attributes and is perfectly aligned with text you were typing when you 
pressed Enter. You can press Enter as many times as you like while typing a text pas­
sage. However, be aware that you can only backspace as far as the last place where 
you pressed Enter. 

Typing text over patterns in MacPaint 

Typing directly over a patterned area of a MacPaint picture leaves a white 
border around the text. To eliminate the surrounding white space, type the text in 
a vacant area of the picture, Jasso it, and drag it over the patterned area. If the 
patterned area is dark, type the text in outline or shadow style to make it stand out 
more. If the patterned area or the text is especially large, you may have to type the 
text in a remote part of the picture (or even a scratch picture), then lasso it, cut it 
to the Clipboard, and finally paste it into place over the patterned area. 

As you drag the text over the patterned area, you'll notice that the hollow parts 
of letters such as 0 and e are filled with white. You can fill those voids with the paint 
can; FatBits may be helpful in this endeavor. 

Creating compact shadow and outline text 

If you want a more compact outline-style text than you can obtain with Mac­
Paint's regular Outline option (from the Style menu), select plain text with the 
selection rectangle and use the Trace Edges command. If you hold down the Shift 
key while you choose Trace Edges, or press Shift-Command-£, you get a compact 
shadow-style text. 

194 



Graphics 

Normal: Lafayette, we are here. 

MacPaint's Trace &lges command yields compact outline- andshadaw-styl.e text. 

Ultrabold 

Many commercial typefaces come in an "ultrabold" or "heavy bold" weight that 
is even larger than the regular bold available on the Mac. You can create ultrabold 
lettering in MacPaint as follows: 

I. Choose Outline, and optionally Bold, from MacPaint's Style menu before 
you type the text. 

2. After typing, use the paint can to fill the hollow letters with black or a 
dark pattern. For small sizes and ita lics, you may have to do the filling 
in FatBits. 

3. Use the pencil in FatBits to clean up the notches in letters such as a, e, h, i, n, 
r, s, and T. 

New York Globe 

New York Globe 
U ltrabold style can be simulated in MacPaint by filling outline-styl.e letters with the 

paint can and loudzing up in Fa/Bits. 
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Patterned MacPaint text 

0fle way of creating fancy titles in a MacPaint document is to change ordinary 
black text into patterned text. Just lasso the text, click the pattern you want in the 
pattern palette, and choose Fill from the Edit menu. 

White text 

Two of the Mac's text styles, outline and shadow, allow you to create white text 
against a black or patterned background. The procedure is similar in MacPaint 
and MacDraw: 

0 In MacPaint, choose Outline or Shadow, and optionally Bold, from the Style 
menu and type the text. Then lasso the text and drag it over the patterned 
background. Or draw an unfilled shape around the text and, using the paint 
can, fill it with any pattern. 

0 In MacDraw, type the text (or select some existing text) and choose Outline 
or Shadow, and optionally Bold , from the Style menu. Then choose a back­
ground pattern from the Fill menu. Or drag the text over a patterned object 
and, if necessary, choose Bring to Front from the Arrange menu. 

Mixing MacDraw text attributes 

MacDraw treats text typed together as a single object that must have the same 
font, size, and style attributes. If you want some parts to have different attributes, 
you must type them separately, choose their attributes, and position them over gaps 
you have left in the main text. 

As you get each insert positioned correctly, group it together with the main text. 
To do that, hold down the Shift key while you click on the main text and the insert, 
thereby selecting both, and then choose Group from the Arrange menu. When you 
finish, you'll be able to move the group of text pieces as a single object, without dis­
turbing the relative positions of the inserts. 
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MacDraw superscripts and subscripts 

MacDraw's Style menu does not include superscript or subscript, but you can 
fake them with the same technique just described for mixing text attributes. Use a 
small type size for the superscripted or subscripted text and, when you drag it over 
the main text, position it slightly above or below the standard line. Don't forget to 
group the superscript or subscript with the main text by selecting both and choos­
ing Group from the Arrange menu. 

Converting MacDraw captions to paragraphs 

There are two types of text in MacDraw. When you click a text insertion point 
using MacDraw's text tool, which has an I-beam-shaped pointer, and then type, you 
create caption text. Caption text appears on one line unless you start a new line by 
pressing the Return key. In contrast, when you select an object, such as a rectangle, 
and then type, you create paragraph text. Line breaks occur automatically in para­
graph text so that it fits within the imaginary rectangle that bounds the selected 
object in which you type it. 

Text pasted into a MacDraw document from another application appears 
as caption text. You can convert it, or any other caption text, to paragraph text 
as follows: 

1. Select the text tool (the I-beam-shaped pointer) by clicking on the Tin the 
tool rack at the left side of the drawing window, and then triple click any­
where on the caption to be converted. (Double clicking selects one word; 
triple clicking selects the entire caption.) 

2. Copy the caption to the Clipboard by choosing Copy from the Edit menu or 
by pressing Command-C. 

3. Draw or select a rectangle and type a few letters to be used as a disposable 
paragraph. Do not select the text tool or click the mouse button for any other 
reason before typing the temporary text. Your typing appears inside the 
rectangle as paragraph text. 

4. Select the text tool again and triple click anywhere on the temporary text 
you just typed inside the rectangle. 

5. Replace the selected temporary text with the caption text from tl1e Clip­
board by choosing Paste from the Edit menu or by pressing Command-V. 
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When MacDraw text won't align ... 

When the Align Objects command won't align caption text with other obj ects, 
it may be because there are blank spaces at the beginning of the text. To see the 
true size of a piece of caption text, select it by clicking on it with the arrow-shaped 
pointer. Remove extra blank spaces by selecting them with the text tool and then 
either choosing Clear from the Edit menu or pressing the Backspace key. 
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Text with extra blank spaces at the beginning is impossib/,e to align using the Align 
Objects command in MacDraw's Command menu. 

ERASING AND REMOVING 
Erasing with the Backspace key 

To erase an object you don't want to use again, select it and press the Backspace 
key. Backspace, like the Clear command in the Edit menu, does not put the selected 
object on the Clipboard. Thus, you can use it to erase without disturbing the 
Clipboard. 
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Detailed erasing in MacPaint 

MacPaint's paintbrush tool makes a good eraser. Just pick a pattern to match 
the background and paint over unwanted parts of a picture. For detail work, select a 
small brush shape (after choosing Brush Shape from the Goodies menu or double 
clicking on the paintbrush in the tool rack). 

Erasing lines in MacPaint 

You can erase black lines by filling them with white paint from MacPaint's 
paint can. But be ready to undo: If the lines you're erasing touch another part of 
the picture, it will be erased too! · 

Erasing with MacPaint rectangles 

Use a borderless white rectangle to erase large swaths across the MacPaint 
drawing window. As you draw the rectangle, you can adjust its size and shape with­
out permanently erasing what it covers. When its size and shape are just right, 
release the mouse button to finalize the erasure. 

Massive MacPaint erasures 

You can erase large sections of a MacPaint document from the Show Page view. 
To be safe, save your document just before erasing from Show Page. Erasures done 
in Show Page cannot be undone, and the lack of detail makes it easy to erase 
erroneously. If you save first, you can always use the Revert command to undo. 

None of the tools or menus is available in the Show Page view, but you can slide 
everything on the page to a new position. Just place the pointer outside the dotted­
line rectangle and drag. To erase, simply slide part or all of the picture off the page 
and click OK. 

Hiding objects with MacDraw masks 

T here is no way to erase part of an object in MacDraw, but you can hide part of 
one object with another. The object that does the hiding is called a mask. A mask can 
be any simple object-a rectangle, oval, freeform shape, polygon, and so on-or it 
can be a composite of several simple objects. Once a mask is in place, you should 
select it and the object it covers and then choose Group from the Arrange menu, 
so both objects will be treated as one. 
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MOVING AND COPYING 
Constraining movement 

By selecting part of a MacPaint picture with the Jasso or selection rectangle and 
then dragging it with the pointer, you can move it any direction. This freedom of 
movement is often an advantage, but not when you're trying to move one part of a 
picture parallel with another to keep the parts aligned . You can keep the parts par­
allel, however, if you constrain the movement to a horizontal or ver tical direction by 
pressing the Shift key before you start to drag the pointer. Once you start to drag, 
you can release the Shift key. You can't change direction once you start dragging, 
so be ready to undo and start over if you find yourself heading the wrong way. 

You can also constrain movement in MacDraw. If you press the Shift key after 
you start to drag an object, MacDraw keeps the object aligned with its initial loca­
tion, either on a vertical, horizontal, or 45-degree diagonal line, whichever is closer. 

Making the MacPaint pointer less obtrusive 

Does the arrow-shaped pointer get in the way when dragging a small lassoed ob­
ject in MacPaint? Once you have used the lasso to select an object inside the drawing 
window, you can place the pointer out of the way near the edge of the window and 
still drag the object wherever you need it. Try this: 
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1. After lassoing, move the lasso-shaped pointer toward the left edge of the 
window. As the pointer approaches the edge, it becomes an arrow. 

2. T he instant the pointer changes to an arrow, stop, press the mouse button, 
and drag the selection by remote control. For best results, position the 
pointer exactly over the left edge of the drawing window before you press 
the mouse button and drag. If you accidentally move the pointer too far be­
fore pressing the mouse button, the remote-control feature does not work. If 
you don't move the pointer far enough and press the mouse button while it is 
still lasso-shaped , the lassoed object is deselected. 
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Making foreground objects appear transparent 

Sometimes when you drag one object over another, you will want the back­
ground object to show through the voids in the foreground object. For example, 
the eyes on a face should show through when you give the face a pair of glasses. 

To achieve this transparency in MacPaint, you must make sure none of the voids 
in the foreground object is completely enclosed before you lasso and drag it. Other­
wise the lasso selects the voids as white spaces and they end up obscuring the 
background oqject. Proceed as follows: 

1. Create a temporary path from each void to the outside edge of the fore­
ground object. For example, you would need to cut the frames of the glasses 
before lassoing them. 

2. Drag the object into place on top of the background object. T he background 
object is able to fill the voids in the foreground object by flowing along the 
temporary paths. 

3. Touch up the foreground object to remove the temporary paths. 

MacPaint duplicates 

To make several separate and complete copies of an object in MacPaint, select 
the object, hold down the Option key, and drag away a copy. Once you have started 
dragging, you can release the Option key. When you release the mouse button, the 
copy of the object is selected instead of the original. You can make another copy by 
again holding down the Option key and dragging the selected object. 

MacPaint multiples 

In MacPaint, dragging a selected object while holding down both the Command 
and Option keys creates continuous multiple copies of the selected object. T he essen­
tial word here is continuous. If you drag the selected object slowly, each new copy 
overlaps most of the previous copy. If you drag quickly, the copies overlap less. If you 
drag erratically, you will get sporadic, out-of-sequence, chaotic fragments of the 
selection instead of multiple copies. 

The line-width palette in the lower left corner of the screen also affects the 
amount of overlap, as you can see in the following figure. Less overlap occurs if you 
select one of the thicker line widths. 
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Draggi.ng an object in MacPaint while holding d<rwn the Command and Option keys 
creales continuous multiple copies of lhe object. The speed at whidi you drag lhe object 

and the line width selected control the amount of (J(Jerlap between copies. 

Gauging movement of groups of objects in MacDraw 

If you want to drag a group of objects in MacDraw, start by pointing to the com­
ponent of the group that will best enable you to tell whether the group is correctly 
positioned in its new location. When you start to drag the group, a dotted-line rect­
angle that shows the group's overall size and location moves with the pointer. Inside 
the rectangle, an outline of the component at which you were pointing when you 
started to drag allows you to gauge how far and in which direction to move. 

If you start by pointing at a piece of text, a freehand shape, or a polygon, 
MacDraw uses a rectangle that represents its overall size and position within the 
group selection. All other components are represented by their true outlines. 

If you want to see MacDraw objects as you drag them ... 

If you want to see outlines of the MacDraw objects you are dragging, instead of 
the usual generic rectangle, hold down the Option key as you start to drag. All types 
of objects, including text, freehand shapes, and polygons, are represented by their 
true outlines. 

Holding down the Option key continuously greatly slows the speed at which 
objects move on the screen, especially when you're dragging a complex object such as 
a smoothed polygon. To speed things up, just press the Option key when you want to 
take a reading on the exact location of the object or objects you are dragging, rather 
than continuously. 
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Equally spaced MacDraw duplicates 

If you duplicate an object by choosing Duplicate from MacDraw's Edit menu or 
by pressing Command-D, MacDraw watches to see what you do next. If you move 
the copy of the object, MacDraw remembers where you moved it in relation to the 
original object. Then, if you use the Duplicate command again, MacDraw places 
the third object in the same position relative to the second object as the second 
is to the first. This makes it easy to create a series of equally spaced objects. 

To take advantage of this feature, you must create the entire series of objects 
before doing anything else. If, for example, you draw a new object or select an exist­
ing one between uses of the Duplicate command, MacDraw forgets the relative 
position of the duplicated objects and cannot guarantee that any subsequent 
duplicates will also be equally spaced. 

LAYOUT 
MacPaint's grid feature 

Ever wonder about the grid feature in MacPaint's Goodies menu? It's barely men­
tioned in the MacPaint user's manual, but it has several important uses. 

Choosing Grid from MacPaint's Goodies menu imposes an invisible grid on the 
drawing window. Pointer movement for some tools is constrained to the grid lines, as 
if the drawing window were a piece of graph paper and the pointer could only move 
along the lines or jump from line to line. The invisible grid lines are eight dots apart, 
so the pointer moves eight dots at a time instead of one, making it easy to position 
parts of a picture by eye. The grid feature only affects the following operations: 

D Selecting, dragging, and duplicating with the selection rectangle. 

D Selecting a text insertion point with the I-beam pointer. 

D Drawing straight lines. 

D Drawing rectangles, rounded-corner rectangles, ovals, and polygons 
(but not freehand shapes). 

D Dragging and duplicating an object selected by the lasso. However, the 
grid does not affect the process of selecting with the lasso. 
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Temporary alignment aids 

You can draw temporary lines and rulers to make it easier to align and space 
objects. They are especially helpful in MacPaint, which has no built-in rulers or 
alignment commands. 

Importing a ruler 

MacPaint can't help you measure parts of your picture, but you can get around 
this deficiency by temporarily importing ready-made rulers from MacDraw. To dis­
play a copy of a MacDraw ruler, do this: 

1. Start MacDraw and choose Show Rulers from the Layout menu. Change the 
ruler calibration if you like, using the Custom Ruler command in the Layout 
menu. 

2. Scroll the MacDraw window to the upper left corner and take a snapshot of 
the screen by pressing Command-Shift-3. 

3. Quit MacDraw, start MacPaint, and open the screen snapshot document, 
which is stored on the MacDraw disk under the name Screen 0. 

4. Select the ruler and cut it to the Clipboard. 

5. Paste the ruler into the Scrapbook for later use, or paste it directly into the 
MacPaint document where you need it. 

You could import MacWrite's formatting ruler in a similar manner, but there's a 
drawback to using MacWrite's rulers: An inch on the MacWrite ruler measures 1.11 

inches in MacPaint. 

Rulers and coordinates 

If you often create MacPaint pictures that need precise measurements, you'll be 
interested to know about a desk accessory called Rulers that displays rulers along the 
sides and bottom edges of the MacPaint picture window. Rulers, which is part of 
Accessory Pak I from Silicon Beach Software, offers a choice of three calibration 
scales: inches, centimeters, or pixels. A thin gray line in each ruler tracks the move­
ment of the pointer in the MacPaint drawing window, letting you know precisely 
where you are, both vertically and horizontally. 
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The same software package also includes a desk accessory called Coordinates 
that displays the location of the pointer relative to the upper left corner of the screen 
(not the upper left corner of the drawing window). The pointer 's coordinates are dis­
played at the right end of the menu bar. You can choose whether the coordinates are 
reported in inches, centimeters,or pixels. 

Centering one object on another 

The Align Objects command in MacDraw's Arrange menu makes it easy to 
center two or more objects on one another. Simply select both LI R Centers and 
T l B Centers in the Align Centers dialog box. 

In MacPaint, you can't center several objects on one another in the same opera­
tion. However, you can center them, one at a time, in the middle of the drawing 
window. If you center them in order of size, starting with the largest, they will be 
coincidentally centered on each other. 

To center an object in the drawing window, select it with the lasso, cut it, and 
immediately paste it. 

Adjusting MacDraw's grid spacing 

MacDraw's invisible grid makes it relatively easy to control the size and position 
of objects as you draw them, but if the grid lines are too widely spaced, you may not 
be able to accurately size and place objects. If this is the case, you may want to turn 
off the grid from the Layout menu or change its spacing. 

The spacing of MacDraw's grid lines is determined by the number of minor divi­
sions selected in the Custom Rulers dialog box. The more divisions, the less distance 
between the invisible grid lines. Initially, there are eight minor divisions, making the 
invisible grid lines Vs inch apart. Follow these steps to change the spacing: 

l. Choose Custom Rulers from the Layout menu. 

2. In the dialog box that appears, select the Custom option. The dialog box ex­
pands, revealing more settings. 

3. Select the number of minor divisions you want and click OK. 

Note that the MacDraw rulers might not show all the minor divisions you select. 
For example, if you set grid-line spacing at V32 inch, the rulers show minor divisions 
only ever y V.6 inch. T he finer grid lines are there, even though they're not marked 
on the rulers. 
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Finding a lost MacDraw object 

Have you ever lost an object in MacDraw? Here are three ways to find a small 
object that is hidden behind a larger object: 

0 Select the object you can see and choose the None pattern from the 
Fill menu. 

0 Select the object you can see and choose Send to Back from the 
Arrange menu. 

0 Drag the object you can see off to the side. 

MacDraw alignment rules 

Ever wonder how MacDraw decides where to align objects when you use the 
Align Objects command? Here is a list of its rules: 

Option 
Left Sides 

Right Sides 
Tops 

Bottoms 
UR Centers 
T/B Centers 

Aligns with 
Left edge of leftmost object 

Right edge of rightmost object 
Top edge of topmost object 

Bottom edge of bottom-most object 
Halfway between leftmost and rightmost objects 

Halfway between topmost and bottom-most objects 

Aligning large MacDraw objects 

To align objects that are too large to all fit in a MacDraw window at once, use a 
reduced view, as follows: 

1. Choose Reduce or Reduce to Fit from the Layout menu. 

2. Select the objects and then choose Align Objects from the Arrange menu. 
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RESIZING 
New size and shape in MacPaint 

You can stretch or shrink everything inside MacPaint's selection rectangle by 
dragging on or inside the flashing edge of the rectangle while holding down the 
Command key. To resize horizontally, drag from a side edge. To resize vertically, 
drag from the top or bottom edge. To resize both horizontally and vertically, drag 
from a corner. There will be some distortion of lines and patterns inside a resized 
selection rectangle, so be ready to undo should you dislike the results. 

New size, same shape in MacPaint 

You can keep the ratio of height to width constant while you stretch or shrink a 
MacPaint selection rectangle. Just hold down the Command and Shift keys as you 
start to drag a corner of the selection rectangle. 

Using the three-finger stretch in MacPaint 

It's possible to stretch just the middle of an object in MacPaint, so that the two 
opposite ends of the object are unchanged and parallel lines connect them. For ex­
ample, a circle can be widened into a shape that has semicircular sides and straight 
top and bottom edges. Here's the general procedure: 

1. Use the selection rectangle to select one end of the object: the left end 
if you want to stretch horizontally to the left, the top end if you want to 
stretch vertically upward, and so on. 

2. Holding down the Command, Option, and Shift keys, drag the selection 
rectangle slowly in the direction of the stretch. As you drag, parallel lines 
appear in the wake of the selection rectangle. 

If you drag too quickly, the parallel lines may be jagged. In that case, drag slowly 
back in the other d irection, far enough to clean up the jaggedness, and then drag 
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ahead again. This method has been dubbed the "three-finger stretch" by MacPaint's 
creator, Bill Atkinson. 

0 
(~ __ [) 

--rt 

In MacPaint, you can wUlen or heighten an object by se/,ecting one sUle and using the 
"three-finger stretch" (dragging whi/,e lw/,ding down Control-Option-Shift). 

Combining the MacPaint grid with the three-finger stretch 

Results of the three-finger stretch are unsatisfactory with patterned objects, 
because the pattern is disrupted . To maintain the pattern, make sure Grid is 
checked in MacPaint's Goodies menu. 

To retain pattern unifomzity in a stretched MacPaint object, choose Grid from 
the Goodies menu, se/,ect one end of the object, ho/,d down Command-Option-Shift, 

and then drag 

Automatically resizing while pasting in MacPaint 

You can preset the size, shape, and location of an object you plan to paste into 
a MacPaint picture from the Clipboard. Before using the Paste command, draw a 

· selection rectangle the size and shape you want the imported object to have and put 
the selection rectangle where you want the object to be. When you paste, MacPaint 
automatically resizes the contents of the Clipboard to fit within the selection 
rectangle. 
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Shrinking full-page MacPaint pictures 

By applying the Mac's built-in screen-snapshot feature to MacPaint's Show Page 
view, you can reduce an 8- by 10-inch picture to 2% by 3Y3 inches. Since the Show 
Page view compresses most of the detail out of a picture, this technique works best 
with large, simple drawings. To try out this technique, follow these steps: 

1. Switch to the Show Page view by double clicking on the grabber or by 
choosing Show Page from the Goodies menu. 

2. Drag the dotted-line rectangle in the Show Page view out of the way 
as much as possible and take a snapshot of the screen by pressing 
Command-Shift-3. The snapshot is saved on the MacPaint disk. 

3. Cancel the Show Page view, close the picture window, and open the screen­
snapshot document. 

4. Find the reduced image of your full-page picture and touch it up as needed. 

5. Select the reduced image with the lasso or selection rectangle and copy it to 
the Clipboard. 

6. Close the drawing window, open the document into which you want to copy 
the reduced image, and paste. 

s rile Edit Goodies Font FontSize 

Use MacPaint's Show Page view to reduce an image by about 3 3 percent. 
Then capture the reductwn using the Mac's screen-snapshot feature and touch 

it up in MacPaint. 
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Expanding drawing-window pictures to full-page 

MacPaint's drawing window shows less than a third of the available drawing page. 
With moderate effort, you can enlarge a MacPaint picture from drawing-window 
size to full-page size. You work with the original picture a third at a time, from left 
to right, as follows: 
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1. Using the selection rectangle, select a third of the drawing window. For best 
results, the selection should be the full height of the drawing window and ex­
actly one-third its width. The drawing window is 415 dots (5% 
inches) wide, so the selection should be 138 dots ( 115/ 15 inches) wide. (For help 
measuring in MacPaint, use the Rulers desk accessory, which is part of 
Accessory Pak I from Silicon Beach Software.) 

2. Drag the selection to the middle of the screen. Because the drawing window 
is oriented horizontally and full pages are oriented vertically, choose Rotate 
from the Edit menu. 

s File Edit Goodies Font FontSlze Style 
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To enlarge a picture in MacPaint's drawing window to full-page siu,.first cul it 
verticaJ1y into thirds, then rotate each third, and save each third in the Scrapbook. 
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3. Cut the rotated selection to the Clipboard and then paste the clipping into 
the Scrapbook. 

4. Repeat steps 1 through 3 for the remaining two thirds of the picture. 

5. In the Show Page view, press the Shift key and drag the dotted-line 
rectangle to the top of the page. Click OK to return to the regular 
drawing window. 

6. From the Scrapbook, cut the third of the original picture that was at the 
right side of the drawing window. 

7. Select the entire drawing window by double clicking the selection rect­
angle tool in the tool rack to the left of the drawing window, then paste. 
MacPaint automatically resizes the clipping to fit the large selection 
rectangle. 

8. Repeat steps 5 through 7 pasting the middle and left thirds of the original 
picture into the middle and bottom thirds of the page, respectively. Be 
sure to use the Shift key to prevent horizontal movement as you scroll the 
dotted-line rectangle vertically to a new position on the page. If necessary, 
you can use the grabber tool to precisely position the regular drawing 
window before selecting the entire window in step 7. 

After pasting the pieces into position, you should save your work. Use the Save 
As command to save it under a different name. Then check for gaps between the 
middle third and the top and bottom thirds. Eliminate any gaps by lassoing the top 
and bottom thirds and dragging them toward the middle. If necessary, touch up 
jagged lines and blotchy patterns using any of MacPaint's tools and commands. 
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To finish enlarging a picture from drawing-wirul(!W size to full-page size, paste each 
rotated third of the original picture into a third of the page. MacPaint will resize 

each segment automatically. 
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Enhancing MacPaint enlargements 

The enlargements you produce in MacPaint by dragging a selection rectangle 
while pressing the Command key are pretty crude. You can touch them up with the 
paintbrush and other tools, but there is a more mechanical approach that yields 
good results with proportional enlargements that are some exact multiple-two, 
three, four, and so on-of the original. First you make the crude enlargement and 
then you thin its blocky texture, as follows: 

I. Create a gauge for enlargement by arranging copies of the original side by 
side. For example, to triple the size of the object, arrange three copies of the 
original next to each other. 

2. Select the leftmost original with the selection rectangle and proportion­
ally enlarge it by pressing the Command and Shift keys as you start to drag 
the lower right corner. Continue to drag until the enlargement covers the 
rightmost copy of the original. The large, blocky dots in the enlargement 
should be uniform in size. 

3. Start thinning by inverting the crude enlargement with the Invert 
command from the Edit menu. This yields a negative image of the crude 
enlargement. 

4. Using a borderless filled rectangle with the third pattern from the left in the 
top row of the standard pattern palette, hold down the Command key and 
draw a transparent screen over the entire negative image. 

5. Invert the negative image to get a light positive image. Save your work now 
so you can revert to this point later. 

6. Now darken the light positive image by lassoing it, holding down the 
Option key, and dragging a copy one or two dots away. Release the mouse 
button without moving the mouse. 
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7. The light positive image is still selected. Darken it still more by holding 
down the Option key again and dragging another copy of the image a dot 
or two in another direction. Release the mouse button without moving 
the mouse. 

8. Repeat step 7 until you get the look you want. You'll have to experiment. If 
you completely clobber the enlargement, the File menu's Revert command 
lets you go back to the single light positive image you saved in step 5, so you 
can begin darkening anew. 

MacPaint'.s coarse enlargemenls can be enhanced without a lot of freehand touclzup 
work, providing a smoother transition from blaclt to white. (Eyes &y Mark Stephen 
Pierce. Reproduced by permission from Art Crabber and Body Shop [Cam&ridge, 

MA: SPINNAKER Software Corp., 1986], Female Disguise Kit.) 

Easy MacPaint enlargements 

While it's possible to enlarge part of a MacPaint picture using MacPaint tools 
and commands, it's not always easy and the results can be somewhat crude. Another 
program, PaintMover by Bill Atkinson, can enlarge part of a MacPaint picture from 
I to 16 times. The maximum size of the enlargement is 8 by I 0 inches, the same as a 
standard MacPaint document, and PaintMover restricts the size of the area being 
enlarged according to the magnification factor, so you know how large an area will 
fit on the 8- by IO-inch page. It optionally thins, smooths, or both thins and smooths 
the enlargement for better-looking results. 
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Creating jumbo MacDraw pictures with MacPaint components 

Many individual MacPaint documents can be copied and pasted into one 
MacDraw document, creating one large picture. MacDraw can print the large pic­
ture full-size or half-size, using as many sheets of paper as necessary. You then tape 
together the sheets of paper to form the whole picture. 

Each MacPaint picture must be transferred to the composite MacDraw docu­
ment via the Clipboard. MacPaint's small drawing window forces you to chop each 
picture into as many as six pieces. Copying and pasting each piece separately takes 
forever unless you use the Switcher to switch between MacPaint and MacDraw. An 
alternative method is to copy all the pieces from the MacPaint picture to the Scrap­
book, then copy the Scrapbook file, which is inside the System Folder, from the 
MacPaint disk to the MacDraw disk, and finally copy and paste the pieces from 
the Scrapbook to the MacDraw document. 

Copying MacPaint pictures into MacDraw is much easier with the QuickPaint 
desk accessory from EnterSet, which allows you to copy fairly large pieces of any 
MacPaint document without quitting MacDraw. For the most efficient copying of 
full-width or full-height MacPaint pictures-up to 8 by 10 inches-use the Art 
Grabber desk accessory from SPINNAKER Software, or use the Paint Cutter 
program, which is part of Accessory Pak I from Silicon Beach , preferably with 
the Switcher. 

You should paste the MacPaint pictures into MacDraw beginning with the top 
left section of the composite picture. MacDraw initially positions all pasted objects in 
the middle of the drawing window, but you can move them to align them properly. 
Before attempting to align objects, choose Turn Grid Off from the Layout menu, so 
the objects will not be forced to move in Vs-inch increments. 

Use the scroll bars to bring additional MacDraw document space into view in the 
drawing window. If you scroll to the right or bottom edge of the document and still 
need more space, choose Picture Size from MacDraw's Layout menu to enlarge the 
document. 

Resizing or moving? 

When moving, stretching, or shrinking a line or other object that extends out of 
the MacDraw window, it's difficult to tell whether you're changing its size or moving 
it. Choose Show Size from the Layout menu and watch the numbers as you manipu­
late the line. If they change, you're resizing the line, not moving it. 

215 



Mac Insights 

Precise enlargement and reduction 

Scaling an object in MacDraw is easy, if you take advantage of the Show Size 
feature and use a temporary I-inch square as a gauge. You can get reductions and 
enlargements accurate to the nearest whole percent or so by following these steps: 

I. Choose Show Size from the Layout menu. 

2. Draw a I-inch square near the object to be scaled. Use the dimensions pro­
vided by the Show Size command to tell when the square is exactly 1 inch 
high and wide. 

3. Select both the square and the object to be scaled . 

4. Scale the square, and the other object along with it, by dragging one of the 
square's corner handles. Watch the square's dimensions as you drag. Stop 
dragging when both the height and width correspond to the percentage 
reduction or enlargement you want to obtain; for example, 0.50 for a 
50 percent reduction or 2.00 for a 200 percent enlargement. 

5. Cancel the current selection by clicking in any vacant area of the drawing 
window, then select the square and press the Backspace key to erase it. 

CONSTRUCTING OBJECTS 
Equilateral triangles 

The following method for constructing an equilateral triangle in MacPaint 
makes use of three equal circles: 
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I. Draw a small circle and put a dot at its center. For best results, draw the circle 
with the grid feature activated and make the circle an even number of grid 
units in diameter. 

2. Lasso the circle, hold down the Option and Shift keys, and drag a copy of the 
circle to one side so that it just touches the original circle. 

3. With the duplicate circle still lassoed, hold down the Option key (but not 
the Shift key) and drag a copy of the circle to where it just touches the other 
two circles. 

4. Erase the circles, leaving the center dots. Connect the dots using the polygon 
tool. T he resulting triangle is equilateral. 
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You can construct an equil.ateral triangl.e in MacPaint by connecting the centers of 
three equal circl.es, each of which just tmu:hes the other two. 

If the triangle you construct is too large, just draw a horizontal line above the 
existing base and erase whatever you don't need . If the triangle is too small, extend 
the sides, add another base below the existing one, and then erase the existing base. 
You could use the selection rectangle and, holding down the Command and Shift 
keys, drag the triangle to another size, but doing that distorts the lines that make 
up the sides of the triangle. 

Concentric shapes 

You can construct a series of equally spaced concentric circles, squares, ovals, or 
rectangles without measuring. Here are the instructions for drawing equally spaced 
concentric circles in MacPaint: 

1. Draw a 45-degree line across the window (hold down the Shift key as you 
star t to draw). 

2. At the top of the diagonal line, draw two short horizontal lines to mark off 
the distance you want between two circles. 
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3. Lasso the segment of the diagonal line that contains the two marks, including 
the marks in the selection. 

4. Hold down the Option key, drag away a copy of the selected segment, 
and place the copy on the diagonal line so that the upper mark on the 
copy coincides with the lowest mark on the original. 

5. Repeat step 4 until the entire diagonal line has been marked off. 

6. Lasso the diagonal line with its marks, and choose Copy from the Edit menu 
to put a copy of the diagonal line on the Clipboard. You will use the copy to 
erase the original after drawing the circles. 

7. Draw the circles, starting and ending them only where a mark crosses the di­
agonal line. The circles themselves do not cross at the marks, but the invisible 
squares that bound them do. 

8. Erase the diagonal line and the horizontal marks. Tq erase with the copy of 
the diagonal line from the Clipboard, choose Paste from the Edit menu and 
drag the copy that appears exactly over the original diagonal line. While the 
copy is still selected, choose Invert from the Edit menu. Then click the 
mouse button anywhere, and the line is gone. 

You can draw squares in step 7 instead of circles. If you want ovals or rectangles, 
draw the diagonal line in step I on some angle other than 45 degrees. 
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Using a diagonal line as a guide, you can draw equally sj1aced concentric circles, 
squares, avals, and reel.angles. The same basic metlwd W<Jrks in MacPaint 

and MacDraw. 
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A similar method works in MacDraw. The only variation is in the way the diago­
nal line and the horizontal marks are constructed and erased: 

1. Draw a 45-degree line across the window (hold down the Shift key as you 
start to draw). 

2. Draw a horizontal line across the top of the diagonal line. 

3. Duplicate the horizontal line and drag the copy down the diagonal line 
to mark the distance you want between circles. 

4. Duplicate again and again, until the entire diagonal line is marked off. 
MacDraw makes duplicates on a 45-degree line best with the grid on 
(use the Layout menu) at two times the grid interval. Otherwise you may 
have to drag the duplicates left or right until they cross the diagonal line. 

5. Select all the lines, including the diagonal, by holding down the Shift key as 
you click on each in turn. T hen choose Group from the Arrange menu so 
that all the lines will be treated as a single object. 

6. Choose the None pattern from the Fill menu and draw the circles. Start 
and end them only where a mark crosses the diagonal line. The circles 
themselves do not cross at the marks, but the invisible squares that bound 
them do. 

7. Select the group of lines and press the Backspace key to erase them. 

Symmetry 

You can draw a symmetrical object with MacPaint's paintbrush by turning on 
the brush-mirrors feature. MacDraw has no brush mirrors, but you can construct a 
symmetrical object in MacDraw as follows: 

l. Draw half of the object- left or right for horizontal symmetry, or top or 
bottom for vertical symmetry. 

2. Duplicate the half. 

3. Flip the duplicate horizontally or vertically, as appropriate, to get the 
opposite half. 

4. Put the two halves together and group them. 
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When you need symmetry on both horizontal and vertical axes, apply the 
method above to one quarter of the object to create a symmetrical half. Then apply 
the method to the symmetrical half to create a completely symmetrical whole. 

s File Edit Style Font L11yout Arr11nge Fill Lines Pen 
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With MacDraw's Duplicate and Flip commands (from the Edit and Arrange menus), 
you can easily create symmetrical objects. 

Blocking closure of a MacDraw polygon 

When you are using MacDraw's polygon tool, clicking on an existing corner or 
the starting point of the polygon normally means you've finished and want MacDraw 
to complete the polygon. If instead you want to keep drawing, hold down the Option 
key as you click on the corner or starting point. 

Creating curves from smoothed MacDraw lines 

You can take advantage of MacDraw's Smooth and Reshape commands (from 
the Edit menu) to draw curved objects. Here's how: 
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1. Start by drawing an approximation of the curved object using either the 
freehand tool or the polygon tool. If you use the polygon tool, you'll find that 
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lots of short sides and wide-angled corners produce the best approximations 
(remember the connect-the-dots drawings from childhood?). 

2. Choose Smooth from the Edit menu to smooth your rough picture. 
(Smoothing a freehand shape converts it to a smoothed polygon.) 

3. Choose Reshape Polygon from the Edit menu. MacDraw displays a handle 
(black square) at each "corner" of the smoothed shape. 

4. Drag the handles to change the object's shape. If you miss the handles and 
drag the edge of the shape, the object moves. Watch for this, since you may 
want to undo the move and try again. 

As you begin reshaping, the object is redrawn with no fill pattern so you can see 
through it (even if it had no fill pattern to begin with). This takes a few seconds, so 
be patient with your first adjustment. When you finish reshaping and click else­
where, the original fill pattern (if any) is restored. 

Designating unsmoothable MacDraw cusps 

Using MacDraw's polygon tool and Smooth command, you can create an object 
that has some smooth curves and some angular corners. You must designate the 
unsmoothable corners, called cusps, as you draw the object; you cannot conveniently 
go back and designate them once you've finished drawing. 

You designate a cusp by holding down the Option key and double clicking. 
Corners so designated will not be smoothed when you later choose Smooth from the 
Edit menu. Any corner at which you click only once, with or without the Option key, 
is not a cusp and will be smoothed. Double clicking without holding down the 
Option key ends the polygon. 

When you select a smoothed object with cusps and choose Reshape Polygon 
from the Edit menu, the cusps do not seem to have handles. Actually, each cusp has 
two handles stacked one on top of the other, making them both invisible. You can 
drag the cusp handles apart in order to turn the cusp into two smoothed corners. 
You can also drag two handles together to form a cusp, but you lose one corner 
in the process. 
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Retaining detail in smoothed MacDraw objects 

The Smooth command in MacDraw's Edit window can help get rid of unwanted 
roughness in a freehand picture. Sometimes, though, it smooths out the detail along 
with the roughness. You can retain more of the detail by smoothing after enlarging, 
as follows: 

I. Draw a small square near the object to be enlarged and select both 
the object and the square. 

2. Choose Show Size from the Layout menu so you can keep track of 
the square's size as you change it. 

3. Enlarge the square to several times its original size. 

4. Choose Smooth from the Edit menu. 

5. Reduce the square to its original size. 

Original Original after 
smoothing 

Enlarged 200 
percent, smoothed, 

and reduced 

Enlarged 300 
percent, smoothed, 

and reduced 

To retain detail in a smoothed MacDraw object, enlarge it two or three times before 
smoothing, then reduce it to its original size. 

The price you pay for smoothing 

Use MacDraw's Smooth command sparingly. Because smoothed objects take 
longer to display, they slow down scrolling of the window and are slow to move. 
Smoothed objects also use more memory than unsmoothed ones. 
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ANIMATION AND SPECIAL 
EFFECTS 

Using Undo for cheap animation 

You can get really cheap animation in MacPaint by exploiting the Undo feature. 
Using a piece of clip art, one of the pictorial fonts such as Cairo, or something you 
have drawn yourself, you create two slightly different versions of a picture. Then you 
paste one version over the other and press the Tilde key, MacPaint's "undo" key. 
Voita! The picture appears to move. Here are step-by-step instructions: 

I. Draw a picture and, to facilitate aligning it later with a second picture, 
draw a border around it at the edge of the window. 

2. Double click the selection-rectangle tool to select the entire picture, then 
copy the picture to the Clipboard. 

3. Use the Show Page view or the grabber to move to a vacant spot on the page, 
where you can draw the second picture. 

4. Create the second picture by pasting the first picture from the Clipboard 
and making minor changes to it. Save the document at this point. 

5. Paste the first picture exactly over the second and click on any tool to 
cancel the flashing selection rectangle. 

6. Hold down the Tilde key and watch your picture move. 

Change the Key Repeat Rate in the Control Panel desk accessory to slow down or 
speed up the animation. A slow rate yields the most convincing results. 
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Paste a slightly modified version of a picture over the unnwdified version and then 
hold down the Tilde key to make tire picture "move." 

Paste-anywhere animation 

You may have noticed that it takes several seconds to display complicated 
MacDraw documents. This feature of MacDraw versions I. 7 and I. 9 makes it possi­
ble for you to assemble animated drawings in MacDraw for use in the Scrapbook 
and elsewhere. Be forewarned : T his is tedious work! When you finish, you'll have 
gained a new appreciation for Walt Disney's animators. 

You start by breaking down an action into a sequence of discrete events and 
drawing a separate picture for each event. T he pictures are called frames. The 
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frames might be a sample sequence of overlapping MacDraw objects, each one 
larger than the one before. Or they might be a sequence of small objects that fit to­
gether to make a larger object. To animate detailed drawings, you can draw each 
frame as a MacPaint picture and then import the pictures into MacDraw. Or you can 
compose a frame with MacDraw's polygon tool; round corners as needed with the 
Edit menu's Smooth command. Then create a new frame with the Duplicate com­
mand, and advance the motion of arms, legs, and so on by changing the objects with 
the Edit menu's Reshape command. 

Generally, you must put a blank frame between ever y action frame; otherwise, 
each successive frame is overlaid on top of the one before it. However, you don't need 
a blank frame between action frames if the only action is growth of a nontransparent 
object, such as a rising thermometer, because in that case the growth in the second 
frame masks or adds to the condition shown in the first frame. 

The shape of the blank frames affects timing. For fastest action, use borderless 
white rectangles for the blank frames. Slow the action down by using complex bor­
derless shapes, such as polygons, instead of simple rectangles. Be careful not to make 
the blank shape too complex, or the animation will flicker. Smoothing the polygons 
yields a slow-motion effect. 

The easiest way to handle a blank frame is to group it with the action frame that 
comes before it. Before grouping them, align the blank and action frames at their 
left/right centers and along their bottoms. 

When you have paired a blank frame with every action frame that needs one, 
you are ready to stage the frames. If any of the action frames are obscured by 
blanks, you'll want to temporarily make the blanks transparent. To do that, select 
everything with the Select All command, choose None from the Fill menu, and 
choose the second line width from the Line menu. Move the frames into position 
one by one, starting with the frame you want displayed first. As you place each 
frame, use the Bring to Front command to make sure the desired frame is in 
front of all earlier frames. 

Alignment of the frames is vital for realistic animation. If all the action occurs on 
a straight line, "ground" all the frames by selecting them all and then aligning their 
bottoms. If the sequence travels across the screen, do not align their side edges or 
left/right centers. If the sequence is stationary, however, the frames must be aligned 
at their left/right centers in addition to their bottoms. 
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After aligning the frames, select them all, and choose the white pattern from 
the Fill menu and the top line width from the Lines menu. Rerun your completed se­
quence by clicking either of the scroll boxes. If you're satisfied with the performance, 
group all the frames in the sequence. If not, pull the sequence apart and correct the 
faulty frames. 

You can lengthen a performance by combining and repeating sequences. For 
example, if you have a sequence of six frames that show a dog walking % inch across 
the screen, you can lengthen the dog's trip to 6 inches by duplicating the sequence 
seven times. To repeat a sequence, duplicate all the frames in it. Arrange the dupli­
cates for continuous motion by placing each duplicate sequence a distance from the 
start of the foregoing sequence that is equal to the distance between the first and last 
frames of the original sequence. Thus, if the sequence moved % inch across the 
screen, you would position a duplicate sequence % inch from the start of the first 
frame in the sequence that precedes it. 

The animation you assemble in MacDraw can be cut and pasted any­
where MacDraw objects are allowed, including into the Scrapbook, MacWrite, 
and Microsoft Word. 
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These nine figures, drawn in MacPaint, can be assembled into an animation 

sequence in MacDraw, whidt can then be posted anywhere MacDraw objects are 
allowed. (Figures by Mark Stephen Pierce. Reproduced by permission of 

Video Works [Cambridge MA: SPINNAKER Software CorjJ., 1986}, 
Sports file on Art disk.) 
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Pattern-variation animation 

The patterns you use for shading or texture in a MacPaint picture can produce 
special effects, including animation and hidden messages. The special effects are 
achieved by drawing several objects, or several parts of one object, each in a different 
variation of a pattern . T he pattern variations all look the same against a white back­
ground, but when dragged across a certain background pattern, they alternately 
stand out or disappear. T he pattern variations are created by shifting the dots in the 
eight-by-eight pattern definition slightly in various directions. The necessary back­
ground pattern is the inverse, or negative image, of any one of the variations. 

In MacPaint, objects drawn with diff ereni variations of a pattern alternately stand 
out and disappear as they are dragged across certain background patterns. Here, 

figures are drawn in four vmiations of a standard light gray pattern ( /,eft to right): 
tlU! standard pattern, standard shifted one dot up and right, sumdard shifted one dot 
up, and standard shifted one dot dawn and right. The figures are shown against a 

background of the standard pattern inverted. 
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Not all patterns have the same number of variations. An all-black pattern has 
one variation; any way you shift it, it stays all black. At the other extreme, a pattern 
with one black dot has 64 variations, because there are 64 places to put the dot in an 
eight-dot-by-eight-dot pattern block. Regular patterns between those extremes have 
2, 4, 8, 16, or 32 variations. 

Hidden messages 

You can use pattern variation-shifting to send a hidden message. All you do is 
write the message using one variation of a pattern and camouflage it with random 
lines drawn in a different variation. Be careful not to write over the message as you 
camouflage it. The hidden message is revealed by lassoing the camouflaged version 
and dragging it over a background pattern made of any variation of the pattern. 
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A message can be camouflaged by drawing rand()m lines in a differenL variation of 
the pattern used to write the message. Lassoing and dragging the message over a 

backgr()und made of any variatian of the same pattern reveals the message. 



Spreadsheets 

Some people call them spreadsheets, some call them 
worksheets-and still others call them names! 

Whatever you call them, try the hints in this chapter 
the next time you work with a collection of 

formulas, numbers, and bits of text all arranged in 
orderly rows and columns of cells. 
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SELECTING 
Extending selection past window borders 

All spreadsheet programs let you select a block of cells by dragging the pointer 
from the cell in one corner of the block to the cell in the diagonally opposite corner. 
With most programs, you can extend the selection into an area out of view by drag­
ging the pointer into the column headings, the row headings, or one of the scroll 
bars. T he spreadsheet scrolls automatically as long as you hold down the mouse but­
ton and keep the pointer j ust outside the cell area. 

Selecting large areas 

To select a large block of cells, click the cell in one corner, scroll to the cell in 
the diagonally opposite corner, press the Shift key, and click the cell. T his method 
is faster than dragging from one corner of the block to the opposite corner. 

Selecting nonadjacent cells 

To select a group of nonadjacent cells in a Microsoft Excel or Multiplan work­
sheet, press the Command key as you click each cell or drag across each block of cells 
in the selection. You can use the Shift key in conjunction with the Command key to 
concurrently select more than one block of cells. The Command key does not work 
with all spreadsheet programs. 

Selecting cells by name 

There's no need to manually select a large or complex group of cells more than 
once in a Microsoft Excel or Multiplan worksheet. While the group of cells is still se­
lected, you can name it and subsequently select it again by that name. To name a 
selected group of cells, use the Define Name command in Microsoft Excel's Formula 
menu or Multiplan's Select menu. To reselect the same group of cells, use the Goto 
command in Microsoft Excel's Formula menu or Multiplan's Select menu. 
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PERFORMANCE 
Creating your own Microsoft Excel Command-key shortcuts 

Have you ever wished Microsoft Excel had more keyboard shortcuts for its menu 
choices? Commands in the Format, Data, and Options menus in particular have very 
few Command-key equivalents. It's easy to create macros that not only choose com­
mands from a menu, but that also select specific options in the dialog boxes that 
accompany the menu choices. And you can execute each command macro with 
a keyboard shortcut that you designate. For example, you could create a macro 
to assign the bold style to text in a cell, as follows: 

1. Use Microsoft Excel's New command to create a new macro sheet, or open 
an existing macro sheet to which you wish to add this macro. 

2. Choose Set Recorder from the Macro menu. 

3. On the macro sheet, click any blank cell that has several blank cells below it 
and type a macro name such as SetBold. Press the Return key. 

4. Go through the motions of selecting a cell-any cell, on the macro sheet 
or on a worksheet-to be made bold. Microsoft Excel is not recording 
now, so this action won't be part of the macro. You want to keep cell selec­
tion a manual operation so that you can select different cells each time you 
use the macro. If Microsoft Excel were recording cell selection, the macro 
would always make the same cells bold. 

5. Choose Start Recorder from the Macro menu. 

6. Choose Style from the Format menu and, in the dialog box that appears, se­
lect the Bold style. Press Return or click the OK button. Microsoft Excel 
watches what you do and places the necessary macro formulas on the macro 
sheet. 

7. Choose Stop Recorder from the Macro menu. 

8. Repeat steps 3 through 7 for each additional macro you wish to create. 
Of course, in step 3 you'll want to type a different name for each macro, in 
step 4 you'll go through the motions of setting up for the macro action, and 
in step 6 you'll do whatever it is you want the macro to do. 

9. Save the macro sheet using the File menu's Save command. 
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Microsoft Excel macros can execule abnost any command you can think of, not just 
this simple one that sets the style to bol.d for everything in the ceUs you. have selected. 
By using the recorder commands in the Macro menu, you can have Microsoft Excel 

create the macro for you as you shaw it what you UXlnt done. With the Fomiula menu's 
Define Name cmnmand, you can also designate a ke)•board sfwrtcuJ, 

f m· the command macro. 

To designate a keyboard shortcut for a macro you've created, you must name it. 
Open and activate the macro sheet if necessary, and proceed as follows: 

1. Select the first cell of the macro on the macro sheet and choose Define Name 
from the Formula menu. A dialog box appears. 

2. Microsoft Excel usually suggests a name for the macro based on the contents 
of the cell above the one you selected in step I. If it doesn't, or if the sug­
gested name is not to your liking, type the name of your choosing in the 
space provided. 

3. At the bottom of the dialog box, click the Command option. This activates 
the adjacent Option-Command Key option. 

4. Click in the space provided for the Option-Command Key, type a single let­
ter, and click OK. Microsoft Excel differentiates between upper- and 
lowercase letters (Bis not the same as b). You may not use digits, symbols, or 
the lowercase letters e, u, i, or n. 

To run a macro for which you've designated a keyboard shortcut, make sure the 
macro sheet that contains the macro is open (it need not be active), select cells or do 
whatever other preparatory actions are required, and then press Command-Option 
along with the letter you designated for the macro. 
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Clearing the Clipboard 

After cutting or copying and then pasting a particularly large group of spread­
sheet cells, it's a good idea to clear the cells from the Clipboard. The contents of the 
Clipboard occupy valuable space in the Macintosh's memory and therefore reduce 
the amount of space available for your spreadsheet. 

To clear the Clipboard completely, select a single cell and choose Copy from the 
Edit menu twice. The first Copy command clears the Clipboard, but holds onto its 
contents in another area of memory so that you can, if necessary, undo the copy op­
eration. The second Copy command clears the large cell selection from the undo 
area of memory. 

Increasing accuracy by rounding 

Calculations based on formatted cell values may often appear to come out wrong 
because the calculations are made with the cells' precise values, which may not have 
the same number of decimal places as their displayed values. For example, if a list of 
numbers were calculated to 14 decimal places but displayed to the nearest cent, the 
sum of the calculated values, when displayed to the nearest cent, would probably not 
equal the sum of the displayed values. To avoid such discrepancies, most spreadsheet 
programs have a ROUND function that you can use to limit the number of decimal 
places in a calculated value. 

Microsoft Excel's Options menu has a Precision As Displayed command, which 
forces the stored value of every cell on the worksheet to match its displayed preci­
sion. The penalty for using this command is slower worksheet calculation, because 
Microsoft Excel rounds every cell value whether it needs it or not. Also, any constant 
values you may have entered with extra decimal places are permanently rounded; 
you can't get the extra precision back later by choosing Full Precision from the 
Options menu. 

Copying quickly to many cells 

Here's a quick way to copy the contents of one cell to any group of cells in a 
Microsoft Excel worksheet: 

1. Select the group of cells to which you want to copy. Use the Shift key for 
large selections and the Command key for nonadjacent selections. 

2. Press the Command key and then click the cell whose contents you 
want to copy. 

233 



Mac Insights 

3. Click the formula-editing area, and edit the cell contents or enter the 
new contents. 

4. Press Option-Enter or press Option and click the enter box in the 
formula-editing area. 

Using the Option key to propagate cell contents adjusts relative cell references 
in a formula the same way as using the Copy and Paste commands. Relative cell 
references in each copy of a formula refer to different cells than they refer to 
in the original formula. 

Resetting Microsoft Excel dialog boxes 

To quickly reset a section of a Microsoft Excel dialog box to its previous settings, 
click the section title. 

This technique works only with a section whose title overlaps the border sur­
rounding the section. For example, in the Find dialog box (Formula menu), the 
technique works with the Look in, Look at, and Look by subtitles, but not with 
the Find What subtitle. 

Designating the order of cell entry 

It's possible to preselect a group of cells in a Microsoft Excel or Multi plan work­
sheet for which you will later enter values, and to designate in advance the order 
in which the values must be entered later. To do this, open the worksheet and pro­
ceed as follows: 
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1. Select the group of cells for which values must be entered , using the 
Command key and possibly the Shift key, as described in "Selecting non­
adjacent cells." Select the cells in the order in which you want their 
values entered. 

2. After selecting the last cell in the group, press the Enter key once. This 
makes the first cell of the group the active cell. 
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3. Give the group of select cells a name, something like Entry, using the Define 
Name command, as described in "Selecting cells by name." 

4. Save the worksheet to disk. 

When it's time to enter values, open the worksheet and use the Goto command 
to select the named group of cells. Enter the value for the active cell, which has a 
heavy white border. Then press the Enter key, not the Return key, to end the entry 
and advance to the next selected cell. If you need to back up to a previous cell, press 
Shift-Enter. 

Hiding columns 

Spreadsheets often contain tables, auxiliary and intermediate calculations, pro­
prietary formulas, or other information that you'd rather keep out of the public eye. 
In Microsoft Excel and Multiplan, you can hide private cells, by putting them in 
columns outside the public part of your worksheet and then setting the widths of 
those columns to zero. To change a column width to zero: 

1. Move the pointer over the label of the column you want to change, at the 
very top of the column. 

2. Move the pointer right, over the column boundary line, and drag the right 
boundary to the left until it overlaps the left boundary. If you want to hide 
several adjacent columns, drag the right boundary of the rightmost column 
you want hidden to the left until it overlaps the left boundary of the leftmost 
column you want hidden. 

You can also set column widths to zero by selecting the columns and using the 
Column Width command from the Format menu. 

If you change your mind about hiding a column or you need to make changes, 
you can expose it as follows: 

1. Move the pointer above the column to the right of the hidden column, near 
but not over its left boundary. 

2. Drag to the right until the information in the newly exposed column 
is visible. 

In Microsoft Excel, you can also hide cells with numeric values by changing their 
formats to single semicolons. 
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FORMULAS 
Copying formulas to a new worksheet 

Microsoft Excel's Cut, Copy, and Paste commands transfer both formulas and 
values from one worksheet to another, provided the source worksheet is open when 
you choose the Paste command. 

In Multiplan, the Cut, Copy, and Paste commands normally transfer only cell 
values-not the formulas in the cells-from one worksheet to another. You can re­
tain the formulas by disguising them as text before cutting or copying and removing 
the disguise after pasting. Here's how: 

1. Open the worksheet you want to copy from, and choose Save As from the 
File menu to make a copy of the worksheet. Experiment with the copy, not 
the original. 

2. Choose Show Formulas from the Options menu. 

3. One at a time, select each cell that contains a formula you want to transfer 
and, in the formula-editing area below the menu bar, use standard text­
editing methods to remove the equal sign. Then press the Enter key to dis­
guise the formula as text. Don't bother disguising any formulas that can be 
replicated by filling down or filling right. 

4. Select the group of cells you want to transfer, and choose Cut or Copy from 
the Edit menu. 
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5. Open another worksheet or create a new one. 

6. Select the location at which you want pasting to begin, and choose Paste 
from the Edit menu. 

7. One at a time, select a disguised formula and, in the formula-editing area 
below the menu bar, insert an equal sign. Then press the Enter key to con­
vert the text back to a true formula. 

8. If necessar y, use the Copy Down and Copy Right commands from the Edit 
menu to recreate similar formulas that you didn't disguise in step 2. 
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Bypassing formula errors 

When nothing you do seems to rid a formula of an elusive error and you'd like 
to move on without erasing the formula completely, just remove the equal sign at the 
beginning of the formula. Microsoft Excel, Multiplan, Jazz, and most other spread­
sheet programs won't let you put an erroneous formula in your spreadsheet. But 
without the equal sign, the spreadsheet program considers the formula to be text 
and lets you enter it. Later, you can return for another try at resolving the error. 

Converting formulas to fixed values 

Want to convert the calculated values in a group of cells that now contain for­
mulas to constants? Use the Cut, Copy, and Paste commands with the Scrapbook, 
as follows: 

I. Select the cells and choose Copy from the Edit menu. This puts a copy of 
the cell contents, including any formulas, on the Clipboard. 

2. Choose Scrapbook from the Apple menu and then choose Paste from the 
Edit menu. The Paste command evaluates any formulas on the Clipboard 
and puts the resulting values in the Scrapbook. 

3. Choose Cut from the Edit menu to put the calculated values on the Clip­
board in place of the formulas, and close the Scrapbook. 

4. The cells you selected in step l should still be selected. Choose Paste to 
return the calculated values to their respective cells. 

If you want to convert the calculated value of just one cell of a Microsoft Excel 
or Multiplan worksheet to a constant, select the cell , click anywhere in the formuJa­
editing area, and choose Calculate Now from Microsoft Excel's Option menu or 
Multiplan's Calculate menu. 

Saving time with manual calculation 

Save time when working on a large spreadsheet by using the manual calculation 
option. In Microsoft Excel, for example, choose Calculation from the Options menu 
and, in the dialog box that appears, select the Manual option. In Multiplan, choose 
Manual Calculation from the Calculate menu. You can force Microsoft Excel or Mul­
tiplan to calculate at any time by pressing Command-=, which is the shortcut for 
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the Calculate Now command. In Jazz, use the recalculate command in the 
Range menu to set manual calculation, and recalculate as needed by pressing 
Command =R. 

Calculating the difference between two dates 

Multi plan, unlike Microsoft Excel, has no built-in date-calculating ability. T hus, 
you can't simply subtract two dates to deter mine the number of days between them . 
Instead, you must set up a series of formulas and a table to make the calculation. 
T hese are the required formulas: 

Datet a date such as 02/28/87 

Date2 a date such as 03/0t /88 

Year1 VALUE(MID(Datet , 7 ,4)) 

Montht VALUE(MID(Datet , t ,2)) 

Da'{I VALUE(MID(Datet ,4,2)) 

Leapt IF(AND(Montht > 2,0R(Yeart /400 = INT(Yeart /400), 

AND(Yeart/4 = INT(Year1 /4),Year1 /t00<> 

INT(Year1/t00)))), t ,O) 

Year2 VALUE(MID(Date2,7,4)) 

Month2 VALUE(MID(Date2,t ,2)) 

Day2 VALUE(MID(Date2,4,2)) 

Leap2 IF(AND(Month2>2,0R(Year2/400 = INT(Year2/400), 

AND(Year2/4 = INT(Year2/4), Year2/t 00< > 

INT(Year2/t00)))), t ,O) 

DaysBetween ABS((Yeart •365 + Leapt + LOOKUP(Montht, MonthAsDays) + Da'{I) 

- (Year2*365 + Leap2 + LOOKUP(Month2,MonthAsDays) + Day2)) 

Each of the two dates is entered as text in a separate cell. You can use any punctua­
tion to separate the month, day, and year, but you must enter both the month and 
the day as two digits (use a leading zero if necessary) and the year as four digits. For 
example, enter 0310111988 or 03-01-1988, but notJ/1188. 

Auxiliar y formulas use the text dates to calculate the month, day, and year as 
numbers, and to calculate whether or not each year is a leap year. A table supplies 
the number of days from the first of the year to the first of each of the twelve 
months. Using values from the table and auxiliary formulas, the main formula 
converts each date into a number of days since the imaginary date 0010010000, 

and subtracts the difference to get the number of days between the dates. 
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Accurately cakulating the number of days between two dates in a Multip!.an wurk­
sheet is no simple matter. In addition to the main formula (shawn here in cell R4C2), 
you need several auxiliary f ormul.as (shown in R 4C5 through Rl OC5) and a table 

(shawn in Rl4C4 through R25C5). 

HEADERS AND FOOTERS 
Viewing long headers and footers 

Microsoft Excel and Multi plan can print a one-line page header at the top and 
a one-line page footer at the bottom of every page. You enter the header and footer 
text in the Page Setup dialog box. If all the text of a long header or footer is not visi­
ble at once in the Page Setup dialog box, you can use the I-beam pointer to scroll the 
text right or left. To do that, place the pointer anywhere over the text, press the 
mouse button, and drag the pointer to either end of the text. When the pointer 
reaches the end, the text starts to scroll slowly in the opposite direction. The farther 
away you drag the pointer from the edge of the text, the faster the text scrolls. 
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Microsoft Excel and Multiplan header and footer commands 

In addition to regular text, you can include special commands in a header or 
footer to have Microsoft Excel or Multiplan print the current date, time, page num­
ber, and document name. Other commands affect the text style and alignment. 
Here is a list of the available commands: 

Command 
&L 

&C 
&R 

&P 

&D 

&T 

&F 

&B 

&I 
&& 

Effect 
Aligns text that follows at left margin 

Centers text that follows 

Aligns text that follows at right margin 

Prints page number 

Prints current date 

Prints current time 

Prints document name 

Prints immediately following text (left, right, or center part) in bold 

Prints immediately following text (left, right, or center part) in ita lic 

Prints one ampersand 

WORKSHEET GRAPHING 
Creating bar graphs in Multiplan 

Multiplan doesn't have the built-in graphing capabilities of other spreadsheet 
programs. But where it's meaningful to show the relative magnitude of several 
values, you can use the Bar Graph format to have numbers displayed graphically. 

The Bar Graph format is designed to work best in standard-width columns 
with values between 0 and IO. If values are mostly out of that range, they must be 
multiplied by a scaling factor or the bar graph will not look good. For example, 
percentages commonly have values between 0 and I (the Percent format auto­
matically multiplies them by 100 for display purposes only), and they should be 
multiplied by IO for best bar-graph results. If the range of values is very wide, 
you may also want to widen the column that contains the bar graph. 

When there are positive and negative values to be graphed, use IF functions to 
separate them into two columns, with negative values in the left column and positive 
values in the right. Align the negative values on the right and the positive values on 
the left. This makes the boundary between the columns a zero line, with negative 
values extending to the left and positive values to the right of the line. Multi plan au­
tomatically graphs negative values in light gray and positive values in dark gray. 
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Multiplan's Bar Graph format l.ets you easily compare the magnitude of several 
va.lues. Values to be graphed must be scaled to be between 0 and 10. An IF functi.on 

in each cell separates positive and negative values. Aligning the two columns against 
their common boundary makes that boundary a zero line. The dark and light shading 

variations are automatic. 

Creating Microsoft Excel scatter graphs 

A scatter graph is normally used to analyze the relationship between two vari­
ables, usually called the X variable and the Y variable. If you can establish a high 
degree of correlation in observed values of the two variables, you can predict with 
some certainty the value of one variable that will correspond to a hypothetical value 
of the other. However, creating a scatter graph with Microsoft Excel is not as 
straightforward as with other types of graphs. Collect your observed data and 
proceed as follows: 

1. Arrange the known values of the X and Y variables into a two-column 
table in a worksheet. The first column of the table lists the X values, which 
are the values for the category (horizontal) axis, and the second column 
lists the Y values, which are the values for the value (vertical) axis. 

2. After setting up the table, select all of the values in both columns and choose 
Copy from the Edit menu. 
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3. Use the New command in Excel's File menu to create a new chart window. 

4. Choose Paste Special from the Edit menu. Do not choose the Paste com­
mand. Because both columns of the table contain values, if you use Paste, 
Microsoft Excel will assume that you do not want category-axis labels on your 
chart and will plot both the X and Y values along the value axis as two data 
series, instead of plotting one point for each pair of X and Y values. 

5. In the Paste Special dialog box, select the Categories in First Column 
option to tell Microsoft Excel to use the values in the first column for the 
category (horizontal) axis. Click OK, and Microsoft Excel plots the chart 
using its standard chart type, which is normally a column chart. In a col­
umn chart, each tick mark on the category axis corresponds to one X 
value from the worksheet. 

6. Change the chart to a scatter graph by choosing Scatter from the Gallery 
menu and selecting a scatter-graph style in the dialog box that appears. As 
Microsoft Excel draws the scatter graph, it adjusts the category axis so the 
tick marks measure equal X-value increments, from the lowest value on the 
worksheet's list of X values to the highest. 

7. Label the axes and the data points with the Attach Text command from the 
Chart menu. Unfortunately, you cannot link labels from the worksheet to the 
axes or data points in the chart; you have to retype them. 

In step I, you may arrange the X and Y values in rows instead of columns, in 
which case the X values go in the first row. You can also use a short macro to do most 
of the work of steps 2 through 7. After setting up the two-column table of X and Y 
values, run this macro: 

A 
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B 
ScatterGram 
· COPY() 
·NEW(2) 
·PASTE.SPECIAL(2,FALSE,TRUE) 
·GALLERY .SCA TTER(1) 
·RETURN 
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Scatter graphs are useful Jar spouing relationships between two variables. Here, 
actual data suggest that people live longer in richer countries, but that the rela­

tionship is not linear. To set u/J a scatter graph in Microsoft Excel, you create a table 
of known values Jar each variable, use the Copy and Paste Special commands to 
trans/er the values to a new cluirt, arul add labels to the dat,a points and axes. 
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Getting two computers to communicate, 
whether they're connected over phone lines with modems or 

directly cabled, is not a task for the faint-hearted. 
Don't let the technical complexity daunt you. 

Look through this chapter for some ideas that will 
help you get online successfidly. 
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GETTING READY TO 
COMMUNICATE 

Connecting directly to another computer 

You can bypass modems and telephone calls by directly connecting the Mac and 
a nearby computer with a cable. What you need is a null-modem cable, which swaps 
the incoming and outgoing data lines. In most cases, an lmageWriter cable works. 
One end of the cable plugs into the Mac's modem port, and the other end plugs into 
the other computer's serial port. 

If the serial port on the other computer is wired for a non-null-modem cable, 
then a null-modem cable such as the ImageWriter cable woi:t't work. In that case, you 
should use the ImageWriter cable with a null-modem adapter or a non-null-modem 
cable, which you can purchase in most computer stores. 

First-time settings 

If you don't know what options to select in the Compatibility Settings dialog box 
the first time you call an information service or a remote computer, try 300 or 1200 
baud, 8 bits per character, no parity, I stop bit (not an option with MacTerminal), 
and XOn/XOff handshake. 

Best time to call 

For best performance when communicating with an information service or 
other remote computer, contact it late at night or very early in the morning. More 
people call during daytime and evening hours. The busier the remote computer 
becomes, the longer it takes to handle your requests and, as a result, the more 
expensive your communications session will be. 

Reducing the risk of full disks 

When the terminal program records or captures a telecommunications 
session in a disk file, there is always the risk of running out of disk space while that 
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particular session is in progress, especially with a single-sided (400K) disk. You can 
minimize the chance of the disk becoming full by saving the information recorded 
during the last session on a different disk and then recording the new session in 
a fi le on an otherwise blank disk. 

Using MacTerminal, you can save the last session and clear the disk as follows: 

1. Choose Save As from the File menu and, in the Save As dialog box, use 
the Drive and Eject buttons to store the previous session's document on 
a blank disk. 

2. After saving, choose Clear Lines Off Top from the Commands menu. 

Automatic answering 

Many terminal programs do not answer incoming calls. In MacTerminal 
versions 1. 0 and l. l , for example, the Wait for Call command on the Phone menu 
does not work, and neither does the Number of Rings Before Answer setting in the 
Phone Settings dialog box. However, most modems, including the AppleModem 
1200, the Apple Personal Modem, and other modems compatible with the Hayes 
SmartModem, will answer an incoming call even if your terminal program will not. 

To institute automatic answering, you must type a command to the modem, 
as follows: 

1. Make sure the terminal program is on line. (In MacTerminal, check the 
On Line setting in the Terminal Settings dialog box.) 

2. Turn on the modem. 

3. Type the following command in capital letters: 

ATSD =1 

This command tells the modem to answer the phone after one ring. The number 
after the equal sign determines how many rings the modem waits before answering. 

4. Stop automatic answering by typing the following command: 

ATSD =D 

or turn the modem off and back on again. 
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Typing modem commands directly 

Although you will probably want to use your terminal program to have your 
modem dial often-used numbers automatically, you can also send commands di­
rectly to your modem by typing them on the Mac's keyboard. With any modem com­
patible with the Hayes SmartModem, for example, typing ATD14155559196 and 
pressing Return dials the number 1/415/555-9196 directly; in MacTerminal, this 
bypasses the Phone menu altogether. When typing modem commands, use all 
capital letters or the commands will not take effect. 

After you establish connection with another computer, the modem stops watch­
ing for commands. To get its attention, wait at least a second, type three plus signs 
( + + +), and wait another full second. You should see OK appear on the screen, 
after which you can type commands to the modem. For example, you might need 
to bring a communication session to a hasty conclusion by typing ATH (the com­
mand to hang up). 

Inserting commas for pauses 

You can instruct any modem compatible with the Hayes SmartModem to 
pause during dialing. For each two-second pause required in a dialing sequence, 
insert one comma. 

Escaping from PBX 

To dial out of a private branch exchange (PBX), prefix the number you're calling 
with a 9. If you normally have to wait for a second dial tone before dialing the out­
side number, insert one or two commas between the 9 and the outside number. 
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Phone Settings 

Phone Number 

I· 
Di81 ~ @Tone O Pulse OMIHed 

Number of Rings Before Rnswer LJ 
Modem O Rpple 300 ® Rpple t 200 O Other 

This plume number dials a 9 to get an outside line from a PBX, wails two seconds, 
and then dials the remote computer at 555-1212. 

Special modem commands 

Some modems have special dialing commands. For example, the Prometheus 
ProModem 1200 recognizes the letter Win a dialing sequence as an instruction to 
wait up to 20 seconds for a second dial tone or an access tone. Using this command 
means that you don't have to estimate how long the wait will be, as you do with com­
mas. The following example is equivalent to the previous one: 

Phone Settings 

Phone Number 

Dl81 ~ @Tone O Pulse QMIHed 

Number of Rings Before Rnswer D 
Modem O Rpple 300 ® Rpple 1200 O Other 

This phone number dials a 9 to get an outsi.de line from a PBX, wails for a second 
dial tone, and then dials the remot,e computer aJ 555-1212. 
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Alternate long-distance companies 

Your modem will dial a long-distance number using an alternate company if you 
enter the dial command as follows: 

1. Prefix the remote computer's number with the local-access phone number 
and your account number. 

2. Insert commas between the local-access number and the account number to 
allow time for the long-distance company to answer and sound its tone. 

Phone Settings 

Phone Number 

Dial ~ @Tone 0 Pulse Q MIHed 

Number of Rings Before Rnswer LJ 
Modem O Rpple 300 @ Rpple 1200 O Other 

Thisphonenumberdial,s 832-5016 (a long-distance company's local-access number), 
wails six seconds, dia/,s account number 1234567, and then dials the remote 

computeral214-555-1212. 

Credit-card calls 

From most touch-tone phone lines, your modem will provide all the billing infor­
mation for an AT&T credit-card call if you enter the dial command as follows: 
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1. Prefix the area code with a 0 (instead of a I). 

2. Add three commas, the credit-card number, and another comma to the 
end of the remote computer's phone number. 
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Phone Settings 

Phone Number 

Dial ~ @Tone O Pulse Q MiHed 

Number of Rings Before Answer LJ 
Modem 0 Apple 300 @ Apple 1200 0 Other 

This phone number dials the remote compuler at 214-555-1212, waits six seconds, 
dials credit-card number 415 555 1212 9876, and then waits two more seconds 

bef m·e connecting. 

Suspending Call Waiting 

The click or beep that announces that a call is waiting on a phone line equipped 
with the Call Waiting feature wreaks havoc with telecommunications. But in many 
areas, you can suspend the Call Waiting feature for the duration of the ensuing call 
by dialing a three- or four-digit code, waiting for a second dial tone, and then dial­
ing a regular phone number. This feature is available in so-called easy-access areas, 
in which you are automatically connected to the long-distance company of your 
choice and need not dial special access numbers to use a company other than AT&T. 

Phone Settings 

Phone Number 

Dial ~ @Tone O Pulse Q MIHed 

Number of Rings Before Answer LJ 
Modem O Apple 300 @ Apple 1200 O Other 

This f1hone number dials the code *70 to suspend Call Waiting on a touch-tone 
line, waits two seconds for a second dial tone, and then dials the remote compull'r 

at555-1212. 
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To suspend Call Waiting on a touch-tone phone line, type the four characters 
*70, in front of the phone number. To suspend Call Waiting on a rotary or pulse­
dial phone line, type the five characters 1170, in front of the phone number. 

If you are not in an easy-access area, it is best to avoid using a phone line that has 
Call Waiting for telecommunications. 

Staying connected 

If your terminal program always seems to disconnect shortly after the number 
you dial is answered, try suffixing the number with two or three commas. 

Busy ... busy ... busy 

MacTerminal has no special command to redial a busy number. A few seconds 
after detecting a busy signal, it displays the message The call was answered, but rw com­
puter responded and waits for you to do something. You could redial by choosing Dial 
from the Phone menu, but here's a faster method: Assuming the last command you 
chose was Dial from the Phone menu, type Al to redial a busy number. Do not press 
the Return key or you will cancel this repeat command. Typing Al tells any modem 
compatible with the Hayes SmartModem to repeat the last command it received. 

Redialing continuously 

Anyone who uses electronic bulletin boards knows a remote computer can be 
busy for 20 minutes straight. In a situation like that, manual redialing quickly gets 
tedious. Few terminal programs or modems have an automatic redial-on-busy com­
mand; certainly MacTerminal and the Apple modems do not. But you can give 
MacTerminal an unintelligent continuous-redial capability with some preliminary 
word processing and these temporary changes to its file-transfer settings: 
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1. Use MacWrite or another word processor to create a text document con­
taining about 60 lines that each have a capital A followed by a slash (N, the 
modem's repeat command). 

2. Save the document-on the MacTerminal disk if possible-using the 
Text Only option. MacWrite asks whether to put a return character at 
the end of each paragraph or the end of each line; choose Paragraphs. 



Communications 

3. Start MacTerminal and dial the number. If the number is busy, 
MacTerminal will hang up within lO seconds. 

4. In the File Transfer Settings dialog box, note the setting for Delay 
Between Lines and temporarily change it to 1800 (30 seconds). Also, 
note the setting for Transfer Method and then select Text. Click OK. 

5. Choose Send File from the File menu and double click on the name of 
the redial-command document. MacTerminal will start sending one line 
of the document, which contains one redial command, every 30 seconds. 

6. Listen to the modem speaker. When you hear the remote phone ring, 
immediately type Command-Period to stop MacTerminal from sending 
any more redial commands. Another Al command will cause the modem 
to hang up! 

7. After logging onto the remote computer, restore the Delay Between Lines 
and Transfer Method settings in the File Transfer Setting dialog box to their 
states prior to step 4. 

If your·modem won't respond to the repeated Al commands, try turning it 
off and back on again. Then redial the number. If the number is still busy, continue 
with step 5. 

AVOIDING GIBBERISH 
Normal gibberish 

It is normal to see gibberish on the screen when you first connect with some 
information services or bulletin boards. To stop it, try pressing the Return key once 
or twice, or press Command-C. 

Extraneous characters 

The most likely cause of extraneous characters, such as],{, or}, in the informa­
tion you receive is a bad phone connection creating static on the line. Long-distance 
calls are particularly susceptible to noisy lines. Some long-distance companies have 
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noisier connections than others, but bad connections are possible with any company. 
Here are some possible solutions: 

D Hang up and try again. If you were using an alternate long-distance 
company (via a local-access number), place the call directly, through your 
normal long-distance company. 

D Try another number for the information service. In major metropolitan 
areas, you often have a choice of several local numbers for one service. 

D Use a slower baud rate. Modems are less sensitive to static at 300 baud 
than at 1200 baud. 

D Activate XOn/XOff "handshake" protocol (in MacTerminal 's Phone Settings 
dialog box). 

D Try a different modem. Some models filter noise better than others. 

Invisible typing 

If what you type doesn't appear on the screen, choose your terminal program's 
local echo or half-duplex option. In MacTerminal, for example, you select the Local 
Echo setting in the Terminal Settings menu. 

DDoouubbllee ttyyppee 

If every letter you type appears doubled, disable your terminal program's local 
echo or full-duplex option. In MacTerminal, for example, make sure the Local Echo 
setting in the Terminal Settings menu is not selected. 

Missing characters 

Intermittent missing characters may mean the remote computer is sending infor­
mation faster than your terminal program can receive it. To correct this problem: 
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D Make sure both computers are using the same baud rate; try a slower rate at 
both ends, such as 300 baud. 

D See if activating the XOn/XOff "handshake" protocol helps. (Check Mac­
Terminal 's Compatibility Settings dialog box.) 

D Stop capturing or recording incoming information on disk. (In Mac­
Terminal, choose Don't Record Lines Off Top from the Commands menu.) 
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THE MACTERMINAL 
KEYBOARD 

The Control key 

When using Mac Terminal and most other terminal programs, the Mac's 
Command key is equivalent to the Control key on other computer keyboards. For 
example, most information services recognize Command-S (Control-S) as a com­
mand to stop sending information until you press Command-Q (Control-Q). 

Most Control-key combinations have direct Command-key equivalents. How­
ever, Mac Terminal handles two Control-key combinations peculiarly: If you need to 
send a Control-", press Command-6 (without the Shift key), and if you need to send 
a Control_, press Command-/. 

The Delete key 

The Mac keyboard has no Delete key (also called Del, Rubout, or Rub). 
Many terminal programs let you make the Backspace key simulate a Delete key. 

Mac Terminal version 2.0, for example, offers the option of treating the Backspace 
key as a Delete key or as a Backspace key; whichever you pick, you can still type the 
other by pressing Command-Backspace. Indicate your preference by choosing 
Keyboard from MacTerminal's Settings menu. 

The Escape key 

The Escape or Esc key found on most computers does not exist on the Mac. 
MacTerminal simulates the Escape key when you press the Tilde key. 

Tildes and accents 

Because MacTerminal uses the Tilde key as an Escape key, you must press 
Command-Tilde to type an accent grave ('). Pressing Command-Shift-Tilde types 
a tilde(-). 

The Break key 

When using MacTerminal in its VTlOO mode, pressing the Enter key simulates 
the Break key found on VTlOO keyboards. 
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Using MacTracks with terminal programs 

The MacTracks desk accessory may interfere with MacTerminal's ability to use 
the Command key in simulating the Control, Delete, and Escape keys. For best 
results, record all MacTracks "tracks" to be used in a terminal program as combina­
tion keystrokes that include the Option and/or Shift keys in addition to the requisite 
Command key. For example, use Command-Option-C or Command-Option-Shift-C 
for a track, but not Command-C, which is the equivalent of the Control-C character 
used by many computers to stop processes. 

TRANSFERRING INFORMATION 
Don't use XOn/XOff with XModem 

For accurate file transfer from a remote computer, use the XModem error­
checking protocol, but make sure your terminal program's XOn/XOff feature is 
inactive. Otherwise, the XOn/XOff feature may introduce spurious errors during 
file transfer, causing blocks of information to be re-sent needlessly. When that 
happens, the receiving computer gets duplicate blocks of information. In Mac­
Terminal, you set the Xon/Xoff option by choosing Compatibility from the 
Settings menu. 

Unsuccessful XModem 

When an attempt at transferring information to or from an information service 
is unsuccessful, it could just mean the service is too busy. When lots of people are 
using the service, XModem transfer does not work reliably. 

Preventing screen clearing 

Does CompuServe clear your screen while you have MacTerminal set to Record 
Lines Off Top? You don't want the screen cleared before the lines have a chance to 
move off the top, or they'll never be recorded. 

To prevent unwanted screen clearing in MacTerminal versions 2.0 and above, 
choose File Transfer from the Settings menu and select the Save Screens Before 
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Clearing option. In MacTerminal versions 1.0 and l. l , you must set MacTerminal 
to act like a TTY terminal, not a VT 100 terminal, like this: 

1. Select the TTY option in MacTerminal's Terminal Settings dialog box. 

2. You must also tell CompuServe which terminal type you are using, 
so once you are connected to CompuServe, type GO TERMINAL at any 
exclamation-point prompt. This transfers you to CompuServe's 
T ERMI NAL/OPT IONS menu. 

3. Choose option 2, Setting Your Terminal Type, to proceed to the 
T ERMINAL TYPE menu. 

4. Choose type 6, which is "O ther (General Purpose)." 

You are now ready to type any standard CompuServe navigational command, 
such as GO MACUS to go to CompuServe's Mac user group, and can proceed with 
your communications session with no further screen-clearing problems. 

Direct Mac-IBM PC (MS-DOS) file transfer 

An IBM PC or other computer that uses the MS-DOS operating system does not 
need a terminal program for simple file transfer when it is connected directly to the 
Mac. The DOS MODE and COPY commands suffice. T he Mac does require a termi­
nal program, however. To transfer files between the PC and the Mac: 

1. Make sure the PC is waiting for a DOS command. T he flashing cursor should 
be right next to a prompt, such as A> . 

2. Type an appropriate MODE command on the PC to set up the serial port to 
match the settings in the terminal program on the Mac. For example, the fol­
lowing command sets serial port COM I: for 9600 baud, no parity, 8 data bits 
per character, and l stop bit: 

MOOE COM1:9600, N, 8, 1 

3". To send a file from the PC, prepare the Mac terminal program to capture 
or receive a fi le and then type an appropriate COPY command on the PC. 

T he following example copies from the file named PCSTUFF.TXT on 
dr ive B to the COM I: serial por t: 

COPY B:PCSTUFF.m COM1: 

4. To receive a fi le on the PC, type an appropriate COPY command on the 
PC and then have the Mac's terminal program start sending the file. 
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When the Mac finishes, you usually have to press Command-Z on the Mac 
to tell the PC that the Mac is done sending. The following COPY com-
mand receives a file from serial port COM l: and saves it in a disk file named 
MACSTUFF.TXT on drive A: 

COPY COM1: A:MACSTUFF.TXT 

Direct Mac-CP/M file transfer 

Any computer that uses the CP/M operating system does not need a terminal 
program for simple fi le transfer when it is connected directly to a Mac. CP/M's STAT 

and PIP commands do the job. The Mac does require a terminal program, however. 
To transfer files between the CP/M machine and the Mac: 
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1. Set the baud rate, parity, bits per character, and other compatibility set­
tings in the terminal program on the Mac to match tne standard port 
settings on the CP/M computer. If the CP/M computer's manual doesn't 
say what those settings are, try 1200 baud, no parity, and 8 data bits 
per character. 

2. Make sure the CP/M computer is waiting for a command. The cursor 
should be right next to a prompt, such as A> . 

3. Type the following STAT commands on the CP/M computer to set up 
the serial port to send and receive files: 

STAT PUN:= PTP: 

STAT ROR: = PTR: 

4. To send a file from the CP/M computer, prepare the Mac's terminal 
program to capture or receive a file and then type an appropriate PIP 
command on the CP/M computer. The following example copies from 
the file named CPMSTUFF.TXT on drive B to the serial port: 

PIP PUN: = B:CPMSTUFF. TXT 

5. To receive a file on the CP/M computer, type an appropriate PIP com­
mand on the CP/M computer and then have the Mac's terminal program 
start sending the fi le. When the Mac finishes, you usually have to press 
Command-Z on the Mac to tell the CP/M computer that the Mac is done 
sending. T he following PI P command receives a fi le from the serial port 
and saves it in a disk file named MACST UFF.TXT on drive A: 

PIP A:MACSTUFF.TXT = ROR: 
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CP/M computers include Kay Pro, Morrow, Osborne, Digital Microsystems, 
Micromation, Dynabyte, Onyx, Altos, Industrial Micro Systems, Exidy, Vector 
Graphic, and the Apple II with a CP/M card. 

Direct Mac-Radio Shack model 100 file transfer 

The Radio Shack Model 100 computer is 100 percent compatible with most Mac 
terminal programs, and you can use the ImageWriter cable to connect the two com­
puters. Mac Terminal, however, cannot receive files from the Model 100 unless you 
first perform temporary software surgery on the Model 100, like this: 

1. Start the Model lOO's built-in BASIC by pressing the Enter key while the main 
menu is displayed. 

2. Type the command POKE 63066,255. Double-check the accuracy of your 
typing and backspace to correct if necessary. Press Enter. 

3. Quit BASIC. 

After the command in step 2, the Model 100 computer sends an invisible line­
feed character after the return character at the end of each line. Without these char­
acters, MacTerminal displays all the text it receives on the same line. The Model 100 
change stays in effect until you perform a "cold start" or start BASIC and type the 
command POKE 63066,0. 

AFTER TRANSFERRING 
INFORMATION 

Cleaning up captured information 

After using Recording Lines Off Top with Mac Terminal to capture an entire 
communications session in a single disk file, you'll probably want to split the single 
file into several files and get rid of the junk that inevitably accumulates. You can't 
clean up the file with MacTerminal, but you can with MacWrite or Microsoft 
Word. To do this: 

1. Quit MacTerminal. 

2. Start MacWrite or Microsoft Word. 
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3. Using the word processor's Open command, open the MacTerminal 
document that contains the information you recorded. Before MacWrite 
opens a MacTerminal document, it asks whether return characters should 
signify the ends of lines or the ends of paragraphs; click the Paragraphs 
button. (The Line Breaks button may be the right choice with documents 
saved by other terminal programs. Experiment and see which looks best.) 

4. Edit the file as you would any other word-processing document. 

Once you have saved the document with MacWrite or Microsoft Word, 
MacTerminal will no longer be able to open it. 

Using MacWrite on a Mac 5 l2K, you won't be able to open MacTerminal 
documents longer than 2047 lines; on a I28K Mac, the limit is 500 lines. Every line 
of a MacTerminal document ends with a return character, and MacWrite limits the 
number of return characters in a single document. 

Quick text selection in a MacTerminal document 

You may want to simply copy some text from a MacTerminal document and 
paste it into another type of document or the Scrapbook. To quickly select a large 
block of text before choosing Copy from the Edit menu, click once before the first 
word, use the scroll bar to bring the last word into view, and hold down the Shift key 
while you click after the last word. 

Strange characters 

Strange characters appear when one application program encounters formatting 
codes embedded in a document by another application program. Almost all word 
processors allow boldface text, variable margins, and page headers, for example, but 
WordStar accomplishes that formatting one way on an IBM PC, and MacWrite does 
it another way on a Macintosh. If you simply transfer a WordStar document to the 
Mac and open it with MacWrite, the document will be full of strange characters­
the result of MacWrite's misinterpreting the WordStar formatting conventions. 

You can use a special file-transfer program to convert document formats. For 
example, MacLink converts between WordStar, Multimate, or Displaywrite docu­
ments on the PC and MacWrite documents on the Mac. 
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Strange diaracters appear when Mac Write tries w interpret Jormatting codes embed­
ded in a document by WordStar. 

Converting to plain text 

Often, the only way to use a Mac document on another computer, or vice versa, 
is to first convert the document to plain text, eliminating all formatting codes. On 
the Macintosh you do this by selecting the Text Only option in the Save As dialog 
box, the form of which may vary depending on the program. Many application pro­
grams on other computers have similar options. 

Formatting detritus can also be removed from a word-processing document 
by a "filter" program such as the public-domain File Filter program, either before or 
after transfer. Naturally, you lose all formatting, such as margin settings, pagination, 
and text styles, in the process. After conversion, you can open each plain-text docu­
ment with MacWrite or Word and add character, paragraph, and document 
formatting. 
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APPENDIX 
Products Mentioned in This Book 

Access01y Pak / ,Silicon Beach Software, P.O. Box 261430, San Diego, CA 92 126, 
(6 19) 695-6956 

BitFixer, All Star Computer Services, 3822 19lh Street, #5, San Francisco, CA 94 114, 
(4 15) 282-0540 

ClickArt Effects, T /Maker Graphics Company, 2 115 Landings Drive, Mountain View, CA 
94043, (4 15) 962-01 95 

CompuServe, CompuServe Information Service, PO. Box 202 12, 5000 Arlington Centre 
Blvd., Columbus, OH 43260, (800) 848-8 199, (6 14) 457-0802 in OH 

Coordinates, see Accesso1y Pak I 

Dayton Fonts, Plugh Incorporated, P.O. Box 358, Dayton, OH 45459 

Dvorak, from users groups such as BMUG, 1442A Walnut Street, Suite 162, Berkeley, CA 
94709, (4 15) 849-9114 

Fade to Black, Brian L. Matthews, 10513 S.E. 219th Street, Kent, WA 9803 1; or from users 
groups 

Fanny Mac, Beck-Tech, 4 1 Tunnel Road, Berkeley, CA 94705, (415) 548-4054 

Fedit, MacMaster Software, 939 East El Camino Real, Suite 122, Sunnyvale, CA 94087 

FONTastic, Altsys Corp., P.O. Box 865410, Plano, TX 75086, (2 14) 596-4970 

Helix, Odesla Corporation, 4084 Commercial Avenue, Northbrook, IL 60062, 
(800) 323-5423, (3 12) 498-56 15 in IL 

Jazz, Lotus Development Corp., 55 Cambridge Parkway, Cambridge, MA 02 142, 
(6 17) 253-9150 

Lisa Visi01i, Lisa Vision, 254 1 Ninth Avenue, Sacramento, CA 958 18, (800) 538-8157, 
Ext. 816, (800) 672-34 70 in CA 

MacBreeze, Levco, 6 160 Lusk Boulevard, Suite C-203, San Diego, CA 92 12 1, (619) 457-20 11 

MacDraw, Apple Computer, incorporated, 20525 Mariani Avenue, Cupenino, CA 95014, 
(800) 538-9696, (800) 662-9238 in CA 

Maclink, Data Viz, 16 Winfield Street, Norwalk, CT 06855, (203) 866-4944 

Mac Memory Disk, Assimilation, 485 Alberto Way, Los Gatos, CA 95030, (800) 662-5464, 
(800) 421-0243 in CA 

MacBooster, Mainstay, 286 1 IB Canwood St. Agonva Hills, CA 91301, (8 18) 991-6540. 

MacPaint, Apple Computer, Incorporated , 20525 Mariani Avenue, Cupertino, CA 950 14, 
(800) 538-9696, (800) 662-9238 in CA 

MacProjecl, Apple Computer, Incorporated, 20525 Mariani Avenue, Cupertino, CA 95014, 
(800) 538-9696, (800) 662-9238 in CA 
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MacTerminal, Apple Computer, Incorporated, 20525 Mariani Avenue, Cupertino, CA 95014, 
(800) 538-9696, (800) 662-9238 in CA 

MacWrite, Apple Computer, Incorporated, 20525 Mariani Avenue, Cupertino, CA 95014, 
(800) 538-9696, (800) 662-9238 in CA 

MDC II, New Canaan MicroCode, 136 Beech Road, New Canaan, CT 06840, (203) 966-6969 

Microsoft Chart, Microsoft Corporation, 160 II N .E. 36th Way, Box 97017, Redmond, WA 
98073-97 17, (800) 426-9400, (206) 882-8080 in WA and AK, (4 16) 673-7638 in Canada 

Microsoft Excel, Microsoft Corporation, 16011 N .E. 36th Way, Box 97017, Redmond, WA 
98073-97 17, (800) 426-9400, (206) 882-8080 in WA and AK, (416) 673-7638 in Canada 

MicrosoftMultiplan, Microsoft Corporation, 16011 N. E. 36th Way, Box 97017, Redmond, WA 
98073-9717, (800) 426-9400, (206) 882-8080 in WA and AK, (416) 673-7638 in Canada 

Microsoft Word, Microsoft Corporation, 160 I I N .E. 36th Way, Box 97017, Redmond, WA 
98073-97 17, (800) 426-9400, (206) 882-8080 in WA and AK, (416) 673-7638 in Canada 

Mock Write, CE Software, 801 73rd Street, Des Moines, IA 50312, (5 15) 224-I995 

Mouse Mover, Magnum Software, 21115 Devonshire Street, Suite 337, Chatsworth, CA 913 11 , 
(818) 700-0510 

Paint Cutter, see Accessory Pak I 

Paint MoueJ; prerelease version from users groups such as BMUG, 1442A Walnut Street, Suite 
162, Berkeley, CA 94709, (415) 849-91 14 

QuickPainl, Enterset, 410 Townsend Street, San Francisco, CA 94107, (415) 543-7644 

RarnStarl from users groups such as BMUG, 1442A Walnut Street, Suite I62, Berkeley, CA 
94709, (4 15) 849-9114 

ResEdit, from users groups such as SMUG, 1442A Walnut Street, Suite 162, Berkeley, CA 94709, 
(4 I5) 849-9 I14 

Ru/,ers, see Accessory Pak I 

SciFonls, Paragon Courseware, 4954 Sun Valley Road, Del Mar, CA 92014, (619) 481-1477 

SideKick, Borland International, Incorporated, 4585 Scotts Valley Drive, Scotts Valley, CA 
95066, (800) 255-8008, (800) 742-11 33 in CA 

Switche1; Apple Computer, Incorporated , 20525 Mar iani Avenue, Cupertino, CA 950 14, 
(800) 538-9696, (800) 662-9238 in CA 

ThinkTank, Living Videotext, Incorporated, 2432 Charleston Road, Mountain View, CA 94043, 
(415) 964-6300 

TurboClzargeJ; Nevins Microsystems, Incorporated, P.O. Box 1249, Capitola, CA 950 JO, 
( 408) 4 79-0860 

263 



Mac Insights 

A 
Al command, 252-53 
A> prompl, 257-58 
AbbrcviaLions, 137 
Accent grave, 255 
Accessory Pak I, 204-5, 210, 2 15 
Addresses, envelope, 164-66 
ADLOW, 78 
Alarm Clock, 2, 11 
Alen boxes, ediLing , 97-100 
Align O~jecls command, 205 
Alignment, in g raphics, 204, 206 
All SLar Compuler Services, 29 
ALRT resources, 100, JOI 
AILsys, 74 
Amplifier, audio, 29 
Amps, elecLrical, 32 
An imation , 223-28 

action , 225 
Answering. automatic telephone, 247 
Apple menu, Aashing, 11 
ApplcCarc, in foreign country, 33 
ApplcTalk 

errors, 23, 24 
lmageWriter a nd, 62 
LascrWriter and, 124 
printing problems caused by, 19 
setting, in Control Panel, 113 

Appl Font desk accessory, 76 
Applications 

Clipboard conversion when 
switching, 42 

Creator attribute of, 53 
documents compatible with , 2 
foms in, 85 
icons for, 53- 54 
locki ng, 54- 55 
memory use of, 43- 44 
moving, 56 
naming, 55-56 
paper sizes in, custom. 104- 5 
RAM disks, on, 39-40 
removing. 4 
resources in, 72, I00- 10 I 
shoncuts. adding Command-key, 

93-95 
speeding up, 40 
stanup, designating, 38 
switching , 40, 42- 43 (sef also 

Switche r) 
Type aLtribULe, 53 
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INDEX 
Arrow ke}'S 

O pen and Save comma nds with , 5 
simulating in Microsoft Word , 

130-3 1 
Art Grabber desk accessory, 173, 

214, 2 15 
Ascent of characters, 78 
ASCII codes, 79, 8 1, 177 
AssimilaLion. 39 
Athens font , 128 
Atkinson, Bill , 208, 2 14 
Attributes 

character, 142-43 
Creator and Type, 53 

B 
Backspace key 

erasing graphic obj ects with , 198 
insertion poim, finding with, 130 
restoring text erased by, 135 

Bar Graph format, Microsoft 
Multiplan, 240-4 1 

Baseline of fonts, 78 
Battery, clock. See also Parameter 

RAM 
dead , 14 
primer, affect on, 112 
resetting lmageWritcr wiLh, 18 
rescuing Mac with, 16, 17, 54 

Battery-powered Mac, 32 
Baud , 246,254,257 
Beck-Tech, 30 
Becker, LofLy, 76 
Beep, and screen snapsl10L, 4 
BcsL-qualiLy priming, 17, 108, 

114-15, 117, 119 
BidirecLional priming on 

lmageWriter, 120 
Bil Fixer, 29 
Bitmap images, printing. 11 7 
Bits, daLa, 246, 257 
Black areas. prin1 ing. 33 
Blank pages, removing, 111 
Blank spaces 

removing, 136-37, 162 
text centering, d isrupLio n of. 198 

Body Shop. 214 
Bold 

heavy, 195 
Microsoh Excel macro for, 23 1-32 

Break key, 255 

Brush , MacPaint 
as eraser, 199 
shapes, 176- 78, 180 

Brush Mirrors command, L80 
Bulletin boards, elecLronic, 252 
Busy signal , 252 
Buuons, operating fro m keyboard, 7 

c 
Cable 

disk drive, 12, 14, 15 
lmageWriter, 113 
keyboard , 13 
mouse, 11 
null-modern , 246 

Cadillac, 2 10, 212 
Cairo fom , 223 
Calculate Now, 237 
Calculations, spreadsheet 

hid ing, 235 
rounding, 233 

Call Wailing, 250- 52 
Camouflage. 228 
Cancel button , 7 
Caption text, 197 
Capture, fi le, 256-59 
Casteel , Michael A., 117 
Catalogs, disk, 57, 67 
Category axis, 24 1-43 
Ccl ls, spreadsheet 

copying comems of one to 
many, 233 

naming, 230 
order of cnLry, 234-35 
selecting. 230 

Cemering 
objects, 205 
text, 145-46, 198 
top-to-bottom, 163 

Change command 
Return characters, removing 

with , 167 
text, replacing with , 137 

Change Fam desk accessory, 76 
Characters 

bold style, in Microsoft Excel, 
23 1-32 

creating, 8 1 
exLrancous and missing, d uring 

communications, 253- 54 
formatting , in texl, 14 1- 43 



Characters (continued) 
overstrike style, 80 
Return, 153, 167, 260 
secret, typing 76 
strange, in using MacTerminal, 

260-6 1 
unprintable, 114 
widths, 80 

Chicago font , 79. 141 
Choose Printer desk accessory, 124 
Chooser desk accessory, 124 

lmageWriter use with , 17 
LaserWriter use with, 19 

Circles 
concentr ic, 218 
triangles, construCLion using, 

216-17 
Clean Up command, compacting 

small icon view with , 5 1 
Clear command, 198 
Clear Lines Off Top command, 

MacTerminal, 247 
Click A rt Effects, 118 
Clipboard, 198 

clearing, 10, 233 
Switcher, conversion with, 42 

C lipboard File, 48 
C lock battery. See Bauery, clock 
C lock memory. Su Parameter RAM 
Clock. inaccurate, 14 
Color pr inting on lmageWrite r, 19 
Columns 

alig ning text in , 146 
hiding in spreadsheets, 235 
width in spreadsheets, 235 

COM l :, 258, 259 
Comma 

for diali ng pause, 248 
key, viewing MacPaint fonts and 

font sizes with, 6 
Command key 

arrow keys and, 5 
cell entry, designating order with , 

234- 35 
dragging a window with , 2 
hyphen, as optional, 145 
icons, a r rang ing with , 52 
patterns, transparent, in 

MacPaint, 182 
screen snapshot with, 4 
selecting with , 134, 230 
shortcuts using, 3, 7, 8, 93-95, 179, 

23 1-32, 255 
tools, reusing in MacDraw with, 

18 1 
Communications 

answering ca lls automatica lly. 247 
best times to call , 246 

Communications (co11li1111ed) 
captu red information, 

cleaning up 259-60 
compatibility settings, 246 
d irect connections, 246 
full disk, dealing with , 247 
Fade to Black problems, 28 
gibberish in, 253-54 
keyboard, using MacTerminal, 

255-56 
placing calls, 248-53 
transferring information, 256-59 

Compatibility settings, 246 
CompuSer ve, 8, 256-57 
Concentric shapes, 2 17-19 
Constants, converting spread sheet 

formulas to, 237 
Control key, 255 
Control Panel desk accessor y 

animation speed, controls, 223 
battery removal, use after, 54 
desktop pattern , sets of. 50 
LaserWriter, required with , 124 
touch setting, 5 

Coordinates, MacPaint drawing 
window, 204-5 · 

Coordi nates desk accessor y, 205 
COPY command , IBM PC, 258 
Copying graphics, 200-203 
Correspondence, 15 1, 156, 157, 161 
Courier font, 125, 126, 127, 14 1 
CP/M, 258-59 
Creator attribute, 53 
Cred it-card calls, 250-25 l 
CURS resources, 90-91 
Cursor. See Insertion point; Pointer 
Curves 

from lines, in MacDraw, 22 1 
smoothing, in MacPaint, 182 

Cusps, 221 

D 
Data bits, 246, 257 
Databases, 40 
Dates, 155-56, 238-39 
Dayton Fonts, 142-43 
Decimal places in spreadsheets, 233 
Define ame, 230 
Delay Between Lines, 253 
Delete key, 255 
Delphi , 8 
Descelll of characters, 78 
Desk accessories, 63, 64. See also 

individual accessories 

Index 

Desktop 
file, 53, 68, 88-89 
patte rn, 50 

Dialog boxes 
editing of, 97-100 
shortcuts in, 5-6, 234 

Dimensions 
font, 78 
of MacDraw objects, 2 16 
in MacPaint, 204-5 

Direction keys. See Arrow keys 
Disk cache 

with Switcher, 20, 43 
uses, 40 

Disk drives. See also Disks 
hroken, 10, 12, 14- 16 
cables for, 12, 14, 15 
changing, 5, 7 
d irty, 10, 14 
double-sided, 39 
dual drive, using, 68 
externa l, placement of, 26, 29 
power requirements, 32 
RAM disk, 67 
single drive, using, 67 

Disklnfo desk accessory, 64 
Disks. See also Disk drives; RAM disk 

bad, 10, 16, 17, 69 
catalogs, 57, 67 
copying, 56 
document-only, 67, 68 
ejecting, 3-4 , 7, 12, 15, 68 
erasing, 67, 69 
full , 14, 17, 119-20, 247 
icons, removing from , 3 
initializing, 16, 67 
life of, 26, 29 
locked, 14, 17, 114-15 
naming, 55-56 
organizing, 67-68 
salvaging, 69 
space on, 4. 62-67, 124 
startup, 12, 48-50, 69, 124 

Displaywrite, 26 1 
DIT L resources, 97-99 
DLOG resources, 97- 98 
Documents 

blank pages in, removing, 11 l 
complex and large, 10 
converting, 167-69, 260-61 
copying , 56 
Creator auributes of, 53 
deleting, 64 
disks of, 67, 68 
formatting , 159-66 
icons for, 53-54 
locking, 54-55 
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Documents (r.011.tinued) 
moving, 56 
naming, 55-56 
opening, 2, 14, 42-43 
printing multiple, 109 
on RAM disks, 39 
saving to, problems with, 14 
scrolling quickly through, 40 
selecting entire, 134 
splitting, I 0 
with Switcher, 42-43 
templates for, 163-64 
temporary, 64 
text-only, 64, 26 1 
type attributes of, 53 
unformatted, 64 

Don't Record Lines Off Top, 254 
Dots 

lmageWriter. 117 
screen , 29 

Double-click. See Mouse 
Dover font, 116, 141 
Draft-quality printing, 62, 

11 5-16.119 
Dragging, 2 
Drawing window, 180, 210 
Drawings, Mac Draw. See also 

Pictures, MacPaint 
animating, 224-26 
enlarging, 216, 222 
printing, 119-20, 127-28, 187 
reducing, 206, 2 16 
selecting, 173-74 
Duplex, 254 
Duplicate command, MacDraw 

symmetry with, 219-20 
D\'orak keyboard, 92 

E 
Echo, 254 
Edit menu, Comma nd-key 

equivalents, 3 
Ejecting disks. 3-4, 7, 12. 15, 69 
Electricity, 31-33 
Emergency exit, Switcher, 45 
En largements 

with MacDraw, 216, 222 
with MacPaint. 2 10-11 , 213-14 
with MacWrite and Microsoft 

Word, 140 
printing, 110 
thinning, 213-14 

Enter key 
dialog boxes, use in. 6 
insertion point, finding with, 130 
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Enter key (co11ti11ued) 
mixing text attributes in MacPaint 

with, 194 
spreadsheets, use in , 234-35 

EnterSet, 215 
Envelopes 

Formatting addresses for, 164-66 
printing, 128 

Equal sign, 237 
Equations 

subscripts and superscripts in , 
142-43 

typing, 14 1 
Equilateral triangles, 216-17 
Eraser, 177, 179 
Erasing 

d isks, 67, 69 
graphics, 198-99 

Error alerts, 11 , 12. See also Messages 
Error messages. See Messages 
Errors. See also Messages; System 

errors 
in AppleTalk, 23, 24 
disk, 10, 16, 17, 23, 69 
d isk fu ll, 14, 17, 119-20, 247 
fi le, 22-23 
ID codes of, 21-24 
input, 22 
memory, 24 
output, 22 
Parameter RAM, 23 
printing, 16-20, 28, 112-13, 114, 

119-20, 123 
resource. 24 
in spreadsheet formulas, 237 

Escape key, 255 
Excel. See Microsoft Excel 

F 
Fade to Black desk accessory, 28 
Fanny Mac, 30 
Fans. for cooling equipment, 30, 34 
Faster-quality printing, 17. 108. 

114-15, 119, 120 
FatBits 

activating precisely, 179 
shortcut to, 180 
tools in, 179 

Fcdit, 69 
Female Disguise Kit, 2 14 
File Filter desk accessory. 261 
Files 

DeskTop, 53, 68, 88-89 
disks, storage capacity of, 66- 67 
dividing in MacTerminal, 259-60 
errors in, 22-23 
finding by typing. 5 

Files (co11ti11ued) 
invisible, 50 
locking, 54-55 
removing, 65 
salvaging, 69 
temporary, 64, 67 
transferring, 257-60 

Filling, graphics, 188, 196 
Filter programs, 261 
Find command, 131-32 
Finder 

bypassing, 38 
damaged, 13 
desktop, 4, 68 
d isks, ejecting from, 3 
documents, opening from, 2, 3 
font, 54 
icons in, 3, 52, 53 
invisible, making, 49-50 
missing, 13 
pr inting from, 109 
RAM disk on, 40 
removing, 4, 62 
renaming, 49 
starting up with, 38 
startup disks and, 48, 49 
with Switcher, 41 
version 4.1, 124 
windows in, 51, 52 

Fingerprints on disks, 34 
FixPic desk accessory, 117 
FKEY resource, 92-93 
Flip command, 172, 219-20 
Folders, 15, 56, 5 7 
FOND resources, 80, 84 
FONT resources, 77-79, 82-84, 9 1, 

176-78 
FONTastic, 74 
Font/DA Mover 

disk space, freeing with, 63 
fi le, opening in, 85 
fonts and desk accessories, 

removing, 63 
startup disk, modifying with, 48 

Fonts. See also individual font names 
application files in, 85 
for best-quality printing, 115 
characters, 

changing, 77-79 
creating and adding, 82-84 

dimensions of, 78 
disk space used by, 63 
for draft-quality printing, 115 
fami lies of. 84 
Finder, wrong, 54 
headers and footers in MacWritc, 

155-56 
LaserWriter, used with , 79, 124-28 



Fonts (co11ti1111ed) 
MacPaint, used wiLh . 6, 176-78, 

192-93 
measuring, 78 
memory use, 38 
mixing in documcms, 194, 196 
monospaced, 14 1 
proponio nal, 141 
removing from disk, 63 
resou rce 1 D numbers of, 82-84 
in ROM , 39 
secret characters in , 76 
sta ndard , chang ing of, 76 
on stanup d isk, 48 
subscripLs and superscripts in, 

142- 43 
Footers 

as bottom marg in , 16 1 
foms in , 155-56 
using pictures in , 156 
spreadsheet, 239-40 
windows, 1'1acWrite, 154 

Footnotes, 158 
FormaLLing 

characters, 14 1-43 
documems, 159-66 
footers and headers, 155-58 
lines, 143-46 
paragraphs. 147-54 
rulers, in MacWrite (see Rulers, 

formatt ing) 
templates. 163 
text 

in MacPa inL, 192-93, 194 
in MacDraw, 196 

Formulas, spreadsheet 
copying, 236 
converLing to consLants in 

MicrosofL MulLiplan , 237 
dates, computing d ifference 

beLween two, 238-39 
errors in , bypassing, 237 
fixed va lues. convening Lo, 237 
hiding. in spreadsheets, 235 
subscripls and superscr ipls in, 

142-43 
typing. 14 1 

Frames, animation, 225-26 
Free space, on d isk, 63- 65 
Full Precision, 233 
Funct ion keys, 92- 93 

G 
Gauges, for enlargemem and 

reduction. 216 
Geneva font. 76. 125, 14 1 

Gel Info 
comme111 s box, 55, 68, 97- IOO 
locking, 54-55, 114- 15 

Glossary in MicrosofL Word, 158 
GoLO command in Microsoft Excel 

and Multip lan, 230 
Grabber, 6, 180 
Graphics. See also Drawings; Pictures 

animation, 223-28 
constructing objects, 216-22 
copying, 200-203 
erasing, 198-99 
fi lling, 188 
hal fLOne screen simulation , 182-84 
layout, 203-6 
letlering. 192-98 
moving, 200-203 
patterns, 20. 185-87 
print ing, 20, 33 
removing obj ecLs. 198- 99 
resizing, 207-16 
shadows, 19 1-92 
shapes, 179, 217-19 
smoothing. 222 
special effects, 227-28 
symmetry, 180, 2 19-20 
transparency, 182, 20 1 
tria ngles, 216-17 

Graphs 
scatter, 24 1-43 
spreadsheel, 240-43 

Grays, on LaserWriter, 187 
Grid 

MacDraw, 2 19 
MacPai nt, 203, 208 
spacing, 203, 205 
three-finger stretch with , 208 

Gross domestic producL graph, 243 
Grounding, electrical, 31 

H 
Halftones, 182- 84 
I-land. Ser Grabber 
Handles in MacDraw, 174, 22 1 
Ha ndshake, 113, 246, 254 
Hang up (modem comma nd), 248 
Hard disk drives, 13, 108. See also 

Disk drives 
Hard Disk 20 fi le, 11, 12, 15, 16 
Hayes Microcomputer ProducLs, 108 
Headers 

fonts in , 155- 56 
pictures in, 156 
for spreadsheets, 239-40 
suppressing. 157 
as top margin. 16 1 
in windows, MacWrite, 154 

Headings, 149-50 
Help files, 65 

Index 

Helvetica font, 125, 126, 127, 14 1 
Hierarchical File System ( I IFS) 

arrow keys, using with, 5 
disk un readable, 16 
drives, changi ng with , 5 
fo lders missing, 15 
single-sided disks and , 67 
sta rlup disks, 48 
Switcher 4.4 and , 43 
HoL spoLs in icons, 90, 9 I 
Hyphens, 144-45 

I 
IBM PC, 257-58 
ICN# resources, 86-89 
ICON resources, 86-89, 95-97 
ICON Switcher, 74 
Icons 

blank, 53-54 
in DeskTop fi le. 53 
ed iting, 86- 89 
Finder, 5 1-52 
generic, 53-54 
MacWrite header and footer. 

155-56 
masks, 88 
menu, 95-97 
MiniFinder, 59 
naming. 55-56 
removing d isk, 3 
removing locked , 4 

ID codes, errors in, 21-24 
IF function in MicrosofL Muhiplan, 

240-4 1 
lmageWriter 

AppleTalk and, 62 
bidirectional printing on, 120 
broken, 16- 17, 18, 33, 112 
cable. 11 3 
and Chooser, 17 
color printing on, 19 
fi les, 62, 117, 119 
maintenance of, 33 
orientation of page on, 18 
paper, loading, 18, 113, 120, 121 
paper sizes, custom, 102-5 
power requirements, 32 
print qualiLy problems, 17, 18, 

112- 13, 114, 116 
printer bul'ler, 17, 108-9 
RAM disk, using with , 40 
Select switch, 16, 17 

267 



Mac Insights 

lmageWriter (cor1ti1111ed) 
setup, 115-16 
switch settings, 17, 19, 113, 122 

Indentation, MacWritc, 14 7-5 1 
Information services, onlinc. See also 

Information, transferring 
best times to call , 246 
calling, 248-53 
efficient use or, 8 
gibberish from , 253-54 
keyboard use, 255-56 

Infosphere, 109 
Initializing disks, 16, 67 
Insertion poi nl 

finding, 130 
moving, using keyboard. 130-3 1 
pictures, positioning with. 138 

Installer 
LaserWriter, use with, 19, 124 
priming resources, use with, 17 

Invisible 
files, 50 
Finder, 49-50 
formatting rulers, 151-52 
typing, 254 

Italics, 141 

J 
Jazz 

errors, bypassing in formulas 
using, 237 

manual calculation in, 237 
J ohnat han Freeman Designs, 108 

K 
Key Caps desk accessory, 81, 92 
Key equivalents of menu 

commands, 94 
Key Repeat Rate, 223 
Keyboard 

cable, 13 
dead, 13 
erratic, 14 
insertion point, finding with, 130 
repeat rate, 223 
shortcuts in Microsoft Excel, 

23 1-32 
simulating missing keys. 255 
T ilde key, 223, 255 

L 
Labels, printing, 128 
Laser Prep file, 62, 124 
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Laser Writer 
Chooser and, 19 
Control Panel required for, 124 
envelopes, priming with, 128 
fi les for, 62, 124 
fonts, 19, 20, 79, 125, 126 
formatting for, 19, 123-25 
gray tones, printing with, 187 
italics on, 141 
labels, printing with. 128 
manual feed, 128 
with RAM disk, 40 
repairing, 19- 20, 112 
slow printing, 20, 127-28 
toner cartridge, 123 
uneven printing, 123 

Lasso, 172, 173, 179, 200 
remote-control pointer, 200 

Layout 
Leading, font, 78 
Lellerhead , 161 
Lcuering in graphics, 192-98 
Letters. formatti ng and printing, 

156, 157, 161 
Levco, 30 
Library. pattern, 187 
Life expectancy chart, 24 3 
Linc Breaks option, MacWrite, 260 
Lines 

breaking text at hyphens. 144-45 
centering text, 145-46, 163, 198 
dashed and doued, in MacPaint, 

18 1-82 
erasing, in MacPaint, 199 
45-degree angles, drawing at, 2 17 
heights, custom, 144 
patterned. 18 1 
selecting text, 132-33 

Lisa. See Mac XL 
LisaVision, 29 
Local Echo option, 

MacTerminal, 254 
London font. 128 
Long-distance calls, 250, 253-54 

M 
Mac. Sre also Battery, Clock; Cable; 

Disks; Disk drives; Keyboard; 
Mouse; Memory; Parameter 
RAM; Screen, d isplay; 
Speaker; Startup 

confused , 15, 16, 18 
cooling, 30 
in foreign country, 33 
grounding, 3 1 
memory, 512K versus 128K, 38 

!\lac (<011ti1111ecl) 
opening the case. 34- 35 
power requirements, 32 
repairing, 11. 12, 13 
reselling with clock bancry, 16. 17, 

54 
upgrading, 39 

Mac Memor y Disk, 39 
Mac XL. 29. See also Mac 
MacBooster. 40 
MacBottom. 108 
MacBreeze, :~o 
MacDraw. S1'e al.so Drawings; 

Graphics; Printing 
aligning objects. 206, 225 
animation, 224-26 
blank pages, removing, 111 
centering obj ects, 173, 205 
curves, 221 
documents 

large or complex, 10 
opening several at once, 3 

duplicating objects, 203, 2 19 
erasing objects, 199 
filling arou nd objects, 188 
grid. 205, 219 
handles, 174, 221 
hiding objects, 199 
lmageWriter file required with. 119 
lines, drawing, 219 
lost objects, finding, 206 
MacPaint pictures in, 215 
mani pulating objects, 200, 202, 

2 15, 221 
margins. 110 
measuring objects, 205, 216 
patterns, 187, 188-90 
priming, disk space required 

for, 120 
scrolling slowly in , 222 
selecting objects, 173, 174 
shadows in, 191-92 
shapes, drawing, 218-22 
symmetry in, 2 19-20 
using text with, 196-98 
tools, reusing, 18 1 
transparent ohjects, 225 

MacDrive, !08 
Macintosh. See Mac; Mac XL 
MacLink, 168, 26 1 
Mac~late!, 39 
MacPaint. See also Graphics; Pictures; 

Priming 
alignment in, 204. 205 
a nimation, 223-24, 227-28 
brush mirrors, 180 
brush shapes, custom, 176-78 
copying in, 201-2 



MacPaint (continued) 
curves, smoothing in, 182 
desktop patterns, 50 
enlargements, 207, 210- 11 , 213-14 
erasing, 199 
Fade to Black, problems with , 28 
FatBits, using with, 179 
fi lling around objects, 188 
Grid, 203, 208 
halftone screen simulation, 182-84 
lines, 18 1-82, 199 
measuring in, 204-5 
memory use, 38, 43, 65 
moving objects, 200-201 
pasting in, 208 
patterns, 185, 186-87, 227-28 
PICT resources, 65 
pictures in MacDraw, 2 15 
pointer, remote-comrol, 200 
Pri111 Catalog command, 57 
Print Final command, 117 
pri111ing, d isk space required 

for, 120 
reductions, 207, 209 
selecting, 172, 173 
shadows, 19 1-92 
shapes, drawing, 179, 2 16-18 
shortcuts in, 6, 180 
smoothing, 214 
text, use in, 192-97 
thi nning pictures, 214 
three-finger stretch, 207 
tools, 175, 179 
transparency, 182, 201 
wide documents in, 118 
window, size of, 2 10 

MacProject, 7-8, IO 
Macros in Microsoft Excel, 

231-32, 242 
MacServe, 109 
MacTerminal. See also 

Communications 
automatic answering, 24 7 
compatibility settings, 246 
disk fu ll, 24 7 
docume111, opened with 

MacWrite, 2 
echo settings, 254 
keyboard, 255- 56 
MacTracks, using with , 256 
modem commands in, 248 
redialing continuously with , 252-

53 
screen clearing, preventing in , 

256-57 
strange characters using, 260-61 
text selecting in, 260 

MacTracks, 256 

MacWrite. See also Fonts; Printing; 
Text, graphics; Style; Word 
processing 

animation in, 226 
backspaced text, restoring, 135 
centering, 145-46, 163 
colum ns, aligning text in , 146 
compatible documem types, 2 
envelope addressing, 164-66 
footers, 154-57 
footnotes, 158 
headers, 154-57 
hyphens, 144-45 
indentation, 147- 5 1 
insertion point, finding, 130 
letterhead, creating and spacing 

headers for, 161 
line height, 125, 144 
locked documents (saves over), 

54-55 
MacTerminal documents, opening 

with, 2 
margins, 110, 161 
page breaks, 162 
paragraph formatting, 147-52 
paragraphs, too many, 148-49 
pictures in, 117, 118, 138-40 
place markers, 13 1-32 
printing, disk space required for, 

120 
splitting fi les, 259-60 
using windows in, 138, 159, 160 

Magnum Software, 27 
Mainstay, 40 
Maintenance 

d isk, 34 
of lmageWriter, 17, 33 
keyboard, 34 
of Mac in foreign counu·ies, 33 
of mouse-button switch, 27-28 
opening Mac case, 34-35 

Maitreya Designs, 64 
Margins 

bottom, 161 
changes in, automatic, 110 
MacWritc, 147, 159, 160 
picture location, effect on, 138-39 
text, in MacPaint, 192-93 
top, 161 

Markers in text documents, 
131-32 

Marquee. See SeleCLion rectang le 
Masks 

erasing in MacDraw with, 199 
icon, 88 
pointer, 90, 9 1 

Matthews, Brian L., 28 
MDC ll , 57, 67 

Index 

Memory 
applications in, 43-44 
cluttered, I 0 
conserving, 4 1 
insufficient, causes and cures, IO 
in Microsoft Word, effects of 

low, 134 
RAM disk and, 39- 40 
with Switcher, requirements and 

allocation, 43-44 
test, fa iled , 12 
upgrading, 34 
uses of, 38 

MENU resources, 93-97 
Menus, 3, 7, 93-97 
Messages 

An application can't be found far 
this docwnenl, 2 

A re you sure you want to 
remove .. . ?, 4 

Can't load Finder, 13 
hidden , 228 
ID codes, 21-24 
memory, too little, IO 
Not enough disk space to print current 

page, 119 
Please insert the disk ... , 3 
R eplace items with same names with 

the selected items?, 57 
Serious system errar . .. , 2 I, 68 
Session too long : low on 

memory . .. , 134 
System error, I 0, 21 
Thal item is locked or in use, and can't 

be removed, 4 
The print command was not 

com/1/eted, 119 
Too many paragraphs for this 

document!, 148-49 
Microsoft BASIC, 7 
Microsoft Chart 

d ialog box shortcuts, 7 
grays, printing on LaserWriter, 187 

Microsoft Excel. See also Priming; 
Spreadsheets 

blank rows and columns, 11 1-12 
bold text, 23 1-32 
calculations 

manual in, 237 
rounding in, 233 

cell entry, order of in, 234-35 
cells, selecting in, 230 
charts in, 24 1-43 
Clipboard, clear ing, 233 
column width, 235 
command-key shortcu ts, 23 1-32 
copying in , 233-34, 236 
dialog box shortcuts, 7, 234 
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Microsoft Excel (continued) 
draft printing, 62 
enlargements, previewing, 6 
E111 er key, use wi1.h , 234-35 
footers, 239-40 
formula errors, bypassing. 237 
grays. printing on LaserWriter, 187 
headers. 239-40 
macros, 23 1-32, 242 
margins, 110 
memory required, 43 
names in, 230, 232 
nonadjacent pages, priming in, 112 
opening several documents in, 3 
page breaks, 111 
precision, 233 
print area, 111 
Resume Excel icon, 5 1 
scauer graphs in, 24 1- 4 3 

Microsoft File, 7 
Microsoft Multiplan. See nlso 

Printing; Spreadsheets 
bla nk rows and columns, 111-12 
calculations 

manual in, 237 
rounding in , 233 

cell entry, order of, 234-35 
calculation , manual in , 237 
calculations, rounding in , 233 
C lipboard , clearing, 233 
column width, 235 
dates, computing difference 

between two, 238-39 
dialog box shortcuts. 7 
draft printing, 62 
Enter key. use with , 234- 35 
formulas 

convening to constants in, 237 
copying from, 236 
errors, bypassing in , 237 

graphs in , 240-4 1 
headers and foo ters, 239-40 
naming cells, 230 
nonadjacent pages, priming, 112 
page breaks, 111- 12 
selecti ng cells in , 230 

Microsoft Word. See also Fonts; 
Printing; Style; Tex t, 
graphics; Word processing 

animation in, 226 
character formats, 143 
columns, align ing text in, 146 
copying text directly in , 136 
deleting previous word in. 7 
dialog box shortcuts, 7 
envelope addressing, 164-66 
files, sp li tting, 259-60 
insenion point, finding, 130 
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l\licrosoft Word (contirmed) 
keyboard navigation , 130- 3 1 
leuerhead and. 16 1 
line, new, 143 
line height, custom, 144 
locked documents, saves over, 

54- 55 
margin changes, au tomatic, 1 IO 
memory low, 134 
moving text directly in, 136 
page breaks, 162, 163 
page numbers, 157-58 
paragraph formauing, 153-54 
pictures in, 138-40 
place markers, 13 1-32 
Preferences command, 11 6 
printing, disk space required 

in, 120 
printing, draft, 62, 115-16 
rulers, formauing, 153-54 
selecting in, 7, 133 
ThinkTank documents in , 168-69 
windows, multiple, 137 

Milestone, MacPrc~ect , 8 
MiniFinder, 58-61 
Mitchell , john, 69 
MockWrite, 138, 158 
MODE command, IBM PC, 257-58 
Modems 

automatic answering, 24 7 
bypassing, 246 
commands, typing directly, 248 
dialing commands, special, 249 
long-distance dialing, 250 
noise filtering, 254 
pause during dialing, 248 
redialing with , 252 

Monaco font, 115, 125, 126, 127, 141 
Mouse 

broken, 10 
button switch, 27- 28 
cable loose, 10 
dirty, 10 
disassembling, 27-28 
documents, opening from the 

Finder with. 2 
double-clicking in Microsoft d ialog 

boxes, 7 
feet, II , 27 
screen saver, deactivating with , 11 
selecting with , 132-34, 

172-74, 230 
windows, dragging with, 2 

Mouse buuon, 27-28 
Mouse Mover, 27 
Mouse pad, 27 
Moving 

Alarm Clock, 2 
constraining, 200 

Moving (co11tirwed) 
graphics, 200-203 
windows, 2 

MS-DOS, 257-58 
Multimate, 168, 26 1 
Multiplan. See Microsoft Muhiplan 

N 
Names 

application, 55-56 
cell, in spreadsheets, 230 
dates in , 55 
disk, 55-56 
document, 55-56 
font. 83-84 
length of, 55, 67 
long, 55, 56 
macro, 232 

Nelson, George A., 39 
1evins, 40 

New Caanan Microcode, 57, 67 
New York font, 76, 125, 126, 127, 14 1 
Note Pad desk accessory 

footnotes in MacWrite with, 158 
typing in MacPaint with, 192 

Note Pad File, 48 
Notepad+ desk accessor·y, 138, 158 

ull-modem cable, 246 
Number of Rings Before Answer 

option, MacTcrminal , 247 

0 
Objects, constructing, 2 16- 22 
Offset, character, 78 
Oil, to lubricate lrnageWriter, 33 
OK button, keyboard equivalents 

for, 6 
Open command 

arrow keys and, 5 
date, list by, 55 
dialog boxes, editing with , 100-101 

Opening documents from Finder, 
2, 3 

Option key effects 
cell contents propagation, 233-34 
character combinations, unused , 8 1 
Clipboard conversion in Switcher, 

42 
cusp designation in MacDraw, 221 
files, opening in FonliDA 

Mover, 85 
font name changing, 83 
grabber, 6 
grouped object movement in 

MacDraw, 202 
ha rd spaces, 14 I 



Option key effects (co11ti11ued) 
HFS on single-sided disks, 67 
icon realigning in Finder, 52 
lines, patterned, 181-82 
MacPaint 

copying in, 218 
duplicating in, 201 

MiniFinder, bypassing, 6 1 
polygon-closure blocking in 

MacDraw, 220 
startup disk switching, 49 
text copying and moving, 136 
windows in Finder, 52 

Outline-style text, compact, 194-95 
Ovals 

borderless, 179 
concentric, 218 

·patterned, 18 1 
Overlapping MacPaint copies, 201-2 
Overstrike characters, 80 

p 
Page breaks, 111 , 162 
Page numbers, 155-56, 157-58 
Page Setup options 

Font Substitution option, 
LaserWriter, 19 

headers and footers, 239-40 
illustrated, 110 
margins, 19 
No Gaps Between Pages, 114, 
12 1-22 
orientation, 118 
paper sizes, custom, 102-5 

Pages, scrolling by, 130-31 
Paint can, MacPaint 

erasing with , 199 
in FatBits, 179 
filling around objects with, 188 

Paint Cutter, 11 8, 173, 215 
Paint Mover, 118, 173, 2 14 
Paintbrush, ~lacPaint 

as eraser, 199 
shapes, 176-78, 180 

Paper, lmageWriter 
loading, 18, 113, 120, 121 
sizes, 102-5, 122 
wrinkles, 113 

Paragraph text, MacDraw, 197 
Paragraphs 

formatting, 147-54 
limits in MacWrite documems, 

148-49 
option, MacWrite, 260 
Return key, 167 
selecting, 133 

Parameter RAM. See also Battery, 
clock 

clearing, 54 
errors, 23 
font, standard, 54 
resetting, 16, 17, 18 

Parity, 246, 257 
Paste Special command, Microsoft 

Excel, 242 
Patterns 

animation by varying, 227-28 
custom, MacDraw, 188-90 
desktop, 50 
editing, MacPaint, 180, 185, 

186-87 
hidden messages with , 228 
library of, MacPaint, 187 
lines, 18 1 
"None" in MacDraw, 206 
position dependence, 181-82 
printing, 116, 128 
stretching, MacPaint, 208 
system fi le identification with, 50 
text, 196 
text over, MacPaint, 194 
three-finger stretch with, 208 
transparent, 182 
variations of, 227-28 

PBl Software, 74 
PBX, dialing through, 248-49 
Pencil, MacPaint, 6 
Period key, 6 
Personal Computer Peripherals 

Corp., 108 
Photographs, simulating, 182- 84 
PICT resources, 65 
Picture tube coating, excess, 10, 11. 

See also Screen, display 
Pictures, MacPaint. See also 

Drawings, MacDraw 
animating, 223-24, 227-28 
enlarging, 210-11 , 214 
in MacWrite headers and 

footers, 156 
positioning, 138-39 
priming, 118 
reducing, 209 
selecting, 138 
smoothing, 214 
in text documents, 138-40 
thinning, 213-14 

Pierce, Mark Stephen, 2 14 , 226 
Pipe, grounding Mac cable to, 31 
Point size, 78 
Pointers 

editing, 90-91 
grid, movement constrained 

to, 203 

Index 

Poimers (co11ti11ued) 
hot spot, 90, 91 
problems with , 11 
remote-comrol, MacPaint, 200 

Polygons 
borderless, 179 
closure of, blocking in 

MacDraw, 220 
dotted and dashed, 181-82 
self-closing, 179 

PREC resources, 102-5 
Print Catalog command , 

MacPaint, 57 
Print spoolers, 17, 108-9 
Printer. See lmageWriter; 

Laser Writer 
Primer buffer, 17, 108- 9 
Printer Setup, 115-16 
Printing. See also ImageWritcr; 

Laser Writer 
best-quality, 17, 108, 114- 15, 

11 7, 119 
black areas, 33 
blank pages, removing, 111 
color, 19 
d raft-quality, 62, 115-16, 119 
enlargements, 110 
envelopes, 128, 164-66 
fasterquality, 17, 108, 114- 15, 

11 9, 120 
from Finder, 109 
font substitution during, 126 
with full disk, 119-20 
labels, 128 
on LaserWriter, preparing 

documents for, 123- 25 
on letter·head, 161 
withMacDraw on LaserWriter, 

127-28, 187 
margins, 19. 110 
multiple documents, 109 
overstrike text, 80 
page breaks, 11 2, 12 1-23 
page orientation, 18, 118 
paper, loading, 121 
paper size, 122 
patterns, 116, 128, 187 
pictures outside MacPaint, 117, 118 
previewing, in Microsoft Excel, 6 
reductions, 110 
resources, 17, 48, 117 
slow, on LaserWriter, 127-28 
trouble, 16-18, 28, 114, 123 
wrinkled paper, 113 

Programs. See Applications 
Prometheus ProModem, 249 
PUN command, CP/M, 258-59 
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Q 
Quick Disk, 39 
QuickDraw, 39 
QuickPaint, 173, 2 15 

R 
Radio Shack Model 100, 259 
RAM cache 

with Switcher, 20, 43 
uses, 40 

RAM disk 
applications on, 39-40 
documents on. 39 
Finder on, 40 
fonts on, 85 
ImageWriter and, 40 
with Switcher, 43 

RamStart, 39, 67 
Record Lines Off Top c:ommand, 

Mac"lc rmina l, 259 
Recorder, Microsoft Excd macro, 

23 I- 32 
Rectangles 

borderless. 179 
concemric, 2 I 8 
erasing with , 199 
patterned, 18 1 

Redial, 252-53 
Reductions 

using MacDraw, 206, 2 I6 
using MacPaint, 209 
using MacWrite and Microsoft 

Word, 140 
in printing, I 10 

Remote-control pointer, 200 
Repairs. See Maintenance 
Res Edit 

brush shapes, editing in MacPaint, 
176-78 

characters, adding to fonts, 8 I 
dialog boxes, editing in, 98-IOO 
font names, changing, 84 
font-editing window, 77-79, 80, 

177-78 
fonts, changing characters in, 77-

79 
fonts, creating, 82-84 
function keys creating, 92-93 
HFS disks, using with , 74, 75 
icon editing, 86-89 
MacPaint help, removing, 65 
menu 

editing window, 94 
icons, adding, 95-97 
style changes, 95 
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Res Eel it (continued) 
overstrike char·acters, creating, 80 
paper size changes, 102-5 
pauern changes, MacDraw, 188- 90 
pointer editing, 90-91 
poimer-ecliting window, 90 
reset from keyboard. 92-93 
startup disk switching, preventing, 

49- 50 
template editing, 102-3 
using, 74-75 
versions of, 74 
windows, 74- 75 
wording changes, 95 

Reset from keyboard, 92- 93 
Reshape command, MacDraw, 221 
Resizing, 207-16 
Resources 

ALRT, I00-10 1 
in applications, 72, 100-IO I 
changing, 74 
CURS, 90-9 1 
dialog box, 97-98 
d ialog item list, 97-99 
DITL, 97-99 
DLOG, 97-98 
FKEY, 92-93 
FOND, 80, 84 
FONT, 77-79, 82-84, 91 , 176-78 
ICN#, 86-89 
ICON, 86-89, 95-97 
ID numbers, 72, 75, 82, 93, 

95-97, IO I 
invisible dialog list, 101 
keyboard, 92-93 
ME U, 93-97 
names, 83 
PAT#, 189- 90 
PICT, 65 
PREC, 102-5 
precedence of duplicate, 72 
printing, 17, 62, 124 
in ROM, 39 
standard, list of, 73 
templates, I02-3 
TMPL, 102-3 
types, 72, 73, 75 

Restart, 4 
Return address, printing on 

envelope, 166 
Return characters, 153, 167, 260 
Return key 

in dialog boxes, 6 
MacProject task or milestone, 8 

ROM upgrading, 39 
Rotate command, 172 
Round ing spreadsheet 

calculations, 233 

Rulers 
formauing in MacWrite 

changing qu ickly, 147- 48 
invisible, 151-52 
pictures, near, 139 
specificat ions, 147 

in MacPaint. 204- 5 
Rulers desk accessory, 204, 210 
Running heads, 157-58, 239-40. See 

also Footers; Headers 

s 
Sad Mac icon, 12 
Save as 

arrow keys and, 5 
dialog box editing, I00-10 I 

Scaling 
graphs in Microsoft Multiplan, 

240-41 
precisely in MacDraw, 216 

Scauer graphs, Microsoft Excel, 
24 1- 43 

ScauerGram macro, 242 
SciFonts, 143 
Scrapbook 

animation in, 224- 26 
enlarging MacPaint pictures 

via, 2 10-11 
multiple, 63-64 
pattern library in, 187 
purging, 63-64 
spreadsheet formulas, converting 

to constants with , 237 
... anup disk. on, 48 

Screen, display 
cleared during communications, 

256-57 
dimming, 28 
d istortion in Mac XL, 29 
clots in Mac XL, 29 
dumps, 4 
etching, 28 
LaserWriter foms on, 124-25, 

126-27 
picture tube, JO, 11 
snapshots, 4, 193, 209 
trouble, 11 , 12 

Screen, halftone, 182- 84 
Screen clumps, 4 
SCSI devices, I 2 
Secret characters, typing, 76 
Select switch, lmageWriter-, 16, 17 
Selecting 

cells in spreadsheets, 230 
graphics, I 72-74 , 200 
text, 132-33, 260 

Selection box, picture, 139-40 



Selection rectangle 
constraining, 200 
enlargements with, 2 10- 14 
in MacDraw, 174 
properties in MacPaint, 172 
resizing, 207 
size of, 208 

Send to Back command, MacDraw, 
206 

Sending a file, 257-59 
Sentences, selecting, 130-3 1, 133 
Set Startup, 38, 43, 62 
SetBold, Microsoft Excel macro, 

231-32 
Shadows, drawing, 191-92 
Shadow-style text, compact, 194 
Shapes, drawing, 179, 18 1, 2 17-19 
Shift key 

constraining movement with, 200 
constraining tools with, 175 
extending selection with, 133-34, 

174, 230 
Shortcuts 

Command-key, 93-95 
dialog box, 5, 6, 7, 234 
in MacPaint, 180 

Show Page command, MacPaint, 
180, 199,209 

Show Size command, MacDraw, 
215, 216 

Silicon Beach Software, 204, 
2 10, 215 

SMB Development, 39 
Smooth command, MacDraw, 22 1 
Smoothing 

MacDraw curves, 22 1-22 
MacPaint enlargements, 214 

Snapshot, screen, 4, 193, 209 
Sound, amplifying, 29 
Spacebar, 146 
Spaces 

centered lines, disrupting, 145- 46 
column alignment with, 146 
excess, around pictures, 138 
extra, after italics, 14 1 

. hard, 141 
removing extra, 136-37, 162 
text centering, d isrupting, 198 

Speaker 
chirps and clicks, 13 
placement, 29 
static, 11 

Special effects, graphic 227- 28 
Spray can, MacPaint, 179 
Spreadsheets 

blank rows and columns, 111- 12 
calculation, manual, 237 
calculations, accuracy of, 233 

Spreadsheets (continued) 
calculations, rounding in, 233 
cells, naming, 230 
cells, selecting in, 230 
Clipboard, clearing, 233 
column width, 235 
dates, computing difference 

between two, 238-39 
documents, large or complex, 10 
formula errors, bypassing in, 237 
formulas, converting to 

constants, 23 7 
headers and footers in, 239- 40 
nonadjacent pages, printing, 112 
page boundaries, 111- 12 
precision, 233 

Squares 
concentric, 218 
gauge MacDraw scaling, 216 

Starti ng up 
faster, 38, 39, 58 
impossible, 12-13 

Startup application, 38, 43 
Startup disk 

contents, 48 
determining, 48 
ejecting, 3 
free space on, 62-64 
LaserWriter-equipped, 124 
on one-drive system, 67 
repairing, 69 
switching, 15, 48 
on two-drive system, 68 

STAT command, CP/M, 258-59 
Stationery, printing on, 161 
Stock Performance, 24 1 
Stop bits, 246, 257 
Style 

character, 142-43 
header and footer, MacWrite, 

155- 56 
Microsoft Excel macro for, 23 1-32 
mixing, 194, 196 
text, in MacPaint, 192-93 
ultrabold text, 195 

Subscripts and superscripts, 142- 43, 
197 

Switch, mouse button, 27- 28 
Switch settings, lmageWriter, 17, 19, 

11 3, 122 
Switcher 

application sets, 20, 42- 43 
Clipboard conversion, 42 
commands, 4 I , 43-44 
documents, attached, 42-43 
emergency exit, IO, 13, 15, 45 
Finder in, 4 1 
MacDraw with , 215 
MacPaint with , 215 

Index 

Switcher (continued) 
memory use, 20, 4 I, 43 
Save Screen option, 4 1 
speeding up, 4 1-42 
System error escape, IO, 13, 15, 45 

Switch-launch, 49-50 
Symmetry, graphic, 180, 219-20 
Symmetry Corp., 39 
System error 

causes and cures, IO, 13, 68 
emergency exit, Switcher, 45 
ID codes, 21 
in printing, 19, 11 4 
at startup, 13 

System fi le 
contents, 72 
identifying, 50 
missing, 12 
on RAM disk, 40, 67 
removing; 4 
resources in, 72, 74, I00-101 
startup disk and, 48 
switching, 48 

System Folder 
RAM disk, on, 67 
startup disk, H FS, 48 

T 
Tab key 

dialog boxes, using in, 5 
MacProject Task Info window, 

opening with , 7 
paragraphs, ending with, 148-5 1 

Tables 
aligning columns in, 146 
hiding columns in 

spreadsheets, 235 
Tabs 

Change and Find commands, 
Microsoft Word, 168-69 

column alignment, 146 
Rush headings, indented 

paragraphs, 149- 50 
markers, MacWrite, 147, 148 
paragraphs ending with , 148-49 

Tall Adjusted orientation, 118 
Tall orientation, 118 
Tape recorder, attaching, 29 
Task, MacProject, 8 
Task Info, MacProject, 7, 8 
Tecmar, I08 
Telecommunications. 

See Communications 
Telephone calls 

automatic answering, 247 
Call Waiting, suspending, 250-52 
credit-card, 250-5 1 
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Telephone calls (co11t i1111ed) 
dialing commands for, 249 
hanging up, 248 
long-distance, 250, 253-54 
placing, 248-53 
through PBX, 248-49 

Templates, document, 163 
Text, graphics. See also Style 

aligning, 198 
attributes, mixing, 194, 196 
borderless, 194 
caption, 197 
centering, 198 
outline-style, compact, 194- 95 
paragraphs, 197 
patterned, 196 
patterns, 194 
shadow-style, compact , 194-95 
style, 192-93 
superscripts and subscripts, 197 
typing, 192 
ultrabold, 195 
white, 196 

T hinkTank 
converting to Microsoft Word, 

168-69 
documems, large or complex, 10 
margin changes, 110 

T hinning MacPaint pictures, 213-14 
Three-finger stretch, 207-8 
T ilde key, 6, 223, 255 
T ime, formatting headers and 

footers to include, 155-56 
T imes font , 125, 126, 127, 14 1 
T itle Page command, MacWrite, 157 
TMPL resources, 102-3 
Toner cartridge, 123 
Tools, drawing 

constraining, 175 
FatBits, using in, 179 
reusing in MacDraw, 18 1 

l orx T-15 screwdriver, 34, 35 
Trace Edges command, MacPaint, 

172, 19 1, 194 
Transet 1000, 108 
Transfer Method, MacTerminal, 253 
Transferring in formation 

cleaning up liles after, 259-60 
with CP/M computer, 258-59 
with IBM PC, 257-58 
with Radio Shack Model 100, 259 
screen clearing, preventing during, 

256-57 
strange characters while, 260- 61 
text, converting to plain style after, 

26 1 
XModem for, 256 
XOn/Off during, 256 

Transformer, step-down, 33 
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Transparem objects, 20 I, 225 
Trash 

ejecting disks with, 3 
locked items to , 4 

Triangles, drawing equilateral, 
216-17 

TTY terminal, 257 
TurboCharger, 40 
Type attributes, 53 
Typewriter, 115-16 
Typing 

double, 254 
finding fi le names by, 5 
invisible, 254 

u 
U only prims, 112-13 
Ultrabold text, 195 
Undo command 

a nimation with, 223- 24 
quick MacPaint, 6 
phrasing options, evaluating 

with , 135 
Un iversal Primer Buffer, 108 

v 
Value axis, 24 1-43 
Values, fixed, from formulas, 237 
Venice font, 128 
Vents, cooling, 30 
VideoWorks, 226 
Voltage, foreign, use with Mac, 33 
Vollage inverter, 32 
VTIOO terminal, 255, 257 

w 
Wait for Call command, 

MacTerminal, 247 
Warra my for Mac in foreign 

countries, 33 
Washing ton D.C. font, 14 1 
Watercolor paint , 182 
Watts, 32 
Wide oricmation, 118 
Windows 

coordinates in, 204-5 
dragging without activating, 2 
drawing, 180, 210 
Finder, 5 1, 52, 54 
footnote, 154-57 
formats, copying across, 154 
resource editing, 77- 79, 87, 90, 

93, 94,98-100, 177-78, 189 

Windows (co11li1111ed) 
using several when editing. 

137 
snapshots or, 4 
Widening, in MacWrite, 159, 160 

Word. See Microsoft W01·d 
Word processing. See also MacWrite: 

Microsoft Word 
abbreviations in, 137 
animation in, 226 
backspaced text, restoring, 135 
cemering, 145-46, 163 
character formatting, 14 1- 43 
columns, aligning text in, 146 
converting documents, 168 
corrections while typing, 134 
deleted text, reusing, 135 
envelope addressing, 164- 66 
footers, 154-57 
footnotes , 158 
formulas and equations, 141 
headers, 154-58 
h)•phens, 144-45 
insertion poim, finding, 130 
letterhead, fo rmatting for, 161 
lines, formatting, 125, 143-46 
margins, 110, 14 7. 16 1 
page breaks, 162, 163 
paragraph formatting, 14 7-54 
phrasing options, evaluating, 135 
pictures in , 11 7, 118, 138- 40 
place markers, 13 1- 32 
replacing text d irectly, 135 
Return characters, 167 
running heads, 154-58 
scrolling, 130- 3 1 
selecting, 7, 130-3 1, 132-34 
spaces, 136-37, 14 1 
subscripts and superscripts, 

142-4 3 
tabs, 147, 148-5 1 
title page, MacWrite, 157 
visual separation, 14 2 
wide documents, 159, 160 
Word wrap, 143 

Words 
hyphenated, 144-45 
selecting, 130- 3 1, 132 
selecting previous, in Micrnsoft 

Word, 7 
WordStar, 168, 260- 6 1 
Worksheets. See Spreadsheets 

X,Y 
X variable, 24 1- 4 2 
XModem, 256 
XOn/XOff, 246, 254. 256 
Y variable, 24 1-42 
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BitFixer'" is a trademark of All Star Computer Services. 
FONTastic'" is a m1demark of Altsys Corporation. 
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MacPaint'", MacProject '", MacTerminal'", MacWrite'", and Switcher'" arc trademarks of 
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Touch Tone® is a registered trademark of AT&T. 
Fanny Mac'" is a trademark of Beck-Tech. 
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Macimosh ™ is a trademark of Mclmosh Laboratories, Incorporated. 
Microsoft® and Multiplan® are registered trademarks of Microsoft Corporation. 
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